1. 3D Pole (3D Array)

Ribbon Upravit > Upravit > Pole > 3D pole
Menu Modifikace > 3D Operace > 3D Pole
Panel nastoju Modifikace > 3D Pole

Klavesnice 3darray, 3dpole

Klavesova zkratka 3A

Alias 3A

Vytvari nasobnou kopii prvkd ve 3D. Entity jsou uspofadany ve 3D pravouhlych vzorech (fadky, sloupce
a urovné) a ve 2D polarnich vzorech v prostoru. Polarni vzory jsou tvofeny kopirovanim prvkd po zadané
ose.

Vyberte entity pro pole:

Vyberte entity, z nichZ chcete vytvofit pole.

Typ pole: Kruhové (P) /<Obdélnikové>:

Pro vytvofeni obdélnikového pole, vychozi volba, stisknéte Enter. Pro vytvofeni kruhového pole, napiste P
a stisknéte Enter.

Tvorba 3D obdélnikového pole

Kdyz vytvafite obdélnikové pole, fady jsou definovany ve sméru osy x, sloupce jsou definovany ve sméru
osy y a urovné jsou definovany ve sméru osy z.
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Vychozi entita pro pole.
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A. Zadejte pocet fadkl obdélnikového pole.

B. Zadejte pocet sloupcli obdélnikového pole.
C. Zadejte pocet urovni obdélnikového pole.
D. Pocatecni pozici prvku v obdélnikovém poli.
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Vyberte "Obdélnikové".

Pocet Fadku v poli <1>:

Pro odsouhlaseni vychoziho nastaveni stisknéte Enter. Pro tvorbu jiného poctu fadku (nez 1), zadejte
pozadovany pocet. Plusova hodnota poctu vytvofi fadky v plusovém sméru osy x, zaporna hodnota
naopak. Musite zadat minimalné 2 fadky pro 1 sloupec.



Pocet sloupci <1>:

Pro odsouhlaseni vychoziho nastaveni stisknéte Enter. Pro tvorbu jiného poc&tu sloupct (nez 1), zadejte
pozadovany pocet. Plusova hodnota po€tu vytvori sloupce v plusovém sméru osy y, zaporna hodnota
naopak. Musite zadat minimalné 2 sloupce pro 1 fadek.

Pocet urovni <1>:

Pro odsouhlaseni vychoziho nastaveni stisknéte Enter. Pro tvorbu jiného poctu urovni (nez 1), zadejte
pozadovany pocet. Plusova hodnota vytvofi Urovné v plusovém sméru osy z, zaporna hodnota
naopak.Vytvofenim pole s 1 Urovni dostanete pole ve 2D.

Vertikalni vzdalenost mezi fadky:

Zadejte poZadovanou vzdalenost mezi kazdym fadkem (x soufadnici) v kreslicich jednotkach.
Horizontalni vzdalenost mezi radky:

Zadejte poZadovanou vzdalenost mezi kazdym sloupcem (y soufadnici) v kreslicich jednotkach.
Vzdalenost mezi urovnémi:

Zadejte pozadovanou vzdalenost mezi kazdou Urovni (z soufadnici) v kreslicich jednotkach.

Tvorba 3D kruhového pole
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Vychozi entita pro pole.
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A. Zadejte prvni bod stfedové osy kruhového pole.
B. Zadejte druhy bod stfedové osy kruhového pole.

Vyberte Kruhové (P).

Klavesou ENTER urcite uhel mezi polozkami/<Pocet polozek pro pole>:

Zadejte pocet kopii prvkd. Pro uréeni uhlu mezi prvky stisknéte Enter.

Uhel k poli (+ proti sméru hodinovych ruéiéek, - po sméru) <360>:

Pro vytvoreni pole v plném kruhu (360°) stisknéte Enter. Pro tvorbu prvkl pole v protisméru hodinovych
ruci¢ek zadejte kladnou hodnotu, pro tvorbu prvkd pole ve sméru hodinovych ruci€ek, zapornou hodnotu.
Otacet entity kolem pole? Ne/<Ano (Y)>:

Pro odsouhlaseni vychoziho nastaveni stisknéte Enter. Pro nataceni prvkd kolem stfedové osy pole,
zadejte Ano (Y+Enter). Pokud nechcete prvky otacet, zadejte Ne (N+Enter).

Stied kruhového pole:

Urcete bod, kolem kterého chcete vytvofit kruhové pole.

Uréete druhy bod podél centralni osy pole:

Urcete druhy bod pro zadani osy, kolem které se budou prvky otacet.

Uréeni uhlu mezi prvky

Stisknéte Enter.

Uhel k poli (+ proti sméru hodinovych ruéiéek, - po sméru) <360>:

Pro vytvoreni pole v pIném kruhu (360°) stisknéte Enter. Pro tvorbu prvkd pole v protisméru hodinovych
ruci¢ek zadejte kladnou hodnotu, pro tvorbu prvkd pole ve sméru hodinovych rugic¢ek, zapornou hodnotu.
Uhel mezi prvky:

Zadejte uhel mezi jednotlivymi prvky.



Natacet entity kolem pole? Ne/<Ano (Y)>:

Pro odsouhlaseni vychoziho nastaveni stisknéte Enter. Pro nataceni prvkd, zadejte Ano (Y+Enter). Pokud
nechcete prvky otacet, zadejte Ne (N+Enter).

Stied kruhového pole:

Urcete bod, kolem kterého chcete vytvofit kruhové pole.

Uréete druhy bod podél centralni osy pole:

Urcete druhy bod pro zadani osy, kolem které se budou prvky otacet.

2. 3D Prevod (3D Convert)

Ribbon Kreslit 3D > Sité z ploch > 3D prevod
Klavesnice 3dconvert

Pro pfevedeni trojrozmérného télesa
1. Napiste <b>3dconvert</b> a stisknéte Enter.
2. Vyberte entity, které chcete prevést.

3. 3D sité (3D Mesh)

Ribbon Kreslit 3D > Kresli 3D sité
Menu Kreslit > Plochy > 3D sit’
Panel nastoju Kreslin > Plochy
Klavesnice 3D, 3dsit’

Kresli primitivni trojrozmérné plasté: klin, jehlan, kvadr, kuzel, valec, koule, misa, kopule, anuloid
Wedge . Pyramid . Box . Cone . cyLinder . Sphere . DIsh . DOme . Torus . Mesh:

3D pfikaz, ktery kombinuje dalSi pfikazy klin, jehlan, kvadr, kuzel, valec, koule, kopule, misa.

4. 3D Zrcadleni (3D Mirror )

Ribbon Upravit > Upravit > Zrcadlit > Zrcadlit 3D
Menu Modifikace > 3D Operace > Zrcadleni 3D
Panel nastoju Modifikace > 3D Operace > Zrcadleni 3D
Klavesnice  mirror3d, zrcadli3d

Kresli odrazeny obraz vybrané entity skrz rovinu.
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A. Zvolte entitu, kterou chcete zrcadlit.
B. Zvolte entitu, kterou chcete pouZit pro definovani roviny zrcadleni.
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FILtr/<Vyberte entity pro zrcadleni>:
Vyberte entity, které chcete zrcadlit, a stisknéte klavesu Enter. Vyberte filtr pro filtrovani vybéru podle
vlastnosti.

Ur¢it rovinu zrcadleni pomoci: Entita/posLedni/pohled (V)/osaZ/XY/YZ/ZX/<3body>:

Pro definici roviny zrcadleni pomoci tfech bodd, stisknéte Enter.

Pro ur€eni roviny zrcadleni pomoci vybrani entity, zvolte Entita.

Pro zrcadleni zvolenych entit kolem posledni definované roviny zvolte posLedni.

Pro definici roviny zrcadleni normalné k roviné prohlizeni skrz zvolené body, zvolte pohled (V).

Pro definici roviny zrcadleni bodem na roviné a normalnim bodem k roviné zvolte osaZ. Pro zvoleni roviny
zrcadleni pouZitim rovin X,y; y,z nebo z,x zvolte XY, YZ nebo ZX.

Pro definovani roviny zrcadleni pomoci tfi bodt

Vyberte 3body nebo zvolte bod. Po zvoleni bodu jste vyzvani k uréeni druhého bodu.

Prvni bod v roviné:

Zvolte prvni bod v roving.

Druhy bod v roviné:

Zvolte druhy bod.

Treti bod:

Zvolte treti bod.

Odstranit pavodni entity? ano (Y)/<Ne>:

Pro souhlas s aktualnim nastavenim stisknéte Enter. Pro zachovani entit, vyberte ano (Y). Pro smazani
entit zvolte Ne.

Pro definovani roviny zrcadleni pomoci zvoleni entity

Zvolte Entita.

Vyberte entitu, kterd ma smér vysunuti: Zvolte entitu.

Odstranit plvodni entity? ano (Y)/<Ne> : Pro souhlas s aktualnim nastavenim stisknéte Enter. Pro
zachovani entit, vyberte ano (Y). Pro smazani entit zvolte Ne.

Pro zrcadleni entit pomoci predchozi roviny zrcadleni

Zvolte posLedni.

Odstranit pavodni entity? ano (Y)/<Ne>:



Pro souhlas s aktualnim nastavenim stisknéte Enter. Pro zachovani entit, vyberte ano (Y). Pro smazani
entit zvolte Ne.

Pro zrcadleni entit pouzitim roviny nahledu aktualniho pohledu.

Zvolte pohled (V).

Bod v roviné pohledu <0,0,0>: Zvolte bod, nebo x,y,z soufadnice.

Odstranit pavodni entity? ano (Y)/<Ne>:

Pro souhlas s aktualnim nastavenim stisknéte Enter. Pro zachovani entit, vyberte ano (Y). Pro smazani
entit zvolte Ne.

Pro zvoleni roviny zrcadleni pomoci bodu v roviné a bodu normalnimu k roviné

Zvolte osaZ.

Prvni bod v roviné:

Zvolte prvni bod v roviné.

Druhy bod v roviné:

Zvolte druhy bod v roviné.

Tieti bod v roviné:

Zvolte treti bod.

Odstranit pavodni entity? ano (Y)/<Ne>:

Pro souhlas s aktualnim nastavenim stisknéte Enter. Pro zachovani entit, vyberte ano (Y). Pro smazani
entit zvolte Ne.

Pro definovani roviny zrcadleni pomoci roviny xy, yz nebo zx

Zvolte XY, YZ nebo ZX.

Bod v roviné XY [YZ, ZX] <0,0,0>:

Odstranit pavodni entity? ano (Y)/<Ne>:

Pro souhlas s aktualnim nastavenim stisknéte Enter. Pro zachovani entit, vyberte ano (Y). Pro smazani
entit zvolte Ne.

5. 3D krivka (3D Polyline)

Ribbon Kreslit 3D > Kresli 3D sité >3D krivka
Menu Kreslit > 3D KFivka

Klavesnice 3dpoly, 3dkFivka

Alias 3P

Kresli trojrozmérnou kfivku s rovnymi segmenty. Ackoli pfikaz 3D kfivka nema tolik voleb jako Kfivka, je
mozné po jeho dokon&eni vyuzit editaci jako pfevod na spline pomoci pfikazu Editace kFivky.

Pfiklad trojrozmérné kfivky.

Klavesou ENTER pouzijete posledni bod/Podle (F)/<Zacatek kiivky>:

Zadejte pocatecni bod.

Enter pro pokracovani z posledniho pfedchoziho bodu.

Podle (F — Follow) | Pokracovani ve sméru pfedchoziho nakresleného segmentu. Pohyb kurzoru je



omezen na Uhel dle posledniho nakresleného segmentu. Hodnota uhlu je uloZena v proménné
LASTANGLE.

Dalsi bod:

Zadejte dalSi bod kfivky.

Zavrit (C)/Zpét (U)/<Dalsi bod>:

Pokracujte pfidanim dalSiho bodu kFivky.

Zavfit (C — Close) | Uzavie kfivku. Volba dostupna, pokud mé kfivka minimalné 3 body.

Zpét (U — Undo) | Odstranéni posledniho vytvofeného segmentu.

6. 3D Rotace (3D Rotate)

Ribbon Upravit > Upravit > Otocit > Otocit 3D
Menu Modifikace > 3D Operace > Rotace 3D
Panel nastoji Modifikace > 3D Operace > Rotace 3D
Klavesnice rotate3d, oto¢3d

Otagdi entity kolem trojrozmérné osy. Uhel otageni je rozdil mezi po&atednim a koneénym thlem.

A. Zvolte entitu, kterou chcete otocit.
B. Zvolte prvni bod osy rotace.

C. Zvolte druhy body osy rotace.

D. Zvolte thel rotace.

Zvolte entitu pro otoceni:

Zvolte entitu, kterou chcete otocit.

Vyberte osu podle: Entity/posLedni/pohled (V)/osaX (X)/osaY (Y)/osaZ (Z)/<2 body>:
Stisknéte Zpét pro zvoleni dvou bodl osy rotace. Pro uréeni osy pomoci jakékoli dostupné metody, zvolte
Entita, posLedni, pohled, osX, osaY nebo osaZ.

Urcete prvni bod osy otoceni:

Kliknéte na prvni bod rotaéni osy.

Urcete druhy bod osy otaceni:

Kliknéte na druhy bod rotacni osy.

Reference/<Uhel otoéeni>:

Zvolte uhel ota€eni, vychozi nastaveni. Pro ureni zakladniho uhlu zvolte Base angle.




7. O Programu (About)

Ribbon Napovéda > Napovéda > O 4MCAD
Menu Napovéda > O programu ...

Panel nastoju Napovéda > O programu ...
Klavesnice  about, zprava

Zobrazi dialogové okno O 4MCADu, které obsahuje verzi a informace o registraci, stejné tak i copyright
a informace o spolecnosti. Kliknéte na OK pro vyjeti z dialogového okna.

8. Acis export (ACIS Out)

Ribbon Vystup > Exportovat > Exportovat Acis
Menu Soubor > Acis export

Panel nastoju Soubor > Acis export

Klavesnice acisout, piSacis

Dovoluje exportovat ACIS entity jako tfeba povrch, region, a téleso do ACIS souboru ve formatu ASCII
(SAT).
Zvolte ACIS entity, které si prejete uloZit, poté uréete jméno souboru, ktery chcete vytvofit a kliknéte na
Ulozit.
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9. Pridat / odstranit annotativni méritko (Add / Delete Scales (in Annotation Scaling))

Ribbon Poznamky > Skalovani anotace > Pridat / odstranit méFitka

Menu Modifikace > Annotativni méritko > Pridat / Odstranit méritka

Klavesnice objectscale, objméritko

Pfifazuje nebo odstrafiuje méfitka k jedné nebo vicero entitam. Annotativni méfitko Vam umozfiuje
nastavit konkrétni entity, takze jejich méfitko se nepretrzité zobrazuje v pribéhu zobrazeni nebo tisku
vykresu.

Entity, které mohou mit annotativni méfitko zahrnuji text, vicefadkovy text, odchylku, kéty, odkazové ¢ary,
atributy, Srafy a bloky.

Annotativni méfitko mazete nastavit i pomoci Panelu vlastnosti. Pro entitu nastavte annotativni na Ano,
potom kliknéte na Méfitko.

MOZNOSTI DIALOGOVEHO OKNA
Seznam méritek Zobrazuje annotativni méFitka, které jsou pfipsany zvolenym entitam.

Pridat Kliknéte na zvolené annotativni méfitko pro pfipsani ke zvolenym entitam. Zobrazi se dialogové
okno Pfidani méfitek.



Odstranit Kliknéte pro odstranéni zvolenych méfitek ze seznamu.

Zobrazit vSechna méfitka vybranych entit Zvolte pro zobrazeni v seznamu annotativnich méFitek, ktera
jsou pfipsana ke zvolenym entitam.

Zobrazit spoleéna méfitka vybranych entit Zvolte pro zobrazeni pouze annotativnich méfitek, ktera
maiji entity ze seznamu spolecné.
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10. Pridat annotativni méritko (Add Current Scale)

Ribbon Poznamky > Skalovani anotace > Seznam méfitek

Menu Modifikace > Annotativni méritko > Pridat annotativni méritko
Klavesnice aiobjectscaleadd

PFipiSe aktualni annotativni méfitko jedné nebo vicero entitdm. Entity, které mohou mit annotativni
meéfitko zahrnuji text, vicefadkovy text, odchylku, koty, odkazové Eary, atributy, Srafy a bloky.

FILtr/<Vyberte entity>: Zvolte entity, ke kterym chcete pfipsat annotativni méfitko.

11. Pridat k pracovni mnoziné (Add to Working Set)

Menu Nastroje > Uprava bloku a externi reference na misté > Pfidat k pracovni mnoziné
Klavesnice refset, refsada

PFidava entitu z vykresu k bloku nebo externi referenci, které byly na misté upraveny. Pfed pouZitim
pfikazu musite pouzit pfikaz Upravit referenci.

Zadejte moznost [pfidAt/odebRat] <Pfidat>: (Tato vyzva se zobrazi pokud pouzijete REFSET pfikaz

v pfikazovém Fadku a ne z menu.)

Vyberte objekty pro pridani (odebrani): Zvolte entity z vykresu, které chcete pfidat do bloku a stisknéte
Enter.

Pokud jste s ipravou bloku nebo externi reference skongili, zvolte Nastroje > Uprava bloku a externi
reference na misté > Zavrit referenci.

12. Zarovnat (Align)

Ribbon Upravit > Upravit > Zarovnat
Menu Modifikace > Align

Panel nastoju Modifikace > Align
Klavesnice  align, srovnej

Alias ALIGN



UmozZiuje zarovnat vybrané entity s ostatnimi entitami v 3D prostoru. Vyberete entity, které byste chtéli
zarovnat, poté urcite jeden, dva nebo tfi pary bodl pro zarovnani vybranych entit.

e Jeden par entit — Posouva vybranymi entitami

e Dva pary bodl — Posouva a otaci vybrané entity. Druhy par bodu muze také urcit méfitko entit,
s kterymi hybete (méfeni je mozné pouze pokud pouzivate dva pary bodu).

e TFi pary bodl — Posouva, otaci a pak znova otaci vybrané entity.

FILtr/<Vyberte entity>:
Vyberte entity, kterymi chcete posouvat a zarovnat je, poté stisknéte Enter. Do vybéru nezahrnujte cilovou
entitu. Zvolte FILtr (FIL) pro filtrovani vybéru dle viastnosti.

Zarovnani entit posouvanim

Uréete prvni zdrojovy bod:
UrCete zdrojovy bod vybranych entit, které chcete pfemistit.

Urcete prvni cilovy bod:
Urcete cilovy bod, poté zmacknéte Enter.
Vybrané entity se budou posouvat ze zdrojového bodu ke koncovému.

Zarovnani entit posouvanim a otacenim

Urcete prvni zdrojovy bod:
Urcete zdrojovy bod vybranych entit, které chcete premistit.

Urcete prvni cilovy bod:
Urcete cilovy bod, poté zmacknéte Enter.

Urcete druhy zdrojovy bod:
Urcete druhy zdrojovy bod, ktery uruje bod, ze kterého se entity budou otacet.

Urcete druhy cilovy bod:
Urcete druhy cilovy bod, ke kterému se vybrané entity budou otacet. Zmacknéte Enter

Ménit méritko objekti na zakladé bodu zarovnani [Ano (Y)/Ne] <Ne>:

Zvolte Ano, pro Skalovani (zmé&nu méfitka) vybranych entit, nebo zvolte Ne. Pokud ménite méritko,
vybrané entity se Skaluji umérnég, takZe vzdalenost mezi dvéma zdrojovymi body je stejna jako mezi body
cilovymi.

Vybrané entity se posouvaiji z prvniho zdrojového bodu do prvniho cilového bodu, pak se otaci z druhého
zdrojového bodu do druhého cilového bodu. Pokud jste zvolili Ano, vybrané entity jsou Skalovany.

Zarovnani entit posouvanim a poté otacenim dvakrat

Urcete prvni zdrojovy bod:
Urcete zdrojovy bod vybranych entit, které chcete premistit.

Urcete prvni cilovy bod:
Urcete cilovy bod, poté zmacknéte Enter.



Uréete druhy zdrojovy bod:
Urcete druhy zdrojovy bod. Ten ur€uje bod, odkud se entity budou otacet.

Uréete druhy cilovy bod:
Urcete druhy cilovy bod, ke kterému se vybrané entity budou otacet.

Urcete tieti zdrojovy bod:
UrCete tfeti zdrojovy bod, ze kterého se budou vybrané entity podruhé otacet.

Urcete tieti cilovy bod:
Urcete treti cilovy bod, ke kterému se budou vybrané entity podruhé otacet.

13. Vypnout vSechny uchopy (All entity snaps off)

Ribbon Kreslit > Uchopy entit > Vypnout aktivni Gichopy entit
Menu Nastroje > Uchopy entit > Vypnout véechny tuchopy
Panel nastojii Uchopy entit > Vypnout

Klavesnice f3

Vypne v8echny uchopy. Pfikaz je moZné zapnout klavesou F3.

14. Zdanlivy prasecnik (Apparent intersection snap)

Ribbon Kreslit > Uchopy entit > Nastavit uchopeni zdanlivého praseéniku
Menu Nastroje > Uchopy entit > Zdanlivy priiseénik

Panel nastoji Uchopy entit > Zdanlivy praseénik

Klavesnice  apparent

Zapne nebo vypne Uchop zdanlivého prusecéniku. Kdyz je zapnuty, mizete uchopit priise¢nik dvou entit,
které se neprotinaji realné ve 3D prostoru, ale zdanlivé se protinaji v aktualnim pohledu. Uchopit je mozné
prinik jakychkoliv dvou entit - kombinaci oblouku, kruznice, pfimky, kfivky, polopfimky, elipsy, eliptického
oblouku, spliny, Srafovaciho vzoru nebo polygonové sité. Mzete uchopit i bod priniku v ramci jedné
entity v€etné kfivky nebo spline.

Moznost vzdaleny zdanlivy praseénik vytvori ichop v misté, kde by se dvé entity (pfimky, oblouky nebo
eliptické segmenty) protali, kdyby méli nekonecnou délku. IntelliCAD automaticky vyuziva moznost
prodlouzeni pouze v pfipadé, ze napiSete app do pfikazového fadku (ne piny nazev pfikazu apparent) po
zvoleni pfikazu jako je UseCka nebo kruznice. Zobrazi se prodlouzeni Usecek preruSovanou ¢arou pro
znazornéni zdanlivého prasecéniku.
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A. Nakresleni nové entity diky uchopeni zdanlivého prasecniku entit, které ve skute€nosti nejsou ve stejné
roving.

15. Pripojit text (Append text)

Ribbon Plus > Text > Pripojit
Klavesnice tappend

Pfikaz umoZzniuje pfipojit dalSi text, pfiponu nebo predponu.

FILtr/<Vyberte entity>:

Zvolte entity, ke kterym chcete pfipojit pfedponu nebo pfiponu. A stisknéte Enter.
Pridat pfedponu nebo piiponu

Pro pfipojeni pfedpony zvolte P.
Pro pfipojeni pfipony zvolte S. Stisknéte Enter.

Zadejte text pro pripojeni :

Zadejte do pfikazového Fadku text, ktery chcete pfipojit a stisknéte Enter.

16. Oblouk (Arc)

Ribbon Kreslit > Kreslit > Oblouk tfema body > Oblouk
Menu Kreslit > Oblouk

Panel nastoju Kreslit > Oblouk

Klavesnice  arc, oblouk

Alias A

Kresli oblouk jakékoli velikosti.

P¥i provadéni pfikazu oblouk mizete zadavat volby pomoci pismena v zavorce (jde o prvni pismeno
anglického nazvu volby). Mlzete také volit do¢asné uchopy — napfiklad ,end“ pro uchop koncového bodu
nebo ,cen” pro uchop stfedového bodu.



Pokud jste jesté nevytvofili Zadnou jinou entitu, zobrazi se tyto moznosti:
Stied (C)/<Zacatek oblouku>:

Zadejte poc¢atecni bod pro kresleni oblouku vychozi metodou.

Stied (C — Center) | Zadani stfedového bodu oblouku

Pokud jste jiZz nakreslili alespori jednu entitu, mate tyto moZnosti:

Klavesou ENTER pouzijete posledni bod/Stifed (C)/Podle (F)/<Za¢atek oblouku>:

Zadejte pocatecni bod pro kresleni oblouku vychozi metodou.

Enter pro kresleni od posledniho pfedchoziho bodu.

Stied (C — Center) | Zadani stfedového bodu oblouku

Podle (F — Follow) | Vytvofeni oblouku dle naposledy vytvofené entity. Jeji koncovy bod bude pocatecnim
bodem oblouku a oblouk bude vytvoren jako te€ny k této entité.

Poznamka
PFikaz Oblouk pro pfedchozi bod pouziva hodnoty ulozené v systémové proménné LASTPOINT. Pfi volbé
moznosti Podle (F) vyuziva hodnoty Uhlu z proménné LASTANGLE.

17. Plocha (Area)

Ribbon Nastroje > Dotaz > Plocha
Menu Nastroje > Dotaz > Plocha
Panel nastoju Dotaz > Plocha
Klavesnice area, plocha

Alias AA

Vypoc¢ita plochu entit nebo definovanych ploch.

Poznamka: Plocha a obvod pocitany pfikazem ,Plocha“ je uloZen v systémovych proménnych AREA
a PERIMETER.

Entita/pfidAt/odebrat (S)/<Prvni bod>:

Pro vypocet plochy zadanim bodu, stanovte po€ate¢ni bod. Pro zjisténi plochy jednotlivé entity, zvolte
Entita. Pro zjisténi plochy jedné nebo vice entit, zvolte Pfidat (A). Pro odebrani plochy z vicero entit zvolte
Odebrat (S).

Vypocet plochy zadanim bodu

A. Zvolte prvni bod pocitané plochy
B. Zvolte druhy bod
C. Zvolte tfeti bod

Urcete pocatecni bod plochy, kterou chcete pocitat.

Dalsi bod:
Zvolte druhy bod pocitané plochy. Pokra€ujte pro uréeni bodu. VSechny body musi leZet v roving x, y.



Pokud neuzavfete plochu, kterou chcete pocitat, program spocita plochu jako by byl posledni uréeny bod
spojeny s prvnim; nicméné tato délka neni pfidana pfi vypoctu délky. Po ureni viech bodu pro vypocet
plochy, kliknéte pravym tlacitkem mysSi a nebo Enter. Plocha a obvod jsou zobrazeny v pfikazovém Fadku.
Pokud se vam tento fadek neukazuje, plochu a obvod najdete také v okné historie pfikaz(.

P 4MCAD Historie vjzev EENEERT

-,

Command:

Command:

Nacitani podpora renderovani.

Nacitani ArchLib4m...

Hotovo

Podpora rastrovych obrazka nactena.

Command: '_HELP

Command: _circle

2Body (2P)/3Body (3P)/TecTecRad/TecTecTec/Oblouk (A)/Vicenasobné
(M) /<Stred kruhu>:

Prumér (D)/<Polomérs>:

Command: AREA

Entita/Pridat (A)/Odebrat (S)/<Prvni bod>: E

V{berte entitu pro vypocet plochy:

Plocha = 254198.426051 ctv. jednotek, Obvod = 1787.2749
Command: '_PMTHIST

Command :

Vybér entity

Entity, které mUzete vybrat pro vypocet plochy, jsou kruznice, elipsy, uzaviené kfivky, stopy a roviny. Pfi
vybéru pfimky, oblouku nebo spliny se vypocita pouze délka.

la 1

A '@

A. Vyberte entitu pro plochu, kterou chcete pocitat.

Vyberte entitu.

Urcete entitu pro vypocet plochy: Plocha je zobrazena v pfikazovém fadku.
Pro rovinu, polygon, nebo kfivku, je vysledek podobny jako:

Plocha = 6.1296 Ctv. Jednotek, Obvod = 10.6762

Pro kruznici je vysledek podobny jako:

Plocha = 6.4033 &tv. Jednotek, Obvod = 8.9703

Pro oblouk nebo pfimku je vysledek podobny jako:

Délka = 10.8278



Po vybrani oteviené kfivky, je plocha poc€itana, jako by kone¢ny bod posledniho nakresleného segmentu
byl spojen s poCatecnim bodem prvniho segmentu; avSak délka pro uzavieni polygonu se nepocita pfi
méreni celkové délky entity.

Pro stopu, pfikaz plocha poc¢ita pouze délku jednoho segmentu stopy. Pro kfivky s tloustkou, pfikaz
Plocha pocita plochu a délku na zakladé stfedové osy kfivky s Sitkou.

Pridani a odebrani entit

Muzete pfidavat a odebirat entity pro zachovani pribézné celkové plochy a obvodu kalkulaci.

Ld°

A. Vyberte prvni plochu pro vypocet
B. Vyberte entitu pro pfidani nebo odebrani z celkové plochy
C. Vyberte dalSi entitu pro pfidani nebo odebrani z celkové plochy

Zvolte Pfidat (A) nebo Odebrat (S).
Pokud vyberete pfidat, nasledujici pfikaz se zobrazi v pfikazovém fadku:

PFidani: Entita/Odebrat (S)/<Prvni bod>:

Pro vybrani plochy, kterou chcete pfidat, zvolte prvni bod. Pro pfidani entity, zvolte Entita (E). Pokracujte
v uréovani bodd nebo vyberte entitu pro vypocet plochy vaseho vybéru. Pro odebrani plochy pfi pfidavani
plochy, kliknéte pravym tlacitkem mysi, vyberte Odebrat (S) a poté uréete prvni bod nebo entitu, kterou
chcete odebrat.

Pokud vyberete Odebrat (S), zobrazi se vam v pfikazovém fadku nasledujici pfikaz:

Odebrani: Entita/pfidAt/<Prvni bod>:

Pro vybrani plochy pro odebrani, uréete prvni bod, z kterého chcete odebrat plochu. Pro vybrani entity pro
odebrani, zvolte Entita (E). Pokradujte v ur¢ovani bodu nebo vyberte entity pro odebrani plochy z vaseho
vybéru. Pro pfidani plochy béhem odebirani, kliknéte pravym tlacitkem mysi, vyberte Pfidat (A) a poté
zvolte prvni bod nebo entitu z plochy, kterou chcete pfidat.

18. Pole (Array)

Ribbon Upravit > Upravit > Pole
Menu Modifikace > Pole

Panel nastoji Modifikace > Pole
Klavesnice array, pole

Alias AR

Vytvari nasobné kopie entit v jednom ze dvou moznych symetrickych vzor(: provouhlém (fady a sloupce)
nebo radialnim (kruhovém). Jde o podobny pfikaz jako 3D Pole (3D Array), ale entity jsou vytvofeny
pouze ve dvourozmérném prostoru. Polarni pole kopiruje entity po kruznici kolem stfedového bodu, ktery
urcite; entity mohou byt pooto€eny (vSechny mifici na stfedovy bod) nebo nemusi.

Linearni pole podél kfivky je mozné vytvofit pomoci pfikazu Rozdélit (Divide) nebo Rozméfit (Measure)

s volbou Blok. Pro vytvoreni nepravidelného pole pouZijte pfikaz Kopie (Copy).



Vyberte entity pro pole:
Zvolte entity a potvrdte vybér pravym tlacitkem mysi nebo klavesou Enter.

Typ pole: Polarni/<Obdélnikové>:
Pro vytvofeni pravouhlého pole stisknéte Enter.
Polarni (P) | Volba pro polarni (kruhové pole).

Pravouhlé pole

Entity jsou nakopirovany v pravouhlém vzoru v pozitivhich smérech os X a Y. Pro kopirovani v opaéném
sméru zadejte pro pocty sloupcu a fad zaporné hodnoty. Pravouhlé pole musi mit alespor dvé Fady nebo
dva sloupce.

A — ¢

TUUU
AVAVAY,

A. Vyberte entity pro vytvoreni pole.
B. Zadejte pocet fad.
C. Zadejte pocet sloupcu.

Volba Pravouhlé.
Pocet Fadku v poli <1>: Zadejte pocet fad v poli.
Pocet sloupct <1>: Zadejte pocet sloupci.

POZNAMKA Musite zadat alespori dvé fady nebo dva sloupce. Pokud pro podet sloupct i fad zadate 1,
program pfikaz ukonci

Vertikalni vzdalenost mezi fadky, nebo obdélnik roztece:
Zadejte vzdalenost mezi fadami v poli nebo uréete na obrazovce dva body, které budou reprezentovat
vertikalni a horizontalni vzdalenost mezi fadami a sloupci.

Horizontalni vzdalenost mezi sloupci:
Zadejte vzdalenost mezi sloupci v poli.

POZNAMKA Pokud bude vertikalni nebo horizontalni vzdalenost nulova, program v tomto sméru entity
nevytvori. Pokud by byly nulové obé vzdalenosti, program nevytvofi Zadné entity.

Polarni pole

A—

A—

Yo O A,
(AP

A. Vyberte entity pro pole.

B. Urcete stfedovy bod pole Obrazek vlevo ukazuje entity v poli pootocené.

Volba Polarni (P).

Zaklad (B)/Stired polarniho pole (C):
Stied (C — Center) | Zadani stfedového bodu, kolem kterého bude pole vytvoreno.



Klavesou ENTER urcite uhel mezi polozkami/<Pocet polozek pro pole>:
Zadejte pocet prvku v poli nebo pomoci klavesy Enter pfejdéte na moznost zadani thlu mezi entitami.

Uhel k poli (+ proti sméru hodinovych ruéiéek, - po sméru) <360>:

Pro vytvoreni entit po celém kruhu potvrdte vychozi hodnotu. Pro vytvoreni pole protisméru hodinovych
rucicek zadejte hodnotu kladnou. Pro vytvofeni po sméru hodinovych ruci¢ek zadejte hodnotu zapornou.
Vychozi hodnotou pro vytvorfeni polarniho pole je 0 stupnu.

Otocit entity kolem pole? Ne/<Ano>:
Zvolte, zda chcete entity v poli natacet.

19. Pfipojit (Attach)

Ribbon Vlozit > Reference > Pripojit
Menu Soubor > Pripojit
Klavesnice attach, pfipoj

PFipojuje externi soubory k vykresu. MUzete pfipojit soubory téchto typu: soubory .dxg vykresy, .pdf
soubory, .dwf soubory, soubory .dgn vykresy a obrazky.
V dialogovém okné, které se zobrazi, zvolte soubor, ktery chcete pfipojit.

20. Vlozit rastrovy obrazek (Attach raster image)

Ribbon Vlozit > Data > P¥ipojit obrazek > Pripojit obrazek
Menu Vlozit > Rastrovy obrazek
Klavesnice imageattach, obrpfipoj

Pfipoji obrazek k vykresu. Po zvoleni obrazku, ktery chcete pfipojit, se zobrazi dialogové okno P¥ipojit
obrazek.

MOZNOSTI DIALOGOVEHO OKNA
Obrazek nalezen v: Zobrazi slozku s umisténim obrazku.

Cesta obrazku bude ulozena jako: Zadejte jiné umisténi souboru, pokud je to potfeba. Kliknéte na > pro
zvoleni zpUsobu ukladani cesty k obrazku:

- PIn& cesta - na obrazek odkazuje plna cesta, napfiklad: c:\\Moje obrazky\Obrazek.jpg. PouZijte tuto
moznost, pokud je obrazek uloZen ve slozce, ktera nesouvisi s aktualni sloZzkou vykresu.

- Relativni cesta - na obrazek ukazuje relativni cesta v aktualni sloZce vykresu, napfiklad ..\Moje
obrazky\Obrazek.jpg. Tato moznost je vhodna, kdyz je obrazek ulozeny v podslozce aktualniho vykresu.

- Pouze nazev souboru - na obrazek se odkazuje pouze ndzvem obrazku v aktualni sloZce vykresu,
napfiklad Obrazek.jpg. Tato moznost je vhodna, pokud je obrazek ulozen ve stejné slozce jako aktualni
vykres.

Pouzit soubor pozice Zvolte pro automatické umisténi obrazku do vykresu s vyuzitim specifikace zadané



v souboru s umisténim. Zadejte TWF soubor souvisejici s obrazkem nebo jej zvolte kliknutim na [...] .

Detaily obrazku Kliknéte pro zobrazeni dalSich informaci v€etné barevné hloubky a rozliseni
v dialogovém okné Detaily obrazku.

Bod vlozeni Zvolte pro uréeni bodu vloZeni pfimo ve vykrese, nebo zadejte soufadnice.

Méritko Zvolte pro ur€eni velikosti obrazku ve vykrese, nebo zadejte Sitku (X) a vySku (Y) v jednotkach
vykresu. Zatrhnéte Zachovat pomér stran, pokud chcete, aby se $ifka a vySka ménili proporéné pfi zméné
velikosti obrazku.

Otoceni Zvolte pro uréeni otoceni ve vykrese, nebo zadejte o kolik stupiit se ma obrazek otodit vlevo.
Pouzit prahlednost Zvolte, jestli entity umisténé pod obrazkem jsou viditelné (pro vykresy, které
podporuji alfa prihlednost, co znamena pro obrazky, které maji alespori jednu barvu, ktera maze byt

zobrazena jako pruhlednad)

Zobrazit hranici ofezu Zvolte, jestli chcete zapnout nebo vypnout zobrazovani hranice ofezu v obrazku.

21. Definice atributti (Attribute Definition)

Ribbon Vlozit > Definice bloku > Definovat atributy
Klavesnice attdef
Alias -AT

Vytvafi Definici atributd, coz je entita tvofena jménem, vyzva po informaci, zobrazované vlastnosti
a vychozi text. Pouzijte definici atributl pro text, ktery chcete spojit s blokem definici.

DIALOGOVE OKENKO MOZNOSTI

Nazev
Napiste jméno, které chcete pfifadit atributu.

Vyzva
Zadejte identifikani vyzvu informace, zobrazené pfi vioZeni bloku, ktery obsahuje atribut.

Vychozi text
Zadejte vychozi nebo konstantni hodnotu. U variabilnich atributd je vychozi hodnota nahrazena skute¢nou
hodnotou, kdyZz pozdé&ji vloZite blok, ktery obsahuje atribut.

Souradnice vlozeni
Urcete x-, y- a z- soufadnice pro vlozeni atributl bodu. Klepnéte na tlacitko Vybrat, urCete vlozeni atributt
bodu vybérem bodu ve vykresu.

Skryty
Zvolite vlozeni skrytého atributu.

Konstantni
Zvolte vytvoreni konstantni hodnoty atributu.

Ovérovany
Zvolite vytvoreni atributu, jehoz hodnota musi byt ovéfena, pokud pozdéji vkladate blok, ktery obsahuje
atribut.



Nastaveny
Vyberete vytvofeni atributu, jehoZ hodnota je definovana a neni poZzadovana, kdyZ pozdé&ji vkladate blok,
ktery obsahuje atribut. Hodnotu muzete upravovat po vlozeni bloku.

Uzaméeny
Vyberte vytvofit atribut, jehoz pozice je uzaméena.

Styl textu
Zvolte styl textu ze styll jiz definovanych ve vykresu.

Zarovnani
Zvolte zarovnani textu.

Vyska textu

Urcete vysku textu, nebo kliknéte pro uréeni vySky vybranim dvou bodd ve vykresu.

Otaceni

Urcete Uhel otaceni textu, nebo kliknéte pro ur€eni Uhlu rotace vybranim dvou bodu ve vykresu.

Definovat
Po kliknuti je mozné definovat dalSi atribut.

Definovat a ukongit
Kliknéte pro pfidani atributu a ukon&eni pfikazu.

22. Zobrazeni atributt (Attribute Display)

Ribbon Vlozit > Definice bloku > Zobrazeni atributt
Menu Zobrazit > Zobrazit > Zobrazeni atributti > Zapnuto
Klavesnice attdisp

Je mozné zobrazeni atributl zapnout, vypnout nebo zobrazit je normalné.

Rezim zobrazeni atribut: ano (ON)/ne (OFF)/Normalni/: Pro pfijeti vychozi hodnoty normalini stisknéte
Enter. Pro zobrazeni vSech atribut zvolte ano (ON), pro vypnuti zobrazovani atribut( stisknéte ne (OFF).

23. Audio poznamka (Audio Note)

Ribbon Nastroje > Spravovat > Audio poznamka
Klavesnice audionote

Vytvafi, pfehrava a maze audio poznamky, Cili zvuky, které jsou pfipojeny k jednotlivym obrazkim. Kdyz
do obrazku pfidate audio poznamky, ulozi se do souboru s vykresem, ne jako samostatny audio soubor.
Nezapomerite, Ze se tim zvétSuje velikost Vadeho vykresu. Audio poznamky, které jste vytvofrili

z existujiciho souboru *.wav se ukladaji do souboru s vykresem a samostatné *.wav soubory zUstavaji
nezméneéne.

Své audio poznamky muzete prehravat pouze v InteliCADu.



Vyberte entity: Zvolte poZzadované entity. Nezapomerite, Ze ikony, které zastupuji audio poznamky si
vybrat nemuzete - zvolit miizete pouze entity, které odpovidaji pozadované audio poznamce.

pfFipojit (A)/nahRat/Prehrat/oDstranit/vybrat (S)/ukongéit (X)/<Zaznam>: Pro nahrani a pfipojeni nové
audio poznamky zvolte nahRat (R). Pro pfehrani audio poznamky pro zvolenou entitu zvolte Prehrat (P).
Pro vymazani audio poznamky pfipojené ke zvolené entité zvolte oDstranit (D). Pro zvoleni jinych entit
zvolte vybrat (S). Pro ukonéeni pfikazu zvolte ukongit (X).

Pro nahrani a pfipojeni nové audio poznamky

Zvolte nahrat (R).

Zobrazi se dialogové okno Audio poznamka.

Kliknéte na Zaznam, abyste mohli nahrat audio poznamku, pak mluvte do mikrofonu.

Kliknéte na Ukoncit pro ukon&eni nahravani.

Pro pfezkouseni audio poznamky kliknéte na Piehrat a pak pouzijte Pauza nebo Konec pro ukon&eni
prehravani.

Kliknéte na Pripojit k entitam.

Pro pripojeni audio poznamky s vyuzitim *.wav souboru

Kliknéte na pfipojit (A).
Zvolte pozadovany *.wav soubor a kliknéte na Otevrit.
Zvolte Ukoncit.

Pro piehrani audio poznamky.

Kliknéte na pfehrat (P).

Zobrazi se dialogové okno Audio poznamka.

Kliknéte na pfehrat (P).

Pro doCasné pozastaveni prehravani stisknéte Pauza.
Kliknéte na Konec pro ukonceni pfehravani.

Kliknéte na OK.

Pro smazani audio poznamky

Kdyz zvolite odstranéni audio poznamky z entity, audio poznamka je trvale odstranéna a neni mozné ji
znovu pouzit.

Zvolte odstranit (D).

Pro vybér entit

Zvolte vybrat (S).

Vyberte nové entity pro praci s audio poznamkami a stisknéte Enter.

Pokracujte v praci s audio poznamkami a zvolte pozadovany pfikaz.

Tip Vzhled ikon pro audio poznamky muzete upravit s pomoci systémovych proménnych Audioicon,
Audioiconcolor nebo Audioiconscale.

24. Audit (Audit)

Ribbon Tlacitko aplikace > Nastaveni kresleni... > Audit
Menu Soubor > Audit
Klavesnice audit, diag



Zkontroluje chyby v aktualnim vykrese, napfiklad pokud vykres pochazi z jiného programu nebo byl
poskozen v pfi padu systému.
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Opravit veskeré zjisténé chyby? [ano (Y)/Ne] <N>: Pro kontrolu souboru a automatickou opravu
nalezenych chyb zvolte ano (Y). Pro pouhou kontrolu souboru zvolte ne (N).

Pokud je systémova proménna AUDITCTL zapnuta a audit nalezne chyby, vytvofi se ASCII soubor, ktery
popisuje vysledky auditu. ASCII soubor se ulozi do stejné sloZky jako vykres, ve kterém probéhl audit,
a ma stejny nazev jako soubor s vykresem, jen s pfiponou .adt.

25. Zakladni bod (Base)

Ribbon Vlozit > Definice bloku > Zakladni bod (v Definici bloku)



Menu Kreslit > Blok > Zakladni bod
Klavesnice ba

Nastavi referenni bod pro vloZeni tohoto vykresu do jiného vykresu.

Referencni bod pro vloZeni tohoto vykresu <0.000000,0.000000,0.000000>: Pro pfijmuti aktualniho,
vychoziho, referenéniho bodu stisknéte Enter, nebo zvolte x,y,z-soufadnice pro novy referencni bod. Je
dobré zadat z-soufadnice. Pokud z-soufadnici nezadate, program pouzije hodnotou uloZzenou

v systémové proménné ELEVATION.

Poznamka: PouZzivani pfikazu Base je podobné uréovani bodu viozZeni, kdyzZ vytvarite blok. Kdyz vkladate
vykres do jiného vykresu, program pocita s referenénim bodem 0,0,0. S pfikazem Base muzete zménit
referenc¢ni bod na jinou hodnotu.

26. Referenéni bod (Base point)

Menu Kreslit > Blok > Zakladni bod
Klavesnice base, refbod
Alias BA

Nastavi referen¢ni bod pro vkladani vykresu do jiného.
Referencéni bod pro vlozeni tohoto vykresu <0.000000,0.000000,0.000000>:
Chcete-li pfijmout aktualni referenni bod, vychozi, stisknéte klavesu Enter nebo zadejte x-, y-, z-

soufadnice pro novy referenéni bod. Zadani z-soufadnice je volitelné. Pokud nechcete zvolit z-soufadnici,
vychozi nastaveni programu nastavi hodnotou uloZzenou v systémove proménné ELEVATION.

27. Blok (Block)

Ribbon Vychozi > Blok > Vytvofit blok
Menu Kreslit > Blok > Vytvorit...
Panel nastoju Kreslit > Vytvofit blok
Klavesnice  block, blok

Alias -B

Ze skupiny entit vytvofi jednu sloZenou.

VAN /AN VAN
+ {7 !
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A. Uréete bod vlozeni bloku.

B a C. Zvolte entity, které chcete do bloku zahrnout.
D. Blok vloZzeny do vykresu.




Nazev nového bloku, nebo ? pro seznam existujicich bloku:

Zadejte nazev nové vytvareného bloku. Nazev muze obsahovat alfanumerické znaky véetné znaku $,
poml¢ky (-) a podtrzitka (_). Maximalni délka je 255 znaka.

? | Zobrazeni seznamu blokl ve vykrese.

Pokud zadate jiz existujici nazev bloku, objevi se upozornéni: ,Blok jiz existuje. Chcete jej pfedefinovat?*
Pokud zadate N, je pfikaz bloku ukonéen. Pokud zvolite Ano (Y) pfikaz pokracuje.

Bod vlozeni nového bloku: Zvolte bod vioZeni, ktery bude zakladnim bodem pfi vkladani bloku.

Vyberte entity pro blok: Zvolte entity, které chcete v bloku zahrnout. Entity z vykresu zmizi.

Pro obnovu zmizelych entity napiSte pfikaz UNDELETE.

Diky blokiim muazete kombinovat vice entit do jediné a znovu ji pouzivat pfi vkladani nasobnych kopii. Blok
je do vykresu vkladan pomoci pfikazu Vlozit blok.

Blok existuje pouze ve vykrese, ve kterém byl vytvoren. Pro kopirovani blokd mezi rGznymi vykresy nebo
pro ulozeni bloku na disk je mozné vyuzit Prizkumnika 4MCAD.

Vypis existujicich blokt

Zvolte ?.

Vypsat blok(y) <* pro vSechny>:

Zadejte *. V okné historie pfikazll je zobrazen vypis blok{ definovanych ve vykrese ve Ctyfech kategoriich:
Uzivatelské bloky: Bloky vytvofené uzivatelem.

Externi reference: Externé pfipojené vykresy umisténé pomoci pfikazu Externi reference nebo pomoci
Spravce externich referenci.

Zavislé bloky: Bloky nachazejici se ve vykresech externich referenci.

Nepojmenované bloky: Bloky vytvoifené programem jako jsou napfiklad vzory Sraf.

Predefinovani bloku

PFi vyzvé k zadani nazvu nového bloku, zadejte nazev bloku, ktery si prejete predefinovat. Pfi upozornéni
na predefinovani bloku zvolte Ano (Y) a pokracujte dale jako pfi definici nového bloku. Novy blok nahradi
blok se stejnym nazvem.

Moznosti dialogového okna



Definice bloku X

Nazev
| v|
Zakladni bod Entit
l' Zadejte bod l' Vyberte entity il
X @ zachovat

Y |0.0000 (O Konvertovat na blok
(O odstranit
Nejsou vybrany Zadné entity.

Z |0.0000

Nastaveni

[] 3kalovat rovnomérné
Umoznit rozlozeni

Popis

' Hypertextowy odkaz... |

OK Storno . Napovéda

28. Spocitat bloky (Block Count)

Klavesnice blkcount

Spocitd, kolikrat je blok vloZzen do vykresu.
Zadejte nazev bloku pro vypocet :
Napiste do pfikazového fadku nazev bloku, ktery chcete spodcitat.

V prikazovém Fadku se vam zobrazi pocet.

29. Nahrazeni bloku (Block Replace)

Klavesnice blockreplace

V dialogovém okné vyberte, ktery blok chcete vyménit za ktery, a kliknéte na Pfijmout.



30. Zobrazit blok (Block Show)

Klavesnice blkshow

Skryje ostatni entity a zobrazi pouze vyhledavany blok.
Zadejte nazev bloku pro zobrazeni :
Zadejte blok, ktery chcete zobrazit.

Zobrazeni zUstava, dokud nezvolite jiny pfikaz.

31. Nahradit blok (Block Swap)

Klavesnice blkswap

Nahrazuje blok druhym, jiZ existujicim blokem.

FILtr/<Vyberte entity>:

Vyberte entitu nebo vice entit rznych blokd, které budete chtit nahradit jinym blokem.
Zadejte nazev nového bloku :

Zadejte nazev bloku, kterym budete chtit nahradit vybrané bloky.

32. Srafa (Boundary Hatch)

Ribbon Kreslit > Kreslit > Srafy > Srafy
Menu Kreslit > Srafa

Panel nastojii Kreslit > Srafa

Klavesnice  bhatch, hsrafy

Alias BH

Umoznuje pouzit kfizové Srafovani a vyplné vzory na uzaviené entity uvnitf ur€enych hranic. Hranice Sraf
mohou byt zvoleny jako asociativni. V takovém pfipadé se Srafa zméni spole¢né s Upravou jeji hranice.
Asociativni Srafy z jinych CAD programu se ve 4MCAD zobrazuji a mohou byt editovany.

Vice informaci o vytvareni hranic pro Srafovani naleznete u pfikazu Hrani¢ni kfivka.

POZNAMKA Vzory $raf maji velké naroky na pamét poditade a jejich vykresleni mize vyzadovat velké
mnozstvi Casu. Pro lepsi vykon je dobré Srafovat az v jednom z poslednich kroku pfi vytvareni vykresu
nebo vkladat Srafy do zvlastni hladiny, kterou je mozné zmrazit a pokracovat v kresleni.



Podrobnégjsi informace o Srafovani naleznete v sekci Napovéda.

33. Hranice (Boundary Polyline)

Ribbon  Kreslit > Kreslit > Srafy > Hranice

Menu Kreslit > Hrani¢ni krivka
Klavesnice boundary, hranice
Alias BO, BPOLY

S pfikazem Hranice muzete navrhnout urcitou oblast vykresu pro operaci, jako je Srafovani a kétovani.
Hranici vytvorite vyb&rem plochy uvnitf uzavieného uzlu. Plocha, kterou jste vybrali mize byt ohraniCena
jedinou uzavienou entitou nebo vice entitami, které se protinaji.

V pfipadé, Ze se entity protinaji, IntelliCAD bere hranici jako uzavieny uzel nejblize bodu uréené plochy.
Napfiklad v nasledujicim pfipadé bod vybrané plochy v obdélniku vytvafi uzavieny uzel nejblize od bodu
oznaceni, neoznacuje plochu samotného obdélniku, v némz se bod nachazi.

Ko = o ERa
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A) Urcete bod plochy, ktery bude uvnitf obdélniku.
B) Vysledna hranice.

Pro pfesnéjsSi ur€eni hranic mizete vytvofit mnozinu hranic. Mnozina hranic urcuje, které entity jsou
povazovany za urcujici pro vedeni hranice. Pokud pracujete ve sloZitém vykresu, pomaha to vytvaret
hranice rychleji.

V nasledujicim pfipadé& jsou vybranymi entitami kruh a trojuhelnik. Pokud vyberete plochu kdekoliv uvnitf
kruhu nebo trojuhelniku, vysledkem bude vzdy kfivka ohraniCujici Sedou plochu.

) &

Trojuhelnik (A) a kruh (B) vybrany pro mnoZinu hranic.
Bod oznacgeny ve vybrané plose (C), jehoz vysledkem je nové vytvofena hranice kolem Sedé hranice.

Moznosti dialogového okna
Zadat mnozinu hranice
Vyberte entity, které chcete udélat dostupnymi pro tvorbu hranic:

Vyberte V8echny viditelné entity, aby jste méli vSechny entity ve vykresu, kdyZ budete vytvaret hranice.



Pouzijte tlaCitko Zadat plochu (ne tlacitko Zadat entity!) pro vytvofeni vlastniho vybéru mnoziny, ktery
Kliknéte na Zadat mnoZinu hranice. Ve vykresu vyberte entity individualn& nebo zvolte metodu vybéru

z vybé&rového okna a stisknéte Enter. Automaticky se zvoli Aktualni vyb&rova mnoZina, kterou jste vybrali
pomoci Zadat mnozinu hranic a Srafovani se bude tykat entit v této mnoziné.

POZNAMKA

Mizete volit mezi Vyberte vSechny viditelné entity a Aktualni vybérova mnozina bez toho, abyste museli
znovu vybirat entity pomoci Zadat mnozinu hranic. Moznost Aktualni vybé&rova mnoZzina vyuziva posledni
mnozinu entit, kterou jste vybrali pomoci Zadat mnozinu hranic.

Typ hranice
Ukazuje, Ze hranice je vytvorena jako kfivka.

Zpusob detekce ostrivki

Zvolte Normalni a vnéjSi entitu a vSechny ostrivky budou povazovany za hranice. Zvolte VnéjSi a pouze
vnéjsi entity a jejich vnéjsi ostriivky budou povazovany za hranice. Zvolte Ignorovat a pouze vnéjsi entity
budou povazovany za hranice.

Zadat plochu

Pro uréeni neuzaviené plochy pro uréeni hranic, kliknéte na Zadat plochu, kliknéte dovnitf uzavieného
poloméru hranice, ne v8ak na hranici samotnou. Pokud je to zadouci, pokracuijte v klikani na dalsi
uzaviené poloméry a na konci vybéru stisknete Enter.

34. Kvadr (3D sit) (Box (3D mesh))

Ribbon Kreslit 3D > Kreslit 3D sité > Kvadr
Menu Kreslit > 3D sité > Kvadr

Panel nastoju Kresli 3D sité > Kvadr

Klavesnice  ai_box

Alias Al_BOX

Kresli kvadr jako 3D sit, definovanou délkou (x-soufadnice), Sifkou (y-soufadnice) a vyskou (z-
soufadnice).

Urceni délky, Sifky a vysky kvadru.

Uréete rohovy bod kvadru:
Urcete bod na jednom konci kvadru.

Urcete délku kvadru:
Urcete délku kvadru podél osy x.

Uréete Sifku kvadru nebo [Krychle (C)]:
Urcete Sitku kvadru podél osy y.

Urcéete vysku kvadru:
Urcete vysku kvadru podél osy z.

Uréete uhel oto€eni kvadru kolem osy Z:
Pokud je to poZzadovano, zadejte uhel otoCeni.



A. Urcete délku kvadru.
B. Urcéete Sirku kvadru.
C. Urcete vysku kvadru.

Vytvorieni krychle

Uréete rohovy bod kvadru:
Urcete bod na jednom konci kvadru.

Urcete délku kvadru:
Urcete délku kvadru podél osy x.

Urcete Sirku kvadru nebo [Krychle (C)]:
Zvolte Krychle (C).

Urcete uhel oto€eni kvadru kolem osy Z:
Pokud je to pozadovano, zadejte Uhel otoceni.

35. Kvadr (3D téleso) (Box (3D solid))

Ribbon Kreslit 3D > Kreslit 3D télesa > Kvadr
Menu Kreslit > 3D télesa > Kvadr

Panel nastoju Kreslit 3D télesa > Kvadr

Klavesnice  box, kvadr

Kresli 3D kvadr jako ACIS pevné téleso, definované jeho délkou (x-osa), Sifkou (y-osa) a vyskou (z-osa).

Urceni vrchol( kvadru.

Pro umisténi vrcholu na jiné misto, ur€ete bod, ktery bude polohu urovat.

Nlarl

A. UrCete prvni bod.
B. UrCete bod pro proté&jsi vrchol.
C. Urcete vysku.

Urcete prvni roh kvadru nebo [Stied (C)]:



Uréete bod v rohu kvadru.

Uréete dalSi roh nebo [Krychle (C)/Délka (L)]:
UrcCete bod v dalSim vrcholu kvadru.

Uréete vySku nebo [2Body (2P)]:
Ur€ete vySku kvadru podél osy z nebo zvolte 2Body pro definovani vysky mezi dvéma body, které jiZ byl
definovany.

Chcete-li urcit stied a jeden roh kvadru.

Urcete prvni roh kvadru nebo [Stied (C)]:
Urcete bod v rohu kvadru.

Urcete stred.
Uréete bod ve stiedu kvadru.

Urcete dalSi roh nebo [Krychle (C)/Délka (L)]:
Urcete bod v dal§im vrcholu kvadru.

Urcete vysSku nebo [2Body (2P)]:
Urcete vySku kvadru podél osy z nebo zvolte 2Body pro definovani vysky mezi dvéma body, které jiz byli
definovany.

Chcete-li uréit samostatné rozméry délky a Sirky.

Urcete prvni roh kvadru nebo [Stied (C)]:
Urcete bod v rohu kvadru.

Uréete dalSi roh nebo [Krychle (C)/Délka (L)]:
Zvolte Délka (L)

Urcete délku:
Urcete délku kvadru podél osy x.

Urcete Sifku:
Urc€ete Sifku kvadru podél osy y.

Uréete vySku nebo [2Body (2P)]:

Ur€ete vySku kvadru podél osy z nebo zvolte 2Body pro definovani vysky mezi dvéma body, které jiZ byl
definovany.
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A. Urcete délku kvadru.
B. Urcéete Sirku kvadru.
C. Urcete vysku kvadru.

Chcete-li vytvorit pravidelnou krychli



Urcete prvni roh kvadru nebo [Stied (C)]:
Urcete bod v rohu kvadru.

Urcete dalSi roh nebo [Krychle (C)/Délka (L)]:
Zvolte Krychle (C)

Uréete dalSi roh nebo [Krychle (C)/Délka (L)]:
Urcete dalSi bod v opacném rohu obdélniku, ktery definuje délku kvadru.

36. Rozdélit (Break)

Ribbon Upravit > Upravit > Prerusit > Prerusit
Menu Modifikace > Rozdélit

Panel nastoju Modifikace > Rozdélit

Klavesnice break, prerus

Alias BR

Rozdéli entitu na dvé samostatné entity. Muzete rozdélovat nebo odstrafiovat konce Usecek, oblouki,
kruznic, kfivek, polopfimek, pfimek, elips, spline a prstenca.
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A. Vyberte entitu a prvni bod rozdéleni na entité.
B. Ur€ete druhy bod rozdéleni na entité.

Vyberte entitu k preruseni: Vyberte entitu.
Pokud urcite entitu bodem, nasleduje v pfikazovém fadku tato vyzva:

Prvni bod preruseni (F)/<Druhy bod pferuseni>:

Urcete druhy bod preruseni. Ve vychozim nastaveni pfedpoklada program, Ze bod vybéru je zaroven
prvnim bodem pferuSeni.

Prvni bod preruseni (F — First break point) | Ur€eni prvniho bodu rozdéleni.

Pokud urgite entitu pomoci kfizujiciho okna, objevi se v pfikazovém fadku nasledujici vyzva:

BK/ e

A. Vyberte entitu pro rozdéleni.
B. UrCete prvni bod rozdéleni.
C. Urcete druhy bod na entité.

Prvni bod preruseni: UrCete prvni bod pro rozdéleni entity.
Druhy bod pferuseni: UrCete druhy bod pro rozdéleni. Pro pfevod kruZnice na oblouk, odstrarite kus
kruznice vybérem druhého bodu rozdéleni v protisméru hodinovych ruc€i¢ek od prvniho bodu vybéru.



TIP Pro rozdéleni entity na dvé oddélené entity, urete stejny bod jako prvni i druhy bod rozdéleni. V
pfikazovém fadku muzete pfi zadavani druhého bodu pouzit zavina¢ (@).

37. Preruseni ¢ary (Break line)

Ribbon Rychlé nastroje > Nastroje > PreruSeni
Klavesnice breakline

Vytvaii misto pfimky lomenou &aru.

Zadejte prvni bod pro konec fadku nebo [Blok/rozmér(S)/prodiouzeni (E)]
Zvolte pocatecni bod.

Zadejte druhy bod pro konec fadku
Urcete druhy, kone¢ny bod Usecky.

Zadejte umisténi pro koncovy symbol
Zvolte bod, ktery bude leZet na pravé nakreslené usecce, kde bude stfed zlomu.

Pro upraveni poly&ary:

Upravit polycaru: Upravit vrcholy (E)/Zavfit (C)/Zrusit zakfiveni (D)/Interpolace (F)/Pfipojit (J)/Typ
¢ar (L)/Obratit (R)/Spline/Ukos (T)/Sirka (W)/Zpét (U)/<Konec (X)>:

Pro upraveni vrcholu stisknéte E.
Pro uzavreni stisknéte C.

Pro zruSeni zakfiveni stisknéte D.
Pro nastaveni interpolace zvolte F.
Pro pfipojeni dalsi entity zvolte J.
Pro zjisténi typl €ar zvolte L.

Pro obraceni entity zvolte R.

38. Carkované ¢ary s mezerami (Broken line with gaps )

Klavesnice mcenter

Klavesou ENTER pouzijete posledni bod/Podle (F)/< Za¢atek usecky >:

Mysi urete pocatecni bod. UrCete mysi vzdalenost koncového bodu a smér tusecky. Mysi uréete koncovy
bod. Stisknéte Enter pro ukon&eni entity nebo zvolte nékterou z moznosti pro upfesnéni navazujici
usecky:

uhel (A)/déLka/pokracovat (F)/zpét (U)/:



Napiste A pro uréeni Ghlu mezi sekami. Uhel uréete mysi nebo napiste do prikazového radku. Stisknéte
Enter.

Napiste L pro ur€eni délky nasledujici usecky. Délku zvolte posunutim mysi nebo napiste Cisly do
pfikazového fadku. Stisknéte Enter.

Pro prodlouZeni nakreslené ¢ary zvolte F - pokraCovat.
Pro vraceni posledniho kroku stisknéte U - zpét.

Stisknéte Enter pro ukon&eni kresleni entity.

39. Prohlize¢ (Browser)

Klavesnice browser

Otevre vas webovy prohlize¢ na uréeném misté.

Zadejte URL <aktualni URL>: Zvolte URL, coz m{ize byt webova stranka, FTP stranka nebo umisténi
souboru.

Pro pouziti tohoto pfikazu musite mit nainstalovany webovy prohlizec.

40. Kalkulacka (Calculator)

Klavesnice cal, kal

Zobrazi standardni Windows Kalkulacku. Pro informace o pouZivani Kalkula¢ky hledejte v Kalkulacka
Napovéda.

Chcete-li zménit kalkulaCku na vé&decky rezim, zvolte View> Scientific.
Chcete-li vlozit vysledek vypoctu do programu, vyberte vysledek a stisknéte Ctrl + C v kalkulacce a Ctrl +
V v programu.

41. Kaskadové (Cascade)

Ribbon Pohled > Zobrazeni > Nové okno > Okna na sebe
Menu Okno > Kaskadové
Klavesnice wcascade

Zkaskaduje oteviena okna vykresu.

42. Stiredovy uchop (Center snap)

Ribbon Kreslit > Uchopy entit > Nastavit ichop stiedového bodu



Menu Nastroje > Uchopy entit > Stied
Panel nastoji Uchopy entit > Polovina
Klavesnice  center

Zapina a vypina stfedovy tchop. Kdyz je ichop zapnuty, mizete uchopit novou entitu, kterou jste
nakreslili ke stfedovému bodu jiné entity. Mizete uchopit stfedové body kruznic, obloukd, elips
a eliptickych obloukd.

Mdzete vyuzit pfikaz Stfed jako do€asny Uchop v prib&hu pouzivani jiného pfikazu. Zkratku CEN muzete

vyuzit v pribéhu pouzivani jiného pfikazu, pokud pouzivate pfikaz samostatné, musite pouzit cely nazev
CENTER.

Y3

A. Uchop stredu se objevi, kdyz kursor umistite nad zvolenou entitu. Stfedovy tchop nové entity, kterou
Jste si zvolili.

43. Kruznice (Circle)

Ribbon Kreslit > Kruznice stied - polomér
Menu Kreslit > Kruznice

Panel nastoju Kreslit > Kruznice

Klavesnice circle, kruznice

Alias C

Kresli kruznice jakéhokoli rozméru. Vychozi metoda pro kresleni kruznice je s pomoci jejiho stfedu
a poloméru, ale mozné jsou i dalSi metody.

2body (2P)/3body (3P)/Te¢Te€Rad/Te€TecTec/oblouk (A)/nasobné (M)/<Stred kruznice>:
Pro kresleni kruznice s ur¢enim stfedového bodu a poloméru nebo priméru zadejte stfedovy bod.
2body | Kresleni s pomoci metody dvou bodu

3body | Kresleni kruznice definované tfemi body

TeCTeCRad (RTT — RadiusTangentTangent) | Kresleni pomoci poloméru a dvou tecen
TecCTec€Ted/ | Kresleni pomoci tii teCen

oblouk (A — Arc) | Pfevod oblouku na kruznici

nasobné (M — Multiple) | Zvolte pro kresleni vice kruznic. Poté zvolte pozadovanou metodu.

44. Kruhové oramovani textu (Circle text border)

Klavesnice circtxt

Pfikaz oramuje text do kruhu.
Vyberte textovou entitu a stisknéte Enter.




45. Ofez obrazku (Clip image)

Ribbon Vlozit > Data > Pripojit obrazek > Ofez obrazku
Menu Modifikace > Objekt > Obrazek >Ofez obrazku
Panel nastoju Obrazek > Ofez obrazku

Klavesnice  imageclip, obrofez

Alias -CH

Orezava obrazky, takZe je ve vykrese viditelna pouze jejich ¢ast. Viditelna ¢ast (nebo neviditelna ¢ast
z invertnich ofezd) mlze byt v tvaru libovolného Ctyfuhelniku nebo mnohouhelniku.

Pokud jste obrazek nezvolili a zvolite pfikaz ofez obrazku, jste vyzvani k vybéru obrazku.
zapnOut/oDstranit/<Novy>: nebo pfi opakovaném pouziti pfikazu vypnOut/Smazat (D)/<Novy>: Pro
zapnuti nebo vypnuti ofezu zvoleného obrazku zvolte zapnout (O) nebo vypnout (O). Pro odstranéni
ofezu ze zvoleného obrazku zvolte odstranit (D). Pro ofezani zvoleného obrazku jinym zplsobem na
obdélnik nebo mnohouhelnik zvolte novy (N).

Pro ofezani obrazku na tvar obdélniku

Zvolte novy (N).

Smazat starou hranici? [Ano (Y)/Ne] <Ano>:: Zvolte ano (Y) pro uréeni nové hranice ofezu obrazku.
Kazdy obrazek mize mit pouze jednu hranici ofezu. Tato vyzva se zobrazi pouze pokud je pro dany
obrazek hranice ofezu jiZ definovana.

Polygonalni/lnvertovat ofiznuti/<Obdélnikovy (R)>: Zvolte obdélnikovy. Pokud chcete inverzni ofiznuti
obrazku, co znamena, Ze se ofeze Cast obrazku uvnitf vyznacené hranice, zvolte Invertovat ofiznuti jesté
pred volbou obdélnikového ofiznuti.

Prvni roh obdélniku ofezu: Zadejte prvni roh ofezu obrazku.

Druhy roh obdélniku ofezu: Zadejte prot&jSi roh obrazku pro obdélnikovy ofez. Zvoleny obrazek je
ofezan tak, ze viditelna zlstane pouze jeho €ast uvnitf obdélniku.

Pro ofezani obrazku na tvar mnohouhelniku

Zvolte novy (N).

Smazat starou hranici? [Ano (Y)/Ne] <Ano>:: Zvolte ano (Y) pro uréeni nové hranice ofezu obrazku.
Kazdy obrazek mize mit pouze jednu hranici ofezu. Tato vyzva se zobrazi pouze pokud je pro dany
obrazek hranice ofezu jiz definovana.

Polygonalni/lnvertovat ofiznuti/<Obdélnikovy (R)>: Zvolte polygonalni. Pokud chcete inverzni ofiznuti
obrazku, co znamena, Ze se ofeze Cast obrazku uvnitf vyznacené hranice, zvolte Invertovat ofiznuti jesté
pfed volbou polygonalniho ofiznuti.

Prvni bod polygonu: Zadejte prvni roh polygonu pro ofez obrazku.

Zadejte body polygonu, kldvesou ENTER uzaviete: Zadefinujte dal8i body pro vytvofeni ofezavaciho

polygonu. Po zadani posledniho bodu stisknéte Enter pro ukon€eni polygonu. KdyZ skoncite, je zvoleny
obrazek ofezan, co znamena, Ze je viditelna pouze €ast uvniti zadané hranice ofezu.



Pro zapnuti ofezu obrazku
Zvolte zapnout (O). Obrazek se zobrazi v ofezané podobé.
Pro vypnuti ofezu obrazku

Zvolte vypnout (O). Zobrazi se cely obrazek a hranice pro ofez je zmazana.

46. Oriznuti vyrezu (Clip layout viewport)

Klavesnice vpclip, vorez

Orezava vyrezy tak, Zze ve vykresovém prostoru zUstane viditelna pouze ¢ast vyrezu.

Vyberte vyiez k ofiznuti: Ve vykresovém prostoru vyberte vyfez, ktery chcete ofiznout.

Vyberte ofezavajici entitu nebo [Polygonalni/oDstranit] <Polygonalni>: Pro ofezani zvoleného vyfezu
podle tvaru existujici entity zvolte entitu. Pro ofezani zvoleného vyfezu do tvaru obdélniku nebo
mnohouhelniku zvolte P (polygonalni). Pro odstranéni ofezu ze zvoleného vyfezu zvolte D (odstranit).
Volba je dostupna pouze pokud mate jiz ofezany vyrez.

Pro ofezani vyiezu do tvaru existujici entity

Zvolte existujici kruh, elipsu, uzavienou kfivku, uzavienou spline nebo oblast.

Pro ofezani vyrezu do tvaru nového polygonu

Zvolte polygonalni (P).

Zacatek krivky:Zadejte prvni bod polygonalniho ofezu.

oblouk (A)/zaviit (C)/vzDalenost/pokracovat (F)/polovi¢ni Sirka (H)/Sirka (W)/zpét (U)/: Zadejte druhy
bod polygonalniho ofezu.

oblouk (A)/zavfit (C)/vzDalenost/pokracovat (F)/poloviéni Sifka (H)/Sifka (W)/zpét (U)/: Zadejte treti
bod polygonalniho ofezu nebo stisknéte Enter pro uzavfeni polygonu.

Vyzva se bude opakovat, pokud neskoncite se zadavanim ofezu.

Pokud jste skongili, zvoleny vyfez je ofezan a viditelna je pouze jeho &ast uvnitf ofezu.

Pro odstranéni ofezu

Zvolte odstranit (D). Vyfez se opét zobrazi cely a hranice ofezu jsou smazany.

47. Orez Xref (Clip Xref)

Ribbon Vlozit > Reference > Ofiznuti Xref

Menu Modifikace > Objekt > Externi reference > Orez Xref
Panel nastoju Modifikace >Ofez

Klavesnice  xclip, xorez



Orezava externi reference, takze zlstava viditelna pouze jejich ¢ast. Mizete upravovat, presouvat nebo
kopirovat ofezané externi reference stejnym zplsobem jako upravujete neofezané externi reference.
Ohraniceni se pohybuje spole¢né s referenci. Pokud externi reference obsahuje vnofené pfipojené externi
reference, ty se taky objevi ve vykrese ofezané. MUzete taky castecné skryt bloky s vyuzitim hranic ofezu.

Vyberte entity:

48. Konec (Close)

Ribbon Tlacitko aplikace > Konec
Menu Soubor > Konec
Klavesnice close, zavri

Zavira aktivni okno vykresu bez ukonéeni programu. Pokud jste provedli ve vykresu zmény, objevi se
vyzva s dotazem, zda chcete zmény uloZit. Pro uloZeni zmén kliknéte na Ano. Pokud zmény uloZzit
nechcete, zvolte Ne. Pro vraceni se zpét do vykresu zvolte Zrusit.

Pokud je to zrovna novy vykres, ktery jste nepojmenovali, a zvolite Ano, objevi se okno UloZit jako pro
pojmenovani vykresu.

49. Zaviit (Close (Window))
Ribbon Pohled > Zobrazeni > Nové okno > Zavrit

Menu Okno > Zavrit
Klavesnice wclose

Zavira aktivni okno. Zobrazi se vyzva s dotazem, jestli chcete ulozit ve vykresu zmény.

50. Zavrit vSe (Close All)

Ribbon Pohled > Zobrazeni > Nové okno > Zavrit vSe
Menu Okno > Zavrit
Klavesnice wcloseall

Zavira vSechny okna vykresu. Zobrazi se vyzva s dotazem, jestli chcete ulozit ve vykresu zmény.

51. Zavrit referenci (Close reference)

Ribbon Vlozit > Reference > Zaviit referenci
Menu Nastroje > Uprava bloku a externi reference na misté > Zaviit referenci
Klavesnice refclose, refzavfi



Zavira blok nebo externi referenci, ktera byla na misté upravena a vraci se do vykresu. Pfed pouZitim
pfrikazu musite vyuzit pfikaz Nastroje > Uprava bloku a externi referenci na misté > Upravit referenci.

Enter option [Save/Discard reference changes] : Pokud chcete ulozit zmény, které jste vykonali v bloku
nebo externi referenci, zvolte Ulozit, nebo zvolte Discard pro ulozeni zmén.

y vz

52. Prikazovy Fradek (Command Bar)

Ribbon Pohled > Zobrazeni > Pfikazovy fadek
Menu Zobrazit > Zobrazit > Pfikazovy fadek
Klavesnice cmdbar, prikaziad

Zobrazuje a skryva pfikazovy fadek. Kdyz si ho zobrazite, program vas vyzve k tomu, abyste ho umistili
na obrazovce.

plovouci (F)/doLe/nahofe (U)/<Skryt pfikazovy Fadek>:

Pro prepinani viditelnosti pfikazového fadku, stisknéte Enter. Pro ukotveni pfikazového fadku kamkoli na
obrazovku, zvolte plovouci (F). Pro umisténi pfikazového fadku ve spodni €asti obrazovky (hned nad
stavovy fadek), zvolte doLe. Pro ukotveni pfikazového Ffadku v horni €asti okna programu (pod panely
nastroju), zvolte nahore (U).

Pro uvolnéni vice mista na obrazovce, umistéte panely nastroju vedle ukotveného pfikazového fadku, coz
zmenS§i Sifku pfikazového fadku.

Pokud mate zvoleny pohyblivy pfikazovy fadek, mizete zménit jeho velikost potahnutim za okraje. Pokud
natahnete vysku pfikazového Fadku, zobrazi se vam vice nez tfi Fadky textu.

53. Kuzel (3D sit’) (Cone (3D mesh))

Ribbon Kreslit 3D > Kreslit 3D sité > Kuzel
Menu Kreslit > 3D sité > Kuzel

Panel nastoju Kresli 3D sité > Kuzel

Klavesnice ai_cone

Alias Al_CONE

Kresli kuZel jako 3D sit..

A. Zadejte stied zakladny kuZzele.



B. Zadejte polomér zakladny kuZele.
C. Zadejte vysku kuZele.

Stred zakladny kuzelu: Zadejte stfedovy bod zakladny kuzele.

Pramér (D)/<Polomér zakladny>: Zadejte polomér zakladny kuzele, nebo urcete druhy bod pro
stanoveni poloméru. Pro zadani praméru zakladny zvolte D (primér) a pak zadejte primér nebo uréete 2
body.

Primér (D)/<Polomér horni plochy>: Viozte polomér vrchni plochy kuzele nebo zadeijte tfeti bod pro
ur€eni poloméru. Pro zadani priméru zakladny zvolte D (primér) a pak zadejte priimér nebo urete 2
body.

vrchol (A)/<Vyska kuzele>: Viozte vySku kuzele.
Pocet déleni kolem kuzelu <16>: Zadejte poc¢et déleni kolem kuZelu, obvykle mezi 4 a 20. Velké

mnozstvi déleni vyznamné zpomali program. Malé mnozstvi déleni zpUsobi, Ze kuzel se nebude dat
rozpoznat.

54. Kuzel (3D téleso) (Cone (3D Solid))

Ribbon Kreslit 3D télesa > Kresli 3D télesa > Kuzel
Menu Kreslit > 3D télesa > Kuzel

Panel nastoju Kreslit 3D télesa > Kuzel

Klavesnice  cone, kuzel

Kresli 3D kuzel jako ACIS téleso, s kruhovou nebo eliptickou zakladnou a se symetrickym nebo sfezanym
vrcholem.

Elipticky/<stred zakladny kuzelu> <0,0,0>: Zadejte stfedovy bod zakladny kuzele. Pro kuzel s eliptickou
zakladnou zvolte E (elipticky).

prumeér (D)/<poloméR zakladny>: Zadejte polomér zakladny kuzele, nebo uréete bod pro stanoveni
poloméru. Pro uréeni praméru zakladny, zvolte D (pramér), a pak zadejte primér nebo uréete 2 body.

vrchol (A)/<Vyska kuzelu>: Zadejte vySku kuZele nebo zvolte bod pro uréeni vysky. Pro kuzel bez
sfezaného vrcholu zvolte A (vrchol).

Pro kresleni kuzele s eliptickou zakladnou

Zvolte elipticky.

stied (C)/<prvni konec osy elipsy>: Zadejte prvni konec elipsy, ktera bude pfedstavovat zakladnu
kuzele. Tato elipsa je nakreslena se stanovenou délkou, pficemz Sitka ma polovi¢ni délku. Pro nakresleni
eliptické zakladny se stiedovym bodem vedlejSi a hlavni osy zvolte C (stied).

Pro nakresleni zakladny s vrcholem

Zvolte A (vrchol).



Vrchol kuzelu: Zadejte bod, ktery bude vrcholem kuZele.

55. Omezené otaceni (Constrained Orbit )

Ribbon Pohled > 2D navigace > Omezené otaceni
Menu Zobrazit > 3D Orbit > Omezené otaceni
Klavesnice 3dorbit

Dovoluje vam otacet s vykresem, nebo otocit zobrazeni, v realném Case, zatimco bude drzet x-osu
kamery rovnobé&zné k pohledu roviny XY. Muzete otacet, kdyz jste v modelovém prostoru, ne prostoru
vykresu.

Pouzivejte tento pfikaz k rotaci pohledu entit, ne na opravdovou polohu entit.

Zadejte 'Set' pro zménu bodu oto&eni nebo stisknéte ENTER, pravé tlacitko mysi nebo Esc pro
dokonceni: Kliknéte a tahnéte mysi po vykresu k otaceni vykresu. Zvolte Set, abyste mohli zvolit jiny bod
rotace. Pak kliknéte mysSi a tahnéte, abyste vidéli orbital.

Kdyz jste skonili, pustte tlaCitko mysi. Pro dalSi otaceni opakujte. Kdyz skoncCite, zmacknéte Enter, pravé
tlaCitko mysi nebo Esc.

56. Omezené otaceni X (Constrained X Orbit )

Menu Zobrazit > 3D Orbit > Omezené otaceni X
Klavesnice rtrotx

Umoznuje otocit zobrazeni entit v realném ¢ase zatimco zachova osu x.

Muzete zobrazeni otacet béhem toho, co jste v modelovém prostoru, ne vykresovém.

Pouzivejte tento pfikaz k rotaci pohledu entit, ne na opravdovou polohu entit.

Zadejte 'Set' pro zménu bodu oto&eni nebo stisknéte ENTER, pravé tlaCitko mysi nebo Esc pro
dokonceni: Kliknéte a tahnéte mysi po vykresu k otaceni vykresu. Zvolte Set, abyste mohli zvolit jiny bod
rotace. Pak kliknéte mysSi a tahnéte, abyste vidéli orbital.

Kdyz jste skonili, pustte tlaCitko mysi. Pro dalSi otaceni opakujte. Kdyz skoncCite, zmacknéte Enter, pravé
tlacitko mysi nebo Esc.

57. Omezené otaceni Y (Constrained Y Orbit)

Menu Zobrazit > 3D Orbit > Omezené otaceni Y
Panel nastoju Zobrazit > 3D Orbit > Omezené otaceni Y
Klavesnice  rtroty

Umoznuje otocit zobrazeni entit v realném Case zatimco zachova osu y.

Muzete zobrazeni otacet béhem toho, co jste v modelovém prostoru, ne vykresovém.

Pouzivejte tento pfikaz k rotaci pohledu entit, ne na opravdovou polohu entit.

Zadejte 'Set' pro zménu bodu otogeni nebo stisknéte ENTER, pravé tlacitko mysi nebo Esc pro
dokonceni: Kliknéte a tahnéte mysi po vykresu k otaceni vykresu. Zvolte Set, abyste mohli zvolit jiny bod
rotace. Pak kliknéte mysi a tahnéte, abyste vidéli orbital.



Kdyz jste skonili, pustte tlaCitko mysi. Pro dalSi otaceni opakujte. Kdyz skon¢ite, zmacknéte Enter, pravé
tlacitko mysi nebo Esc.

58. Omezené otaceni Z (Constrained Z Orbit)

Menu Zobrazit >3D Orbit > Omezené otaceni Z
Panel nastoju Zobrazit >3D Orbit > Omezené otaceni Z
Klavesnice rtrotz

Klavesova zkratka Ctrl+Right Mouse Button

Umoznuje otocit zobrazeni entit v realném ¢ase zatimco zachova osu z.

Muzete zobrazeni otacet béhem toho, co jste v modelovém prostoru, ne vykresovém.

Pouzivejte tento pfikaz k rotaci pohledu entit, ne na opravdovou polohu entit.

Zadejte 'Set' pro zménu bodu otogeni nebo stisknéte ENTER, pravé tlacitko mysi nebo Esc pro
dokonceni: Kliknéte a tahnéte mysi po vykresu k otaceni vykresu. Zvolte Set, abyste mohli zvolit jiny bod
rotace. Pak kliknéte mysSi a tahnéte, abyste vidéli orbital.

Kdyz jste skonili, pustte tlaCitko mysi. Pro dalSi otaceni opakujte. Kdyz skon¢ite, zmacknéte Enter, pravé
tlaCitko mysi nebo Esc.

59. Plynulé otacéeni (Continuous Orbit)

Ribbon Pohled > 2D navigace > Omezené otaceni > Plynulé otaceni
Menu Zobrazit > 3D Orbit > Plynulé otaceni

Panel nastoju Zobrazit > 3D Orbit > Plynulé otaceni

Klavesnice  3dcorbit, 3dporbit

Umozniuje vam otacet vykres, nebo zobrazeni v realném Case a pokraCovat v otaceni i po pusténi mysi.
Muzete otacet vykres zatimco jste v modelovém prostoru, ne prostoru vykresu.

Pouzijte tento pfikaz pro ota€eni nahledu entit ne na samotné umisténi entit.

ENTER, pravé tlacitko mySi nebo Esc pro dokonéeni: Kliknéte a tahnéte mysi ve vykresu pro otaceni
vykresu podle pohybu s mysi, poté pusté tlaCitko. Nahled bude pokracovat v otaceni se. Pro ukonceni
otaceni stisknéte Enter, pravé tlacitko mysi nebo Esc.

60. Zménit CTB tabulky tiskovych styli (Convert CTB Print Style Tables)

Klavesnice convertctb, prevodctb

Méni tabulky stylu tisku na pojmenované tabulky stylu tisku.

V pojmenovanych tabulkach stylu tisku jsou styly tisku oznaceny jako Styl 1, Styl 2 atd. Pokud chcete
vyuzit jiné nazvy pro styly tisku, pfejmenujte styly tisku dfive, nez je pfifadite k entitam a hladinam ve
vykrese. Pokud pfejmenujete styly tisku pro jejich pfifazeni, nebudou souhlasit v pribéhu tisku vykresu.

Nemizete zménit tabulku stylu tisku na tabulku stylu tisku zavislou na barvé, protoze tabulka stylu tisku
zavisla na barvé obsahuje pouze styly tisku pojmenované po 255 barvach, které zobrazuiji.




61. Zménit tabulky stylu tisku kresleni (Convert Drawing Print Style Tables)

Klavesnice convertpstyles, prevodvstylu

Zméni typ tabulky stylu tisku vyuzivaného v aktualnim vykrese. Kazdy vykres vyuziva jak na barvé
zavislé, tak pojmenované tabulky stylu tisku. Pokud potfebujete, mizete zménit typ tabulky stylu tisku
vyuZivaného ve vykrese.

Pokud ménite vykres pro vyuziti pojmenovanych tabulek styly tisku, méli byste nejdfive pouzit pfikaz
Zmeénit CTB tabulky tiskovych styl (CONVERTCTB) pro zménu tabulek stylu tisku zavislych na barvé na
pojmenované tabulky. Pokud tak neudélate, vSechny informace o stylu tisku, které jste zadali ve Vasem
vykrese se ztrati.

Zména vykresu pro pouziti tabulky stylu tisku zavisla na barvé odstrani vSechny informace
o pojmenovanych stylech tisku z entit, hladin a vykresu. Pojmenované tabulky stylu tisku se vSak
nesmazou z Vaseho pocitace.

62. Hraniéni plocha (3D Plochy) (Coon Surface)

Ribbon Kreslit 3D > Kreslit 3D sité > Rotacni plocha > Hrani¢ni plocha
Menu Kreslit > 3D > Hrani¢ni plocha

Panel nastoju Kreslit > 3D > Hrani¢ni plocha

Klavesnice  edgesurf, hplocha

Vytvafi trojrozmérnou sit’ s vrcholy primérné mezi ¢tyfmi hranami.

Tento pfikaz mlzete pouzit pto jakékoli Ctyfi sousedici hrany. Tyto okraje mizou byt pfimky, oblouky nebo
oteviené dvou nebo tfirozmérné polylines, ale vSechny hrany se musi dotykat, aby vytvofili uzavienou
obdélnikovou entitu. Mlzete pouzit SURFTAB2 systémovou proménnou pro uréeni sméru hustoty sité.

oJ

A. Zvolte prvni hranu sité.
B. Zvolte druhy okraj.

C. Zvolte treti hranu.

D. Zvolte ctvrtou hranu.

Predtim, nez muzete pouzit pfikaz CoonsSurface, musite nakreslit ¢tyfi spojené linearni segmenty.
Vyberte prvni ze &tyf spojenych linearnich entit pro hraniéni plochu: Mizete zvolit &tyfi okraje v jakémkoli
poradi. Zvolte prvni okraj. Prvni hranice, kterou urcite, ur€uje M-smér sité, rozrustajici se od koncového
bodu, ktery je nejbliz bodu, ktery jste zvolili k dalSimu koncovému bodu. Dva okraje, které se dotykaji
prvni hranice jste zvolili z N-hranice sité.

Vyberte druhou hranu: Zvolte druhou hranu.

Vyberte tfeti hranu: Vyberte tfeti hranu.

Vyberte posledni hranu: Vyberte ¢tvrtou hranu.



Poznamka: Muzete zménit M- a N-hustotu sité se systémovymi proménnymi SURFTAB1 a SURFTAB2.
Minimalni hodnota je 2, vychozi je 6 a maximalni je 32766.

63. Souradnice (Coordinate)

Klavesnice coordinate
Klavesova zkratka F6, CTRL + D

Zméni zobrazeni soufadnic ve stavovém fadku: zapnuty, vypnuty a relativni soufadnice.

Pro zapnuti zobrazovani souradnic

Souradnice jsou vypnuty: zapnout (ON)/uhel (A)/vzDalenost/<vypnout>: Pro zapnuti zobrazovani
soufadnic x, y, z ve stavovém fadku v realném Case zvolte zapnout (ON). Napfiklad: 2.3456, 3.4567,
0.0000

Souradnice Z ma obvykle hodnotu 0, pokud nenastavite elevaci na nenulovou hodnotu, nebo nekreslite
tfidimenzionalni entity.

Pro zobrazeni relativnich souradnic:

Souradnice jsou zapnuty: vypnout (OFF)/uhel (A)/vzDalenost/<zapnout>: Pro zobrazeni relativnich
polarnich soufadnic zvolte uhel (A)/ vzDalenost. Napfiklad: Vzdalenost = 1.2345 @ Uhel = 45.6789

Relativni polarni soufadnice jsou zobrazovany pouze v pribéhu pfikazu kreslit.

Pro vypnuti zobrazovani souradnic:

Souradnice jsou nastaveny na uhel/vzdalenost: zapnout (ON)/vypnout OFF)/<uhel/vzdalenost>: Pro
vypnuti zobrazovani soufadnic v realném €ase zvolte vypnout (OFF). Soufadnice se zobrazi pokazdé,

kdyz kliknete na obrazovku.

Tip: Viyuzijte prikaz Nastroje > Nastaveni kresleni pro zménu formatu souradnic, délky a Ghlu
zobrazovaného ve stavovém radku.

64. Kopie (Copy Entity)

Ribbon Upravit > Modifikace > Kopirovat
Menu Modifikace > Kopie

Panel nastoju Modifikace > Kopie

Klavesnice  copy, kopie

Alias Co,CP

Kresli kopie vybranych entit. MGzete kreslit kopie vybéru a urcit zakladni bod a bod posunu. Entity
vybrané pro kopirovani nejsou z plivodniho umisténi posunuty. Kopirované entity si zachovavaiji vSechny
atributy pavodnich entit jako barvu, typ ¢ary nebo hladinu.



A. Zvolte entity, které chcete kopirovat.
B. UrCete zakladni bod.

C.Ur¢ete bod posunu kopie.

Vysledek.

Vyberte entity pro kopirovani:
Zvolte entity.

Vektor/mOde/<Referenéni bod>:

Vyberte zakladni bod pro umisténi kopii.

Vektor (V) | Ur€eni umisténi kopii pomoci soufadnic X, Y, Z.

mOde (O)| Volba rezimu kopirovani — jednoduchy nebo nasobny. Vychozi nastaveni je nasobné
kopirovani.

Bod posunu: Zadejte body pro umisténi kopii. Pro ukon&eni pfikazu stisknéte Enter.

Kopie entit s pouzitim soufadnic x, y, z
Zvolte Vektor (V).

Zadejte smérovy vektor (x,y,z):
Zadejte hodnoty soufadnic x. y, z pro umisténi novych kopii entit.
mOde (O) | Volba rezimu kopirovani — jednoduché nebo nasobné kopie.

65. Kopirovat vlastnosti entity (Copy Entity Formatting)

Ribbon Upravit > Kopirovat vlastnosti
Panel nastoju Standard > Kopirovat vlastnosti
Klavesnice  matchprop, kopievlast

Alias MA

Zkopiruje vlastnosti jednoho prvku na druhy. Kopirovany jsou jen vlastnosti, nikoli entita samotna.
Pfenasené vlastnosti jsou barva, hladina, typ ¢ary, Sitka, text, kotovani a Sitka kfivky (pokud vSechny
segmenty zdrojoveé pkfivky maji shodnou Siiku).

A B
— ]
Pocatek Vysledek

A. Vyberte entitu s vlastnostmi, které chcete kopirovat (pfenést).
B. Vyberte entitu, kterou chcete zménit.

Vyberte entitu, z niz chcete kopirovat vlastnosti: VVyberte entitu s vlastnostmi, které chcete kopirovat.



Vyberte entitu, do niz chcete kopirovat vlastnosti: Vyberte entitu, kterou chcete zménit, poté potvrdte
pravym tlacitkem mysi nebo Enter a pfikaz ukoncete.

66. Kopirovat historii (Copy History)

Klavesnice copyhist, kopiehist

PFejima text okna Historie Vyzev do schranky Windows.

Pokud toto vlozite zpatky do vykresu, program obsah vyhodnoti, jako by to byl skript. Pokud pouzijete
pfikaz Upravit > VloZit specialné... v jinych programech, uvidite pouze jednu moznost: Neformatovany
Text.

67. Kopirovat odkaz (Copy Link)

Menu Upravit > Kopirovat odkaz
Klavesnice copylink, pkopie

Kopiruje obsah aktualniho zobrazeni do schranky Windows. UloZené polozky pak miizete vlozit do
dal§iho programu, ktery podporuje OLE.

68. Kopirovat do schranky (Copy to clipboard)

Ribbon Upravit > Kopirovat
Menu Upravit > Kopirovat
Klavesnice copyclip, skopie

Klavesova zkratka Ctrl+C

Kopiruje vybér do schranky Windows. Vybér mlzete vlozit do jiného vykresu, nebo do jiného programu.

FILtr/<Vyberte entity pro kopirovani do schranky>:
Vyberte entity, které chcete kopirovat. Vyberte FILtr pro filtrovani vybéru podle vlastnosti.

Entity jsou kopirovany do schranky v téchto formatech:

Format Popis
Obrazek WMF (Windows metafile), vektorovy format
Bitmapa BMP, rastrovy format

Enhanced metafile EMF (enhanced metafile), vektorovy format

Entity InteliCAD  Vychozi vektorovy format programu

Blok IntelliCAD Vychozi vektorovy format programu vlozeny jako definice bloku
Object Descriptor VyuzZivan v ActiveX v2.

DIB Device-independent bitmap, rastrovy format



Pro rozsifené nastaveni kopirovani, v€etné toho, kterou verzi .dwg pro soubory pouzijete, pouzijte
Nastroje > Moznosti... > zalozka Schranka.

Pro vlozeni vykresu v ur€itém formatu, pouzijte pfikaz Upravit> Vlozit specialné. Napf. mizete vykres
vlozit do formatu obrazku (WMF nebo EMF), pro vytvoreni 2D verze 3D vykresu. Nebo muzete zvolit
Bitmap format, pro vloZeni vykresu do rastrového editoru.

69. Vytvorit nebo upravit data entity (Create or Edit Entity Data)

Ribbon Upravit > Data entity > Vytvorit ¢i upravit data entity
Menu Nastroje > Data entity > Vytvofit nebo upravit data entity
Klavesnice editedata

Vytvari nebo upravuje data entit pro zvolené entity.

Moznost vytvaret a upravovat rozsifena data entit byla pdvodné pfistupna pouze pro aplikace vyvojaru
tfetich stran a vyzadovala pfitomnost externi aplikace pro umisténi rozSifenych dat pro danou entitu.
Avsak tato funkce je taky pfistupna koncovym uzivatelim IntelliCADu pfes graficky editor rozSifenych dat.
V tomhle kontextu termin aplikace odkazuje na kli¢ nebo index, se kterym je mozné na rozSifena data
entit odkazovat nebo je upravovat, jak je ukazano v nasledujicim pfikladu.

Vyberte entitu pro tvorbu nebo upravu dat entity:

Zvolte entity, kterym chcete vytvofit nebo upravit data. Zobrazi se dialogové okno Vytvofeni nebo Uprava
dat entit.

Nazev aplikace je nutné prednastavit pfed vkladanim jakychkoliv jinych dat.

Pro vytvofeni nazvu aplikace kliknéte na Vlozit a zvolte Nazev aplikace, pak nazev vepiste.

Po zadani nazvu aplikace se stanou dostupnymi dal8i typy dat v menu Vlozit.

Priklad

Voader-Dame 01311999

Entita, pro kterou se budou tvofit data entity.

Smazat Pro smazani entity dat poloZky ji zvolte a pak kliknéte na Smazat.

Vlozit Pro vlozZeni entity dat polozky zvolte umisténi, kam je chcete vlozit. Kliknéte na Vlozit a pak zvolte
typ dat, které chcete vkladat. Program vlozi entitu dat polozky, pfi€emz pro ni vygeneruje nazev. Nahradte

napsany nazev daty.

Prejmenovat Pro zmé&nu nazvu entity dat poloZky zvolte poloZku a kliknéte na Pfejmenovat. NapiSte nova
data a stisknéte Enter.




70. Vyjmout (Cut)

Ribbon Upravit > Modifikace > Vyjmout
Menu Upravit > Vyjmout

Panel nastoju Standard > Vyjmout

Klavesnice cutclip, vyjmis

Klavesova zkratka Ctrl + X

Vyjme (odstrani) vybranou ¢ast vykresu a umisti ji do schranky Windows. Vybér ze schranky mizete
vlozit na jiné misto ve vykrese, do jiného vykresu nebo do jiného programu.

FILtr/<Vyberte entity k vyjmuti do schranky>: Zvolte entity, které chcete vyjmout. Entity se do schranky
kopiruji v nasledujicich formatech:

Format Vysvétleni

Obrazek WMF (Window metafile), vektorovy format
Bitmap BMP, rastrovy format

RozSifeny metasoubor EMF(rozSifeny metasoubor), vektorovy format
IntelliCAD Vlastni vektorovy format programu

Descriptor objektu Vyuziva se v OLE v2.

DIB Bitmapa nezavisla na zafizeni, rastrovy format

Pro vliozeni vykresu v specifickém formatu vyuzijte pfikaz Upravit > Vlozit specialné. Napfiklad mazete
vykres vlozit ve formatu obrazku (WMF nebo EMF) pro vytvofeni dvoudimenzionalni verze z 3D vykresu.

71. Valec (Cylinder (3D Mesh))

Ribbon Kreslit 3D > Kreslit 3D sité > Valec
Menu Kreslit > Plochy > Valec

Panel nastoju Kreslit > Plochy > Valec
Klavesnice  ai_cylinder

Kresli vélec jako trojrozmérnou sit' s kruhovym nebo eliptickym fezem a svislymi nebo Sikmymi stranami.

s

A. Urcete polomér valce.
B. Urcete vysku valce.



Stfed zakladny valce: UrCete stfed zakladny valce.

Pramér (D)/<Polomér valce>: Zvolte polomér zakladny valce, nebo urCete druhy bod pro uréeni poloméru.
Pro uréeni praméru valce zvolte Diameter a poté urCete primér nebo zvolte dva body.

Vy8ka valce: Zvolte vySku valce, nebo urCete dva body pro uréeni vysky.

Pocet déleni kolem valce <16>: UrCete poCet déleni, obvykle mezi 4 a 20. Vétsi Cislo déleni zabere
programu delSi ¢as, nez zobrazi valec. Malé Cislo déleni déla valec nerozpoznatelnym.

72. Valec (Téleso) (Cylinder (3D Solid))

Ribbon Kreslit 3D > Kreslit 3D télesa > Valec
Menu Kreslit > Télesa > Valec

Panel nastoju Kreslit > Télesa > Vélec

Klavesnice cylinder, valec

Kresli trojrozmérny valec jako ACIS téleso s kruhovym nebo eliptickym fezem a svislymi nebo zkosenymi
stranami.

Stfed zakladny valce: UrCete stifed zaklady valce. Zvolte Elliptical pro valec, ktery ma elipticky fez.
Primér (D)/<Polomér valce>: Uréete polomér zakladny nebo zvolte druhy bod pro uréeni poloméru. Pro
ur€eni praméru valce zvolte Primér (D) a poté zvolte primér nebo uréete dva body.

Vyska valce: Pro vytvofeni vertikalniho vélce zvolte vysku valce nebo uréete dva body pro uréeni vysky.
Pro valec se skosenymi stranami zvolte C pro ur€eni stfedu zékladny pro druhy konec.

Kresleni valce uréenim priméru

Zvolte Pramér (D)
Primeér valce: Urcete primér valce.
VySka valce: Ur€ete vysku valce, nebo urcete dva body urcujici vysku.

Kresleni valce s eliptickou zakladnou

Zvolte Elliptical.

Stfed - <Prvni okraj elipsy>: UrCete prvni okraj elipsy zastupujici zakladnu valce. Tato elipsa je nakreslena
na zakladé délky jedné osy a poloviny délky druhé osy. Zvolte Stfed pro nakresleni eliptické zakladny na
zakladé stfedového bodu a koncovych bodu vétsi a mensi osy.

73. Cerchované éary (Dash-dot line)

Klavesnice mdashdot

Klavesou ENTER pouzijete posledni bod/Podle (F)/<Zacatek usecky>:

Mysi urete po€ateCni bod usecky. UrCete smér usecky, opét mysi, a urCete koncovy bod.
Stisknéte Enter pro ukon&eni entity, nebo vyberte jednu z dalSich moznosti:

uhel (A)/déLka/pokracovat (F)/zavrit (C)/zpét (U)/<koncovy bod>:
Napiste A pro zadani uhlu usecky, zvolte Enter. UrCete uhel a opét stisknéte Enter.

Napiste L pro pfesné zadani délky usecky a zvolte Enter.



Napiste F pro prodlouzeni use€ky v zadaném sméru.
Napiste C pro uzavieni kfivky (spojeni posledniho bodu s prvnim).

Napiste U pro vraceni posledniho kroku.

74. Carkované éary (Dashed line)

Klavesnice mdashed

Klavesou ENTER pouzijete posledni bod/Podle (F)/:

Urcete mySi na vykrese pocateCni bod a nasledné koncovy. Stisknéte Enter pro ukonceni entity a nebo
zvolte dal8i z mozZnosti pfi ur€ovani navazujici Usecky:

uhel (A)/déLka/pokracovat (F)/zpét (U)/<Koncovy bod>:

Napiste A pro uréeni Ghlu Gsecky. Stisknéte Enter. Uhel zvolte mysi nebo napiste do pFikazového fadku.
Stisknéte Enter.

Napiste L pro ur€eni délky. Stisknéte Enter. Urete délku mysi nebo Cisly do pfikazového fadku
a stisknéte Enter.

Pro prodlouzeni nakreslené Cary stisknéte F - pokracovat.
Pro zruseni posledniho kroku stisknéte U - zpét.

Pro ukon&eni kresleni entity stisknéte Enter.

75. Definovat pohled (Define View)

Ribbon Pohled > Pohledy > Definovat pohled
Menu Zobrazit > 3D dynamicky pohled
Panel nastoji Zoom > Dynamicky

Klavesnice  dview, dpohled

Alias DV

Dynamicky definuje paralelni nebo perspektivni pohled. S vyuzitim kamer a cilovych objektll mizete
dynamicky ménit nahled na Vas 3D vykres. MUzete ménit smér zobrazeni pfepinanim mezi kamerou
a cilovym objektem. Za cil se povaZzuji entity zvolené terCikem.
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Kamera nasmérovana na tercik - cil.

Klavesou ENTER vyberete vSechny entity/< Vyberte entity pro zobrazeni v nahledu>: Vyberte entity,
které chcete zobrazit v nahledu. Pokud chcete zobrazit v8echny entity, stisknéte Enter.

[kamera (CA)/cil (TA)/vzDalenost/body (PO)/posunout (PA)/Zoom/natocit (TW)/ofiznout (CL)/skryt
(H)/vypnout (Off)/zpét (U)]: Pro vypnuti dynamického nahledu stisknéte Enter. Pro otaCeni kamerou
kolem cile zvolte CA (kamera). Pro otaceni cile kolem kamery zvolte TA (cil). Pro natoeni pohledu zvolte
TW (natocit). Pro ur€eni vzdalenosti kamery od cile zvolte D (vzdalenost). Pro zadani soufadnic x, y, z pro
umisténi kamery zadejte PO (body). Pro vypnuti perspektivy zvolte Off (vypnout). Pro potladeni skrytych
Car zvolte H (skryt). Pro posun zobrazovaciho okna zvolte PA (posunout). Pro zménu pfiblizeni zvolte Z
(Zoom). Pro zruSeni posledniho nastaveni dynamického zobrazeni zvolte U zpét.

Pro otaceni kamery

Muizete zadat novou pozici kamery jejim ota€enim kolem cile.

il

A. Kamera se otaci pro zobrazeni vykresu z jednoho sméru.
B. Kamera se otaci pro zobrazeni vykresu z jiného uhlu.

Zvolte CA (kamera). Objevi se dialogové okno Nastaveni pohledu.
Pro otaceni cile

Muzete zadat nové umisténi cile (entit, které chcete zobrazit) pomoci otoceni cile kolem kamery.
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A. Cil se otaci pro zobrazeni vykresu z jednoho sméru.



B. Cil se otaci pro zobrazeni vykresu z jiného Ghlu.
Zvolte TA (cil). Objevi se dialogové okno Nastaveni pohledu.

Pro natoceni pohledu

Pohled nato¢eny o 20-stuprid.

Mduzete klopit pohled na 3D vykres nato€enim pohledu kolem linie zobrazeni mezi kamerou a cilem.
Zvolte TW (natocit).

Nové natoc€eni pohledu <0.0000>: Pro potvrzeni aktualniho nastaveni stisknéte Enter, nebo zadejte
novou hodnotu - zadanim velikosti Uhlu nato€eni nebo nato¢enim pohledu pohybem kursoru pfimo ve
vykrese.

TIP Uhel nato&eni se méfi proti smé&ru hodinovych rugisek.

Pro uréeni vzdalenosti kamery od cile

Muzete zménit perspektivu zménou vzdalenosti kamery od cile.

A. Kamera se pohybuje pro zobrazeni vykresu ze vzdalenéj$i perspektivy.
B. Kamera se pohybuje pro zobrazeni vykresu z menSi vzdalenosti.

Zvolte D (vzDalenost).

Nova vzdalenost kamery od cile <hodnota>: Pro potvrzeni aktualniho nastaveni stisknéte Enter nebo
zadejte novou hodnotu.

Pro zadani x-, y- z- soufadnic kamery a cile

Zvolte PO (body).



Zadejte cilovy bod &l;thodnota, hodnota, hodnota>: Zadejte bod nebo vlozte soufadnice pro cilovy
bod.

Zadejte bod kamery &l;thodnota, hodnota, hodnota>: Zadejte bod, nebo vlozte soufadnice pro bod
kamery.

Pro posun zobrazovaciho okna

Mdzete pohybovat obrazkem v zobrazovacim okné beze zmény zvétSeni pomoci posunu pohledu.

A. Nahled na entitu pfed posunem pohledu.
B. Nahled na entitu po posunu vlevo

Zvolte PAn (posunout).
Urcete zakladni bod nebo premisténi: UrCete prvni bod posunu.

Urcete druhy bod: Ur€ete druhy bod posunu. Vzdalenost mezi obéma body uréuje vzdalenost, o kterou
se posune zobrazeni.

Pro zménu pfriblizeni

Muzete zménit pfiblizeni zvétSenim nebo zmen$eni velikosti entit v aktualnim nahledu.

A. Aktualni pfiblizeni vykresu
B. Vykres po zvétseni pfiblizeni.

Zvolte Z (Zoom).

Pokud je zapnuta perspektiva, objevi se nasledujici vyzva:
Délka ¢oc¢ek <mm> pro vyuziti v zobrazeni <hodnota>:
Pokud je perspektiva vypnuta, objevi se tato vyzva:

Urcete koef. méfitka zvétSeni <1.000000>: Pro pfijeti aktualni hodnoty stisknéte Enter nebo zadejte
novou hodnotu.




76. Odstranit (Delete)

Ribbon Vychozi > Upravit > Smazat
Menu Modifikace > Vymazat
Panel nastoju Modifikace > Vymazat
Klavesnice delete

Klavesova zkratka Del

Alias E, ERASE

Odstrani vybrané entity z vykresu.

Vyberte entity pro odstranéni:
Vyberte entity, které chcete odstranit a stisknéte Enter.

Smazané entity jsou odstranény z databaze vykresu. Pokud neiumysiné smazete entity, mizete pouzit
pfikaz Zpét odstranit hned po smazani entity nebo i po nékolika jinych pfikazech.

77. Kétovani (Dimension)

Klavesnice dimension, kéty
Klavesova zkratka dim
Alias DIM, DIM1

Pfikaz kétovani: Zvolte si pfikaz pro kétovani, ktery chcete vyuzit z okna s vyzvou nebo napiste pfikaz.
Pro opusténi kétovaciho médu a navrat do pfikazové rfadky stisknéte klavesu Esc nebo napiste Exit.

V prubéhu pouzivani pfikazl pro kétovani muzete také vyuzivat ptikazy z nasledujici tabulky, které

s kotovanim souvisi. Pro jejich spusténi staci napsat jejich zkratku (nemusi zacinat pismeny DIM).

Prikaz Zkratka Popis

Aktualizovat upP Aplikuje kotovaci styl pro zvolené kéty
Editace kot ED Upravuje text ke kétam a sklon ¢ar
Horizontalni kéta HOR  Kresli horizontalni kétovaci ¢ary

Kota poloméru RA Méfi polomér kruhu nebo oblouku poly€ary
Kota priméru D Zméfi pramér kruhu, oblouku nebo oblouku poly&ary
Koéta stfedové znacky CE Umisti stfedovou znacku

Koéta od zakladny B PokraCovani pfimé koty ze zakladniho bodu
Novy text N Nahradi text koty

Obnova RES  Obnovuje aktualni kétovaci styl

Odkazova &ara LEA Kresli odkazovou &aru a text

Otocit RO Kresli otoCené koty

Otéaceni textu TR Otaci text koty

Posun textu koty PO Méni polohu textu ke kété

Proménné VA Seznam hodnot konkrétniho kétovaciho stylu
Prekresli RED  Ptekresli obrazovku

Prepsat kétovaci styl ov Prepisuje kotovaci styl




Pfima kéta VE Kresli vertikalni pfimé kéty

Retézova kéta CO PokraCuje v pfimé koté

Sklon OB Sklon kétovacich Ear

Stani¢ni kéta OR Stanic¢ni kéta

Status STA  Zobrazuje dalSi textové styly pro kotu
Sikma kéta AL Pridava koty, které jsou zarovnané k entité
Uhlova kéta AN Pro kétovani uhla

Ukoncit DO Opusténi kétovaciho médu

UloZeni SA Uklada v8echny kétovaci styly
Vertikalni kota VE Kresli vertikalni pfimé kéty

Zpét U Vrati zpét posledni pfikaz

Editace kot

78. Kéta Sikma (Dimension Aligned)

Ribbon Poznamky > Kéty > Linearni > Sikma
Menu Koty > Sikma

Panel nastoji Kéty > Sikma

Klavesnice  dimaligned, kétysrovnej

Alias DAL, DIMALI

Pridava koty, které jsou zarovnané k entité.

Klavesa ENTER pro vybér entity/<Pocatek prvni vynaseci ¢ary>
Urcete bod prvni vynadeci €ary, nebo zvolte entitu po stisknuti Enter.

Tvorba kéty ruénim oznaéenim bod

o
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A. UrCete prvni bod vynaseci Cary.
B. UrCete druhy bod vynaseci Cary.
C. Posunte kurzorem tam, kde chcete umistit kétu a jeji popisek.
Po volbé bodu prvni vynaseci Cary:

Pocatek druhé vynaseci ¢ary:
Urcete bod druhé vynaseci Cary.

Automaticka tvorba kot vybérem entity.
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A. Vyberte entitu, kterou chcete kotovat.
B. Posunite kurzor na misto, kam chcete kotu umistit

Stisknéte Enter.

Vyberte entitu pro kétu:
Vyberte entitu, ke které chcete pfidat kétu. Entita musi byt usecka, kruznice, oblouk nebo kfivka.

uhel (A)/Mtext/Text/<Umisténi kétovaci cary>:
Zadejte umisténi kotovaci Cary.

Pro zménu uthlu textu
Zvolte Uhel (A).

Uhel textu:
Zadejte uhel nato€eni textu uvnitf koty.

Pro zménu textu
Zvolte text.

Text kéty <3.6667>:
Koty zvolené entity jsou zobrazeny ve vychozim nastaveni. Pro zménu textu uvnitf kétovaci €ary napiste
novy text a stisknéte Enter.

79. Kéta uhlova (Dimension Angular)

Ribbon Poznamky > Kéty > Linearni > Uhlova
Menu Kéty > Uhlova

Panel nastoju Kéty > Uhlova

Klavesnice  dimangular, kétyahel

Alias DAN, DIMANG

Popisuje uhel mezi dvéma vybranymi entitami, nebo kruzZnicemi nebo oblouky.

Stisknutim klavesy ENTER urcete uhel/<Vyberte Gsecku, oblouk, nebo kruznici>:
Vyberte entitu. Pro ur€eni Uhlu anotace stisknéte Enter nebo praveé tlacitko mysi.

Kétovani thlu mezi dvéma tseckami

c

Ay



Vyberte prvni Usecku Uhlu, kterou chcete okétovat (A).
Zvolte druhou usecku (B).
Ur€ete kurzorem misto textu koty (C).

Vyberte prvni Usecku.

Dalsi usecka pro uhlovou kétu.
Vyberte dalSi entitu, kterou zahrnete do koéty.

uhel (A)/Text/<Umisténi kétovaci ary>:
Ur€ete umisténi oblouku koty a textu koty.

Pro ur€eni uhlu textu v ramci kétovaci €ary, zvolte uhel (A).
Pro zménu textu kéty, zvolte Text.

Kétovani oblouku

Yoo

Vyberte oblouk, ktery chcete okoétovat (A).
Kurzorem zvolte umisténi texty kéty (B).

Vyberte oblouk a pohybem kurzoru uréete umisténi textu koty.
uhel (A)/Text/<Umisténi kétovaci ¢ary>:

Urcete umisténi oblouku kéty a textu koty.

Pro ureni Uhlu textu v ramci kétovaci ¢ary, zvolte uhel (A).
Pro zménu textu koty, zvolte Text.

Koétovani kruznice
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Vyberte kruznici, kterou chcete okétovat (A).
Urcete Uhel a poté pohybem kurzoru uréete umisténi textu koty (B).

Vyberte kruznici.

Druha strana uhlu:
Urcete druhou stranu Uhlu, kterym chcete kétovat a pohybem kurzoru urCete umisténi textu koty.

uhel (A)/Text/<Umisténi kétovaci ary>:

Ur€ete umisténi oblouku koty a textu koty.

Pro uréeni Uhlu textu v ramci kétovaci ary, zvolte Uhel (A).
Pro zménu textu kéty, zvolte Text.

Pro zménu uthlu textu
Zvolte Uhel (A).



Uhel textu:
Zadejte uhel nato€eni pro text obsazeny v koté.

uhel (A)/Text/<Umisténi kétovaci ary>:
Urcete umisténi kotovaci ¢ary. Pro zménu textu v kété, zvolte Text.

Pro zménu textu
Zvolte Text.

Text kéty <hodnota>:
Jako vychozi nastaveni se zobrazi délka vybrané entity. Pro zménu textu v ramci koty, napiste novy text
a stisknéte Enter.

uhel (A)/Text/<Umisténi kétovaci ary>:
UrCete umisténi Cary koéty. Pro ur€eni Uhlu textu, zvolte uhel (A).

80. Kéta od zakladny (Dimension Baseline)

Ribbon Poznamky > Kéty > Od zakladny
Menu Kéty > Od zakladny

Panel nastoju Koty > Od zakladny

Klavesnice  dimbaseline, kétyzakl

Alias DBA, DIMBASE

PokraCovani predeslé pfimé, uhlové nebo stanicni kéty. Pokud nebyla v pfedchozim kroku vytvofena
Z4dna kota, jste vyzvani si zvolit pfimou, staniéni nebo uhlovou kétu, ktera se vyuZije jako zakladni kéta.
Program vyuziva prvni vynaseci ¢aru prvni koty jako prvni vynaseci ¢aru pro dalsi kétu.

Od zakladny: Klavesou ENTER vyberte pocatecni kotu/zpét (U)<Pocatek dalsSi vynaseci ¢ary>: Pro
urceni po€atku dalSi vynaseci €ary, vychozi nastaveni, zadejte bod. Pro ur€eni pocatecni koéty stisknéte
Enter.

Pro volbu pocatku dalsi vynaseci ¢ary

Zadejte bod pro umisténi po¢atku dalSi vynaseci ¢ary.

Text kéty <hodnota>: Pro akceptaci aktualni hodnoty stisknéte Enter. Pro zménu textu kéty zadejte novy
text.

Pro volbu pocatecni kéty

Aj 8
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A. Zvolte kétu, kterou chcete pouZit jako kotu od zakladny
B. Uréete pocatek dalsi vynaseci cary.



C. Zadejte pocCatek dalSi vynaseci ¢ary atd.
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Vysledek

Vyberte kétu od zakladny: Zvolte kétu, kterou chcete pouzit jako kétu od zakladny.

0Od zakladny: Klavesou ENTER vyberte pocatecni kotu/zpét (U)<Pocatek dalsi vynaseci ¢ary>: Pro
ureni poCatku dalSi vynaseci €ary, vychozi nastaveni, zadejte bod. Pro ur€eni pocatecni koty stisknéte
Enter.

Text kéty <hodnota>: Pro akceptaci aktualni hodnoty stisknéte Enter. Pro zménu textu kéty zadejte novy
text.

81. Kéta stredové znacky (Dimension Center Lines)

Menu Koty > Stiredové znacky
Panel nastoju Kéty > Stiredové znacky
Klavesnice  dimcenter, kétystied
Alias DCE

Umistuje zna¢ku do stfedu kruznice nebo oblouku kfivky. Neobsahuje zadny text.

A B

O ®

A. Zvolte kruh, kam chcete umistit znacku.
B. Znacka umisténa ve stredu kruZznice.

Vyberte oblouk nebo kruznici: Zvolte kruh, kruznici nebo kfivku obsahujici oblouk.

Muzete zménit velikost znacky vyuzitim systémové proménné DIMCEN. Muzete vyuzit i Koty > Styl pro
zobrazeni dialogového okna Spravce styld kétovani.

82. Kéta retézova (Dimension Continue)

Ribbon Poznamky > Kéty > Od zakladny > Pokrac¢ovat
Menu Kéty > Pokracovat

Panel nastoju Koty > Pokracovat

Klavesnice  dimcontinue, kétystied

Alias DCO, DIMCONT



Program vyuZiva posledni vyna8eci ¢ary prvni kéty jako prvni vynaseci ¢aru druhé koty.

B
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A. Vyberte pocatecni kotu.
B. Urcete bod pro navazujici kotu.
C. Urcete dalSi bod pro dalSi navazujici kétu.
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Vysledek

Klavesou ENTER vyberte pocatecni kotu/zpét (U)/<Pocatek dalSi vynaseci cary>:
Urcete pocatek nasledujici vynaseci €ary, nebo stisknéte Enter pro vybrani pocatecni entity.

Pro uréeni poéatku dalSi vynaseci ¢ary.

Ur€ete po€ate¢ni bod nasledujici vynaseci Cary.

Text koty :

Zvolte novy text koty, pokud existuje, nebo stisknéte Enter pro text, ktery je zobrazeny.

Pro vybér pocatecni koty.
Stisknéte Enter.

Vyberte kétu pro pokra¢ovani:
Vyberte kétu pro pokracovani.

Pokracovat: Klavesou ENTER vyberte pocatec¢ni kétu/zpét (U)/<Pocatek dalSi vynaseci ¢ary>:
Urcete pocCatek nasledujici vynaseci Cary, nebo stisknéte Enter pro vybrani pocateéni entity.

83. Kéta priméru (Dimension Diameter)

Ribbon Poznamky >Koéty > Osy > Pramér

Menu Koty > Primér
Klavesnice dimdiameter, kétypriim
Alias DDI

Koétuje primér kruznice nebo oblouku. Mzete umistit ¢aru praméru v jakémkoli Uhlu uvnitf nebo zvenku
kruhu ¢&i oblouku.
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Vyberte si kruZnici, kterou chcete okétovat (A).
Pohybem kurzoru urcite umisténi textu koty (B).

Vyberte oblouk nebo kruznici:
Vyberte oblouk nebo kruznici, které chcete zméfit.

uhel (A)/Mtext/Text/<Umisténi kétovaci €ary>:
Urcete umisténi kotovaci Cary.

Pro ureni uhlu textu kéty, zvolte uhel (A).

Pro zménu textu, zvolte Text.

Pro zménu uhlu textu.
Zvolte Uhel (A).

Uhel textu:
Zvolte uhel natoceni textu v koté.

uhel (A)/Mtext/Text/<Umisténi kétovaci €ary>:
Urcete umisténi kotovaci Cary.

Pro urceni textu koty zvolte Text.

Pro zménu uhlu textu zvolte uhel (A).

Pro zménu textu.
Zvolte Text.

Text kéty<hodnota>:
Jako vychozi nastaveni je zobrazen rozmér vybrané entity. Pro zménu textu kéty zadejte novy text
a stisknéte Enter.

uhel (A)/Mtext/Text/<Umisténi kétovaci €ary>:
UrCete umisténi kotovaci Cary.

Pro ureni Uhlu textu kéty, zvolte uhel (A).

Pro zménu textu, zvolte Text.

84. Editace kot (Dimension Edit)

Ribbon Poznamky > Kéty > Upravit text koty
Menu Kéty > Editovat text koty

Panel nastoju Kéty > Upravit text kéty

Klavesnice  dimedit, kétyedit

Alias DED, DIMED

Edituje text koty. Mizete ménit, otacet nebo obnovit text, nebo muzete sklopit Fadky.

Zadejte typ upravy koty: domu (H)/Novy/natocit text (R)/SikmO/<Domii>: Pro uloZeni opraveného



textu koty stisknéte Enter. Pro editaci textu zvolte Novy. Pro sklopeni fadkl zvolte $ikmO. Pro natoceni
textu zvolte natocit text (R).

Pro editaci textu koty
Zvolte Novy.

Novy text kéty: Viozte novy text kéty. Muzete pouzit nasledovné kédy pro viozeni specialnich znak:

Kéd Vyznam

%%c Symbol pro stfed

% %d Symbol pro stuper
% %p Symbol plus - minus
<> Originalni text

Mdzete vlozit i rozSifené znaky ze standardni sady znakd ANSI Microsoft Wordu. Podivejte se na Mapu
znak( Windows pro ziskani dal$ich informaci o podporovanych znacich.

Vyberte kéty pro nahrazeni novym textem: Zvolte text koty, ktery chcete nahradit.

Pro seSikmeni koty

"’ 2859 "'I
Sikmé kéta.
Zvolte SikmO.
Vyberte primé koéty pro sklopeni: Zvolte koty, které chcete zménit.
Zadejte uhel sklopeni: Zadejte Uhel, pod kterym chcete natocit text.

TIP Natocte text pod uhlem 30 stuprit pro koty v isometrickych vykresech.

Pro natoceni textu

I,.,- 28¥? /I
Skosena kota s natoCenym textem

Uhel textu kéty: Zadeijte uhel, pod kterym chcete natogit text. Uhel textu koty je relativni k vynaseci ¢are
koty. Pokud je hodnota nato€eni textu kéty O, Uhel textu je uréen typem a stylem koty.

Vyberte entity pro oto€eni textu: Zvolte koty, u kterych chcete natocit text.



85. Odkazova kéta (Dimension Leader)

Ribbon Poznamky > Kéty > Odkaz
Menu Kéty > Odkaz

Panel nastoju Kéty > Odkaz

Klavesnice  dimleader, pozice

Alias LE, LEAD, LEADER

Kresli Usecku, nebo Ffadu Usecek pro Fizené umisténi textu kéty. Odkazova ¢ara mize mit na svém
zacCatku Sipku, na konci ma text.

¢
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A. Zvolte pocéateéni bod odkazové cary.
B. Zvolte dalsi bod odkazové Cary
C. Zvolte koneény bod odkazové cary.

Zacatek odkazové ¢ary: Zvolte pocatecni bod odkazové koty.
DalsSi bod: Zvolte bod zalomeni odkazové &ary.
Do bodu: Format/zpét (U)/<anotace>: Pro vloZeni textu potvrdte Enter.

Prvni fadek textu anotace (F)/<moznosti>: Pro vioZeni textu zvolte anotace(F). Nebo stisknéte
moznosti (M):

Moznosti textu kéty: Blok/kopirovat (C)/Nic/Tolerance/<Mtext>:

- k odkazové kété mazete vlozit Blok (B)

- text odkazové koty je mozné skopirovat (C)

- odkazovou koétu muazete nechat bez textu (N)

- pro zadani geometrické tolerance zadejte Tolerance (T).

- pro zadani odstavcového textu stisknéte Enter. Zobrazi se dialogové okno pro odstavcovy text.

Pro nastaveni formatu textu

Do bodu: Format/zpét (U)/<anotace>: Zvolte format (F).

Sipka (A)/Nic/Spline/pfima (ST)/<konEc>:

- pro vytvoreni Sipky na zaCatku odkazové Cary zadejte Sipka (A)
- pro zruseni nastaveni formatu stisknéte N

- pro vytvofeni odkazové €ary ve formé kiivky stisknéte Spline (S)

- pro pfimou odkazovou ¢aru zvolte pfima (ST)
- pro ukonceni pfikazu stisknéte Enter




86. Kéta prima (Dimension Linear)

Ribbon Poznamky > Kéty > Linearni > Linearni
Menu Koty > Pfima

Panel nastoju Kéty > Pfima

Klavesnice  dimlinear, kotypfim

Alias DIMLIN, DLI

Pridava k entité horizontalni a vertikalni kétu.

Klavesa ENTER pro vybér entity <Pocatek prvni vynaseci ¢ary>:
Vyberte poCatecni bod kéty nebo stisknéte Enter pro vybrani entity.

Rucni tvoreni két vybérem bodt
¢ !'_ 8 2859
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A. Vyberte pocatek prvni vynaseci ¢ary.
B. Vyberte pocatek druhé vynaseci Cary.
C. Posunte kurzorem do pozice, kde chcete umistit popisek koty.

Pocatek druhé vynaseci ¢ary:
Vyberte bod pro druhou vynaseci ¢aru.

uhel (A)/Mtext/Text/Orientace kétovaci ¢ary: Horizontalni/Vertikalni/nato¢ena (R):

Pro pfidani horizontalni koty zvolte Horizontalni.
Pro pfidani vertikalni kéty zvolte Vertikalni.

Pro pfidani nato¢ené koty volte nato€ena (R).

Pro bliz8i ur€eni uhlu popisku koty, zvolte dhel (A).
Pro zménu textu kéty, zvolte Text.

Automatické tvoreni két vybranim entit.
8
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A. Vyberte entitu, kterou chcete okétovat.
B. Posurite kurzor do pozice, kde chcete popisek koty.

uhel (A)/Mtext/Text/Orientace kétovaci €ary: Horizontalni/Vertikalni/natoéena (R):
Pro pfidani horizontalni kéty zvolte Horizontalni.

Pro pfidani vertikalni koty zvolte Vertikalni.

Pro pfidani otoCeni kéty volte natocena (R).

Pro blizsi ur€eni Uhlu popisku kéty zvolte uhel (A).

Pro zménu textu koéty zvolte Text.



Pridani horizontalni koty

—]

Vyberte Horizontalni.

uhel (A)/Mtext/Text/<Umisténi kétovaci €ary>: ]
Vyberte umisténi koty. Pro zménu Uhlu popisku kéty, zvolte Uhel. Pro zménu textu kéty, vyberte Text.

Pridani vertikalniho rozméru

Vyberte Vertikalni

uhel (A)/Mtext/Text/<Umisténi kétovaci cary>: )
Vyberte umisténi koty. Pro zménu dhlu popisku kéty, zvolte Uhel. Pro zménu textu koty, vyberte Text.

Pridani rotacniho méritka
‘Y/ 2857 ”\
Zvolte Otadeni

uhel kétovaci ¢ara <0>:
Vyberte Uhel otolené ary.

uhel (A)/Mtext/Text/<Umisténi kétovaci cary>: )
Vyberte umisténi koty. Pro zménu dhlu popisku kéty, zvolte Uhel. Pro zménu textu kéty, vyberte Text.

Zména uhlu popisku
r,- 28%? /1
Zvolte Uhel

uhel textu:
Urcete Uhel sklonu textu zahrnujici sklon samotné kéty.

uhel (A)/Mtext/Text/<Umisténi kétovaci €ary>: )
Vyberte umisténi koty. Pro zménu dhlu popisku kéty, zvolte Uhel. Pro zménu textu kéty, vyberte Text.

Zména textu popisku koéty



Zvolte Text.
Text kéty <hodnota>:

Rozméry vybrané entity jsou zobrazeny jako vychozi nastaveni. Pro zménéni textu v ramci koty, napiste
novy text a zmacknéte Enter.

uhel (A)/Mtext/Text/<Umisténi kétovaci cary>: Vyberte umisténi kéty. Pro zménu Uhlu popisku koty,
zvolte Uhel. Pro zménu textu koty, vyberte Text.

87. Kéta stani¢ni (Dimension Ordinate)

Ribbon Poznamky > Kéty > Stani¢ni
Menu Koéty > Stanicni

Panel nastoju Koty > Stani€ni

Klavesnice  dimordinate, kétystanicni
Alias DIMORD, DOR

PFida kéty bodu.
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Vyberte bod pro stani¢ni koétu:
Zvolte bod pro stani¢ni kotu.

Text/ahel (A)/X data/Y data/<Koncovy bod odkazové cary>:

Pohybem kurzoru urete koncovy bod. Pro zménu textu, vyberte Text. Pro ur€eni x-soufadnic zvolte X
udaje. Pro ur€eni y-soufadnic zvolte Y udaje.

Pro zménu textu
Vyberte text.

Text koty
Pro zménéni textu spojeného se stani¢ni kotou, napiste novy text a stisknéte Enter.

Pouze pro x-udaje
Zvolte X data.

Koncovy bod odkazové ¢ary
Stisknéte Enter pro koncovy bod x-udajl

Text koéty



Chcete-li pfijmout vychozi hodnotu nebo zadat novou hodnotu, stisknéte klavesu Enter.

Pouze pro y-udaje
Zvolte Y data.

Koncovy bod odkazové éary
Stisknéte Enter pro koncovy bod y-udajl

Text kéty
Chcete-li pfijmout vychozi hodnotu nebo zadat novou hodnotu, stisknéte klavesu Enter.

88. Prepsat kotovaci styl (Dimension Override)

Menu Koty > Prepsat
Klavesnice dimoverride, kétyprepis
Alias DIMOVER, DOV

Méni nastaveni stylu pro vybranou skupinu kot. Pfepsat je kétovaci proménna, které hodnota se méni
podle aktualné nastaveného kétovaciho stylu.

Zadejte proménnou koéty k prepsani nebo [vycistit prepsani (C)]: Zadejte nazev proménné kéty, ktery
chcete prepsat. Pro vy€isténi pfepsani na zvolené kété zadejte C.

Pro prepsani kétovaci proménné

Napiste nazev koétovaci proménné. Program vypiSe aktualni hodnotu proménné a vyzve Vas k zadani
nové hodnoty.

Napfiklad:

Zadejte proménnou koty k prepsani nebo [vycistit prepsani (C)]: DIMSCALE

DIMSCALE je nyni <1.0000>. Nova hodnota: Zadejte novou hodnotu a stisknéte Enter.

Pro vy¢€isténi prepsani

Zadejte proménnou koéty k prepsani nebo [vycistit prepsani (C)]: Zvolte kéty a pak stisknéte Enter.
Program prepise koétovaci proménné podle aktualniho nastaveni kétovaciho stylu.

89. Kéta poloméru (Dimension Radius)

Ribbon Poznamky > Koty > Osy > Polomér
Menu Koty > Polomér

Panel nastoju Kéty > Polomér

Klavesnice  dimradius, kétyradius

Alias DIMRAD, DRA

M&Fi polomér kruznice, oblouku nebo kfivky s obloukem. Cara poloméru miize byt v jakémkoliv Ghlu.
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A. Zvolte kruznici, kterou chcete zmérit.
B. Zvolte umisténi odkazoveé cary.

Vysledek

Vyberte oblouk nebo kruznici: Zvolte kruznici, oblouk nebo oblouk kfivky, ktery chcete zméfit.

uhel (A)/Mtext/Text/<Umisténi kétovaci €ary>: Zvolte umisténi kétovaci ary. Pro ur€eni uhlu textu
zadejte uhel (A). Pro zménu textu koty zadejte fadkovy (T) nebo odstavcovy text (M).

Pro zménu uhlu textu

Zvolte uhel (A).

Uhel textu: Zadejte Ghel natogeni textu koty.

uhel (A)/Mtext/Text/<Umisténi kétovaci €ary>: Zvolte umisténi kétovaci Cary. Pro zménu textu koty
zadejte Fadkovy (T) nebo odstavcovy text (M).

Pro zménu fadkového textu koty

Zvolte text (T).

Text koéty : Kbty zvolené entity jsou zobrazeny jako vychozi nastaveni. Pro zménu textu na odkazové
Care vepiste novy text a stisknéte Enter.

uhel (A)/Mtext/Text/<Umisténi kétovaci €ary>: Zvolte umisténi kétovaci Cary. Pro uréeni uhlu textu
zadejte uhel (A).

Pro zménu odstavcového textu (M)

Zvolte Mtext (M).

Zobrazi se dialogové okno pro Odstavcovy text. Po provedeni Uprav v nastaveni potvrdte kliknutim na
OK.

uhel (A)/Mtext/Text/<Umisténi kétovaci €ary>: Zvolte umisténi kétovaci ary. Pro ur€eni uhlu textu
zadejte uhel (A).

90. Posun textu koéty (Dimension Reposition Text)

Ribbon Poznamky > Kéty > Upravit text koty > Zménit polohu textu kéty
Menu Koty > Zména polohy textu kéty

Panel nastoju Kéty > Znovu umistit text koty

Klavesnice  dimtedit, kétytedit



Alias DIMTED

Ur€uje umisténi a uhel textu koty.

Vyberte kétu: Zvolte text kéty, kterého umisténi chcete zménit.

Urcete nové umisténi pro text kéty nebo: vLevo/vpRavo/na stied (C)/domu (H)/ahel (A): Vyberte
nové umisténi textu kéty vlevo, vpravo nebo na stfed. Pro ukonéeni pfikazu zvolte domu (H). Pro zménu
Uhlu textu zvolte uhel (A).

Pro zménu uhlu textu koty

Zvolte uhel (A).

Uhel pro text kéty: Zadejte uhel nebo nato&eni kétovaciho textu.

91. Spravce styli kotovani (Dimension Styles Manager)

Ribbon Poznamky > Kéty > Spravce koétovacich styla
Menu Koty > Styl... Format > Kétovaci styl...

Panel nastoju Kéty > Stav kétovacich proménnych
Klavesnice  setdim

Alias D, DDIM

Zobrazuje Spravce stylu kotovani, ktery Vam umozriuje vytvaret a upravovat styl kétovani. Styly kétovani
jsou nastaveni, které jste zadali a ulozili. Pfi vytvareni stylu kétovani mizete ovlivnit umisténi a vzhled
kterékoliv koty.

MOZNOSTI DIALOGOVEHO OKNA



B ' Sprévce stylt kotovani X

Aktualni styl kot: Standard

Styly: Nahled: Standard
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Standard
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MozZnosti zobrazenych styld:
Seznam: Porovnat...
R Popis:
PouZité styl v
Sy Standard

0

Styly Seznam styll kétovani dostupnych v aktualnim vykrese.

Seznam Zvolte pro vyfiltrovani seznamu stylU kétovani.

Nevypisovat styly externich referenci Zvolte, pokud chcete zobrazit pouze kétovaci styly definované
v aktualnim vykrese. Kétovaci styly, které se vztahuji pouze na externi reference k vykresu budou ze
seznamu vynechany.

Popis Zobrazuje popis zvoleného kotovaciho stylu.

Aktualni Kliknéte, pokud chcete zvoleny styl nastavit jako aktualni.

Novy Kliknéte pro otevieni dialogového okna Novy kétovaci styl, ve kterém muzete vytvaret a definovat
nastaveni pro novy styl kétovani.

Odstranit Kliknéte pro odstranéni zvoleného stylu.

Prejmenovat Kliknéte pro otevfeni dialogového okna Pfejmenovat kétovaci styl, ve kterém muzete zménit
nazev stylu kétovani.

Upravit Kliknéte pro otevieni dialogového okna Zménit styl kétovani, ve kterém muzete ménit zvoleny styl
kétovani.

Prepsat Kliknéte pro otevieni dialogového okna Prepsat aktualni styl kotovani pro zmény nastaveni



aktualniho stylu kétovani. Aktualni styl kétovani musite zvolit ze seznamu pred stisknutim tladitka Pfepsat.
Definice stylu kétovani sama o sobé se neméni, pouze nastaveni aplikované na vybranou kotu.

Ulozit zmény Kliknéte pro uloZeni zmén vykonanych pfikazem Prepsat v aktualnim stylu kétovani.
Zrusit zmény Kliknéte pro odstrané&ni zmén vykonanych pfikazem Pfepsat v aktualnim stylu kétovani.

Porovnat Kliknéte pro otevieni dialogového okna Porovnat kétovaci styly pro zobrazeni vSech nastaveni
kot pro jednotlivé styly kétovani nebo pro nalezeni rozdild mezi dvéma styly kétovani.

92. Misa (Dish 3D solid)

Ribbon Kreslit 3D > Kreslit 3D télesa > Misa
Menu Kreslit > Télesa > Misa

Panel nastoju Kreslit 3D télesa > Misa

Klavesnice dish
Alias Al_DISH

Kresli spodni polovinu koule jako ACIS téleso. Plocha ¢ast koule sméruje nahoru.

Pro nakresleni misy na zadkladé poloméru

Stied dolni misy <0,0,0>: Zadejte stfedovy bod misy.

priamér (D)/<poloméR misy>: Zadejte polomér nebo uréete bod.

Pro nakresleni misy na zakladé priaméru

Stied dolni misy <0,0,0>: Zadejte stfedovy bod misy.

priamér (D)/<poloméR misy>: Vyberte primér (D). Zadejte pramér nebo uréete druhy bod.

93. Vzdalenost (Distance)

Ribbon Nastroje > Dotaz > Vzdalenost
Menu Nastroje > Dotaz > Vzdalenost
Panel nastoju Dotaz > vzdalenost

Klavesnice  dist, vzd

Alias DI

Méfi vzdalenost a Uhel mezi prvnim a druhym bodem.



A. UrCete zaCatecni bod délky, kterou chcete méfit.
B. UrCete koncovy bod.

Pocatecni bod pro vzdalenost:
Urcete pocatecni bod délky, kterou chcete zméfit.

Koncovy bod:
Urcete koncovy bod. V pfikazovém fadku je zobrazena zméfena délka, uhel méfeni a zména soufadnic x,
y, z. Pokud je hodnota soufadnic z vynechana, je pouzivana pro prvni a druhy bod aktualni elevace.

22 4MCAD Historie vizev [ESNE

Podpora rastrovych obrazkua nactena. -
Command: '_HELP

Command: _TBCONFIG

Command: _area

Entita/Pridat (A)/Odebrat (S)/<Prvni bod>:

<Dalsi bod>: =
<Dalsi bod>:

Storno

Storno

Command: _dist

Pocatecni bod pro vzdalenost:

Koncovy bod:

Vzdé18nost = 246.0575, Uhel v roviné Xy = 270, Uhel od roviny
XY =

vzdalenost X = 0.0000, Vzdalenost Y = -246.0575, Vzdalenost Z =
0.0000

Command: '_PMTHIST —

1

Command:l

94. Rozdélit (Divide)

Ribbon Upravit > Upravit > Zmérit > Rozdélit
Menu Kreslit > Bod > Rozdélit

Klavesnice divide, délu

Klavesova zkratka DIV

Alias DIV

Umistuje znacky podél zvolené entity. Znacky rovnomérné déli entity na stanovené mnozstvi stejnych
¢asti. Muzete délit usecky, oblouky, kruznice, elipsy, kfivky nebo spliny. Jako znacky mizete pouzit body
nebo bloky.

o

A. Viyberte entitu pro rozdéleni.
B. Vysledek

Vyberte entitu pro rozdéleni: Zvolte entitu, kterou chcete rozdélit.



Pocet segmentl nebo [Blok]: Zadejte pocet segmentU, na které chcete rozdélit zvolenou entitu.
Minimum je 2, maximum je 32.767.

Pro rozdé&leni entity s vyuZitim bloku (misto bodovych entit), zvolte Blok.
Vyuziti blokt jako znaéek rozdéleni

Pro vyuziti blokd jako znacek rozdéleni tyto musi jiz existovat.

A
| m

A. Viyberte entitu pro rozdéleni.
B. Bloky jsou rovnomérné rozdéleny podél entity.
Zvolte Blok
Nazev bloku pro vlozeni: Zadejte nazev bloku, ktery chcete vyuzit na rozdéleni entity.
Zarovnat bloky s entitou? : Pro zarovnani blok( s entitou, kterou délite, zvolte ano (Y). Tato moznost
umisti osu x bloku na te€nu entity. Pokud nechcete zarovnat blok s entitou, zvolte Ne. Tato moznost

zarovna bloky podle jejich normalni orientace.

Pocet segmentl: Zadejte pocet segmentu, na které chcete rozdélit zvolenou entitu. Minimum je 2,
maximum je 32.767.

95. Kopule (Dome 3D solid)

Ribbon Kreslit 3D > Kresli 3D télesa > Kopule
Menu Kreslit > 3D télesa > Kopule

Panel nastoju Kreslit 3D télesa > Kopule

Klavesnice dome

Alias Al_DOME

Kresli vrchni polovinu koule jako ACIS téleso. Plocha ¢ast koule sméruje dold.

Pro nakresleni kopule na zakladé poloméru

Stied kopule <0,0,0>: Zadejte stfedovy bod kopule.

pramér (D)/<poloméR kopule>: Zadejte polomér nebo uréete bod.

Pro nakresleni kopule na zakladé priméru

Stied kopule <0,0,0>: Zadejte stfedovy bod kopule.



prumér (D)/<poloméR kopule>: Vyberte pramér (D). Zadejte pramér nebo uréete druhy bod.

96. Prstenec (Donut)

Ribbon Kreslit > Prstenec (v Kresli)
Menu Kreslit > Prstenec

Panel nastoji Kreslit > Prstenec
Klavesnice  donut, prsten

Alias BAGEL, DO, DOUGHNUT

Pfikaz pfekladan také jako Prsten.

Kresli vyplnény kruh nebo plochy prstenec. MUzete pouzit systémovou proménnou FILLMODE pro
nastaveni, zda jsou vytvafené prstence vyplnéné.

2Body (2P)/3Body (3P)/PolTecTe¢ (RTT)/<Vnitini pramér prstence> <0.5000>:
Zadejte vnitini a vnéjsi primér prstence pomoci hodnot nebo bodu.

2Body (2P — 2Points) | Kresli prstenec metodou dvou bodu.

3Body (3P — 3Points) | Kresli prstenec metodou tfi bodu.

PolTecTec (RTT — RadiusTangentTangent) | Kresleni pomoci poloméru a dvou te€en.

97. Dvojité ¢erchovana (Double dashed-dot line)

Klavesnice mdivide

Klavesou ENTER pouzijete posledni bod/pokrac¢ovat (F)/<Zacatek usecky>:

Mysi urete pocatecni bod. UrCete mysi vzdalenost koncového bodu a smér tusecky. Mysi uréete koncovy
bod. Stisknéte Enter pro ukonceni entity nebo zvolte nékterou z moznosti pro upfesnéni navazujici
usecky:

uhel (A)/déLka/pokracovat (F)/zpét (U)/<Koncovy bod>:

Napiste A pro uréeni Ghlu mezi sekami. Uhel uréete mysi nebo napiste do prikazového fadku. Stisknéte
Enter.

Napiste L pro ur€eni délky nasledujici usecky. Délku zvolte posunutim mysi nebo napiste Cisly do
pfikazového fadku. Stisknéte Enter.

Stisknéte Enter pro ukon&eni kresleni entity.

98. Dvojité cary (Double lines)

Klavesnice dd



preruseni (B)/uzavieni konctl (CA)/umisténi (D)/Odsazeni/krokovani (S)/zpét (U)/Sifka
(W)/<pocatecni bod>

Napiste B pro ureni, zda chcete oteviené nebo zaviené koce dvoijitych Car.
Stisknéte Enter.

Preruseni v pocatec¢nich a koncovych bodech Dline /ano (ON)/ne (OFF) <OFF> :

NapisSte ON pro preruSeni, nebo OFF pro zruSeni preruseni.
Stisknéte Enter.

Napiste CA pro ur€eni, zda chcete otevfit nebo uzavfit konce dvojitych €ar. Stisknéte Enter.
Kreslit s uzavienim? oBa/konEc/zadNy/zacatek (S)/<Oba>

Zvolte, jestli chcete mit uzavieny pouze zaCatek dvojité Cary (S), konec (E) a nebo oba konce (B).
Stisknéte Enter.

Napiste D, pro ur€eni polohy dvojité ¢ary vzhledem ke kurzoru.
Stisknéte Enter.

Nastaveni pozice druhé €ary vLevo/stred (C)/vpRavo/<Odsazeni od stiedu = 0.00>

Zvolte jestli chcete druhou Caru kreslit tak, aby byla vlevo od kurzoru (L), napravo (R), nebo aby byl kurzor
uprostied dvou €ar (C). Stisknéte Enter.

Napiste S pro nastaveni krokovani.
Stisknéte Enter.

Zadejte rozmér krokovani nebo krokovani zapnout/vypnout. rozmér (S)/zapnout (ON)/vypnout
(OFF)/<OFF> :

Pokud chcete urcit rozmér krokovani, napiste S. Stisknéte Enter. Zvolte do pfikazového fadku velikost
krokovani a stisknéte Enter.

Pokud chcete krokovani vypnout, napiste OFF.
Pokud chcete krokovani zapnout, napiste ON.
Stisknéte Enter.

NapisSte W pro urc€eni Sitky dvoijité Cary.
Stisknéte Enter.

Nova Sifka DLINE <0.05>:

Napiste do pfikazového Fadku pozadovanou Sifku dvojité ary, coz je vzdalenost dvou Car dvojité cary.
Stisknéte Enter.

UrCete MySi na vykrese pocate€ni bod, smér usecky a koncovy bod.

Pro ukonCeni entity stisknéte Enter.

99. Orto rezim (Draw Orthogonal)



Ribbon Kreslit > Nastaveni > Kreslit ortogonalné

Menu Nastaveni > Kreslit ortogonalné

Panel nastoju Stavovy Ffadek > Zapnout / vypnout orto rezim
Klavesnice orthogonal, orto

Klavesova zkratka F8

Alias OR, ORTHO

Omezi kresleni prvku (€ar) na svislé a vodorovné (zarovnané dle mfizky). Pro kresleni pravouhle neni
tfeba zadavat pfikazy z klavesnice, staci pouzivat myS. Omezeni na pravouhlé kresleni je automaticky
vynuceno (pfi zapnutém orto rezimu).

A. Céra kreslena s vypnutym orto rezimem.
B. Cara kreslena se zapnutym orto reZimem.

ORTHOMODE je pravé vypnut: zapnout (ON)/prepnouT/<vypnout>:
Pro potvrzeni aktualni volby stisknéte Enter. Pro zménu rezimu napiste ON, OFF, T (toggle).

TIP
Pro rychlé pfepinani mezi ZAP./ VYP. orto rezimem doporu€ujeme osvojit si pouzivani rychlé klavesy F8.

100. Nastaveni kresleni (Drawing Settings)

Ribbon Vychozi > Pomiicky > Nastaveni kresleni
Menu Nastroje > Nastaveni kresleni

Panel nastoju Nastroje > Nastaveni kresleni

Klavesnice settings

Klavesova zkratka GR, RM, SE, UN, DDGRIPS, DDOSNA

Zobrazi dialogové okno Nastaveni kresleni, kde mlzete nastavit nebo zménit celkové vychozi nastaveni,
jako jsou jednotky vykresu, zadani soufadnic, zobrazeni, tvorba entit, nastaveni 3D. Posledni zaloZka,
kterou si zvolite v dialogovém okné Nastaveni kresleni se stane vychozi, ktera se Vam zobrazi, kdyz
pfikaz spustite pFiste.

Pro dalSi informace kliknéte na nasledujici odkazy:

Nastaveni vykresu - zalozka Jednotky vykresu
Nastaveni vykresu - zalozka Zadani souradnic
Nastaveni vykresu - zalozka Zobrazeni
Nastaveni vykresu - zalozka Tvorba entit
Nastaveni vykresu - zalozka Modifikace entit
Nastaveni vykresu - zalozka Nastaveni 3D




101. Nastaveni kresleni - zadlozka Nastaveni 3D (Drawing Settings - 3D Settings tab)

Ribbon Tlacitko aplikace > Nastaveni kresleni
Menu Nastroje > Nastaveni kresleni, zalozka Nastaveni 3D
Klavesnice settings-nastaveni-3d

Zalozka Nastaveni 3D slouzi pro nastaveni zplsobu vytvarfeni tfirozmérnych téles jako je vychozi
nastaveni tloustky a elevace nebo povrchu télesa. Z podzalozek si miuzete pro zménu nastaveni vybrat
Stinovani a Plochy.

MOZNOSTI DIALOGOVEHO OKNA

Aktualni tloust’ka 3D - uruje hodnotu pro tloustku entit, jako je bod, ¢ara, oblouk, kruh a kfivka.

Aktualni elevace 3D - ur€uje hodnotu elevace ve sméru osy z. VSechny entity jsou kresleny na urovni
této elevace, pokud se nastaveni nezrusi. Vychozi nastaveni je 0.

Zobrazit pohled shora pfi zméné USS - kliknéte pro zobrazeni pohledu shora pfi zméné USS.
Stinovani

Stinovani hran - zvolte typ stinovani, ktery chcete.

Stinovani plochy bez hran - ekvivalent 256-barevnému stinovani.

Stinované plochy, hrany v barvé pozadi - 256- barvené stinovani s hranami v barvé pozadi.
Bez ploch, hrany v barvé objektu - ekvivalent odstranéni skrytych ¢ar.

Plochy v barvé entity, hrany v barvé pozadi - ekvivalent 16-barevnému stinovani.

Plochy

Nastaveni povrchu - zvolte hustotu pokryti povrcht pro pfikazy Rotac¢ni plocha, Pfimkova plocha nebo
TaZena plocha (Kreslit > Plochy > )

Typ povrchu - zvolte typ vyhlazeni pro moznost Vyhladit pfikazu Upravit kfivku.

102. Nastaveni vykresu - zalozka Zadani souradnic (Drawing Settings - Coordinate
Input tab)

Ribbon Tlacitko aplikace > Nastaveni kresleni

Menu Nastroje > Nastaveni kresleni, zalozka Zadani soufadnic
Klavesnice settings-zadani-souradnic

Klavesova zkratka RM, SE, DDOSNAP, DDRMODES, DDSEL

Alias DDRMODES, DDSELECT, RM, SE

Zalozka Zadani sourfadnic v dialogovém okné Nastaveni kresleni slouzi na ovladani zpusobu, kterym
vkladate informace jako jsou zplsob uchopovani entit, nastaveni mfizky, velikost teréiku vybéru nebo



uchopu entit, nebo meze vykresu. Z podzalozek zalozky Zadani soufadnic si mizete zvolit Krokovani
a mfizka, Uchopy entit, Vybér entit, Meze nebo Polarni trasovani.

MOZNOSTI DIALOGOVEHO OKNA

Kreslit ortogonalné - zvolte pro vynuceni moznosti kreslit pouze horizontalni a vertikalni ¢ary a pravé
uhly (vychozi nastaveni je vypnuto). Ortogonalni rezim je mozné vypnout nebo zapnout stisknutim klavesy
F8.

Automaticky uchop - zvolte pro automatické uchopovani nejblizSich uchopovych bodu.
Krokovani a mfizka

Zapnout krokovani - kliknéte pro zapnuti modu, ve kterém omezuje program vybér bodd na
preddefinované intervaly krok( (vychozi nastaveni je vypnuto). Krokovani muzete kdykoliv vypnout nebo
zapnout stisknutim tlacitka F9.

Rozte¢ krokovani - zadejte x- a y-ovou rozte¢ krokovani, vychozi nastaveni je 0.5 jednotky.

Polarni vzdalenosti - urCete polarni vzdalenosti krokovani (dostupné, pokud je typ krokovani nastaven na
polarni)

Typ krokovani - zvolte, jestli chcete vyuzit standardni mfizku krokovani nebo polarni krokovani a vyberte
si z nasledujicich moznosti:

- Pravouhlé - vyuZiva pravouhlé krokovani (vychozi nastaveni).

- Isometrické - vyuziva isometrické krokovani. Pokud vybere isometrické krokovani, zvolte po¢atecnou
isorovinu: horni, vlevo (vychozi), nebo vpravo. Isorovinu mizete zménit kdykoliv stisknutim F5 nebo
Ctrl+E.

Zakladni bod krokovani - specifikujte x- a y-ovou soufadnici zakladniho bodu krokovani.

Natocéeni - uréete natoCeni rotacniho Uhlu (vychozi hodnota je 0 stuprill). Zobrazeni mfizky se pfizplsobi
nastaveni krokovani.

Poznamka: Zakladni bod krokovani a uhel natoceni ovlivriuji umisténi Sraf.

Zapnout mfizku - kliknéte pro zobrazeni referenéni mfizky. Mfizku mazete kdykoliv zapnout stisknutim
F7. Mfizka je soubor te€ek nebo &ar, které jsou vyuzivany ve vykrese jako pomucka. Mfizka se ve vykrese
netiskne.

Rozte¢ mrizky - specifikujte x- a y-ovou rozte¢ mfizky; vychozi nastaveni je 0.5 jednotky. Pokud je rozte¢
nastavena na 0, rozte€ mrizky je stejna jako krokovani.

Poznamka: Obvykle se mfizka zobrazuje jako nasobek krokovani. Napfiklad mizZete nastavit roztec
krokovani na 0.1 jednotky a rozte¢ mfizky na 1 jednotku.

Hlavni ¢ara kazdych - zadejte mnozstvi vedlejSich €ar mfizky, které se zobrazi pro kazdou hlavni ¢aru
mrizky.

Adaptivni mfizka - kliknéte pro zapnuti adaptivni mfizky, rozméry které se pfizplsobuji mirce pfiblizeni.

Povolit rozdéleni - kliknéte pro rozdéleni mfiZky pokud je Uroveri pfibliZzeni mensi, neZ jednotka mfizky
(dostupné, pokud je zapnuta adaptivni mfizka).

Zobrazit mrizku mimo meze - kliknéte pro zobrazeni mfizky mimo vymezenou oblast. V opacném
pfipadé je rozsah mfizky omezen mezemi vykresu.



Zobrazit teCkovanou mfizku v modelovém prostoru - kliknéte pro zobrazeni teCkované mfizky
v modelovém prostoru, v opacném pfipadé se zobrazi mfizka slozena z Car.

Zobrazit teCkovanou mfizku v listu/rozvrzeni - kliknéte pro zobrazeni teCkované mfizky ve vykresovém
prostoru, v opacném pfipadé se zobrazi mfizka slozena z Car.

Polarni trasovani

Polarni trasovani - zvolte pro automatické zobrazovani priivodce na obrazovce u stanovenych pfirastkd
uhla. Polarni trasovani muzete zapnout nebo vypnout kdykoliv pomoci dvojkliku na POLAR nastaveni ve
stavovém Fadku.

Nastaveni Uhlu trasovani

Prirtistek uhlu - zvolte pfirlstek, pfi kterém se ma zobrazit privodce polarnim trasovanim.

DalSi uhly - zvolte, jestli chcete specifikovat dal$i pfirlstky uhll, nez ten, ktery je nastaven v polozce
PFirastek uhlu.

Novy - kliknéte pro zadani pfirGstku thlu

Smazat - kliknéte pro smazani zvoleného pfifastku uhlu.

Nastaveni objektového trasovani - zvolte Kolmo pro zobrazeni privodce pro kolmé uhly, nebo zvolte
Pouzit vSechny uhly pro zobrazeni privodce pro polarni thly. Toto nastaveni se pouzije v pfipade, Ze je
zapnuto trasovani objektd (dvojklik na ETRACK ve stavovém fadku funkci zapne nebo vypne).

Polarni méreni Ghlu - zvolte Absolutné pro méfeni polarni Uhli zaloZené na aktualni USS nebo zvolte
Relativné k poslednimu pro méreni polarnich uhlud relativné k poslednimu nakreslenému segmentu, pokud
ma entita vice nez jeden segment (v opaéném pfipadé se objevi privodce pro absolutni thly).

Uchopy entit

Trasovani Uchopu objektu - zvolte pro zapnuti trasovani uchopu objektu, ktery zobrazi privodce pro
stanovené Uhly z vnéjsku k doGasnym trasovacim bodim. Pro dal$i nastaveni trasovani ichopu entit si
prectéte o Polarnim trasovani vySe.

Nastaveni tchopt - zvolte jeden nebo vicero Uchopu entit pro uréeni zplsobu kresleni entit.

Vypnout tchopy entit - kliknéte pro vypnuti vSech tchopu entit.

Vybér entit

Vybér - zvolte metodu, kterou chcete aktivovat pfi vybéru entit.

Vicevybérovy rezim - umoznuje Vam vybrat vice nez jednu entitu pfi jednom vybéru, napfiklad mizete
drzet klavesu Ctrl a zvolit vicero entit.

Tazeni okna - zvolte entity tazenim vybérového obdélnikového okna misto uréeni dvou bodu.

Automatické okno - vyuZijte vyb&rové okno nebo kfizujici okno (zaleZi na sméru, ve kterém pohybujete
kursorem), pokud program nemuze najit entity ve zvoleném bodu.

Predvybér - umoznuje Vam vybirat entity pfedtim, nez si zvolite pfikaz



Tercik vybéru entit - urCete velikost terCiku pro vybér entit, ktera ovliviuje oblast ve vykrese, kterou
program prohleda pokud kliknete do vykresu. Vychozi nastaveni je 4.

Tercik uchopu entit - urCete velikost terCiku uchopu entit, ktera ovliviiuje oblast ve vykrese, ve které
bude program hledat entity pokud vyuzijete uchop entit. Vychozi nastaveni je 13.

Tip: Vétsi tercik vybéru nebo tchopu usnadriuji vybér entity, na druhé strané muzete nechténé zvolit
i entity, které jste do vybéru nechtéli.

Limity

Meze vykresu - zadejte pravou horni a levou dolni soufadnici pro definovani rozsahu kreslici plochy,
nebo kliknéte na Zadat pro stanoveni rozsahu urenim bodl ve vykrese.

Zadat - kliknéte pro stanoveni mezi pfimo ve vykrese.

Nepovolit vstup za meze - kliknéte do zatrhavaciho okénka, abyste zabranili kresleni za mezemi
(vychozi nastaveni je nezatrzeno). Toto je stejné jako prepinac Hranice vykresu.

Nastaveni mezi ovliviuje i zobrazeni prodlouzeni mfizky jako i pfikaz PFiblizit vSe, omezenim zobrazeni
mFizky a maximalniho zvétSeni oblasti na rozmér stanoveny mezemi vykresu.

103. Nastaveni kresleni - zadlozka Zobrazeni (Drawing Settings - Display Tab)

Ribbon Tlacitko aplikace > Nastaveni kresleni
Menu Nastroje > Nastaveni kresleni, zalozka Zobrazeni
Klavesnice settings-zobrazeni

Klavesova zkratka GR, DDGRIPS, LWEIGHT

ZéaloZka Zobrazeni v dialogovém okné& Nastaveni kresleni slouZi pro nastaveni zobrazeni ve 4AMCAD
napfiklad soufadnic, zvyraziovani, barvy mfizky, tloustky ¢ar nebo dialogového okna. Z podzéloZek si pro
zménu nastaveni mlzete zvolit zobrazeni, mezi, tloustky ¢ar, uzld, nebo rozhrani programu.

MOZNOSTI DIALOGOVEHO OKNA

Zobrazeni souradnic - zvolte si format pro zobrazeni soufadnic ve stavovém fadku. Zobrazeni soufadnic
mizete zménit kdykoliv stisknutim F6 nebo Ctrl + D.

Zobrazeni

Zobrazit plnou vypln pro roviny, kifivky a stopy - kliknéte do zatrhavaciho pole pro zobrazeni plnych
vyplni entit jako jsou poly€ary, roviny nebo prstence. KdyZ pole neni zatrZzeno, program zobrazuje z téles
pouze siluety. Vychozi nastaveni je zatrzeno.

Tip - Nezatrzené pole pro vypln urychluje aktualizaci obrazovky a tisk.

Zapnout rychly text - kliknéte do zatrhavaciho pole pro zobrazeni vSech textll jako obdélnikovych siluet.
Vychozi nastaveni je nezatrZzeno. Volba rychlého tisku nema efekt pokud posléze pouzijete pfikaz Regen.

Tip - Zapnuti rychlého textu urychluje aktualizaci obrazovky a tisk.

Zvyraznit polozku pfi vybéru - kliknéte do zatrhavaciho pole pro zobrazeni zvolenych entit



preruSovanymi ¢arami. Tento krok Vam pomUze vidét, které entity jste si zvolili. Vychozi nastaveni je
zatrzeno.

Zobrazit body znacky - kliknéte do zatrhavaciho okénka pro zobrazeni znaménka (+) pokazdé, kdyz
vyberete bod. Toto oznaceni je doCasné a netiskne se. Bod znacky Vam pomuze vidét, které body jste
vybrali, ale obrazovka muze pusobit pfecpané. Pro jejich odstranéni pouzijte pfikaz Redraw. Vychozi
nastaveni je nezatrzeno.

Pretahovani entit - zvolte metodu, kterou ma program pouzit pro zobrazovani pretahovani entit

lkona USS - zvolte, jestli chcete aby byla ikona uZivatelského soufadného systému vypnuta, zapnuta
(vychozi nastaveni), nebo zobrazena v poc¢atku (0, 0, 0). Kdyz zvolite zapnuta, USS ikona se zobrazuje
v pravém dolnim rohu okna.

Limity

Meze vykresu - zadejte pravou horni a levou dolni soufadnici pro definovani rozsahu kreslici plochy,
nebo kliknéte na Zadat pro stanoveni rozsahu uréenim bodl ve vykrese.

Zadat - kliknéte pro stanoveni mezi pfimo ve vykrese.

Nepovolit vstup za meze - kliknéte do zatrhavaciho okénka, abyste zabranili kresleni za mezemi
(vychozi nastaveni je nezatrzeno). Toto je stejné jako pfepina¢ Hranice vykresu.

Nastaveni mezi ovliviuje i zobrazeni prodlouzeni mfizky jako i pfikaz PFiblizit vSe, omezenim zobrazeni
mFizky a maximalniho zvétSeni oblasti na rozmér stanoveny mezemi vykresu.

Uzly

Zapnout uzly - kliknéte do zatrhavaciho okénka pro zobrazeni uzld po vybéru entity. Vychozi nastaveni je
zatrzeno.

Velikost uzla - urCete velikost ¢tverce uzlu. Vychozi nastaveni je 6 pixelu.

Barva uzli - zvolte barvu uzlu. Vychozi je modra.

Rozhrani programu

Zapnout dialogova okna pro vybér souboru - kliknéte do zatrhavaciho okénka pro zobrazeni
dialogového okna kdykoliv je pro pouziti pfikazu nutné otevfit nebo importovat soubor. Kdyz okénko neni

zatrzeno, jste vyzvani zadat nazev souboru v pfikazovém fadku. Vychozi nastaveni je zatrzeno.

Zapnout echo historie vyzev - kliknéte do zatrhavaciho okénka pro zobrazeni pouzitych pfikaz v okné
Historie vyzev.

Vypnout echo polozky menu - zabrafiuje zobrazovani nazva zvolenych pfikazu v pfikazovém fadku.
Vychozi nastaveni je nezatrzeno.

Zapnout prikaz Zpét - kliknéte do zatrhavaciho okénka pro vypnuti pfikazu Zpét. Vychozi nastaveni je
zatrzeno.

Zapnout skupiny Zpét - kliknéte do zatrhavaciho okénka pro zobrazeni skupin pfikazu Zpét. Pfikaz
skupiny Zpét urCuje pocet pfikazu, které vratite zpatky jednim pouzitim pfikazu Zpét. Vychozi nastaveni je
nezatrzeno.

Prikazovy radek - zvolte, jestli se specialni znaky vioZené do pfikazového fadku budou interpretovat



doslovné& nebo budou povaZovany za specialni znaky LISP pfikaz(. Napfiklad pokud zvolite Cist text
doslovné, znak oteviené zavorky nebude viditelny na za¢atku LISP vyrazu.

Prohlizeni

Zobrazuje aktualni nastaveni pro prohlizeni. Tyto nastaveni jsou pouze informativni a neni mozné je
v tomhle dialogové okné zmeénit.

Tloustky ¢ar
Aktualni tloust’ka €ar - zvolte tlouStku ¢ar pro nové entity. Vychozi nastaveni je podle hladiny.
Jednotky pro vypis - zvolte, jestli chcete pro méfeni tloustky ¢ar pouzit milimetry nebo palce.

Zobrazit tloust’ky ¢ar - kliknéte do zatrhavaciho okénka pokud chcete, aby se tloustka ¢ar zobrazila na
obrazovce. Toto neovlivni tloustku ¢ar pfi tisku.

Vychozi - zvolte tloustku €ar, kterou chcete pfipsat hladinam, které vyuZivaji vychozi nastaveni tloustky
Car. Napfiklad pokud zvolite .09 milimetru, entity na hladinach, kterym je pfipsana vychozi tloustka ¢ar,
budou zobrazovany a tistény s tloustkou ¢ary .09 milimetru.

Upravit méritko zobrazeni - nastavte posuvnik pro nastaveni pozadovaného méfitka. Vychozi nastaveni
je 1.0. Méfitko zobrazeni ovliviiuje jak se tlouStka ¢ary zobrazuje na obrazovce a ne zpusob, jakym se
tiskne.

104. Nastaveni vykresu - zalozka Tvorba entit (Drawing Settings - Entity creation tab)

Ribbon Tlacitko aplikace > Nastaveni kresleni

Menu Nastroje > Nastaveni kresleni, zalozka Tvorba entit
Klavesnice settings-tvorba-entit

Klavesova zkratka DDPTYPE, DDEMODES

Alias DDGRIPS, GR, LWEIGHT

Zalozka Tvorba entit v dialogovém okné Nastaveni vykresu slouzi pro vychozi nastaveni novych entit,
jako je barva, hladina, typ Cary a méfitko, tloustka cary, vyska textu a vzor sraf. Z podzalozek si pro
zménu nastaveni mazete zvolit Atributy, Prstence, Elipsu, Skici od ruky, Srafy, Vlozeni, Body, KFivky/stopy
nebo Text.

MOZNOSTI DIALOGOVEHO OKNA

Hladina zvolte hladinu, na které chcete kreslit nové entity. Vychozi nastaveni je 0.

Typ €ary - zvolte typ Cary pro nové entity. Vychozi nastaveni je podle hladiny.

Tloustka €ary - zvolte tloustku €ary pro nové entity. Vychozi nastaveni je podle hladiny.

Styl tisku - zvolte styl tisku pro nové entity. Pro vykresy, které vyuZivaji mapy pro tisk zavislé od barvy,
vychozi nastaveni je podle barvy a neni mozné jej zménit. Pro vykresy, které vyuZivaji pojmenované

mapy stylu tisku je vychozi nastaveni podle hladiny a je mozné jej zménit.

Barva - zvolte barvu pro vSechny nové entity. Kliknéte na Vybrat barvy pro otevieni dialogového okna
Barvy a zvolte Indexové barvy, True color nebo Knihovny barev. Vychozi nastaveni je podle hladiny.



Méritko typu ¢ary - zvolte méfitko pro nové entity. Vychozi nastaveni je 1.0
Globalni méritko typu ¢ary - zvolte typ ¢ary pro nové entity. Vychozi nastaveni je 1.0.
Atributy

Vychozi nastaveni vlozeni - zvolte, jestli chcete, aby se pfi vkladani atributt pouzili vychozi hodnoty
nebo chcete, aby Vas program vyzval pro nastaveni (vychozi hodnota).

Vychozi rezimy atributt - kliknéte do zatrhavaciho okénka, pokud chcte, aby byl atribut neviditelny (Cili
nezobrazuje se ve vykrese pokud nezapnete funkci Zobrazit atributy) a / nebo definovan (atribut prebira
vychozi hodnotu, pokud jste ji zménili). Vychozi hodnota okénka je nezatrzeno.

Metody vkladani atributt - pokud chcete vlozit atribut, mizete Zadat hodnoty v pfikazovém fadku
(vychozi nastaveni) nebo mlzete Zadat hodnoty v dialogovém okné, ve kterém je seznam atributt a jejich
vychozich hodnot.

Rezimy zobrazeni atributti - pro vynuceni zobrazeni v§ech atributll zvolte Zapnuto. Pokud je vykres
pfecpan texty atributd, zvolte Vypnuto. Pro zobrazeni pouze atribut(, které nemaiji nastavenou hodnotu
neviditelny, zvolte Normalni (vychozi nastaveni).

Prstence

Vnéjsi pramér prstence - zadejte hodnotu pro vnéjsi primér prstence (vychozi hodnota je 1.0).
Vnitini pramér prstence - zadejte hodnotu pro vnitfni primér prstence (vychozi hodnota je 0.5).

Elipsa

Vytvaret pravé elipsy - kliknéte pro vytvoreni matematicky presné elipsy.
Vytvaret elipsy jako kfivky - kliknéte pro kresleni elipsy z oblouku kfivky.

Skici od ruky

Metody kresleni skic - pokud chcete, aby se Vase skica vytvofila z jednotlivych Useek (vychozi
nastaveni), zvolte moznost Usecky. Pokud chcete, aby se vytvofila jako jedna kfivka, zvolte moznost
kfivka.

Délky segmentt - uréete délku segmentu ¢ary nebo kfivky. Vychozi nastaveni je 0.1 jednotky.
Srafy

Nazev vzoru - ze seznamu zvolte nazev vzoru, ktery chcete pouzit.

Méritko vzoru - uréete méfitko pro zvoleny Srafovaci vzor. Obvykle odpovida méfitku vykresu.

Uhel vzoru - urgete thel pro vybrany $rafovaci vzor. Obvykle je nastaveni 0 stuprili, protoZe Srafovaci
vZzor je jiz vytvoren v patfiéném dhlu.

Styl vzoru - zvolte, jestli chcete, aby se Srafovaci vzor pouzil ve standardnim modu, ve kterém jsou
Srafovany stfidavé vnitini oblasti (vychozi nastaveni), vnéjSi mod, ve kterém se vysrafuje pouze vnéjsi
oblast, nebo vSe, kde je Srafovano vSe uvnitf okraji v€etné textu.

Srafovani pomoci éar - pokud je rafovaci vzor nanesen pomoci &ar, kliknéte do zatrhavaciho okénka
pro umoznéni dvojitého Srafovani, ve kterém se druhy vzor nanasi pod thlem 90 stupiiG. Uréete rozte¢



mezi ¢arami.

Tip - Rotacni thel a souradnice x a y pocatku Srafovaciho vzoru se da nastavit i jako nastaveni ve:
Zakladni bod krokovani a natoceni.

Vlozeni
Vychozi nazev bloku - zadejte nazev bloku (neni zadana vychozi hodnota).

Zakladni bod vlozeni - uréete soufadnice x, y a z zakladniho bodu vloZeni bloku (vychozi hodnota je 0, O,
0). Kliknéte na Zadat pro uréeni bodu pfimo ve vykrese.

Body

Velikost bodu - urete jakou velikost bodu chcete. Hodnota 0 nakresli bod ve 5% velikosti okna.

Typ zobrazeni bodu - zvolte jak se ma bod zobrazit.

Krivky / stopy

Sirka kfivky - uréete itku kivky (vychozi hodnota je 0).

Sitka stopy - urdete $itku stopy (vychozi hodnota je 0.5).

Pouzit typy €ar souvisle na nové vytvorené kiivky - kdyz se typ ¢ary pouzije na kfivku, typ ¢ary muze
zacit a skoncit s kazdym novym segmentem kfivky (vychozi hodnota je vypnuto), nebo mize zacinat

a kongit se zaCatkem a koncem celé kfivky.

Text

Vychozi vyska textu - uréete vysku textu. Vychozi hodnota je 0.2 jednotky. Kdyz hodnotu nastavite na 0,
prikazy Text a Vicefadkovy text Vas vyzvou k zadani vysky textu.

Vychozi styl textu - zvolte nazev pro styl textu.

Prozkoumat styly textu - kliknéte pro prozkoumani stylt textu ve 4MCAD.

105. Nastaveni kresleni - zadlozka Modifikace entit (Drawing Settings - Entity
Modification tab)

Ribbon Tlacitko aplikace > Nastaveni kresleni
Menu Nastroje > Nastaveni kresleni, zalozka Modifikace entit
Klavesnice settings-modifikace-entit

Zalozka Modifikace entit v dialogovém okné Nastaveni kresleni slouzi na vytvofeni nastaveni modifikace
entit, napfiklad zplsob zrcadleni textu, zkoseni / zaobleni roh( a ofezu €ar. Z podzalozek si mlzete zvolit
Zkoseni / zaobleni, Spline / mezi, Ofezat / prodlouZit a upravit jejich nastaveni.

MOZNOSTI DIALOGOVEHO OKNA

Nastaveni zrcadleni - zvolte zpusob orientace zrcadleného textu.



Vychozi vzdalenost odsazeni - urCete vzdalenost, ktera se ma pouzit s pfikazem odsazeni. Hodnota
menSi nez 0 odsadi entitu skrze bod (moznost skrze). Hodnota vétsi nez 0 predstavuje nastaveni
odsazeni.

Zkoseni / zaobleni

Odstranit rohy - zvolte pro odstranéni rohl po ofezu.

Ponechat rohy - zvolte pro ponechani rohl po ofezu.

Polomér zaobleni - urete polomér oblouku pro ofez, vychozi hodnota je 0.5 jednotky. Kliknéte na Zadat
pro ur¢eni dvou bodl na obrazovce, které predstavuji polomér.

Vzdalenosti a Ghly zkoseni - uréete vzdalenost a pfipadné uhel pro vytvofeni zkoseni. Mlzete si zvolit
mezi dvéma vzdalenostmi nebo vzdalenosti a uhlem.

Spline / mezi

Pocet bodil na zakfiveny segment - zvolte poc¢et bod, které ma program pouzit pro zakfivené
segmenty podél kiivky. Vychozi nastaveni je 8.

Zobrazit kontrolni ramecek kfivky - kliknéte do zatrhavaciho poli¢ka pro zobrazeni ramecku kfivky.
Vychozi nastaveni je vypnuto.

Ofezat / prodlouzit
Rezim promitani - zvolte jeden ze tfi rezimG promitani.

Pouzit prodlouzené hrany pro Orez / Prodlouzeni - kliknéte do zatrhavaciho poli¢ka pro rozsifeni
pomysiné hrany nebo oblouku, které se stanou soucasti ofezu nebo vnéjsiho ohraniceni.

106. Nastaveni vykresu - zalozka Jednotky vykresu (Drawing Settings - Units tab)

Ribbon Tlacitko aplikace > Nastaveni kresleni
Menu Nastroje > Nastaveni kresleni, zalozka Jednotky vykresu
Klavesnice settings-jednotky-vykresu

Zalozka Jednotky vykresu v dialogovém okné nastaveni kresleni umoznuje Upravu vSech vychozich
nastaveni vztahujicich se k jednotkam ve 4MCADu. Tuto zalozku mUzete vyuzit pro zménu nastaveni jako
jsou typy jednotek, smér uhlu, zaklad Uhlu a pfesnost zobrazeni. Z podzalozek si pro zménu nastaveni
vyberte Uhlova, Délkové nebo USS.

MOZNOSTI DIALOGOVEHO OKNA

Odebrat mezery pfi pfevodu vzdalenosti ¢i uhl na text - kliknéte na zatrhavaci okénko pro zobrazeni
vzdalenosti a Uuhlt s pomi¢kami misto mezer. Tento krok neovlivni jak jsou vzdalenosti nebo uhly
vkladany, nemuzete vyuzit mezery pfi zadavani vzdalenosti nebo Ghld.

Zalozka Délkové jednotky

Typy jednotek - zvolte zplsob, kterym chcete aby se zobrazovali vysledky linearnich méfeni:

Exponencialni - exponencialni zapis



Desetinné - desetinné jednotky

Palcové desetinné - stopy a desetinné palce
Architektonické - stopy a zlomkové palce
Zlomkové - zlomkové palce (bez stop)

Presnost zobrazeni - zvolte pfesnost, se kterou chcete zobrazovat vysledky méfeni - Cili mnozstvi
desetinnych mist, ktera chcete zobrazovat pro vSechny jednotky kromé zlomkd. Vychozi hodnota jsou
desetinna mista, maximum je 8 desetinnych mist, minimum O (tehdy se vysledek zobrazuje jako celé
cislo).

Zalozka Uhlové jednotky
Typ jednotek - zvolte si zpusob jakym chcete, aby se zobrazovali hlové jednotky.

Presnost zobrazeni - zvolte si pfesnost, se kterou chcete aby se zobrazovali vysledky Uhlovych méfeni.
Vychozi hodnota je 0 desetinnych mist, maximailni je 8 desetinnych mist pro desetiny stupfu.

Smér uhlu - zvolte, jestli chcete aby se Uhly méfili ve sméru nebo proti sméru hodinovych ruci¢ek od
zakladu uhlu.

Zaklad uhlu - zvolte si stupen, od kterého chcete aby se Uhly méfili. Vychozi nastaveni je 0 stupfid, co
znamena vychodni smér a je obvykle pouzivanym smérem. Nékteré vykresy vyzaduji nastaveni 0 stupnu
smérem na sever.

Uzivatelsky soufadny systém (USS)
Ikona USS - zvolte si, jestli chcete aby ikona USS byl vypnuta nebo zapnuta (vychozi nastaveni), nebo
zobrazovana v pocatku (0,0,0). Kdyz zvolite zapnout, USS ikona se zobrazuje v spodnim pravém rohu

okna bez ohledu na to, jakou ¢ast vykresu pravé zobrazujete.

Zobrazit pohled shora pfi zméné USS - kliknéte do zatrhavaciho okénka pro zobrazeni pldorysu pied
prechodem na novy USS.

107. DXF import (DXF In)

Ribbon Tlacitko aplikace > Import > DXF Import
Klavesnice dxfin, étidxf
Alias DN

Zobrazi dialogové okno Nacist DXF soubor. DXF soubor je textovy soubor, ktery obsahuje databazove
informace o vSech entitach v CAD vykrese.

Pokud jste skoncili s importem DXF souboru, zobrazi se oznam o pfidani souboru.

108. DXF Export (DXF Out)

Ribbon Tlacitko aplikace > Export > Export DXF
Klavesnice dxfout, piSdxf
Alias DX



Zobrazi dialogové okno Vyberte soubor DXF, abyste mohli exportovat aktualni vykres do souboru DXF
formatu. DXF soubor je textovy soubor, ktery obsahuje databazi s informacemi o vSech entitach vykresu.

Pokud zadate pfikaz pro export vykresu do DXF formatu, objevi se dialogové okno Vyberte soubor DXF.
Pokud zadate nazev DXF souboru a kliknete na Ulozit, v pfikazovém fadku se objevi nasledujici vyzva:

Entity/Binarni/Verze/Zadejte presnost na pocet desetinnych mist (0-16) <6>: Pro pfijeti vychoziho
nastaveni urovné presnosti stisknéte Enter. Pro zménu pfesnosti zadejte novou hodnotu. Pro vybér entit,
které chcete exportovat zvolte E (Entity). Pro uloZeni souboru do binarniho formatu zvolte B (binarni).
Binarni format obsahuje stejné informace jako DXF format, pouze jsou tyto informace v kompaktni podobé
(binarni format je mozné nacitat i zapisovat rychleji, ale neni mozné s nim pracovat v tolika programech
jako s formatem DXF). Pro ur€eni verze formatu souboru zvolte V (verze).

Poznamka Vychozi nastaveni Urovné presnosti je 6 desetinnych mist. Urover piesnosti mizete zvysit,
pokud se objevi problémy s pfesnosti po importu ulozenych DXF soubor(. Tento krok vSak navysi
i velikost souboru. Nedoporu€ujeme menSi pfesnost, nez je 6 desetinnych mist.

Pro vybér entit, které chcete exportovat

Zvolte Entity

FILtr/<Vyberte entity pro export>: Vyberte entity, které chcete exportovat do DXF formatu.
Zadejte presnost na pocet desetinnych mist (0-16) <6>: Pro pfijeti vychoziho nastaveni Grovné
presnosti stisknéte Enter. Pro zménu pfesnosti nastaveni zadejte novou hodnotu.

Pro uréeni verze formatu souboru

Zvolte Verze (V).

Verze souboru R2.5/R2.6/R9/R10/R12/R13/R14/A2K/A2004/A2007/A2010/A2013 <A2013>: Pro pfijeti
vychozi verze (A2013) stisknéte Enter. Pro uloZzeni souboru v jiné verzi zadejte Cislo této verze.

109. Dynamické nastaveni pohledu (Dynamic View Control)

Ribbon Pohled > Pohledy > Ovladani dynamického pohledu

Menu Pohledy > Ovladani dynamického pohledu
Klavesnice viewctl
Alias DDVPOINT, VP

Zobrazi dialogové okno Nastaveni pohledu, kterym muzete ovladat smér 3D zobrazeni.
Moznosti dialogového okna

Relativné ke GSS/USS Zvolte, jestli smér zobrazeni je relativni k GSS (globalnimu soufadnému systému)
nebo USS (uZivatelskému soufadnému systému).



Osa X Zadejte uhel od osy X.
Rovina XY Zadejte uhel od roviny XY.
Nastaveni Kliknéte pro nastaveni sméru zobrazeni na padorys.

Upravit Kliknéte pro otevieni dialogového okna Pfednastavené pohledy a nastavte smér zobrazeni
pomoci pfeddefinovanych nastaveni.

Nastavit na pohled shora Kliknéte pro otevieni dialogového okna Ovladani pohledu - vzhledem ke GSS
a nastavte smér zobrazeni interaktivné ve vykrese.

110. Upravit atribut (Edit Attribute)

Menu Modifikace > Objekt > Atribut > Upravit atribut
Klavesnice attedit
Alias -ATE

Upravuje text atributu spojeny s bloky. Atributy mizete upravovat individualné nebo globainé.
Pro upravu individualniho textu atributu potvrdte Enter moznost: Ano-upravovat postupné
Pro Upravu textu vicero atributl sou¢asné potvrdte Enter moznost: Ne-upravovat zaroven

Poznamka: Pro Upravu skrytych atribut( zvolte u této vyzvy moznost Ano. Pevné atributy neni mozné
upravovat.

Upravit atributy kterych blok? <*>: Pro Upravu v§ech blok( s atributy (vychozi nastaveni) stisknéte
Enter. Pro Upravu konkrétniho bloku zadejte nazev bloku, ktery obsahuje atributy, které chcete uprauvit.
Upravit atributy s témito nazvy <*>: Pro Upravu vSech atributl stisknéte Enter. Pro Upravu konkrétniho
atributy zadejte jeho nazev.

Upravit atributy s timto textem <*>: Pro Upravu vSech atributt stisknéte Enter. Pro Upravu textu
konkrétniho bloku zadejte text, ktery je spojeny s atributem, ktery chcete upravit.

Vyberte blok s atributy: Zvolte atributy, které chcete upravit.

Poloha/uhel (A)/Text/Styl/barva (C)/vySka (H)/hLadina/dalsi (N)/pfed (R)/ukongit (Q)/:

Pro Upravu textu dal$iho atributu ve vychozim nastaveni stisknéte Enter. Pro zménu bodu vlozZeni textu
atributu zvolte Poloha. Pro zménu uhlu textu atributu zvolte dhel (A). Pro zménu textu atributu zvolte Text.
Pro zménu stylu textu atributu zvolte Styl. Pro zménu barvy textu atributu zvolte barva (C). Pro zménu
vys$ky textu atributu zvolte vySka (H). Pro zménu hladiny, se kterou je atribut spojeny, zvolte hLadina. Pro
upravu dalSiho atributu zvolte dalSi (N). Pro zménu pfedchoziho atributu zvolte pfed (R). Pro ukon&eni
Upravy atributl zvolte ukongit (Q).

TIP Pro prohlizeni zménénych atributt pfed ukon¢enim prikazu zapnéte REGENAUTO.

Pro zménu bodu viozeni textu atributu

A Size Drawing

>:< PR L
Aktualni bod vlozeni textu atributu.

Zvolte Poloha.

Zadejte bod vilozeni textu: UrCete novy bod viozeni. Mlzete jej zadat také ve formé soufadnic x, y .



Pro zménu uhlu textu atributu

A Size Drawing_

;-(i':‘.
Zména uhlu textu atributu.

Zvolte Uhel (A)
Novy uhel oto€eni <0>:

Zména textu atributu

A Size Drawing
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Zménte existujici text atributu.
Zvolte Text.

zménit (C)/: Pro nahrazeni existujiciho textu celého atributu zvolte Enter. Pro zménu &asti atributu zvolte
zmenit (C).

Pro nahrazeni textu
Zvolte Nahradit.

Novy text atributu : Pro pfijeti vychoziho textu stisknéte Enter. Pro zménu textu zadejte novy text atributu.

Pro zménu textu
Zvolte zmeénit (C).

Text, ktery chcete zménit: Zadejte pismena, kterd chcete zménit.
Novy text: Zadejte nova pismena

Pro zménu stylu textu atributu

A Size Drawing
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Zméni styl textu atributu.

Zvolte Styl.

Nové pismo textu, nebo klavesa ENTER pro Zadné zmény : Pro pfijeti vychoziho nastaveni stisknéte
Enter. Pro zménu stylu zadejte ndzev nového stylu textu.

Pro zménu barvy textu atributu
Zvolte barva (C).

Nova barva [Truecolor/knihovna barev (CO)] : Pro pfijeti vychoziho nastaveni kliknéte na Enter. Pro
zménu barvy zvoleného textu atributu zadejte barvu, kterou chcete prostfednictvim Cisla nebo nazvu.



Pro vlozeni ¢isla barvy

Zadejte Cislo barvy z barevné palety (od 1 do 255). Zadejte 0 pro barvu podle hladiny, nebo zadejte 256
pro barvu podle bloku.

Pro zadani nazvu barvy

Zvolte nazev standardni barvy. Sedm standardnich barev je Cervena (red), zluta (yellow), zelena (green),
azurova (cyan), modra (blue), purpurova (magenta) a bila (white).

Pro zménu vysky textu atributu

A Size Drawing
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Zména vysky textu atributu.

Zvolte vyska (H).

Nova vyska textu : Pro pfijeti vychoziho nastaveni stisknéte Enter. Pro zménu vySky zvoleného textu
atributu zadejte novou hodnotu nebo uréete 2 body.

Pro zménu hladiny, se kterou je text atributu propojeny
Zvolte hLadina.

Nova hladina, nebo klavesa ENTER pro zadné zmény <0>: Pro pfijeti vychoziho nastaveni stisknéte
Enter. Pro zménu hladiny vlozte nazev hladiny.

Pro upravu dalSiho atributu

img { float: left; }
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Volba dalSiho nebo pfedchoziho atributu pro upravu.

Volte dalsi (N) nebo pfed (R) az pokud nebude atribut, ktery chcete upravit, oznaceny x.

111. Editovat atributy bloku (Edit Block Attributes)

Ribbon Vlozit > Blok > Upravit atributy bloku

Menu Modifikace > Objekt > Atribut >Upravit atribut
Panel nastoju Nastroje > Upravit atributy bloku

Klavesnice  ddatte, diatr

Alias ATE

Zobrazi dialogové okno Editovat atributy bloku, takZze muizete upravit hodnoty atributd (informaéni text)
spojené s jednotlivym blokem.



Vyberte blok s atributy: Zvolte blok, ktery ma definované atributy. Objevi se dialogové okno Editovat
atributy bloku.

112. Upravit délku (Edit Length)

Ribbon Upravit > Upravit > Prodlouzit > Upravit délku
Menu Modifikace > Upravit délku

Panel nastoju Modifikace > Upravit délku

Klavesnice editlen, zdvih

Alias LEN, LENGTHEN

Zméni délku neuzaviené entity. Je mozné upravovat usecky, kfivky, entity nakreslené od ruky a oblouky.
POZNAMKA Nelze upravit délku kfivky, ktera byl pfevedena na spline nebo ,pfizpisobena“.

Upravit délku: DYnamicky/prirtstek (I)/Procento/celkem (T)/<Vyberte entitu pro vypis délky>:
Vyberte entitu pro zobrazeni jeji aktualni délky. Vyzva se objevi znova v€etné délky vybrané entity.
DYnamicky (DY) | Uprava délky tazenim.

PrirGstek (I — Increment) | Zména délky o ureny prirtstek.

Procento (P) | Zména délky o procento celkové délky.

Celkem (T — Total) | Zadani celkové délky entity.

TIP Jako vychozi hodnota se v pfikazu zobrazi hodnota uréena v pfedchozim pfikazu.

Uprava délky entity tazenim koncového bodu
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A. Vyberte entitu pro Upravu délky.
B. Presunte kurzor pro zménu délky.

Zvolte Dynamicky (DY).

reziM/<Vyberte entitu pro zménu>:

Vyberte entitu, které chcete upravit délku.

Rezim (M — Mode) | Zména metody.

Novy pocatecni bod ¢ary: UrCete novy pocatecni bod.

Pokud jste vybrali entitu kliknutim pobliz koncového bodu, jste vyzvani k uréeni nového koncového bodu.
Pokud jste klikli blize po¢atecniho bodu, jste vyzvani k zadani nového pocatecniho bodu.

POZNAMKA Volba Dynamicky upravi délku posledniho segmentu kfivky; neméni délku vnitfnich

koncového segmentu.

Uprava délky entity o uréeny prirastek

Zvolte Prirtstek ().

uhel (A)/<Zadejte prirtistek délky (0.0000)>:

Zadejte délku, o kterou se ma délka entity zménit. Pro prodlouzeni zadejte kladnou hodnotu, pro zkraceni
zadejte hodnotu zapornou.

Uhel (A) | Zména Ghlu opsaného obloukem.



Zadejte prirtstek uhlu <0.0000>: Zadejte Uhel, o ktery se ma oblouk zménit. Tuto volbu nelze aplikovat
na usecky a kFivky.

reziM/<Vyberte entitu pro zménu>: Vyberte entitu, kterou chcete prodlouzit. Vzdy, kdyz vyberete entitu,
je jeji délka zvétSena (nebo zménsena) o velikost pfirlstku.

Rezim (M — Mode) | Zména metody pro Upravu délky.

POZNAMKA Volba Prirdstek prodiuZuje koncovy bod nejblizsi k uréenému bodu. Tato volba nezméni
vnitfni segment kfivky; misto toho prodlouZi program koncovy segment nejblize koncovému bodu.

Prodlouzeni nebo zkraceni entity o procento jeji celkové délky

Zvolte Procento (P).

Zadejte procento délky <100.000000>: Zadejte procento celkové délky entity. Pokud zadate hodnotu
mensi nez 100, je entita zkracena. Pfi hodnoté vySsi nez 100, je entita prodlouzena. Pokud zadate
hodnotu 100, zUstane délka entity nezménéna.

POZNAMKA Volba Procento prodiuZuje koncovy bod nejbliZe k uréenému bodu. Volba neméni délku
vnitfnich segmentl kfivky; misto toho program prodlouzi koncovy segment nejblizsi k uréenému bodu. Pro
uzavfeni oblouku kruznice pouzijte volbu Oblouk u pfikazu Kruznice misto zadani procenta vétSiho nez
100.

Uréeni celkové délky entity

Zvolte Celkem (T).

uhel (A)/<Zadejte celkovou délku (0.0000)>: Zadejte novou celkovou délku entity v kreslicich
jednotkach.

Uhel (A) | Zména Ghlu entity.

reziM/<Vyberte entitu pro zménu>: Vyberte entitu.

Rezim (M) | Zména metody pro Upravu délky.

reziM/zpét (U)/<Vyberte entitu pro zménu>: Zvolte dalSi entitu a mizete pokraCovat vybérem dalSich
entit.

Rezim (M) | Zména metody pro Upravu délky.

Zpét (U — Undo) | Vraceni posledni zmény.

POZNAMKA Volba celkem prodlouzi koncovy bod nejblize k uréenému bodu. Na rozdil od jinych voleb
méni tato volba celkovou délku kfivky; segmenty kfivky tak mohou byt odstranény po&inaje koncem
nejbliz§im k uréenému bodu. Tato volba muze mit také neocekavané vysledky pfi editaci oblouku: oblouk
zUstava obloukem (nezméni se na kruznici), ale mize se prodluzovat ¢i zkracovat rozdilné od zadané
celkové délky.

Zobrazeni aktualni délky entity
Vyberte entitu. Aktualni délka je zobrazena v pfikazovém fadku. Pokud byl vybran oblouk, je zobrazen
také uhel opsany obloukem.

113. Svétla (Edit Lights)

Ribbon Render > Editace svétel
Menu Render >Editace svétel
Panel nastoju Render >Svétla
Klavesnice light, svétlo

Alias LIGHT

Tento pfikaz otevira dialogové okno svétla s moznostmi, které jsou popsany nize:



Svétla X

Rozptylené svétlo

Svétla: : | ita: -0.690
Upravit .. ntenzita:
SLUNCE P ( =
HLIOS
Odstranit Barva

Cervena: < >
Zadat< Zelena: < >
Modra: < >

Vyberte viastni barvu...

Novy... Vzdalené svétlo v

Bodové svétlo
UmistVZRE e Vyberte zACI...
Reflektor

Cancel Help

Rozptylené svétlo: Umoznuje Vam pfizpUsobit intenzitu rozptyleného svétla. Rozptylené svétlo je svétlo,
které se nachazi v konkrétnim prostoru bez toho, aby vychazelo pfimo z néjakého zdroje svétla, napfr.
pfirozené svétlo v pokoji v zamraceny den. Jeho intenzita je konstantni pro vSechny povrchy a ve vSech
smérech.

Cim vy$8i je hodnota, tim intenzivnéji budou osvétleny oblasti, které nemaiji pfimy zdroj svétla. Pies
moznost barva si muzete zvolit rizné barvy rozptyleného svétla kromé bilé.

Bodové svétlo: Jedna se o pevné umistény zdroj svétla, ktery zafi vSemi sméry. MUzete zadat nebo
upravit intenzitu a barvu svétla a urcit, jestli se na obrazku budou nachazet néjaka vybledla mista nebo
stiny.

Reflektor: Reflektor vytvari kuzelovité svétlo. Mizete zadat jeho smér, velikost centralniho kuzele
stfedniho louce, barvu svétla a urcit, jestli objekty vrhaji stin.

Vzdalené svétlo: Vzdalené svétlo je paralelni svétlo, kterého lou¢ méa pouze jeden smér. Pfikladem
takového svétla je slunce. V praibéhu renderovani, samozfejmé, nebude nutné zvolit reflektor pro
definovani slunce - slune¢né svétlo snadnéji nastavite vyuzitim pfikazu Slunce (Sun).

114. Editovat kfivku (Edit Polyline)

Ribbon Upravit > Upravit > Upravit krivku
Menu Modifikace > Objekt > Kfivka
Klavesnice editpline

Alias PE, PEDIT

Upravuje dvoudimenzionalni kfivku, tfidimenzionalni kfivku nebo polygonovou sit'.

Nasobné/Vyberte kiivku pro Upravy: Zvolte kfivku, kterou chcete upravit. DalSi vyzvy se liSi podle typu
kfivky, ktery jste si zvolili.



Pokud zvolite upravu 2D kfivku, objevi se nasledujici vyzva:

Upravit kiivku: upravit vrcholy (E)/zavrit (C)/zrusit zakFiveni (D)/vyhladit (F)/spoJit/typ €ar
(L)/obRatit (R)/Spline/ztzeni (T)/Sirka (W)/zpét (U)/<Konec>: Pro ukon&eni modu pro Upravu kfivky
zvolte Enter. Pro Upravu vrcholl zvolené kfivky zvolte E (upravit vrcholy). Pro uzavieni oteviené kfivky
zvolte C (zavfit). Pro zru8eni zakfiveni zvolte D (zruSit zakfiveni). Pro pfidani ¢ary, oblouku, nebo kfivky
na konec existujici kfivky zvolte J (spojit). Pro zménu typu €ary zvolte L (typ €ar). Pro zménu sméru, ve
kterém byla kfivka nakreslena zvolte R (obratit). Pro zménu vrchold na oblouky zvolte S (spline). Pro
zUZeni kfivky zvolte T (zGZeni). Pro zménu Sifky kfivky na stejnomérnou Sifku zvolte S (8ifka). Pro zrudeni

posledni vykonané zmény zvolte U (zpét).
Pokud zvolite editaci 3D kfivku, objevi se nasledujici vyzva:

Upravit kiivku: upravit vrcholy (E)/zavrit (C)/zrusit zakFiveni (D)/spoJit/obRatit/Spline/zpét
(U)/<Konec>: Pro ukon€eni modu pro Upravu kfivky zvolte Enter. Pro Upravu vrcholl zvolené kfivky
vyberte E (upravit vrcholy). Pro uzavieni oteviené kfivky zvolte C (zavfit). Pro zruSeni zakfiveni zvolte D
(zrusit zakfiveni). Pro pfidani ¢ary, oblouku, nebo kfivky na konec existujici kfivky zvolte J (spojit). Pro
zménu sméru, ve kterém byla kfivka nakreslena zvolte R (obratit). Pro zménu vrcholl na oblouky zvolte S
(spline). Pro zru8eni posledni vykonané zmény zvolte U (zpét).

Pokud zvolite editaci polygonové sité, objevi se nasledujici vyzva:

Upravit kiivku: upravit vrcholy (E)/zrusit vyhlazeni (D)/vyhladit (S)/Mclose/Nclose/zpét
(U)/<Konec>: Pro ukon&eni modu pro Upravu kfivky zvolte Enter. Pro Upravu vrchold zvolené kfivky
vyberte E (upravit vrcholy). Pro zruSeni vyhlazeni pavodni polygonové sité zvolte D (zrusit vyhlazeni). Pro
uzavfeni polygonové sité, ktera je oteviena ve sméru M zvolte M (Mclose). Pro uzavieni polygonové site,
ktera je oteviena ve sméru N zvolte N (Nclose). Pro zruSeni posledni vykonané zmeény zvolte U (zpét).

Pro upravu vrcholu
Zvolte Upravit vrcholy

Upravit vrcholy: dalSi (N)/Pfedchozi/thel (A)/prerusit (B)/vlozlt/pfesunout (M)/Regenerovat/vybrat
(SE)/naprimit (S)/Sirka (W)/konec (X)/<Dalsi>: Prvni Uhel (po¢atecni bod) kfivky je oznacen
trojuhelnikem a x. Pokud nechcete tento vrchol upravovat, zvolte N (dal$i) a oznaceni x se pfesune

k dalSimu vrcholu. Pokud chcete upravovat pfedchozi uhel, zvolte P (pfedchozi). Pokud chcete zménit
Uhel ve zvoleném vrcholu, zvolte A (Uhel). Pro pferuseni kfivky ve zvoleném vrcholu zvolte B (pferusit).
Pro vlozeni segmentu za vybrany vrchol zvolte | (vlozit). Pro pfesunuti tohoto vrcholu zvolte M
(pFesunout). Pro regeneraci kfivky zvolte R (regenerovat). Pro vybér vrcholu pomoci uréeni segmentu
kfivky zvolte SE (vybrat). Pro napfimeni vrcholu zvolte S (napfimit). Pro zménu $ifky jednotlivych
segmentl zvolte W (Sifka).

Pro zménu uhlu zvoleného vrcholu

Zvolte Uhel.

Stredovy uhel segmentu (>0 je proti sméru, 0 je pfimy, <0 je po sméru hodinovych ruéic¢ek) <0>:
Vlozte Uhel pro segment kfivky. Pro Uhel vrcholu ve sméru hodinovych ruci¢ek zadejte zapornou hodnotu.
Pro uhel vrcholu proti sméru hodinovych ru€i¢ek zadejte kladnou hodnotu.

Pro preruseni kfivky ve zvoleném vrcholu

Zvolte Prerusit (B).



KFivka se rozdéli na dvé kfivky ve zvoleném vrcholu.

Pro vlozeni nového vrcholu
Zvolte Vlozit (1).

Umisténi nového vrcholu: Zadejte umisténi nového vrcholu.

Pro presunuti zvoleného vrcholu
Zvolte Pfesunout (M).

Nové umisténi vrcholu: Zadejte nové umisténi vrcholu.
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A. Zvolte krivku.
B. Zvolte vrchol.
C. Nové umisténi vrcholu.

Vysledek.

Pro regeneraci krivky
Zvolte Regenerovat (R).

KFivka se zregeneruje bez ukon&eni pfikazu Upravit kfivku.

Pro vybér vrcholu pomoci segmentu ¢ary

Zvolte Vybrat (SE).

Vyberte bod podél segmentu pro Gpravu: Provedeni tohoto kroku zvoli vrchol umistény na konci ¢ary,
ktera je nejbliz k zaCatku kfivky.

Pro napfimeni segmentu kfivky

Zvolte Napfimit (S).

Naprimit: dalSi (N)/Predchozi/vybrat (S)/spustit (G)/konec (X)/: Zvolte N (daldi), P (pfedchozi) nebo S

(vybrat) pro zadani vrchold, které chcete napfimit. Po skonéeni vybéru zvolte G (spustit) pro spusténi
napfimeni zvolenych vrcholl. Od prvniho k poslednimu zvolenému vrcholu se nakresli pfima ¢ara.
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A. Prvni zvoleny vrchol.
B. Posledni zvoleny vrchol.

Vysledek.

Pro zménu Sirky segmentu krivky
Zvolte Sitka (W).

Zadejte pocatecni Sirku <0.0000>: Napiste pocatecni Sitku nebo stisknéte Enter pro pfijeti vychozi
hodnoty.

Zadejte koncovou Sirku <0.0000>: NapiSte koncovou Sitku nebo stisknéte Enter pro pfijeti vychozi
hodnoty.

Sitka ¢ary segmentu nasledujicim po vybraném vrcholu se upravi podle pogateéni a koncové $itky, kterou
jste zadali. Pokud se pocatecni a koncova Sitka lisi, rozdil se proporcionalné rozlozi podél ¢ary segmentu,
jak muzete vidét na nasleduijici ilustraci.

A

Segment kfivky mezi zvolenym vrcholem a dal$im vrcholem je zahroceny pro pfizptusobeni pocate¢ni
a koncové zadané Sifce cary.

Pro zruseni zakfiveni kiivky

Zvolte zrusit zakfiveni (D). VSechny oblouky nebo spliny v kiivce se zméni na ¢ary. Budou odstranény
vS8echny vrcholy, které byly dodate€né vlozeny pro funkce vyhladit (F) nebo Spline.

A I

Pro vyhlazeni oblouku kfivky

Zvolte Vyhladit (F). Kazdy vrchol kfivky se zméni na par obloukt. Oblouky upravené kfivky prechazeji
vrcholy pavodni kfivky. V dialogovém okné nastaveni kresleni mazete urcit, jestli kfivky maiji byt étvercové
nebo kubické.
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A. Zvolte Kkiivku, kterou chcete vyhladit.
B. Vysledna krivka.
Pro spojeni kiivky

FILtr/: Zvolte kfivku, kterou chcete pfidat k existujici kfivce. Koncové body entit, které chcete spojit, se
musi dotykat. Mlzete pfidat ¢aru, oblouk nebo jinou kfivku na konec oteviené kfivky.

A B
QM
A. Zvolte prvni kfivku.
B. Zvolte druhou krivku, kterou chcete pfipojit k prvni kfivce.
C. Zvolte pfipoJit.
Pro zménu modu typu ¢€ary krivky
Zvolte Typ &ar (L).
Plny typ ¢ary podél kiivky: zapnout (ON)/vypnout (OFF) <OFF>: Pro pfijeti vychozi hodnoty stisknéte

Enter. Pro zménu kfivky tak, aby kfivka méla souvislou ¢aru, zvolte ON (zapnout). Pro zménu &ary na
preruSovanou zvolte OFF (vypnout).

A. Krivka s vypnutym modem souvislé ary.
B. Kfivka se zapnutym modem souvislé Cary.

Pro zménu vrcholli na oblouky (spline)

Mduzete zadat Uroven kontinuity, mnozstvi bodl na zakfiveny segment a urcit, jestli chcete zobrazovat
ovladaci ramec v dialogovém okné nastaveni kresleni.

JINR W

A. Zvolte kiivku, ze které chcete vytvofit spline.
B. Vysledna spline.



Pro zuzeni krivky
Zvolte ZuzZeni (T).

Zadejte novou pocatecni Sirku kiivky <0.0000> : Pro pfijeti vychoziho nastaveni stisknéte Enter. Pro
zménu Sifky na zacatku kiivky zadejte novou hodnotu.

Zadejte novou koncovou Sifku kiivky <0.0000> : Pro pfijeti vychoziho nastaveni stisknéte Enter. Pro
zménu Sifky na konci kfivky zadejte novou hodnotu.

S ™ &

A. Zvolte kiivku, na kterou chcete aplikovat zuzZeni.
B. Vysledné krivka.

Pro zménu Sifky kiivky
Zvolte Sitka (W).

Zadejte novou Sitku vSech segmentt: Vlozte novou $itku.

ShiNNE

A. Zvolte krivku, kterou chcete zménit.
B. Vysledné krivka s novou Sitkou.

115. Elevace (Elevation)

Ribbon Kreslit > Elevace (v Nastaveni)
Menu Format > Elevace

Panel nastoju Format > Elevace

Klavesnice elevation

Klavesova zkratka elev

Méni elevaci (vychozi vySku) a tloustku entit, které nakreslite.

116. Eliptické ohranic¢eni textu (Eliptic text border)

Klavesnice eliptxt



Umoziiuje ohrani€it text do elipsy.
Urcete mysi entitu a stisknéte Enter.

117. Elipsa (Ellipse)

Ribbon Kreslit > Kreslit > Elipsa osa-osa
Menu Kreslit > Elipsa

Panel nastoju Kreslit > Elipsa

Klavesnice ellipse, elipsa

Alias EL

Kresli elipsy a eliptické oblouky. Elipsy nebo eliptické oblouky je moZné kreslit dynamicky zadanim hlavni
a vedlejsi osy nebo zadanim stfedového bodu.

V prubéhu pfikazu Elipsa zadavejte pro volby pfikazu pouze jednotliva velka pismena u nazvl voleb
(napf. "C"). Pokud byste zadali CENTER, bude aktivovan uchop stfedového bodu (nikoli volba stfedu

elipsy).

Oblouk!/ stied (C)/<Prvni konec osy elipsy>:

Zadejte prvni konec osy elipsy.

Oblouk (A — Arc) | Volba pro kresleni eliptického oblouku.
Stied (C — Center) | Zadani elipsy jejim stfedem

Kresleni elipsy zadanim koncovych bodu

A B

L. -

A. Zadejte prvni bod hlavni osy

B. Zadejte koncovy bod hlavni osy

C. Urcete polovi¢ni délku vedlejSi osy.
D. Ur€ete koncovy bod osy elipsy

Druhy konec osy:

Urcete druhy koncovy bod.

Otoceni (R)/<Druha osa>:

Pro dynamické zadani elipsy uréete druhou osu.
Otoceni (R — Rotation) | Zadani uhlu natoceni.

Kresleni elipsy zadanim stredového bodu

@ /

A. Zadejte stfed elipsy
B. Urcete koncovy bod hlavni osy
C. Urcete polovinu délky vedlejSi osy

Zadejte Stied (C).
Stied elipsy:
Zadejte stfedni bod elipsy.



Koncovy bod osy:

Zadejte koncovy bod osy.

Otoceni (R)/<Druha osa>

Pro dynamické kresleni elipsy zadejte druhou osu.

Otoceni (R — Rotation) | Zadani natoCeni elipsy uréenim uhlu-

Kresleni eliptického oblouku

Panely nastroju Standard: Kreslit 2D > Elipticky oblouk
Menu Standard: VloZzit > Elipticky oblouk

D
LN
B
A. UrCete pocate€ni bod hlavni osy
B. Urcete koncovy bod hlavni osy
C. Urcete poloviny délky vedlejsi osy
D. UrCete pocatek oblouku
E. Urcete konec oblouku

Zadejte Oblouk (A).

Stied (C)/<Prvni konec osy elipsy>

Zadejte koncovy bod osy elipsy.

Stied (C) | Kresleni pomoci stfedového bodu elipsy.
Druhy konec elipsy:

Zadejte druhy koncovy bod.

Otoceni (R)/<Druha osa>:

Urcete dalSi osu pro dynamické kresleni elipsy.
Otoceni (R) | NatoCeni elipsy zadanim uhlu.

Kresleni eliptického oblouku zadanim stfredového bodu

&

A. Zadejte stfedovy bod eliptického oblouku
B. Zadejte koncovy bod hlavni osy

C. Zadejte polovinu vedlejsi osy

D. Zadejte pocatek oblouku

E. Zadejte konec oblouku

Zadejte Stied (C).

Stied elipsy:

Urcete stfedovy bod eliptického oblouku.
Koncovy bod osy:

Ur€ete koncovy bod hlavni osy.

Otoceni (R)<Druha osa>:

UrCete bod na druhé ose.

Otogeni (R) | Uhel nato&eni eliptického oblouku.
Parametr/<Poc¢atecni uhel oblouku>:



Zadejte poc¢atek oblouku.

Parametr | Vytvoreni oblouku s pouzitim parametrické vektorové rovnice.
Parametr/stiedovy (I)/<Koncovy bod>:

Urcete koncovy bod oblouku.

Parametr | Oblouk s pouzitim parametrické vektorové rovnice.

Opsany (I — Included) | Definice velikosti oblouku ve stupnich.

Kresleni eliptického oblouku zadanim stfredového bodu a thlu
Zvolte Otoceni (R).

Otoceni kolem hlavni osy:

Zadejte uhel oto€eni, nebo urcete bod.

Parametr/<Poéate¢ni uhel oblouku>:

Zadejte poc¢atek oblouku. Chcete-li vytvorit oblouk pomoci parametrické vektorové rovnice, zvolte
Parametr.

Parametr/opsany uhel (I)/<Koncovy uhel>:

Zadejte konec oblouku. Chcete-li vytvofit oblouk pomoci parametrické vektorové rovnice, zvolte Parametr.

Kresleni eliptického oblouku pomoci parametrické vektorové rovnice
Elipticky oblouk muzete vytvofit urenim parametrické vektorové rovnice:
p(u) =c +a * cos(u) =b * sin(u)

kde C je stfed elipsy, A a B jsou jeji hlavni a vedlej$i osa.

Zvolte Parametr.

uhel (A)/<Pocatecni bod>:

UrCete pocatecni parametr oblouku. )

Chcete-li vytvofit oblouk zadanim dhlu, zvolte Uhel (A).

uhel (A)/opsany (I)/<Koncovy bod>:

Urcete koncovy parametr oblouku.

Chcete-li vytvofit oblouk zadanim uhlu, zvolte dhel (A).
Chcete-li zadat opsany Uhel oblouku, zvolte opsany (1).

118. Presnost uchopu entit (Entity Snap Precision)

Menu Nastroje > Pfesnost ichopu entity
Panel nastoji Uchopy entit > Pfesnost tichopu entity
Klavesnice  aperture, kurzor

Alias AP

Nastavi oblast vybéru pro uchopovani entit.

Oblast vybéru pro uchop entity (1-50 pixel) <10>: Zadejte hodnotu mezi 1 a 50 pro velikost oblasti, ve
které se bude nabizet ter€ik kurzoru dle uchopovaného bodu (napf. zna¢ka pro koncovy bod, prisecik
atd. dle Vaseho prednastaveni). Pfi vySSi hodnoté je snadnéjSi vybér entity, ale muze dojit k vybéru vice



voleb nez jste chtéli. PFi nizSi hodnoté se nabizi méné entit, ale vybér je o néco t&zSi ( v zavislosti na
zobrazené podrobnosti). Stisknéte "Enter" pro potvrzeni pozadované hodnoty.

119. Nastaveni uchopt entit (Entity Snap Settings)

Ribbon Kreslit > Uchopy entit > Nastaveni tuchopi entit
Menu Nastroje > Uchop entit > Nastaveni tichopti entit...
Panel nastoji Uchopy entit > Nastaveni ichop( entit

Klavesnice  setesnap

Alias DDESNAP, DDOSNAP, OS

Zobrazi dialogové okno s volbami nastaveni jednotlivych uchopovacich bodu.

120. Uchopy entit (Entity Snaps)

Ribbon Kreslit > Uchopy entit
Menu Nastroje > Uchop entit
Panel nastoji Uchopy entit
Klavesnice  esnap

Alias -0S, -OSNAP, OSNAP

Umoznuje uchopit zcela pfesné pozadované body existujicich prvkd.

Uchopy: nejblizsi (NEA)/koncovy (END)/polovina (MID)/stied (CEN)/kolmo (PER)/prodlouzeni
(EXT)/teéna (TAN)/kvadrant (QUA)/vilozeni (INS)/bod (POI)/prasecik (INT)/zdanlivy
(APP)/rovnobézny (PARA)/zapnuto (ON)/<vypnuto (OFF)>: Pro vypnuti Gchopu prvku stisknéte

zvolte "Koncovy". Chcete-li uchopit entitu v jeji poloving, zvolte "Polovina". Chcete-li uchopit stfedni bod
entity, zvolte "Stfed". Pro uchopeni bodu kolmého k entité, zvolte " Kolmo". Pro uchopeni bodu te¢ny
entity, zvolte "Tecna". Pro uchopeni kvadrantu na entité (napf. oblouku, kruznice, elipsy, eliptického
oblouku) zvolte "Kvadrant". Pro uchopeni bloku, textu, vlastnosti Ize pouZit jejich bod vloZeni, zvolte
"Vlozeni". Pro uchopeni bodu entity, zvolte "Bod". Volba "Prisecik" uchopi entitu v jejim priseciku ve 3D.
Chcete-li uchopit prusecik dvou entit, které nejsou ve stejné roving, ale v aktualnim pohledu se tak jevi,
zvolte "Zdanlivy".

Poznamka: Program nabizi rizné zpusoby kontroly, zda jsou Uchopy entit zapnuty &i ne. Pokud je
kterakoli volba uchopu zapnuta, "ESNAP" se na stavovém fadku zvyrazni ¢erné (na obrazovce vpravo
dole). (od verze 16 podsviceni ikony). Pfi kresleni ¢€i editaci prvku, zobrazuje kurzor pfedvolené nabidky
uchopu na dané entité.

Poznamka: Rychlé pfepinani mezi zapnutou ¢i vypnutou volbou uchopu umoziuje klavesa F3.

121. Rozlozit (Explode)

Ribbon Upravit > Upravit > Rozlozit
Menu Modifikace > Rozlozit



Panel nastoju Modifikace > Rozlozit
Klavesnice  explode, rozloz
Alias X

Rozklada bloky, kfivky, polygonové sité, télesa nebo Srafy na samostatné entity. Pfikaz je mozné pouzit
pro rozbiti blokd nebo kfivek na jednotlivé entity. Vnofené bloky mlize byt potfeba rozlozit vicekrat nez
jednou.

POZNAMKA Nelze rozloZit bloky vioZzené pomoci pfikazu MINSERT nebo jako externi reference.
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. Siroké kfivka je rozloZena na usecky a oblouky o nulové tloustce.

. KFivky jsou rozlozeny na samostatné rovné a obloukové segmenty.

. Multi¢ara je rozloZena na oddélené rovné segmenty.

. Obdélniky a jiné kfivkové entity jsou rozloZzeny na rovné segmenty.

. Srafy vytvorené ve 4MCAD jsou rozloZeny tak, Ze kazda &ara $rafy se stane samostatnou entitou.
. Bloky jsou rozloZzeny na samostatné entity.

MTMoOO W >

Vyberte entity pro rozlozeni: Zvolte entity, které chcete rozlozit. Vybér potvrdte klavesou Enter nebo
pravym tlacitkem mysi.

TIP Entity pro rozloZeni je mozné vybrat i pfed aktivaci tohoto pfikazu.

122. Prozkoumat bloky (Explore Blocks)

Ribbon Nastroje > Prizkumnik > Bloky

Menu Format > Prozkoumat vykres > zalozka Bloky
Panel nastoju Prizkumnik > Bloky

Klavesnice  expblocks

Alias B, BMAKE, XB, XR



Zobrazi Prizkumnika 4MCAD. Zvolte si zalozku Bloky. V prazkumniku si mlzete bloky prohlizet, vytvaret,
kopirovat nebo upravovat. Na pravé strané panelu se objevi maly obrazek kazdého z blokl ve vykrese.

Kliknéte na tlaCitko Detaily ( ) abyste vidéli informace o mnozstvi referenci blok(, bod viozeni a externi

reference vykresu. Kliknéte na tlacitko Ikony () pro navrat k obrazkovému nahledu.

Bloky predstavuji specialni entitu, kterou pokud ulozite, mizete vkladat a manipulovat s ni ve vykrese
jako by se jednalo o samostatnou entitu. Blok mize pozUstavat z viditelnych entit, jako jsou ¢ary, oblouky
a kruznice stejné jako z viditelnych i neviditelnych dat, které se nazyvaiji atributy. Atributy mizete vyuzit
pro zaznaceni Udaju jako jsou part number nebo cena a nasledné informace z atributdl exportovat do
externi databaze. Pokud chcete zaznamenat pocet ¢asti, mizete to udélat opakovanym viozenim atributu
do vykresu. Zjisténim poctu viozZeni zjistite i poCet €asti. Bloky jsou ukladany jako ¢ast souboru

s vykresem.

Externi reference se vyuzivaji obdobné jako bloky. S vyuzitim externich referenci mazete k aktualnimu
vykresu pfipojovat dokonce i celé vykresy. Cim se externi reference od bloku li$i je to, Ze se nestava
soucasti aktualniho vykresu (pokud je prve nepfevedete do podoby blokl. Pro dal$i informace si
prohlédnéte ¢ast Externi reference).

Cestu k externim referencim muzete upravovat jednim kliknutim na nazev cesty k nim. Pak se mlzete
proklikat k souboru, kterym chcete nahradit plvodni vykres (externi referenci). 4MCAD automaticky
aktualizuje nazev cesty a ve vykresu se objevi nova externi reference.

Bloky muzete ukladat i v Prizkumniku 4MCAD. Muzete ho vyuzit i na spravu a vkladani kopii bloku.
Prizkumnik 4MCAD vypiSe seznam vS8ech bloku, které obsahuje aktualni vykres spole¢né s dalSimi
informacemi o kazdém bloku a externi referenci.

123. Prouzkoumat souradné systémy (Explore Coordinate Systems)

Ribbon Nastroje > Prizkumnik > Soufadné systémy

Menu Format > Prozkoumat vykres > zalozka Souradné systémy
Panel nastojii Prizkumnik > Soufadné systémy

Klavesnice  expucs

Alias DDUCS, UC

Zobrazi prazkumnika 4MCAD. Zvolte zalozku Soufadné systémy. V prdzkumniku 4MCAD si mizete
prohlizet, vytvaret, nebo kopirovat definice USS (uzivatelskych soufadnych systému). Kdyz ve vykrese
vytvarfite entity, jsou umistény do vychoziho kartezianského soufadného systému. Kazdy vykres ma
pevné stanoveny soufadny systém dle svétového soufadného systému (WCS). WCS nemuzete ani
smazat ani zménit.

Vas vykres mlze obsahovat dodateéné soufadné systémy, pficemz kazdy z nich ma vlastni po¢atek (bod
0, 0, 0) a vlastni orientaci. Mzete vytvaret tolik USS, kolik chcete, ukladat je a vyvolat, kdyz je budete
potfebovat. MizZete upravovat pocatecni bod soufadného systému pomoci jednoho kliknuti mysi

a vepsani novych soufadnic.

Napfiklad, muzete vytvofit samostatny USS pro kazdou stranu budovy. Pak, pomoci pfepnuti USS pro
vychodni stranu budovy, mlzete nakreslit okna na tuto stranu pouze pomoci specifikace jejich soufadnic
X-ay-.

Muzete vytvofit rizné USS a pak se mezi nimi pfepinat pomoci priizkumnika 4MCAD.




124. Prazkumnik stylt kotovani (Explore Dimension Styles)

Ribbon Nastroje > Prizkumnik > Spravce kétovacich stylt
Menu Format > Prozkoumat vykres > zalozka Kétovaci styly
Panel nastoju Prazkumnik > Spravce kétovacich stylt

Klavesnice  expdimstyles

Alias DIMSTY, DST

Diky prazkumniku stylt kétovani mazete vyjmout, kopirovat a vlozit kétovaci styly z jednoho vykresu do
druhého. Pro zvoleni kétovaciho stylu vyuZijte kliknuti pravym tladitkem mysi a tak vyvolat menu

s moznostmi vyjmout, kopirovat a vkladat pfikazy. Nebo muzete zvolit styl kotovani a vyuzit klavesové
zkratky (Ctrl+X, Ctrl+C, Ctrl+V) pro stejny ucel.

V Prizkumniku IntelliCAD muzete vytvaret nové kétovaci styly. Kliknuti na nastroj Novy. Program pfida
nazev nového stylu kétovani. Pro zménu nazvu stylu kétovani kliknéte pravym tlacitkem na nazev stylu
a z menu zvolte Pfejmenovat.

Pro nastaveni vlastnosti nového stylu kétovani jako jsou Sipky, formatovani, fadky, text a jednotky,
kliknéte na tlacitko Upravit pro otevreni dialogového okna Spravce styld kétovani (Format > Kotovaci styl).

125. Prozkoumat hladiny (Explore Layers)

Ribbon Nastroje > Prizkumnik > Hladiny

Menu Format > Prozkoumat vykres > zalozka Hladiny
Panel nastoju Prazkumnik > Hladiny

Klavesnice  explayers

Alias DDLMODES, DDRENAME, LA, REN

Zobrazi prizkumnika 4MCAD. Zvolte zalozku Hladiny. V prazkumniku 4MCAD si m(zete prohlizet,
vytvaret, kopirovat a upravovat hladiny. M{zete taky nastavit viditelnost hladiny pro aktualni vyfez
zobrazeni, vSechny vyfezy, nebo nové vyfezy. Muzete jednoduse zmrazit nebo rozmrazit entity na
hladinach jednim kliknutim mysi na entitu, kterou chcete zmrazit nebo rozmrazit. Mizete urcit, jestli se
entity na hladinach budou tisknout, a taky jim mazete pfipsat barvu, typ nebo tloustku ary.

Hladiny si mizete predstavit jako prusvitné vrstvy, které se vyuzivaji pfi ru€nim rysovani. Hladiny mazete
pouzit pro usporadani riznych typl informaci na vykrese. Ve 4MCADu je kazda entita na vykrese
umisténa na hlading. JiZ pfi kresleni entity je tato vytvofena na konkrétni hladiné.

Muzete Fidit viditelnost hladin. Kdyz hladinu vypnete, entity, které patfi do této hladiny nebudou viditelné
a taky se nebudou tisknout. | kdyZ hladina neni viditelnd, je pofad mozné ji oznacit jako aktualni. V tomto
pfipadé jsou nové vytvorené entity taky neviditelné, pokud hladinu zase nezménite na viditelnou. Entity na
neviditelné hladiné mGzou ovlivnit zobrazeni a tisk entit na ostatnich vrstvach. Napfiklad, entity na
neviditelné hladiné mizou ukryt jiné entity, kdyz vyuzijete pfikaz Skryt pro odstranéni skrytych Car.

Hladiny mlzete zmrazovat a rozmrazovat. Entity, které jsou nakreslené na zmrazené hladiné se
nezobrazi, nevytisknou a nebudou se regenerovat. Poté, co zmrazite hladinu, entity z ni nebudou
ovliviiovat zobrazeni nebo tisk ostatnich entit. Napfiklad entity na zmrazené hladin& nebudou pfekryvat
ostatni entity, pokud pouzijete pfikaz Skryt pro odstranéni skrytych €ar. Navic na zmrazenou hladinu
nemuzete kreslit az do doby, kdy ji opét rozmrazite. Zmrazena hladina nemuze byt nastavena jako



aktualni.

Na druhé strané nemU(zete ani zmrazit aktualni hladinu. Pokud zadate pfikaz zmrazit pro aktualni hladinu,
objevi se dialogové okno s vyzvou pro zadani jiné hladiny. Taky nemuizete zmrazit hladinu s vyfezem. Pro
nastaveni této vlastnosti musi byt aktivnhi modelovy prostor.

Hladiny mlzete uzamknout a odemknout. Entity na uzamé&enych hladinach jsou pofad viditelné a tisknou
se, ale neni mozné je upravovat. Uzamc&eni vrstvy zabrani nechténé upravé entit.

Hladinu muzete prejmenovat kliknutim pravym tlacitkem mysi na nazev hladiny a pak volbou polozky
Pfejmenovat ze zobrazeného menu. Nemuzete prejmenovat hladinu 0. Pokud se pokusite zménit jeji
nazev, objevi se dialogové okno s vyzvou na volbu jiné hladiny.

Mizete nastavit, jestli se entity na kazdé z hladin budou nebo nebudou tisknout.

Kazda hladina ma vlastni barvu, typ a tloustku ¢ary a styl tisku (pokud pouzivate pojmenované styly
tisku). Nakreslené entity na konkrétni hladiné se zobrazuji s barvou, typem a tloustkou ¢ary a stylem tisku
spojenymi s konkrétni hladinou, pokud to nezru$ite v nastavenich. U nazvu kazdé hladiny se zobrazi
vzorek barvy. Barvu, typ a tloustku ¢ary nebo styl tisku mdzete zménit kliknutim na pfislusny sloupec pro
zvolenou hladinu a pak provést upravy v dialogovém okné Barva, Typ ¢ary, Tloustka €ary nebo Nastaveni
stylu tisku (pokud vyuzivate pojmenované styly tisku).

Hladiny z vykresu, ktery je externi referenci, se objevi v panelu vpravo. Pro jejich odliSeni od ostatnich
hladin, hladiny vykresu, ktery je externi referenci, obsahuji jak nadzev vykresu, tak i nazev hladiny
oddélené znakem "|". Napfiklad bungalov|okna oznacuje nazev vykresu (bungalov) a nazev hladiny
(okna). VSechny souvisejici nastaveni muzete fidit pomoci prizkumnika 4MCAD v ¢asti Stavy hladin.

126. Prozkoumat typy €ar (Explore Linetypes)

Ribbon Nastroje > Prizkumnik > Typy ¢ar

Menu Format > Prozkoumat vykres > zalozka Typy ¢ar
Panel nastojt Prazkumnik > Typy €ar

Klavesnice expltypes

Alias DDLTYPE, LT

Zobrazi Prazkumnika 4MCAD. Zvolte zalozku Typy Car. Typy ¢ar mUzete v prazkumniku prohlizet,
vytvaret, kopirovat nebo upravovat.

Typ Cary pozlstava z opakujiciho se vzoru te€ek, ¢arek a mezer mezi nimi. MlGzete vyuzit rizné typy Car
pro riizné typy informaci ve vykrese. Napfiklad pfi kresleni planu mista mGzete kreslit cesty souvislou
¢arou a na hranice pozemku vyuzit €erchovanou hraniéni ¢aru.

Ve vychozim nastaveni jsou v kazdém vykrese tfi typy &ar - souvisla, podle hladiny a podle bloku. Zadny
z téchto typu €ar nemuzete ani zménit ani vymazat. Vas vykres muze obsahovat nekoneény pocet
dodate€nych typl €ar. Do programu muzete nahrat dalSi typy €ar ze souboru s knihovnou typl €ar nebo
vytvofit a uloZit Vami vytvoieny typ Cary.

127. Prozkoumat styly textu (Explore Text Styles)

Ribbon Nastroje > Prizkumnik > Prozkoumat styly textu



Menu Format > Prozkoumat vykres > zalozka Styly textu
Panel nastoju Prizkumnik > Prozkoumat styly textu

Klavesnice  expfonts

Alias DDSTYLE, EXPSTYLE, EXPSTYLES

Zobrazi prazkumnika 4MCAD. Zvolte zalozku Styly textu. V prizkumniku muazete fonty prohlizet, vytvaret,
kopirovat nebo upravovat.

Text, ktery pridate do vykresu, se vytvori v aktualnim stylu textu. Styl textu je uréen fontem, vyskou,
tloustkou, seSikmenim a stylem fontu. Styly textu taky Fidi, jestli je text ve vychozim nastaveni anotativni
a jestli se font objevi a tiskne zrcadlové, vzhiru nohama nebo vertikalné. Tyto charakteristiky mizete
upravovat, kdyZ na né jednou kliknete.

Kazdy vykres ma minimalné jeden styl textu, ktery se nazyva standardni. Tento styl je pro program 4mcad
vychozi. Standardni styl nemUzete vymazat, je vSak mozné jej pfejmenovat nebo pozménit. Napfiklad
pokud chcete zménit font nebo seSikmeni textu. Ve vykrese muzete taky vyuzit neomezeny pocet
dodatecnych styla.

3
V Prizkumniku 4mcad muzete vytvaret nové styly textu kliknutim na tlacitko Nova polozka (|j ). Program
pfitadi novému stylu textu nazev Novy styl1. Pokud chcete zménit nazev stylu textu, kliknéte pravym
tlaCitkem na pfifazeny nazev stylu textu a v menu, které se objevi, kliknéte na Pfejmenovat.

128. Prozkoumat pohledy (Explore Views)

Ribbon Nastroje > Prazkumnik > Pohledy
Menu Zobrazit > Pojmenované pohledy
Panel nastoju Prizkumnik > Pohledy
Klavesnice  expviews

Alias DDVIEW, V

Zobrazi Prizkumnika 4MCAD se zobrazenym seznamem pohledd. V prizkumniku mizete pohledy
prohlizet, vytvaret, kopirovat nebo upravovat.

PFi praci na vykrese muzete zjistit, Zze €asto prepinate mezi riznymi jeho ¢astmi. Napfiklad, pokud kreslite
pudorys domu, mulzete Casto priblizovat jeho rizné mistnosti a pak oddalit nahled pro prohlédnuti celého
domu. Pro tento ucel sice mizete vyuzit pfikazy posun a zoom, ale jednodussi je ulozit si rizné pohledy
na vykres jako pojmenované pohledy. Mezi t&€mito pohledy se pak da rychle prepinat. MUzete ulozit

a pozdéji si znovu pfivolat pohledy budto pfikazem Pohled nebo Spravce pohledu v prazkumniku 4MCAD.

Se smérem pohledu muzete rychle ménit nahled pomoci zadani soufadnic x, y, z. Smér pohledu muzete
upravovat pomoci jednoho kliknuti na soufadnice a vepsanim novych soufadnic.

129. Export (Export)

Ribbon Vystup > Exportovat > Exportovat
Menu Soubor > Export



Klavesnice export

Alias

EXP

Zobrazi Dialogové okno Exportovat vykres jako, takze mlzete exportovat vykres do zvoleného typu

souboru.

Vykres mulzete exportovat v nasledujicich typech soubor(:

Format
BMP

EMF

WMF

DWF

PDF

STL

SVG
DAE

Vyuziti
Bitmap format souboru. BMP je graficky format, béZné vyuZivany pro obrazky z ne-CADovych
aplikaci, jako jsou textové editory nebo tabulkové procesory.

Enhanced metafile format. EMF je vektorovy format bézné pouzivany pro obrazky z ne-
CADovych aplikaci, jako jsou textové editory nebo tabulkové procesory.

Windows metafile format. WMF je vektorovy format bézné pouzivany pro obrazky z ne-CADovych
aplikaci, jako jsou textové editory nebo tabulkové procesory.

Design Web Format File. DWF soubory Vam umozriuji sdileni Vaseho vykresu ve formatu, ktery
je mozné na webovych prohlize€ich opakované prohlizet, nebo upravovat s vyuzitim bezplatného
softwaru a nastroju AutoCAD. Pokud exportujete do 2D DWF souboru, objevi se dialogové okno
DWF soubor verze a format. Pokud exportujete 3D DWF soubor, tento se ulozi pfimo do souboru.
Portable Document Format. PDF soubory Vam umoZfuji sdilet VaSe vykresy ve formatu €itelném
v Adobe Acrobat Readeru, ktery je bezplatnym softwarem, ktery si uzivatelé mdazou stahnout pro
opakované prohlizeni a Upravu soubort. PFi exportu do PDF souboru je otevie dialogové okno
Export do PDF.

Stereolithography file format. STL je format grafickych souborl vyuzivany pro tvorbu prototypt 3D
modelu.

Scalable Vector Graphics file format. SVG je format grafickych souborud a jazyk pro tvorbu webu.

Collaborative Design Activity file format. COLLADA je interaktivni 3D format grafickych soubor(,
ktery se vyuziva pro 3D grafické aplikace. 3D entity jsou exportovany véetné entit ACIS.

130. Prodlouzit (Extend)

Ribbon
Menu

Upravit > Upravit > Prodlouzit > Prodlouzit
Modifikace > Prodlouzit

Panel nastoju Modifikace > Prodlouzit
Klavesnice  extend, prodiuz

Alias

EX

Prodlouzi usecku, oblouk, dvojrozmérnou kfivku nebo polopfimku po prisecik s jinou entitou. Jako
hrani¢ni entity je mozné vyuzit kfivky, oblouky, pfimky, Usecky, polopfimky, spliny nebo vyfezy ve
vykresovém prostoru. Pokud jako hranici pouZzijete dvojrozmérnou kfivku, jsou entity prodlouzeny ke
stfedu kfivky.

/—D
& |

A. Vyberte entitu, kterou chcete pouzit jako hranici pro prodlouzeni.
B. Vyberte entitu pro prodlouzeni.

A
L=y

Vyberte entity hranic pro prodlouzeni <Klavesou ENTER vyberete vSe>:



Stisknéte Enter pro vybér vSech entit ve vykrese. Jinak vyberte entity, ke kterym se maji jiné entity
prodluzovat. Pro ukon&eni vybéru stisknéte Enter nebo pravé tlacitko mysi.

POZNAMKA Pokud stisknéte Enter pro vyb&r vech entit ve vykrese, pokraduje program neprodiené
k dalSi vyzvé.

rEzim hran/plot (F)/Projekce/zpét (U)/<Vyberte objekt pro prodlouzeni nebo shift-vybér pro
ofiznuti>:

Vyberte entitu pro prodlouzeni.

rEZim hran (E — Edge mode) | Nastaveni, zda ma byt pro prodlouzeni pouZzit pfedpokladany pranik entit
v pfipadé, Ze se entity neprotinaji.

Plot (F — Fence) | Nasobny vybér entit pro prodlouzeni metodou plot.

Prodlouzeni entity k predpokladanému praniku

N

l—l
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A. Zvolte entitu, kterou chcete pouzit jako hranici pro prodlouzeni.
B. Zvolte entity pro prodlouZeni.

Zvolte Rezim hran (E).

Prodlouzit (E)/Neprodlouzit <Neprodlouzit>:

Prodlouzit (E — Extend) | Prodlouzi entity, i kdyz pfimy pranik s hrani€nimi entitami neexistuje.
Neprodlouzit (N — No extend) | Pokud pruanik s hrani¢nimi entitami neexistuje, k prodlouzeni nedojde.

POZNAMKA Pokud jako hraniéni entity vyberete véechny entity ve vykrese, mlze ptikaz prodlouzit vratit
neoCekavané vysledky.

Prodlouzeni entit vybérem bodu plotu
Pomoci bodl plotu mizete prodluzovat vice entit najednou.

A =B

Ly —t— /—
N I
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A. Zadejte hrani¢ni entitu.
B. Urcete prvni bod plotu.
C. Urcete dal8i bod plotu.
D. Ur€ete posledni bod plotu

Zvolte Plot (F).

Prvni bod plotu: Zadejte prvni bod plotu. Jde o po€ate¢ni bod podél plotu pro protnuti entit , které chcete
prodlouzit.

Dalsi bod plotu: Muzete pokracovat v zadavani bodd, dokud neprodlouzite vSechny entity. Pro ukon&eni
stisknéte Enter.

TIP Pro uzavieni oblouku vyuZijte volbu Oblouk (A) v pfikazu KruZnice (Circle).

131. Externi reference (External Reference)



Ribbon Vlozit/Reference/Xref Spravce, Nastroje/Spravovat/Xref Spravce

Panel nastoju Vlozit/Xref Spravce
Klavesnice xref
Klavesova zkratka xref
Alias -XR, XA, XATTACH

Umoznuje Vam fidit externi vykresy, které mate aktualné vioZzeny do Vaseho vykresu bez zmeény jejich
obsahu. Pokud uloZite vykres, uloZi se pouze informace o referenci. KdyZ vykres znovu otevfete, externi
reference se opét vlozi a umozni Vam tak vystavét hlavni vykres s pomoci komponentl vykresu. VSechny
zmeény, které udélate s komponenty vykresu, se projevi v hlavnim vykresu.

Moznosti dialogového okna

Zobrazeni seznamu - kliknéte pro zobrazeni seznamu externich referenci ve formé detailniho seznamu;
Stromova struktura - kliknéte pro zobrazeni externich referenci ve formé hierarchické stromové
struktury;

Pripojit - kliknéte pro pfipojeni vykresu jako externi reference. Otevie se Vam dialogové okno PFipojit
externi referenci;

Odpojit - kliknéte pro odstranéni externi reference a vSech jejich souc€asti, v€etné hladin a typl Car,

z vykresu;

Nacist - kliknéte pro aktualizaci aktualniho vykresu a vSech zmén, které byly provedeny ve zvolené
externi referenci;

Uvolnit - kliknéte pro odstranéni externi reference z aktualniho vykresu, ale uchovani jejich sou€asti

a informace o cesté k externi referenci pro moznost nového pfipojeni;

Vazat - kliknéte, pokud chcete pfipojit externi referenci jako trvalou souc¢ast vykresu, co je stejné jako
vloZeni samostatného vykresu ve formé bloku. V dialogovém okné, které se zobrazi, zvolte Vazat nebo
Vlozit.

Volba mozZnosti Vazat vytvari unikatni nazev pro kazdy pojmenovany objekt, jako je hladina nebo blok,
které se nachazi v externi referenci. Napfiklad, hladina pojmenovana Elektric v externi referenci bude
v aktualnim vykresu pojmenovana Xref$0$Electric. Pokud aktualni vykres ma jiz hladinu nebo blok se
stejnym nazvem, nazev bude zménén na nasledné cislo Xref$1$Electric.

Volba mozZnosti Vloezit neméni nazvy zadnych pojmenovanych externich referenci. Napfiklad hladina
pojmenovana Elektric v externi referenci bude mit stejny nazev, Electric, také v aktualnim vykrese. Pokud
aktualni vykres ma hladinu nebo blok se stejnym nazvem, pojmenovana entita v externi referenci pfebira
nazev entity v aktualnim vykrese.

Oteviit - Kliknéte pro otevieni zdrojového vykresu externi reference;
Cesta k externi referenci - vepiste, nebo kliknéte na Prochazet pro ur€eni umisténi externi reference;
Dalsi cesty vyhledavani XRef - vepiste nebo kliknéte na Prochazet pro uréeni dalSich slozek, kde by se

externi reference mohli nachazet. Oddélte vicero cest pomoci stfedniku. 4MCAD prohledava slozky
v poradi, v jakém jsou uvedeny.

132. Extrahovat atributy (Extract Attributes)

Ribbon Vlozit > Definice Bloku > Extrahovat atributy
Menu Nastroje > Extrahovat atributy
Panel nastoju Nastroje > Extrahovat atributy



Klavesnice  attext
Alias AX

Zobrazuje dialogové okénko Extrahovat atributy, takZze mizete extrahovat udaje atributl (informacni texty)
do DXF nebo TXT soubortl na disk.

MOZNOSTI DIALOGOVEHO OKENKA

Zadat

Pro zadani jednoho nebo vice blokl obsahujicich atributy, kliknéte na Zadat.

Format extrahovaného textového souboru

Pro extrahovani atributl do DXF formatu, zvolte Extrahovat v DXF (drawing exchange format); neni
zapotiebi zadna Sablona vykresu. Chcete-li exportovat atributy ve formatu, kde ¢arky oddéluji hodnoty,
zvolte Extrahovat v CDF (comma delimited format). Pro export atributt do formatu, kde mezery oddéluji
hodnoty, zvolte Extrahovat v SDF (space delimited format).

Soubor Sablony

Urcete nazev souboru Sablony, ktery je potfebny pro CDF a SDF formaty. V exportnim formatu DXF neni
pouzivan zadny soubor Sablony. Musite vytvorit soubor $ablony pfedtim, nez pouzijete pfikaz Extrahovat
atributy. Pro vybrani nazvu souboru z dialogového okénka Soubor $ablony, kliknéte na tlaitko Prochazet.

Vystupni soubor

Zadejte nazev vystupniho souboru, ktery je nutny pro v8echny formaty. Chcete-li zvolit ndzev souboru
z dialogového okna vystupniho souboru, klepnéte na tlacitko Prochazet.

Extrahovat

Pro extrahovani atributd z vybranych bloki kliknéte na tlacitko Extrahovat.

POZNAMKA
Pfedtim, nez zaCnete extrahovat atributy, musite provést dva kroky:
1) musite vloZit atributy do vykresu jako blok

2) musite definovat soubor Sablony




133. Sténa (Face)

Ribbon Kreslit 3D > Kresli 3D sité > Sit’ > 3D plocha
Menu Kreslit > Plochy > 3D stény

Panel nastoju Plochy > 3D plochy

Klavesnice face

Alias 3DFACE, 3F

Kresli 3D plochy. S vyuzitim pfikazu sténa muzete nakreslit i ¢asti 3D ploch.

Urcete body od A po H v poradi znazornéném na obrazku. Vysledkem je kresba s 3D plochami.

nevlditelna hrana/<prvni bod 3d plochy>: Zadejte prvni bod 3D plochy. Pokud chcete, aby tato hrana
byla neviditelnd, zvolte neviditelna hrana (l).

nevlditelna hrana/<druhy bod>: Zadejte druhy bod 3D plochy. Pokud chcete, aby tato hrana byla
neviditelnd, zvolte neviditelna hrana (I).

nevlditelna hrana/<treti bod 3d plochy>: Zadejte tfeti bod 3D plochy. Pokud chcete, aby tato hrana byla
neviditelna, zvolte neviditelna hrana (1). Pro vytvofeni plochy se tfemi hranami stisknéte Enter.
nevlditelna hrana/<posledni bod>: Zadejte posledni bod 3D plochy. Pokud chcete, aby tato hrana byla
neviditelna, zvolte neviditelna hrana (I).

Pokracujte v pfidavani dalSich sousedicich ploch pomoci volby dodate¢nych tfetich a dalSich bodu
(posledni dvé vyzvy se opakuji, pokud neukongite pfikaz Sténa). Pro ukonceni pfikazu stisknéte Enter
nebo kliknéte pravym tlaitkem mysi.

TIP Pro vytvoreni rovinné stény umistéte vSechny body do stejné roviny.

Pro vytvoreni stény s neviditelnymi hranami

A. Sténa se tfema neviditelnymi hranami.

Pro pfesné vytvoreni modell 3D entit s neviditelnymi hranami mizete nastavit, které hrany budou
viditelné. Zvolte neviditelna hrana (1) pro zneviditelnéni hrany jesté pfed zvolenim prvniho z jejich bodu.
Mdzete vytvorit dokonce i sténu, ktera bude mit neviditelné vSechny hrany. Tim vytvofite fantémovou
entitu, ktera se neobrazi jako viditelna, ale mize ukryvat entity z Vaseho vykresu.



134. Zaoblit (Fillet)

Ribbon Upravit > Upravit > Zaoblit
Menu Modifikace > Zaoblit

Panel nastoju Modifikace > Zaoblit
Klavesnice fillet, zaobli

Alias F

Vytvofi zaobleni (zakulaceny roh) v priniku 3D téles, dvou Usecek, polopfimek nebo pfimek. Pokud se
entity zvolené pro zaobleni neprotinaji, jsou ofiznuty nebo prodlouzeny, aby mohlo zaobleni vzniknout.

e
A B

Vybrané entity (A a B) jsou ofiznuty, aby mohlo vzniknout zaobleni.

A B

EA)

Vybrané entity (A a B) jsou prodlouzeny k bodu praniku, aby mohly byt zaobleny.

Pokud jsou obé entity ve stejné hlading, je zaobleni nakresleno v této hladiné. Pokud jsou entity v riiznych
hladinach, je zaobleni vytvoreno v hladiné aktualni.

Zaoblit: kfivka (P)/poloméR/ofezaT/naStaveni/nasobné (M)/<Vyberte prvni objekt>:

Jednoduché zaobleni

Zvolte prvni ze dvou entit, jejichz prisec¢ik bude zaoblen.

Vyberte druhou entitu:

Pro zaobleni prisec¢iku mezi prvni a druhou vybranou entitou, zvolte druhou entitu.

—H

A. Vyberte prvni entitu pro zaobleni.
B. Vyberte druhou entitu.

Zaobleni v§ech vrcholu kfivky

Muzete zaoblit vSechny spojené segmenty kfivky.

Zvolte Kfivka (P — Polyline).

Vyberte 2D kiivku pro zaobleni:

Zvolte kfivku pro zaobleni. V8echny protinajici se hrany kfivky jsou zaobleny.

POZNAMKA Program zaobli uzavienou kfivku pomoci dvou réiznych metod dle toho, jak byla uzaviena.
Pokud to bylo pomoci volby Zavfit (C — Close), pak jsou zaobleny vSechny vrcholy. Pokud jste jen urcili
koncovy bod posledniho segmentu, nebude posledni vrchol zaoblen, i kdyz jste pro umisténi koncového
bodu vyuzili tchopt entit.

Pokud je mezi segmenty kfivky vloZena propojujici Use€ka nebo oblouk, které nejsou &asti kfivky, je tento



segment ignorovan.

A

L

Kfivka pro zaobleni.

Kfivka se zaoblenim.

Zména nastaveni pro zaobleni

Zvolte Nastaveni (S). Objevi se dialogovy panel MoZnosti vykresu s aktivni zaloZkou Modifikace
a zobrazenym aktualnim nastavenim pro zkoseni a zaobleni.

Provedte potfebné zmény a kliknéte OK pro uzavieni dialogu a navrat do vykresu.

Zména rozméru zaobleni

Muzete zménit polomér oblouku zaobleni, coz ovliviiuje i délku, o kterou je kazda entita ofiznuta nebo
prodlouzena.

Napiste R nebo zvolte Nastaveni zaobleni pro uréeni nového poloméru.

Ofezani

Zvolte Ofezat (T)

ofiznouT/<Neofiznout>:

Pokud nechcete ponechat plvodni hrany, potvrdte Enter, pokud je ponechat chcete, zvolte T.

Opakované zaobleni

Zvolte Nasobné (M)

Vyberte prvni a druhou hranu, mezi kterymi chcete zaoblit roh.

Po potvrzeni Enter je mozné dale vybirat hrany a zaoblovat dal$i rohy.
Piikaz ukoncite tlaitkem Esc.

Zaobleni téles

Zvolte hranu télesa pro zaobleni.

UrCete polomér zaobleni.

Vyberte dalSi hrany pro zaobleni a potvrdte klavesou Enter.

135. Filtr vybéru (Filter)

Klavesnice ssx

Vybrat objekt <Zadny>

Zvolte entitu a kliknéte na ni pravym tlacitkem mysi.

Sougasny filtr[[ (0,LINE) (8,0) (210,(0.00000,0.00000,1.00000)) ]

V pfikazovém Fadku se vam objevi parametry filtru zvolené entity.



Zadejte zvoleny filtr [nazev Bloku (B)/barva (C)/Entita/pfiznak (F)/hLAdina/typ ¢ary (LT)/vybér
(P)/Styl/Tloustka/Vektor]

Zadejte novy filtr podle podle vySe uvedenych hodnot a charakteristik.

136. Vyhledat (Find text)

Klavesnice tfind

Umoziuje najit text a nasledné jej priblizit.
Piste cela slova, ne jen jejich ¢asti.

Zadat text pro vyhledavani <> :

Zadejte celé slovo, nebo &ast z textu, ktery chcete najit. Stisknéte Enter.

137. Odruky (Freehand)

Ribbon Kreslit > Odruky
Menu Kreslit > Odruky
Klavesnice freehand
Alias SKETCH

Umozniuje nacrt pomoci kresleni kratkych €ar nebo kfivek tak rychle, jak se pohybuje vstupni zafizeni.

OO

Od ruky: Délka segmentli <hodnota>:
Zvolte délku segmentu pro ¢arovou entitu

TIP
Pro lepSi sledovani, zvolte kratSi segmenty. Obvykle dosahnete hladSi a presnéjsi skicu.

Stisknéte ENTER pro ukonéeni/ukongéit (Q)/Polozit pero/vymazat (E)/zapsat do vykresu
(W)/:(Kresleni...)
Kliknéte mysi pro zaCatek kresleni skici, ale nedrzte tlaCitko mysi, zatimco kreslite.

Stisknéte ENTER pro ukonéeni/Ukong¢it (Q) /zvednout Pero/Vymazat (E) /Napsat do vykresu
(W)/P¥ipojit (C) /Rovné kurzor (S) /: (Pozastaveno...)

Pro ukon&eni pfimky nebo kfivky a zaCatek nové, kliknéte mysi, posurite kurzor na dalSi po¢ateéni bod
a kliknéte znova. Timto simulujete zvednuti pera z nakresu a obnoveni skici na jiném misté.

Pro spojeni s koncovym bodem, zvolte Pfipojit (C).

Pro ukon&eni skici a zachovani kresleni, zvolte Enter.



Preruseni kresleni skici

Pro prerudeni kresleni a napf. posunuti pera na jiné misto, bez ukonceni pfikazu Skica, napiste P, &imz
se spusti volba mezi zvednout Pero a polozit Pero.

Ukonceni kresleni skici

Pro ukon&eni kresleni bez uloZeni, napiste Q pro Ukoncit. Ukon¢€it nezru§i pfikaz Skica. Pokud napiSete
Q, a pak zmacknete Enter, muzete zacit kreslit znovu.

Vymazani segmentu skici

Pro smazani segmentu, napiste D a pohnéte kurzorem na posledni nakresleny segment, nebo zvolte
Vymazat (E). Pro pokracovani v kresleni entity Skica, napiste C, pohnéte kurzorem na konec posledniho
segmentu a pokracujte v kresleni.

Kresleni rovné ¢ary kurzorem az do koneé¢ného bodu

Vyberte Rovné na kurzor (S). Nakreslite rovny segment aZ do koncového bodu.

Psani do vykresu

Vyberte Napsat do vykresu (W). Tato akce zachova kresleni entity, i kdyz zmacknete Enter, a neukondi
prikaz.

138. PIna €ara (Full line)

Klavesnice mcont

Klavesou ENTER pouzijete posledni bod/Podle (F)/<Zacatek usecky>:

Kliknéte mysi pro zacatek usecky. Posunutim mysi urCete délku usecky. Znova stisknéte Enter pro
ukonc&eni UseCky nebo zvolte z moznosti pro urCeni navazujici Usecky.

uhel (A)/déLka /<Koncovy bod>:

Pro ur€eni uhlu Uuse€ky zvolte A. Poté uréete po¢ate€ni bod, uhel a koncovy bod.

139. Mfizka (Grid)

Ribbon Kreslit > Nastaveni > Referen¢ni miizka

Menu Nastroje > Nastaveni vykresu > Zadani souradnic
Panel nastoju Nastaveni > Referenéni mfizka

Klavesnice grid, rastr

Klavesova zkratka F7

Alias G

Zobrazi na obrazovce mfizku (¢arkovanou / bodovou) pro vizualni kontrolu kresleni. Rozte¢ bodu Ize



nastavit.

Priklad referenéni mfizky (bodova) ve vykrese.

Mrizka je vypnuta: zapnout (ON)/krokovani (S)/pomér strAn/<Rozestupy mrizky (x a y = 0.5000)>:):
Pro nastaveni odstupu (roztece) zadejte Ciselnou hodnotu nebo zadejte dvéma body pomoci mysi. Pro
zapnuti mfiZky, zvolte ON. Pro vypnuti zvolte OFF (tato volba je pfistupna jen je-li mfizka zapnuta). Pro
zadani jiné vertikalni a horizontalni vzdalenosti zadejte Pomér stran (A). Pokud jsou horizontalni

a vertikalni hodnoty rozdilné, zobrazi se volba Stejny (E); vyberte ji pro nastaveni shodnych odstupa.

Zpravy o stavu odstupl mfizky:

x ay=10.0000: Vzdalenosti mfizky ve sméru osy x a y jsou shodné (v tomto pfipadé 10 kreslicich
jednotek).

x =12.0000, y = 6.0000: \Vzdalenosti (odstupy) mfizky ve sméru x a y se li8i, tak jak jsou nastaveny
pomoci Poméru stran (A).

Synchr. s tchopem: Odstupy referencni mfizky jsou shodné s rozte€i mfizky krokovani (viz pfrikaz
Krokovat).

Poznamka:
Pokud je odstup mfizky nulovy, neni mfizka vypnuta. Pfesnéji referenéni mfizka je nastavena na stejnou
hodnotu jako mfizka krokovani.

Nastaveni rozdilné hodnoty pro horizontalni a vertikalni smér
Vyberte Pomér stran (A).

Horizontalni odstupy <0.0000>: Zadejte hodnotu pro horizontalni odstupy.
Vertikalni odstupy <0.0000>: Zadejte hodnotu pro vertikalni odstupy.

Poznamka:
Pokud vyberete Stejny (E) nastavi program x (horizontalni) odstup podle y (vertikalniho odstupu).

140. Sroubovice (Helix)

Ribbon Kreslit > Kreslit > Sroubovice
Menu Kreslit > Sroubovice

Panel nastoju Kreslit > Sroubovice
Klavesnice  helix, Sroubovice

Kresli 3D spiralu, ktera je oteviena na obou koncich. Obé strany spiradly mohou mit stejné rozméry,
podobné jako pruzina, nebo riizné rozméry, podobné jako kuzel.

Kresleni Sroubovice



Urcéete stiedovy bod zakladny:
Zvolte stfedovy bod Sroubovice

Urcete zakladni polomér nebo [primér (D)] <1.000000>: :
Urcete polomér (nebo pramér) zakladny Sroubovice.

Urcete horni polomér nebo [primér (D)] <1.000000>:

Urcete polomér (nebo pramér) vrcholu Sroubovice. Rozméry zakladny a vrcholu se nemohou rovnat nule
zaroven.

Uréete vysSku Sroubovice nebo [koncovy bod osy (A)/oTaéky/vyska otacky (H)/oto€eni (W)]
<1.000000>:

Urcete vysku Sroubovice. Pokud je vyska nulova, Sroubovice bude tvofit 2D spiralu, ale pokud by
pocatecni a koncovy polomér byly shodné, bude Sroubovice vypadat jako kruznice.

Zadejte osu sméru misto vysky

Vyberte koncovy bod osy (volba A).

Urcete osu koncového bodu:
Vyberte koncovy bod Sroubovice, ktery ur€uje pozici a smér.

Urcete pocet otacek
Vyberte oTacky (T).

Zadejte pocet otacek:
UrCete pocet otacek. Standardni pocet jsou tfi. Maximalni 500.

Urcete vysSku otaceni misto poctu otacek

Vyberte vyska (H).

UrCete vzdalenost mezi otackami:

Urcete vysku jedné celé otacky, ktera automaticky aktualizuje poCet otacek. Tato volba je dostupna pouze
tehdy, pokud jste zadali pocet zavitu.

Urcete smér otacek

Zvolte otocit (W).

Zadejte stoupani Sroubovice [CW - ve sméru hod. ruciek/CCW - v protisméru hod. rucicek]

141. Te€kovana ¢ara (Hidden line)

Klavesnice mhidden

Klavesou ENTER pouzijete posledni bod/Podle (F)/<Zacatek usecky>:

Kliknéte mysi pro zacatek usecky. Posunutim mysi urCete délku Usecky. Znova stisknéte Enter pro
ukonCeni Use€ky nebo zvolte nékterou z moznosti pro ur€ovani navazujici usecky.



uhel (A)/déLka/<Koncovy bod>
Pro ur€eni uhlu napiste A do pfikazového fadku, poté urcete Uhel a pak koncovy bod.

Pro uréeni délky usecky napiste do pfikazového fadku L a urete délku.

142. Skryt (Hide)

Klavesnice hide, skryj
Alias HI

Vytvarfi pohled na Vas model se skrytymi ¢arami tak, Zze odstrani vSechny Cary, které by byly ukryté za
jinymi povrchy z Va8eho uhlu pohledu. VyuZijte pfikazy Pfekresli nebo Regenerovat pro navraceni
pavodniho draténého modelu.

Pohled pred a po pouZiti pfikazu skryt.

Pokud mate 3D entity v podobé& draténého modelu, vidite ¢ary, které by normalné byly skryté povrchem
entity. S vyuZitim pfikazu skryt odstranite z obrazovky ¢ary, ¢imz se z draténého modelu stane model
prostorového télesa.

Poznamka Nemuzete tisknout vykres s odstranénymi skrytymi ¢arami.

143. Zkosit (Chamfer)

Ribbon Upravit > Modifikace > Zaoblit > Zkosit
Menu Modifikace > Zkosit

Panel nastoju Modifikace > Zkosit

Klavesnice  chamfer, zkos

Alias CHA

Vytvori zkoseni (srazenou hranu) v priseciku 3D téles, Usecek, polopfimek nebo pfimek. Pokud se entity,
které chcete zkosit, neprotinaji, jsou ofezany nebo prodlouzeny dle potfeby.

X\

Vybrané entity (A a B) jsou ofiznuty pro zkoseni v jejich priniku.



A B

77X £\
Vybrané entity (A a B) jsou prodlouzeny do bodu priniku a pak zkoseny.

Pokud jsou obé entity ve stejné hlading, je zkoseni vytvofeno v této hlading. Pokud jsou entity, jejichz
prusecik vytvori zkoseni, ve dvou rliznych hladinach, je zkoseni vytvofeno v aktualni hladiné.

Zkoseni: kiivka (P)/vzDalenost/tuhel (A))mEtoda/ofezaT/nastaveni (S)/nasobné (M)/<Vyberte prvni
objekt>:

Jednoduché zkoseni:

Vyberte jednu ze dvou entit, jejichz pranik bude zkosen.

Vyberte druhou entitu:

Pro zkoseni pruniku mezi prvni a druhou entitou, vyberte druhou entitu.

Zkoseni vSech vrcholl kfivky

Muzete zkosit vSechny spojené segmenty kfivky.

Zvolte Kfivka (P — Polyline).

Vyberte 2D kiivku pro zkoseni:

Vyberte kfivku pro zkoseni. VSechny pruseciky hran jsou zkoseny.

Kfivka pro zkoseni.

Kfivka se zkosenim.

POZNAMKA Pokud jsou segmenty kfivky rozd&lené spojujici iseékou nebo obloukem, které nejsou &asti
kfivky, je tento segment ignorovan.

Zména nastaveni zkoseni

Zvolte Nastaveni (S — Settings). Je zobrazen dialog Moznosti nastaveni s vybranou zaloZzkou Modifikace
a zobrazenim aktualniho nastaveni Zkoseni/Zaobleni.

Provedte poZzadované zmény a kliknéte OK pro zavieni dialogu a navrat do vykresu.

Zména vzdalenosti zkoseni
Muzete zménit vzdalenost, o kterou je kazda entita ofiznuta nebo prodlouzena pfi zkoseni.

A
B f :

- of / °S/P

A. Vyberte prvni entitu, kterou chcete zkosit.

B. Vyberte druhou entitu.

C.Pro zménu prvni pouzité vzdalenosti zvolte Zkoseni Nastaveni > dialog MozZnosti > zalozka Modifikace
> a zménte hodnotu Prvni vzdalenosti.

D.Pro zménu druhé vzdalenosti zménte hodnotu Druha vzdalenost.




Zména nastaveni zplisobu ofezani

Zvolte Metoda (E):

Zkosit pomoci: uhel (A)/<vzDalenost>:
Muzete zménit zplsob zkoseni uhlu:

Potvrdte Vzdalenost (D), nebo zvolte uhel (A).

Ofezani

Zvolte Ofezat (T)

Neofriznout/<Ofiznout>:

Pokud chcete ponechat plvodni hrany, zvolte N, pokud je chcete ofezat, potvrdte Enter.

Zkoseni télesa

Zvolte hranu zakladniho povrchu pro zkoseni. (Jeden ze dvou povrchi pfilehlych ke zvolené hrané bude
zvyraznén.)

Pro volbu jiného povrchu napiste n a stisknéte Enter nebo pfimo stisknéte Enter pro pouziti aktualniho
povrchu.

Urcete vzdalenost zakladniho povrchu (méfeno od vybrané hrany k zakladnimu povrchu).

Urcete vzdalenost pfilehlého povrchu (méfeno od vybrané hrany k pfilehlému povrchu).

UrCete hrany pro zkoseni nebo napiSte / a stisknéte Enter pro vybér vSech hran kolem zékladniho
povrchu.

144. Zménit (Change)

Ribbon Upravit > Upravit > Zménit
Menu Modifikace > Zménit
Klavesnice change, zména

Méni umisténi nebo vlastnosti zvolenych entit. Pfikaz je mozné vyuZit i pro entity textu.
Poznamka Pro dosazeni lepSich vysledk( ménte v jednom kroku pouze jednu entitu.
FILtr/: Zvolte entity, které chcete zménit. Zvolte filter (FIL) pro vyfiltrovani zvolenych vlastnosti.

Urcete bod pro zménu nebo [vlastnosti (P)]: Stisknéte Enter pro zménu vlastnosti zvolenych entit
(vychozi nastaveni), nebo zadejte bod pro zvolené entity.

Pro zménu vlastnosti entit

Urcete bod pro zménu nebo [vlastnosti (P)]: Stisknéte P.
Zadejte vlastnost pro zménu [barva (C)/Elevace/hLAdinal/typ ¢ary (LT)/méfitko tloustky ary
(S)/tloustka €ary (LW)/Tloustka/Material/Anotativni]:

- Pro zménu barvy zvolte barvy (C).
Nova barva [Truecolor/knihovna barev (CO)] <BYLAYER>: Vyberte novou barvu pro zvolenou entitu.
Barvu muzete zvolit podle hladiny (vychozi nastaveni), truecolor nebo z knihovny barev.

- Pro zménu elevace zvolte elevace (E).
Nova aktualni hodnota elevace <0.000000>: Zadejte pozadovanou hodnotu elevace pro zvolenou
entitu.

- Pro zménu hladiny zvolte hladina (LA).



Nova hladina <0>: Zadejte nazev hladiny, do které chcete pfemistit zvolenou entitu.

- Pro zménu typu Cary zvolte typ ¢ary (LT).
Novy typ ¢ary <BylLayer>: Zvolte pozadovany typ ¢ary pro vybranou entitu. Vychozi nastaveni je podle
hladiny.

- Pro zménu méfitka tloustky ¢ary zvolte méfitko tloustky Cary (S).
Nové méritko typu €ary <500.0000>: Zvolte nové méfitko typu Eary pro Vami zvolenou entitu.

- Pro zménu tloustky ¢ary zvolte tloustka cary (LW).
Nova tloust’ka ¢ary <ByLayer>: Zadejte pozadovanou tloustku ¢ary pro vybranou entitu. Vychozi
nastaveni je podle hladiny.

- Pro zménu tloustky zvolte tloustka (T).
Nova tloustka <0.0000>: Zadejte novou prostorovou tloustku vybrané entity. Vychozi hodnota je 0.

- Pro zménu materialu zvolte material (M).
Zadejte novy nazev materialu <ByLayer>: VVychozi nastaveni pro material je podle hladiny. Zadejte
pozadovany novy material zvolené entity.

Pokud zvolite vice nez jednu entitu, kterou chcete zménit a tyto entity maji rozdilné vlastnosti (napfiklad
rozdilnou hladinu), aktualni hodnota vlastnosti, kterou zménite se stane "varies." Pokud zménite
nastaveni pro vicero entit, vS8echny entity ve vybéru se zméni.

145. Zménit prostor (Change space)

Ribbon Upravit > Upravit > Zménit prostor
Menu Modifikace > Zménit prostor

Panel nastoju Modifikace > Zménit prostor
Klavesnice  chspace, zménprostor

Kopiruje nebo pfemistuje entity z vykresového do modelového prostoru.

Vyberte objekt pro: kopirovani (C)/posun (M) <Move>: Zvolte entity, které chcete kopirovat, nebo je
pfesurite. Pro kopirovani entit zvolte kopirovani (C), pro pifemisténi entit zvolte posun (M).

146. Zménit styl (Change the style)

Klavesnice cstyle

Umoznuje zmeénit styl jiz existujiciho textu na vykresu.
Vybér textu Globalni nebo Vybérovy (S):

Zvolte S, Enter a poté mysi vyberte text, ktery chcete zménit. Po vybrani vSech pozadovanych entit opét
stisknéte Enter a napiste nazev nového stylu.

147. Souradnice (ID Coordinates)



Ribbon Nastroje > Dotaz > Soufradnice ID
Menu Nastroje > Dotaz > ID bodu

Panel nastoju Dotaz > ID soufadnic

Klavesnice idpoint

Alias ID

Zobrazi USS souradnice (soufadnice uzivatelského soufadného systému) specifického bodu.
Vyberte bod pro uréeni souradnic: Zadejte bod. V pfikazovém Fadku se zobrazi soufadnice x-, y-, z-.

148. Import (Import)

Ribbon Vlozit > Importovat > Importovat

Menu Soubor > Importovat
Klavesnice import
Alias IMP

Zobrazi dialogové okno Import vykresu, takZze si mizete otevfit jiny soubor s vykresem (.dwg) ve vlastnim
okné v aktualni kreslici sekci. MUzete otevirat rovnéz soubory ve formatech .dxf, .dwf, .dxb, .dwf, .dwt,
.dgn, a .dae.

Poznamka Pfikaz import se liSi jak od pfikazu Xref spravce, ve kterém si mizete prohlizet jiné vykresy
ve stejném Case jako aktudlni vykres, i od pfikazu Blok, diky kterému vkladate importovany vykres
v podobé bloku.

149. Pfimka (Infinite Line)

Ribbon Vychozi > Kreslit > Useéka > Pfimka
Menu Kreslit > Pfimka

Panel nastoju Kreslit > Pfimka

Klavesnice infline, pfimka

Alias XL, XLINE

Kresli linii nekone&nou v obou smérech skrze uréeny bod.
A

A. Zadejte bod, kterym pfimka prochazi

B. Zadejte uhel pfimky

Nekoneéna pirimka: délici (B)/Horizontalni/Vertikalni/ahel (A)/rOvnobézna/<bod Podél pfimky>:
Pro kresleni pfimky vychozi metodou zadejte bod pfimky.

délici (B — Bisect) | Pfimka délici bod nebo entitu

Horizontalni (H) | Pfimka v horizontalnim sméru

Vertikalni (V) | Pfimka ve vertikalnim sméru



uhel (A — Angle) | Zadani uhlu pfimky

rOvnobézna | Rovnobézna k jiné entité

Smér:

UrCete smér, ve kterém chcete pfimku vytvofit.

Smér:

Urcete smér, ve kterém chcete vytvofit dalSi pfimku. Druha pfimka prochazi stejnym bodem jako prvni.
Muzete pokracovat v zadavani smérl dalSich pfimek. Pro ukoncéeni kresleni kliknéte pravym tlacitkem
mysi nebo stisknéte Esc.

Primka délici bod nebo entitu

B
~
N

A)\\/—c

A. Zvolte bod pro déleni.
B. UrcCete pocatek déliciho uhlu.
C.Ur¢ete konec déliciho uhlu.

Zadejte Polovina (B).
Entita/<Vrchol>:

Zvolte bod piimky.

Entita (E) | Volba entity pro déleni.
Pocatecni bod ptlileného uhlu:
Zadejte prvni bod uhlu.

Koncovy bod ptileného uhlu:
Zadejte druhy bod uhlu.

Volba entity pro déleni
Zadejte Entita (E) a vyberte entitu pro déleni.

Vodorovna pfimka podél osy X

3

A. Zadejte bod, kterym pfimka prochazi

Zadejte Horizontalni (H).

Umisténi:

Zadejte bod horizontalni pfimky.

Umisténi:

Urcete bod dal$i horizontalni pfimky. Mdzete pokracovat ve vytvarenim vodorovnych pfimek zadavanim
dalSich bodu. Pro ukonceni kliknéte pravym tlacitkem mysi.

Svisla pfimka podél osy Y
LI
A. Zadejte bod, kterym pfimka prochazi.

Umisténi:
Zadejte bod vertikalni pfimky.



Umisténi:
Zadejte bod dalSi vertikalni pfimky. MUzete pokraCovat ve vytvarenim svislych pfimek zadavanim dalSich
bodu. Pro ukonc&eni kliknéte pravym tlacitkem mysi.

Kresleni pfimky zadanim thlu

5
‘/\'il

A. Zadejte bod piimky a pak uhel.

Zadejte Uhel (A).

Reference/<Zadejte uhel (0)>:

Stisknéte Enter pro pfijeti vychoziho nastaveni nebo zadejte novou hodnotu.

Reference (R) | Zadani entity jako referenéniho bodu.

Umisténi:

Zadejte bod pfimky.

Umisténi:

Urcete bod dalSi pfimky. MUzete pokradovat zadavanim bodud dalSich pfimek. Pro ukonéeni kresleni
stisknéte pravé tlacitko mysi.

Kresleni pfimky s vyuzitim entity jako reference pro uhel

-

A. Zvolte referen¢ni entitu.
B. Zadejte bod pfimky a urcete Uhel.

Zadejte Reference (R).

Vyberte referenéni entitu:

Zvolte entitu, kterou chcete pouzit jako referencni bod pro Uhel.
Zadejte uhel:

Zadejte uhel od referenéniho bodu.

Pfimka rovnobézna s jinou entitou

il
==,

A. Zvolte entitu pro uréeni sméru
B. Zvolte stranu pfimky.

Zadejte Rovnobé&zna (P).

Skrz bod (T)/<Velikost odsazeni rovhobézné primky> (Skrz):

Enter pro pfijeti vychozi hodnoty. Zadejte jinou hodnotu pro ureni pfesné vzdalenosti.
Skrz bod (T — Through point) | Ur€eni bodu pFimky.

Vyberte entitu pro rovhobéznou pfimku:

Zvolte entitu, ke které ma byt pfimka rovnobé&zna.

Strana pro rovnobéznou pfimku:

Strana, kde ma byt rovnobézna pfimka vytvorena.



Volba Skrz bod

=

A. Zvolte entitu pro uréeni sméru
B. Zvolte bod, kterym ma pfimka prochazet.

Zadejte Skrz bod (T).

Vyberte entitu pro rovnobéznou pfrimku:
Zvolte entitu, ke které ma byt pfimka rovnobézna.
Skrz bod:

Zadejte bod pfimky.

150. Viozit blok (Insert Block)

Ribbon Vlozit > Blok > Vlozit blok
Menu Vlozit > Blok...

Panel nastoju Kreslit > Vlozit blok
Klavesnice  ddinsert, diavloz

Alias |

Zobrazi dialog Vlozeni bloku, kde je mozné vkladat bloky do aktualniho vykresu. Je mozné viozit jeden
blok nebo pravouhlé pole bloku.

TIP Pro vkladani blokt do vykresu je také mozné vyuzit Prizkumnika 4MCAD.

Viozit blok X
VloZit
(O Ze souboru: Prochazet...
@ Nézevblokw: | _OBLIQUE v
Bod vloZeni Mefitko Otoceni
Urgit na obrazovce Uréit na obrazovce Uréit na obrazovce
0.0000 2 1.0000 2 hel: |0 2
0.0000 - : 1.0000 =
= hd Jednotka bloku
0.0000 = z: |1.0000 3 Jednotka: lNedeﬂnovéno ‘
Zadat> Jednotné méfitko Koeficient: |1 |
[[JRozlozit
o

Volby dialogu



Ze souboru Zvolte pro vloZeni vykresového souboru jako blok. Jako blok mize byt pouzit jakykoli DWG
soubor.

Prochazet Zvolte pro zobrazeni okna s vybé&rem souboru. Vyberte soubor s koncovkou DWG a kliknéte
na Otevfit.

Nazev bloku Zvolte nazev interniho bloku pro vloZzeni. Seznam obsahuje nazvy vSech bloku.

Umistit blok pfi vkladani ZaSkrtnéte tuto volbu pokud si prejete zadavat bod vloZeni, koeficient méfitka
a uhel natoc€eni v pfikazovém fadku. Nésledujici volby jsou k dispozici pouze, pokud volba neni
zaskrtnuta.

Bod vlozeni Zadejte soufadnice X, Y a Z bodu vloZeni bloku. Vychozi hodnota je obsazena v systémové
proménné LASTPOINT.

Zadat Zvolte pro ur€eni bodu vlioZeni bloku ve vykrese. Dialogové okno je do¢asné uzavieno a mlzete
zadat bod vloZeni. Poté se dialog znova zobrazi. Program aktualizuje soufadnice dle zvoleného bodu.
Souradnice Z pfevezme hodnotu ze systémové proménné ELEVATION.

Méfritko Zadejte koeficient méfitka bloku. Vychozi hodnota je 1.0; hodnota niZsi nez 1 vytvofi zmenSeny
blok; hodnota vy3Si nez 1 blok zvétsi. negativni hodnota blok odzrcadli (obrati jej). MéFitko je mozné
zadavat nezavisle ve smérech X, Y a Z.

Natoceni Zadejte natoceni bloku. Vychozi je O stuprid.

Rozlozit blok pfi vlozeni Zaskrtnéte volbu, pokud si pfejete rozlozit blok na komponenty. Jde

o ekvivalent pouziti pfikazl Vlozit blok a Rozlozit za sebou.

Sloupce Zadejte pocet sloupct blokd. Vychozi hodnota je 1.

Sitka sloupce Uréete vzdalenost mezi sloupci blokd, Vychozi je 1.0 jednotka.

Radky Zadejte poget fadku blokd. Vychozi hodnota je 1.

Sitka fadku Zadejte vzdalenost mezi fadky blok(. Vychozi je 1.0 jednotka.

POZNAMKA Pole bloki je samo novym blokem.

151. Izometricka rovina (Isometric Plane)

Klavesnice isoplane, izorov
Klavesova zkratka F5, Ctrl+E
Alias IS

Kdyz je zapnutéa izometricka mfizka, je mozné prepinat izometrickou rovinu leva, prava, horni.

¢

@

A. Leva izorovina
B. Prava izorovina
C. Horni izorovina

Izorovina (Leva): Leva/pRava/<Prepnout na Horni>: Pro pfepnuti do dalSi izoroviny stisknéte Enter.
Pro pfepnuti do levé izoroviny zvolte leva (L). Pro pfepnuti do pravé izoroviny zvolte prava (P). Pro
pFepnuti na horni izorovinu zvolte Horni (T).

Poznamka Vyuzijte moznost Styl u pfikazu Uchop pro zapnuti izometrického kresliciho modu. Zapnéte
mfizku, aby Vam pomohla s vizualizaci izometrické mfizky. |Izometrické kruZnice kreslete s moznosti
Izokruznice pfikazu Elipsa.



152. Spojit (Join)

Ribbon Upravit > Upravit > Prerusit > Spojit
Menu Modifikace > Spojit

Panel nastoju Modifikace > Spojit

Klavesnice  join, spoj

Spojuje dvé entity (dvé a vice UseCek nebo dva a vice obloukl) do jedné entity. Nelze spojovat UsecCky
s oblouky a naopak. Také muizete spojit pouze rovnobézné Usecky. Vyberte oblouk nebo Usecku pro
spojeni. Zvolte pfimku nebo oblouk, ktery chcete spojit s jinym.

Spojovani primek

el T

A. UrCete prvni usecku, kterou chcete pfipojit
B. Ur&ete druhou rovnobé&znou usecku, kterou s ni chcete spojit

Vyberte zdrojovy objekt:
Vyberte Usecku, kterou chcete spojit.

Vyberte usecky pro pfipojeni ke zdroji: )
Vyberte UseCku nebo Usecky, které chcete pfipojit k prvni Use€ce. UseCka musi byt rovnobézna s prvni
useckou a jsou prodlouzeny, dokud nejsou spojeny.

Spojovani obloukt

Y O

A. Vyberte prvni oblouk, s kterym chcete pracovat.
B. Vyberte druhy oblouk, ktery chcete pfipojit

Vyberte zdrojovy objekt:
Vyberte prvni oblouk pro spojeni

Vyberte oblouky pro pfipojeni ke zdroji nebo [Zav¥it (C)]:
Vyberte oblouky, které chcete pfidavat. Pro spojeni obloukl, musi ¢asti byt z kruhu.

153. Hladina (Layer)

Ribbon Vychozi > Hladiny > Hladiny
Klavesnice layer, hladina

Klavesova zkratka -LA, hl

Alias -LA



Vytvofi pojmenovanou kreslici hladinu a pfifadi k ni barvu a typ ¢ary. Také nastavi aktualni kreslici
hladinu, zmrazeny/rozmrazeny stav hladiny, zamknuti/odemknuti a zapnuti/vypnuti hladiny.

Pfikaz vyvolava dialogové okno Prizkumnika 4MCAD pro hladiny. Pro textovou verzi pfikazuzadejte -
LAYER:

Hladina: ? pro vypis/Noval/vytvorit (M)/naStavit/barva (C)/typ €ary (L)/tloustka ¢ary (LW)/tisk
(P)/zapnout (ON)/vypnout (OFF)/zmrazit (F)/rozmraziT/zamknout (LO)/odemknoUt/FILtrovat:

Napiste pismeno M (vytvorit) pro tvorbu hladiny a jeji nastaveni jako aktualni hladiny.

Pro vybér jiné aktualni hladiny (tj. hladiny, do které se pfimo kresli) vyberte S (nastavit).

Pro nastaveni barvy prvkd kreslenych v hlading, zvolte C (Barva).

Pro vybér typu &ary zvolte L (typ Cary).

Pro nastaveni tloustky ¢ary zadejte LW (tloustka Cary).

Pro nastaveni volby, zda se dana hladina bude nebo nebude tisknout vyberte P (tisk).

Pro zapnuti hladiny zvolte ON, pro vypnuti hladiny OFF. Obsah vypnuté hladiny neni vidét, ale Ize jej
napfiklad zkopirovat.

Pro zmrazeni hladiny vyberte F (zmrazit).

Pro opétovné rozmrazeni pak T (rozmrazit). Obsah zmrazené hladiny neni viditelny ani editovatelny, nelze
jej napfiklad kopirovat.

Pro uzamknuti obsahu hladiny zvolte LO, pro odemknuti U.

Vypis vS8ech hladin vyvolate volbou ?.

Tvorba nové hladiny

Zvolte N a vytvoii se nova hladina.

Nazvy novych hladin: Zadejte nazev nové hladiny. Mizete vytvofit naraz vice hladin, nazvy oddélujte
&arkou. Napfiklad: POPIS, KOTY, TEXT.(Enter)

Pro dalSi praci s hladinami a jejich nastavenim vyberte dalSi volbu nebo stisknéte Enter pro ukon&eni.

Pro vytvoreni nové hladiny jako aktualni

Zvolte vytvorit (M).

Nova hladina pro vytvoreni aktualni:

Zadejte nazev nové hladiny. Mlzete si vytvofit vice nez jednu hladinu najednou oddélenim nazvu ¢arkou,
naptiklad: POPIS, KOTY, TEXT.

Pro dalSi praci s hladinami a jejich nastavenim vyberte dalSi volbu nebo stisknéte Enter pro ukon&eni.

Pro zménu aktualni hladiny

Vyberte nastavit (S).

Hladina, kterou nastavit jako aktualni <_cerchovana>:

Zadejte jméno hladiny, kterou chcete mit aktualni. Nazev aktualni hladiny se zobrazuje ve $picatych



zavorkach.
Pro dalSi praci s hladinami a jejich nastavenim vyberte dalSi volbu nebo stisknéte Enter pro ukongeni.

Vybér barvy entit hladiny zadanim indexové barvy

Vyberte barva (C).

Nova barva [Truecolor/Knihovna barev (CO)] <white>:

Zadejte index barvy, kterou chcete pouzit pro prvky hladiny. MUzete ji zadat Ciselnou hodnotou, nazvem,
zvolit barvu bloku BYBLOCK, nebo barvu hladiny BYLAYER. Napfiklad "red".

Hladiny, které budou RED <nazev>:

Aktualni hladina se zobrazuje v lomenych zavorkach. Mizete definovat barvu vice hladinam najednou,
jejich nazvy oddélujte darkami. pf. POPIS, KOTY, TEXT. (Enter)

Pro dalSi praci s hladinami a jejich nastavenim vyberte dal§i moznosti nebo pro ukonceni stisknéte Enter.

Chcete-li zménit barvu entit v hladiné zadanim skute¢né barvy

Vyberte barva (C).

Nova barva [Truecolor/Knihovna barev (CO)J:

Vyberte Truecolor pismenem "T".

Cervena, zelena, modra:

Zadejte hodnotu RGB skute¢né barvy, kterou chcete pouzit pro entity kreslené v této hladiné. RGB jsou
hodnoty v Cervené (R), zelené (G) a modré (B) barvé oddélené Carkou, napfiklad: 15,105,210.
Hladina(y) 15,105,210 <nazev>:

Zadejte hladiny, pro které chcete barvu pouzit. Aktualni hladina je zobrazena v lomenych zavorkach.
Mizete zménit barvu vice nez jedné hladiny najednou zadanim nazvd oddélenych ¢arkou, napfiklad:
POPIS, KOTY, TEXT.

Pro dalSi praci s hladinami a jejich nastavenim vyberte dalSi moznosti nebo stisknéte Enter pro ukonceni.

Chcete-li zménit barvu entit v hladiné zadanim barvy z knihovny

Vyberte barva (C).

Nova barva [Truecolor/Knihovna barev (CO)]:

Vyberte Knihovna barev pismeny "CO".

Zadejte nazev knihovny barev:

Zadejte nazev pozadované knihovny barev. Jde o nazev knihovny barev, nikoli o .acb nazev souboru.
Knihovna barev musi byt umisténa ve sloZce, kde 4MCAD vyhledava knihovny. Ve vychozim nastaveni
jsou knihovny barev umistény ve stejné slozZce, kde je nainstalovan 4MCAD. Chcete-li ovéfit umisténi
slozky, vyberte pfikaz MoZnosti z nabidky Nastroje, kliknéte na Cesty/soubory, a najdéte slozku Knihovna
barev v seznamu Cesty.

Zadejte nazev barvy:

Zadejte nazev barvy, kterou chcete pouzit pro entity v této hladinég.

Hladiny, které budou Nazev_knihovny|Nazev_barvy <0>:

Zadejte hladiny, pro které chcete barvu pouZit. Aktualni hladina je zobrazena v lomenych zavorkéach.
MUGzete zménit barvu vice neZ jedné hladiny najednou oddé&lenim nazvd &arkou, napfiklad: POPIS, KOTY,
TEXT.

Pro dalSi praci s hladinami a jejich nastavenim vyberte dal§i moznosti nebo stisknéte Enter pro ukonceni.

Vybér typu €ary entit v hladiné

Zadejte TypC (L).

Typ €ary: ? pro seznam/ <CONTINUOUS>:

Zadejte typ €ary. Aktualni typ Cary je zobrazen v lomenych zavorkach. Chcete-li zobrazit typy Car
definovanych v aktualnim vykrese, zadejte "?".

Hladiny pro typ ¢ary Nazev_typu <0>:

Zadejte hladiny, pro které chcete typ ¢ary pouzit. Aktualni hladina je zobrazena v lomenych zavorkach.
MUizete definovat typ &ary vice hladinam najednou, jejich nazvy oddé&lujte arkami. pf. POPIS, KOTY,
TEXT.

Pro dalSi praci s hladinami a jejich nastavenim vyberte dal§i moznosti nebo pro ukonceni stisknéte Enter.

Nastaveni tloust’ky €ar entit v hladiné



Zadejte Tloustkac¢ (LW).

Tloustka €ary: ? pro seznam/0.0 mm-2.11 mm/<Vychozi>:

Zadejte tloustku ¢ary. Aktualni tlousStka €ary je zobrazena v lomenych zévorkach. Chcete-li zobrazit
dostupné tloustky &ar, zadejte "?".

Zadejte hladin(y) pro tloustku ¢ary x mm <0>:

Zadejte hladiny, pro které chcete typ ¢ary pouzit. Aktualni hladina je zobrazena v lomenych zévorkach.
MUizete definovat typ &ary vice hladinam najednou, jejich nazvy oddé&lujte arkami. pf. POPIS, KOTY,
TEXT.

Pro dal$i praci s hladinami a jejich nastavenim vyberte dalSi moznosti nebo pro ukonceni stisknéte Enter.

Nastaveni tisku hladiny

Zadejte tisk (P).

Aktivovat tisk: <ano (Y)>/Ne:

Zvolte Ano (Y) pro tisk entit v hladiné. Zvolte Ne pro vynechani entity v hladin& béhem tisku.

Zmeénit nastaveni tisku hladin(y):

Zadejte nazev hladiny, u které chcete zménit nastaveni tisku.

Pro dalSi praci s hladinami a jejich nastavenim vyberte dalSi moznosti nebo pro ukonceni stisknéte Enter.

Nastaveni stylu tisku hladiny

Tato volba je dostupna pouze v pfipadé, ze vykres pouziva pojmenované tabulky styll tisku.

Zadejte StylT (PS).

Zadat nazev stylu tisku nebo [?] <Normal>:

Zadejte nazev stylu tisku, ktery chcete pfifadit k aktualni hladiné. Zadejte "?" pro seznam dostupnych stylt
tisku.

Zadejte hladiny styl tisku nazev <0>

Zadejte nazev hladiny, pro kterou chcete pfifadit pojmenovany styl tisku. Aktualni hladina je zobrazena

v lomenych zavorkach.

Pro dalSi praci s hladinami a jejich nastavenim vyberte dalSi moznosti nebo pro ukonceni stisknéte Enter.

Chcete-li zapnout nebo vypnout hladinu

Pokud je hladina zapnuta, mizete kreslit a upravovat entity, vSechny entity na vrstvé budou vytisknuty.
Kdyz je hladina vypnuta, jsou tyto entity neviditelné. Mizete upravovat entity (v€etné jejich mazani)

v hlading, ktera je vypnuta, ale doporu€ujeme, abyste hladiny radé&ji zmrazili a rozmrazili nez vypnuli nebo
zapnuli.

Zvolte Zapnout (ON) nebo Vypnout (OFF).

Hladina (hladiny) pro zapnuti / vypnuti:

Zadejte hladinu, kterou chce zapnout nebo vypnout. MizZete zapnout nebo vypnout vice nez jednu hladinu
najednou odd&lenim nazvd arkou, naptiklad: POPIS, KOTY, TEXT.

Pro dalSi praci s hladinami a jejich nastavenim vyberte dalSi moznosti nebo pro ukonceni stisknéte Enter.

Jak zmrazit nebo rozmrazit hladinu

Hladina, ktera je zmrazena, se nezobrazuje a nelze ji tisknout. Kdyz ji rozmrazite, hladina se regeneruje
a zobrazi. Doporucujeme, abyste zmrazili nebo rozmrazili hladiny na delSi dobu; pro kratsi dobu hladinu
zapnéte nebo vypnéte.

Zvolte zmrazit (F) nebo rozmraziT (T).

Zmrazit hladiny:

Rozmrazit hladiny:

Vyberte hladinu, kterou chcete zmrazit nebo rozmrazit. Mlizete zmrazit nebo rozmrazit vice nez jednu
hladinu najednou oddé&lenim nazvt &arkou, naptiklad: POPIS, KOTY, TEXT.

Pro dal$i praci s hladinami a jejich nastavenim vyberte dalSi moznosti nebo pro ukonceni stisknéte Enter.

Chcete-li zamknout nebo odemknout hladinu

Hladinu, ktera je uzamcena, mlzete vidét, ale nemuzete ji upravit a nemulzete v ni kreslit nové entity.
Muzete uzamknout nebo odemknout vice nez jednu hladinu najednou oddélenim nazvui ¢arkou, napfiklad:
POPIS, KOTY, TEXT.

Zvolte uzamknout (LO) nebo odemknoUt (U)



Uzamknout hladiny:

Odemknout hladiny:

Zvolte hladinu, kterou chcete uzamknout nebo odemknout.

Pro dalSi praci s hladinami a jejich nastavenim vyberte dalSi moznosti nebo pro ukonceni stisknéte Enter.

154. Zména barvy (Layer Colour Change)

Klavesnice laycc

Méni barvu u hladiny zvolenych entit.
Vyberte entitu v hladiné pro zménu barvy :

Vyberte entitu, ktera lezi na hladiné, které chcete ménit barvu a zmérite barvu.

155. Zménit na aktualni hladinu (Layer current)

Ribbon Vychozi > Hladiny > Zménit na aktualni hladinu
Menu Format > Nastroje hladin > Zménit na aktualni hladinu
Klavesnice laycur, akthlad

Umoziuje vybrat jednu nebo vice entit a pfifadit vybér k aktualni hladiné.

Vyberte objekty pro zménu do aktualni hladiny "0":

Vyberte jednu nebo vice entit, které chcete pfifadit k aktualni hladiné. Aktudlni hladina je zobrazena
v uvozovkach.

156. Odstranit hladinu (Layer Delete)

Ribbon Vychozi > Hladiny > Odstranéni hladiny
Menu Format >Nastroje hladin > Odstranit hladinu
Panel nastoju Format > Spravce stavl hladin > Odstranit
Klavesnice laydel, vymazhl

Odstrani v8echny entity na hlading, ale i hladinu samotnou. Pokud jsou né&jaké entity na hlading, kterou
mazeme, neoznaceny, tyto entity budou odstranény take.

Vyberte objekt pro smazani hladiny:

Vyberte entitu, kterd leZi na hlading, kterou chcete smazat a mazte. VSechny ostatni entity, které na této
hlading lezi, budou také smazany.




157. Zmrazeni hladiny (Layer Freeze)

Ribbon Vychozi > Hladiny > Zmrazeni hladiny

Menu Format > Nastroje hladin > Zmrazeni hladiny
Panel nastoju Format > Spravce stavu hladin > Zmrazit
Klavesnice layfrz, zmrazhl

Zmrazi hladiny vybranych entit. Entity na zmrazenych hladinach jsou neviditelné.
Vyberte objekt pro zmrazeni hladiny ve vSech vyirezech:

Vyberte entitu na hladiné, kterou chcete zmrazit ve vSech vyfezech.

158. Info hladiny (Layer Info)

Klavesnice laysee

Zobrazi informace o hladiné.
Vyberte entitu pro zobrazeni jeji hladiny:

Vyberte entitu, kterd lezi na hlading, o které chcete zjistit informace.

159. Izolovat hladinu (Layer Isolate)

Ribbon Vychozi > Hladiny > Izolovat hladinu
Menu Format > Nastroje hladin > Izolovat hladinu
Klavesnice layiso, izolhlad

Izoluje vSechny hladiny, kromé téch, na kterych leZi vybrané entity.
FILtr/<Vyberte entity>:
Vyberte entity, které leZi na hladin&, kterou nechcete izolovat. VSechny ostatni hladiny budou zmrazeny.

Pro zruSeni zmén vyuZijte pfikaz Neizolovat hladinu.

160. Zamknuti hladiny (Layer Lock)

Ribbon Vychozi > Hladiny > Uzam¢€eni hladiny
Menu Format > Nastroje hladin > Zamknuti hladiny
Klavesnice laylck, zamknihl



Zamkne hladinu, na které lezi vybrané entity. Entity v zamknuté hladin€ nemohou byt upravovany.
Vyberte objekt pro zaméeni hladiny:

Vyberte entity na hlading, kterou chcete uzamknout.

161. Pfevod do hladiny (Layer match)

Ribbon Vychozi > Hladiny > Pfesunout do hladiny
Menu Format > Nastroje hladin > Pfevést do hladiny
Klavesnice laymch, zménhl

Méni hladinu vybrané entity aby se spoijila s hladinou jiné vybrané entity.
FILtr/<Vyberte entity>:

Vyberte jednu nebo vice entit, které maji uréenou hladinu, kterou chcete zménit.
Vyberte objekt na cilové hladiné:

Vyberte entitu na poZadované hladiné. PfedesIé vybrané entity budou pfipojeny k této zvolené hladinég.

162. Nastavit hladinu podle entity (Layer Match Current)

Klavesnice laymcur

Nastavite hladinu podle zvolené entity, ktera v dané hladiné lezi.
Vyberte objekt pro nastaveni aktualni hladiny:

Zvolte mySi entitu, ktera je na hladiné, kterou chcete zvolit za aktualni.

163. Vypnuti hladiny (Layer Off)

Ribbon Vychozi > Hladiny > Vypnout hladiny
Menu Format > Nastroje hladin > Vypnuti hladin
Klavesnice layoff, vyphlad

Vypne hladinu, na které lezi vybrané entity.
Vyberte objekt pro vypnuti hladiny ve vSech vyfezech:

Vyberte entity, které lezi na hladiné, kterou chcete vypnout.



164. Zapnout vSechny hladiny (Layer On)
Ribbon Vychozi > Hladiny > Zapnout vSechny hladiny

Menu Format > Nastroje hladin > Zapnout vSechny hladiny
Klavesnice layon, zaphlad

Zapne veSkeré hladiny v sou¢asném vykrese.

165. Rozmrazit vSechny hladiny (Layer Thaw)
Ribbon Vychozi > Hladiny > Rozmrazit vSechny hladiny

Menu Format > Nastroje hladin > Rozmrazit vSechny hladiny
Klavesnice laythw, uvolnihl

Rozmrazi vSechny hladiny v aktualnim vykresu.

166. Neizolovat hladinu (Layer Unisolate )

Ribbon Vychozi > Hladiny > Neizolovat hladinu
Menu Format > Nastroje hladin > Neizolovat hladinu
Klavesnice layuniso, neizohlad

Obrati provedené zmény pfi izolovani hladin.

Pro izolovani hladin pouzijte pfikaz LAYISO.

167. Odemknuti hladiny (Layer Unlock)

Ribbon Vychozi > Hladiny > Odemknout hladinu
Menu Format > Nastroje hladin > Odemknout hladinu
Klavesnice layulk, odemkhl

Odemkne hladiny s vybranymi entitami.
Vyberte objekt pro odeméeni hladiny:

Vyberte entitu, ktera leZi na hladiné, kterou chcete odemknout.

168. Vyrezy z rozvrzeni (Layout Viewports)



Ribbon Pohled > Rozvrzeni > Nové rozvrzeni > Rozvrzeni vyrezi
Menu Zobrazit > Plovouci vyiezy > 1 vyiez

Panel nastojii Vyfez > Rozvrzeni vyrez{

Klavesnice  mview, mpohled

Alias Mv

Pfikaz Vyfez vytvaii a ovlada pohledy na Va$ vykres z tabulky rozvrzeni. Musite kliknout na tabulku
rozvrzeni jesté pred pouzitim pfikazu Vyfez. Pokud je to poprvé, co pouzivate tabulku rozvrzeni, Vas
vykres zmizne. Je to v pofadku. Musite vytvofit alespori jeden vyfez, abyste vidéli svuij vykres. Mnozstvi
vyfez(, které vytvofite, je omezeno pouze Vasim systémem.

Priklad raznych pohledd

Vyrezy: zapnout (ON)/vypnout (OFF)/pfizptisobit (F)/zamknout (L)/Entita/Polygonovy/2/3/4/<prvni
roh>: Zadejte prvni roh vyfezu. Pro zapnuti vyfez( zvolte ON (zapnout). Pro vypnuti vyfezu zvolte OFF
(vypnout). Pro vytvoreni vyfezu, ktery vyplni celou obrazovku zvolte F (pfizpusobit). Pro uzam&eni méfitka
vyfezu a pohledu na model pfi vyuziti zoomu nebo posunu ve vyfezu zvolte L (zamknout). Pro vytvoreni
vyfezu s jinym, neZ obdélnikovym tvarem, zvolte P (polygonovy). Pro vytvofeni dvou horizontalnich nebo
vertikalnich vyfezl zvolte 2. Pro vytvoreni tfi horizontalnich nebo vertikalnich vyfezl zvolte 3. Pro
vytvoreni Etyf horizontalnich nebo vertikalnich vyfezl zvolte 4.

Pro uréeni hranic vyfezu

Zadejte prvni roh vyfezu.
Opacny roh: Zadejte opaény roh vyfezu.

Pro zapnuti nebo vypnuti vyiezu

Zvolte zapnout (ON) nebo vypnout (OFF).

Vyberte, které vyrezy zapnout [vypnout]: Zvolte hranu vyfezu pro zapnuti nebo vypnuti a stisknéte
Enter. Timto nezruSite vyfez, pouze ho vypnete.

Pro vytvoreni vyrezu, ktery vyplni obrazovku

Zvolte pfizpusobit (F).



Pro uzaméeni nebo odemc¢eni vyiezu

Zvolte zamknout (L).

Uzamknuti pohledu vyiezu [ano (ON)/ne (OFF)]: Zvolte ano (ON) pro zamknuti méfitka vyfezu

a pohledu v modelovém prostoru pro pouziti funkci posun nebo zoom. Zvolte ne (OFF) pro odemc&eni
méfitka vyfezu a pohledu.

Pro vytvofeni vyiezu uzavienou entitou

Zvolte entita (E).
Vyberte entitu pro ofiznuti vyiezu: Zvolte kruh, elipsu, uzavienou kfivku, spline, nebo oblast, kterou
chcete konvertovat na vyfez.

Pro vytvoreni jiného nez obdélnikového vyiezu

Zvolte polygonovy (P).

Zacatek kiivky: Zvolte pocatecni bod kfivky, kterou chcete pouzit pro ne-obdélnikovy vyfez.

oblouk (A)/zavrit (C)/vzDalenost/pokracovat (F)/poloviéni Sifka (H)/Sirka (W)/zpét (U)/:/<Dalsi bod>:
Pro nakresleni oblouku jako €asti kfivky zvolte A (oblouk). Pro uzavieni kfivky zvolte C (zavfit). Pro zadani
vzdalenosti od po¢atecniho bodu zvolte D (vzdalenost). Nasledné Vas program vyzve k zadani ahlu Cary.
Pro vytvofeni Cary, ktera pokracuje ve sméru posledni ¢ary zvolte F (pokracovat). Pro zizZeni dalSi ary na
polovi¢ni Sifku zvolte H. Pro zadani Sifky ¢ary zvolte W (Sifka). Pro vraceni posledniho kroku zvolte U
(zpét). Pro zadani dalSiho bodu kliknéte do vykresu.

PokraCujte v kresleni segmentu kfivky pomoci vybéru z moznosti v pfikazovém fadku. Po skonceni
kliknéte na Enter pro uzavfeni kfivky a ukon&eni pfikazu.

Pro vytvoreni dodateéného vyirezu, ktery nema obdélnikovy tvar:

Zvolte polygon (P).

Klavesou ENTER pouzijete posledni bod/pokracovat (F)/<Zacatek krivky>: Zvolte pocate¢ni bod
kfivky, kterou chcete pouzit pro vyfez jiného, nez obdélnikového tvaru. Zvolte pokracovat (F) pro
pokracovani v kresleni ve sméru posledni ¢ary. Stisknéte Enter pro pouziti posledniho zvoleného bodu.

Pro vytvoreni nasobnych horizontalnich nebo vertikalnich vyrezu

A B

A. Dva svislé vyrezy.
B. Dva vodorovné vyrezy.

Zvolte 2 vyfezy.

Dva vyrezy: vodorovné (H)/<sVisle>: Pro vytvoreni svislych vyfezl zvolte svisle (V) nebo stisknéte
Enter. Pro vytvofeni vodorovnych vyfezUi zvolte vodorovné (H).

prizplUsobit obrazovce (F)/<prvni roh ohranicujiciho obdélniku>: Zadejte prvni roh vyfezu. Pro
vytvoreni dvou stejnych vyfezl zvolte pfizpUsobit obrazovce (F).

Opacny roh: Zadejte proté&jSi roh vyfezu.

Pro vytvoreni tii vyreza



A. Tii vodorovné vyrezy.

B. TTi svislé vyrezy.

C. Jeden vodorovny vyrez nad dvéma svislymi vyiezy.

D. Jeden vodorovny vyfez pod dvéma svislymi vyfezy.

E. Jeden svisly vyfez vlevo od dvou vodorovnych vyrezil.
F. Jeden svisly vyrez vpravo od dvou vodorovnych vyrezdu.

Zvolte vytvofit 3 vyfezy.

T¥i vyfezy: vodorovné (H)/sVisle/nAd/pod (B)/vLevo/<vPravo>: Pro vytvofeni jednoho velkého vyfezu
vpravo a dvou mensich vlevo zvolte vpravo (P). Pro vytvoreni tfi vodorovnych vyfezl stejné velikosti
zvolte vodorovné (H). Pro vytvoreni tfi svislych vyfezud stejné velikosti zvolte svisle (V). Pro vytvoreni
jednoho velkého vyfezu navrchu a dvou menSich vespod zvolte nad (A). Pro vytvorfeni jednoho vétSiho
vyfezu vespod a dvou menSich nahofe zvolte pod (B). Pro vytvoreni jednoho velkého vyfezu vievo a dvou
menSich vpravo zvolte vlevo (L).

pfizplsobit obrazovce (F)/<prvni roh ohranicujiciho obdélniku>: Zadejte prvni roh vyfezu. Pro
vytvoreni vyfezu, které se pfizplsobi obrazovce zvolte pfizpUsobit (F).

Opacny roh: Zadejte protéjsi roh vyfezu.

Pro vytvoreni Etyr vyrezi

A B
¢ D
E F

Ctyri vyrezy

Zvolte vytvofit 4 vyfezy.



pfizplsobit obrazovce (F)/<prvni roh ohranicujiciho obdélniku>: Zadejte prvni roh vyfezu. Pro
rozdéleni obrazovky na 4 stejné vyfezy zvolte pfizpUsobit obrazovce (F).
Opacny roh: Zadejte proté&jsi roh vyfezu.

169. Spravce knihovny (Library manager)

Klavesnice libman

UmoZhuje vkladat do vykresu pfeddefinované bloky z knihovny a bloky z vykresu vkladat do knihovny.

170. Umisténi svétel (Lights Placement)

Ribbon Render > Umisténi svétel
Menu Render > Umisténi svétel
Panel nastoju Render > Umisténi svétel
Klavesnice  phota

Funkce umisténi svétel Vam umozni umistit do vykresu svétla pro jeho osvétleni v priibéhu renderovani.
Zadejte nazev pro svétlo: Zadejte nazev nového svétla, které chcete vlozit do vykresu.

Zadejte bod vlozeni pro svétlo v roviné XY : Kliknéte do vykresu pro zadani polohy x-, y- nového
svétla.

Zadejte vysSku pro svétlo: Zadejte soufadnici z- nového svétla.

171. Useéka (Line)

Ribbon Kreslit > Kreslit > Kiivka > Usecka
Menu Kreslit > Usecka

Panel nastoju Kreslit > Useéka

Klavesnice line, usecka

Alias 3DLINE, L

Kresli rovné usecky jakékoli délky. Je mozné zadat dvou nebo trojrozmérné soufadnice pro pocatecni
a koncovy bod zadanim hodnot x, y a z.

By
A

\

A. Zadejte pocatecni bod Usecky
B. Zadejte koncovy bod.

Pocatek usecky: Zadejte pocatecni bod usecky.



thel (A)/déLka/<Koncovy bod>: Zadejte koncovy bod Usecky. Pro zadani thlu Gseéky, zvolte Uhel
(pismeno A). Pro zadani délky usecky, zvolte Délka (pismeno L).

uhel (A)/déLka/pokracovat (F)/zpét (U)/<Koncovy bod>: Pro pokracovani kresleni segmentl Usecky
(pocate€ni bod kazdého segmentu je koncovym bodem pfedchoziho segmentu), zadejte dalSi koncovy
bod. Pro zadani délky dalSiho segmentu, zvolte Délka (L). Pro pokracovani usecky ve sméru prfedchoziho
segmentu, zvolte PokraCovat (F). Pro smazani posledniho segmentu, zvolte Zpét (U).

Volba Pokracovat (F) vyuziva uhel ulozeny v systémové proménné LASTANGLE.

Pokud spustite pfikaz Useéka podruhé, pogateéni volby jsou:

Klavesou ENTER pouzijete posledni bod/pokrac¢ovat (F)/<Zac¢atek usecky>: Pro kresleni od
koncového bodu posledniho segmentu stisknéte Enter. Pro kresleni Usecky ve stejném uhlu jako posledni
kreslici pfikaz, zvolte Podle (F). Pro vytvoreni nového pocatecniho bodu Usecky zadejte bod.

Kresleni use¢ky zadanim délky

Zvolte Délka (L).

Délka usecky: Zadejte délku usecky.

Uhel useéky: Uréete thel use¢ky nebo zadeijte jeho hodnotu (ve stupnich).

uhel (A)/déLka/pokracovat (F)/zpét (U)/<Koncovy bod>: Pro pokracovani kresleni segmentl usecky
(pocatecni bod kazdého segmentu je koncovym bodem pfedchoziho segmentu), zadejte dalSi koncovy
bod. Pro zadani délky dalSiho segmentu, zvolte Délka (L).

Kresleni use¢ky zadanim uhlu

Zvolte Uhel (A).

Uhel Gseéky: Uréete Uhel Usecky nebo zadejte jeho hodnotu (ve stupnich).

Délka usecky: UrCete délku useCky nebo zadeijte jeji hodnotu (v kreslicich jednotkach).

uhel (A)/déLka/pokracovat (F)/zpét (U)/<Koncovy bod>: Pro pokracovani kresleni segmentl usecky
(pocatecni bod kazdého segmentu je koncovym bodem pfedchoziho segmentu), zadejte dalSi koncovy
bod. Pro zadani dhlu dal$iho segmentu, zvolte Uhel (A).

Pokracovani v kresleni useéek
Zadeijte koncovy bod dal$iho segmentu. Pro zadani Ghlu nebo délky usecky, zvolte Uhel (A) nebo Délka

(L). Pro kresleni dalSiho segmentu ve stejném sméru zvolte PokraCovat (F). Pro smazani posledniho
segmentu zvolte Zpét (U).

172. Typy ¢ar (Linetype)

Menu Format > Typ éary
Klavesnice linetype, typé
Alias -LT

Otevira dialogové okno Spravce typu €ar pro zvoleni typu €ary nebo nahrani typu ¢ar z knihovny.
Tento seznam obsahuje vSechny typy €ar, které jsou nahrané a dostupné v aktualnim vykrese.

Moznosti dialogového okna

Nazev typu ¢ary Dvakrat kliknéte, abyste typ ¢ary zménili na aktualni. Pokud zvolite typ €ary pro hladinu
s vyuzitim Spravce 4MCAD, kliknéte na typ ¢ary dvakrat, abyste jej zvolili pro danou hladinu.



Nacist Kliknéte pro otevieni dialogového okna PFidani typl €ar, diky kterému mizete do vykresu nacist
dalSi typy car.

173. Méritko typu ¢ar (Linetype Scale)

Klavesnice Itscale, ttmér
Klavesova zkratka LTS
Alias LTS

Nastavi pozadovany faktor méfitka vSem typlm ¢€ar pro aktualni vykres.

/‘—’f -__-‘ Set
- -
-

1

Priklad ¢arkované ééry‘/ v rliznych méfitkach.

Nova aktualni hodnota LTSCALE (vétsi nez nula) <1.0000>: Zadejte nové méfitko. Cim vétsi hodnota,
tim vice jednotek typu ¢ary (kombinace ¢arka/teCka) na kreslici jednotky.

174. Sifrovani LISP (LISP Ecryption)

Klavesnice lispcrypt

Pfikaz je k dispozici ve verzi 4M CAD Professional (od Cisla 14). UmozZnuje konvertovat soubor
s pfiponou LSP do zasifrované podoby.

POZOR!
Pred provedenim prikazu provedte zalohu zdrojového souboru pod jinym nazvem. Pfikaz pfimo
zasifruje a prepiSe zvoleny soubor.

Zvazte také, zda je Sifrovani nutné. LISP soubory funguji i pfimo bez jakékoli kompilace &i Sifrovani.
Ponechanim otevieného souboru umoznite Vasim uzivateldm aplikaci dale rozvijet nebo opravit pfipadné
nedostatky.

Pro zaSifrovani LISP souboru zadejte do pfikazového fadku LISPCRYPT.

V zobrazeném dialogovém okné vyhledejte pozadovany soubor s koncovkou .Isp:



= Select LISP file

Oblast hledsni: | |, test - emekmE-
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175. Vypis informaci entity (List Entity Information)

Ribbon Nastroje > Dotaz > Vypsat informace o entité
Menu Nastroje > Dotaz > Vypis

Panel nastoju Dotaz > Vypis info entity

Klavesnice list, vypis

Alias LI, LS

VypiSe informace o zvolenych entitach v pfikazovém fadku. Program zobrazi typ entity, hladinu, na které
se nachazi, barvu a typ €ary, jakou je nakreslena a jeho soufadnice X, y, z v relativnim umisténi
v uzivatelském soufadném systému (USS). To, jaké dalSi informace se zobrazi, zavisi na typu entity, ktery



jste si vybrali. Napfiklad, informace vypsané pro kruh zahrnuji primér, obvod a plochu, informace o Care
obsahuiji jeji délku.

rolovat (SC)/tridit (SO)/Trasovani/<Vybrat entity pro vypis>: Zvolte entity, pro které chcete ziskat
Udaje z databaze. Pro rolovani vypisem zadejte SC (rolovat).

Pro tfidéni nebo sekvenéni zobrazeni informaci

Zvolte tridit (SO).

posouvat (SC)/SEkvencéni/Trasovani/<Vybrat entity pro vypis>: Zvolte entity, pro které chcete ziskat
Udaje z databaze. Pro zménu zpUsobu vypisu Udaji zvolte SC (posouvat). Pro zobrazeni udajl

z databaze sekvencné zvolte SE (sekvenéni). Pro zménu poctu trasovanych fadku zvolte T (trasovani).

Pro zménu poctu trasovanych radku

Muzete zadat mnozstvi Fadkl pro trasovani nebo vypis zménou trasovani. Pokud je pocet fadkl vySsi nez
mnozstvi fadku, které jste stanovili pro trasovani, program vypusti Udaje na za¢atku seznamu.

Zvolte trasovani (T).

Pocet prikazovych Ffadku k trasovani <256>: Pro pfijeti aktualniho nastaveni stisknéte Enter. Pro
zménu mnozstvi fadkd pro trasovani zadejte novou hodnotu.

TIP Mnozstvi Fadkd pro trasovani mizete zadat i pomoci Nastroje > Moznosti.

176. Snimek (Make Snapshot)

Ribbon Nastroje > Spravovat > Vytvofit snimek
Menu Nastroje > Snimek

Panel nastoju Nastroje > Vytvofit snimek

Klavesnice msnapshot

Alias MSLIDE

Zobrazi Dialogové okno Vytvofit snimek, takze muzete vytvorit snimek (slide - *.sld) kreslici plochy pro
pozdéjsi reference.

Snimek si mlzete zobrazit pfikazem Zobrazit snimek (Nastroje > Zobrazit snimek nebo pfikaz
VSNAPSHOT). 4MCAD snimky slouzi pouze pro prohlizeni a neni mozné je dale upravovat.

177. Zvyraznéni bodt (Marker Blips)

Menu Nastroje > Nastaveni kresleni > zalozka Zobrazeni > zalozka Zobrazeni > zobrazit body
znacky (zatrhnout okénko)

Klavesnice blipmode, znacky
Alias BM



Zapne nebo vypne volbu BLIPMODE. Znacky v podobé& znaménka plus (+) se do¢asné objevi na Vasi
obrazovce a zvyrazni vybrané body.

O~ O~

A Zapnuty BLIPMODE.
B Vypnuty BLIPMODE

BLIPMODE je pravé vypnut: zapnout (ON)/pfepnouT/: Pokud nechcete BLIPMODE zapnout, stisknéte
Enter. Pro zapnuti BLIPMODE zvolte ON (zapnout). Pro pfepnuti BLIPMODE do opa&ného nastaveni
zvolte Toggle (pfepnout).

178. Zrcadli (Mirror)

Ribbon Upravit > Upravit > Zrcadlit > Zrcadlit
Menu Modifikace > Zrcadli

Panel nastoju Modifikace > Zrcadli

Klavesnice  mirror, zrcadli

Alias Mi

Pfesune nebo zkopiruje zrcadlové obraceny obraz zvolenych entit dle osy zrcadleni.

&

[
A. Zvolte entity pro zrcadleni
B. Zadejte pocatecni bod osy zrcadleni.
C.Zadejte koncovy bod osy zrcadleni.

A

FILtr<Vyberte entity pro zrcadleni>:

Potvrdte Enter a zvolte entity pro zrcadleni. Opét stisknéte Enter.

Pocatek osy zrcadleni: UrCete pocatecni bod osy zrcadleni.

Konec osy zrcadleni: UrCete konec osy zrcadleni. Entity jsou zrcadleny dle vytvofené osy.

Odstranit pivodni entity? ano (Y)/<Ne> Pro pfijeti vychozi hodnoty stisknéte Enter. Pro zménu
odpovédi zadejte Ano (Y — Yes) nebo Ne (N — No). Pfi volbé Ne (N) je ve vykrese vytvofen zrcadlovy
obraz zvolenych entit a pivodni entity jsou zachovany. Pfi volbé Ano (Y) jsou plvodni entity odstranény.

Upraveni mnoziny entit pro zrcadleni

FILtr<Vyberte entity pro zrcadleni>:

Zvolte Filtr (FIL):

Vybrat dle vlastnosti: pfidAt/odebRat/Blok/barva (C)/hLAdina/méfitko tloust’ky €ar (LTS)/typ Eary
(LT)/tloust’ka ¢ary (LW)/Proxy/tloustka (TH)/TYp/hodnota (V)/Sifka (W)/konEc:

Pridat (A) - pfida dalSi entity do vybéru pro zrcadleni podle zvolenych viastnosti
Odebrat (R) - ubere z vybéru entity podle zvolenych vlastnosti
Blok (B) - ze seznamu vyberete bloky, které chcete pfidat do vybéru



Barva (C) - vybér entit na zakladé barvy - vychozi hodnota je dle hladiny
Hladina (LA) - ze seznamu vyberete hladiny, které chcete pfidat do vybéru
MéfFitko tloustky €ar (LTS) - méfitko typu €ary k vybrani - zvolte hodnotu
Typ Cary (LW) - index tloustky €ary k vybrani - zvolte hodnotu

Proxy (P) - vybér proxy objektll ze seznamu

Tloustka (TH) - tloustka k vybéru - zvolte hodnotu

Typ (TY) - typy entit k vybéru - vyberte ze seznamu

Hodnota (V) - fetézce textu k vybéru - vyberte ze seznamu

Sitka (W) - $itka k vybéru - zvolte hodnotu

Konec (E) - ukong€i vybér

POZNAMKA Muzete vyuzit systémovou promé&nnou MIRRTEXT pro uréeni, zda si prejete zrcadlit text.
Pro zménu sméru textu nastavte hodnotu proménné MIRRTEXT na 1; pro zachovani sméru textu
nastavte hodnotu na 0.

179. Piepnuti do modelového prostoru (Model Space Toggle)

Klavesnice mspace, model
Alias MS

VétSina Vasi prace pfi tvorbé entit se odehrava v modelovém prostoru (zalozka Model). Modelovy prostor
vyuzivate pro vytvareni dvou- nebo tfidimenzionalnich vykresu tfidimenzionalnich modelu.

Pokud jste pfipraveni tisknout Vas vykres, mlzete upravit pohledy na Vas model ve vykresovém prostoru,
pfi¢emz nezpUlsobite chaos ve Vasi praci v modelovém prostoru. S vyuzitim vykresového prostoru mizete
vytvaret vyfezy z Vadeho vykresu, které Vam umozni pohlizet V4§ model a pracovat s nim z vykresového
prostoru. Vyuziti pfikazu MSPACE je podobné kliknuti do modelového prostoru, s tim rozdilem, Ze takhle
se do modelového prostoru muzete pfepnout v prubéhu prace ve vykresovém prostoru.

ZaloZka vykresovy prostor musi byt aktivni pfed vyuzitim toho pfikazu. Jednodu$e kliknéte na zaloZku
pozadovaného vykresoveého prostoru.

180. Posun (Move)

Ribbon Upravit > Upravit > Pfesunout
Menu Modifikace > Posun

Panel nastoju Modifikace > Posun
Klavesnice move, posun

Alias M

Pfesune vybrané entity na jiné misto ve stejném vykrese.

CeTS
SN
/

k. Y
~

-

A. Vyberte entity pro pfesun.
B a C. UrCete zakladni a cilovy bod.



Vyberte entity pro posun:

Vyberte entity, které chcete posunout a stisknéte Enter.

Vektor/<Referenéni bod>:

Zadejte bod, ze kterého chcete posunout entity (poCatecni bod vektoru). Vzdalenost a smér pro posun
entit jsou vypocitany relativné k pocate¢nimu bodu.

Vektor (V) | Ur€eni vzdalenosti a sméru pomoci hodnot x, y, z.

Bod posunu:

Urcete bod, kam chcete entity pfesunout (koncovy bod vektoru). Pro posun entit o vektor definovany
pocatkem a referenénim bodem stisknéte Enter.

Posun pomoci hodnot x, y, z

Zvolte Vektor (V).

Zadejte smérovy vektor (x,y,z):

Zadejte hodnoty x. y, z pro ureni vzdalenosti a sméru, ve kterém chcete entity pfesunout. Napfiklad
zadani hodnot 3,3,2 pfesune entity ve vzdalenosti 3 jednotek ve sméru x, 3 jednotek ve sméruy a 2
jednotek ve sméru z.

181. Multiline (Multiline)

Ribbon Kreslit > Kreslit > Multicara
Menu nastroje > dotaz > multiline
Panel nastoju nastroje > dotaz > multiline
Klavesnice  mline, m¢ara

Kresli vicenasobné rovnobézné pfimky slozené ze spojovanych Use€ek. Konec jedné usecky je zaCatkem
druhé. Konce usecek jsou vrcholy multiline.

Tin
e/

AN
Kresleni MLINE
Urcete pocatecni bod nebo [nacist styL/zarovnani (J)/méfitko (S)/STyl]:
UrcCete pocateCni bod Mline
DalSi bod: UrCete dalSi vrcholy. Po ur€eni posledniho koncového bodu, zmacknéte Enter.
Uréeni zarovnani mline
UrCete po&atecni bod nebo [nadist stylL/zarovnani (J)/méFitko (S)/STyl]:
Vyberte Zarovnani (J).
Zadejte typ zarovnani [horni (T)/nulové (Z)/dolni (B)] : Pro kresleni s kurzorem na horni pfimce vyberte
Horni (T) a méjte pfidanou pfimku dole. Pro kresleni s kurzorem uprostfed vyberte Nulové (Z). Pro

kresleni s kurzorem na dolni pfimce, vyberte Dolni (B) a pfidana pfimka se vam zobrazi nad pfimkou, na
niz je kurzor.



Uréeni méfitka mline

UrCete pocatecni bod nebo [nadist stylL/zarovnani (J)/méfitko (S)/STyl]:

Vyberte Méfitko (S).

Zadejte méfitko multi¢ary <1.0000>: Pro zvétSeni Sifky multiline zvolte Cislo vétsi nez 1. Pro zuZeni Sitky
multiline zvolte €islo mensi nez 1. Pro sjednoceni multi¢ary a vytvofeni jednoduché pfimky zvolte 1. Pro

obraceni zarovnani béhem kresleni multiline a zménéni méfitka podle hodnoty, kterou jste zadali, zvolte
zaporné Cislo.

182. Nastaveni multipohledu (Multiple view set up)

Klavesnice mvsetup, mpnastav

Nastaveni, zda chcete nahled vykresu vidét jako vykresovy prostor nebo jen jako plochu.
Aktivovat vykresovy prostor? [Ne/ano (Y)] <ano>

Vyberte, zda chcete aktivovat vykresovy prostor.

Pokud ano (Y):

Zadejte volbu [zarovnat (A)/vytvorit (C)/méritko vyrezu (S)/moznOsti/raziTko/zpét (U)]

Pokud chcete text zarovnat (A) zvolte:
Zadejte volbu [Uhel (A)/Horizontalni/Vertikalni zarovnani/Rotovat pohled/zpét (U)]

Vyberte, jak chcete vykres zarovnat.

Pokud chcete vytvofit vyfezy (C):
Zadejte volbu [oDstranit objekty/vytvofit vyiezy (C)/zpét (U)] <vytvorit (C)>
Zvolte jestli chcete odstranit objekty (D) nebo vytvofit vyifezy (C)

Pokud chcete zobrazit méfitko vyfezl zvolte S.
Pokud moznosti vykresu (O):
Zvolte z nasledujicich

Zadejte volbu [hLadina/meze (LI)/jednotky (U)/reference (X)] <konec>

Pokud jste zvolili moZnosti hladiny (L):



Zadejte nazev hladiny pro razitko nebo [.(pro aktualni hladinu)]:

Zadejte nazev hladiny pro razitko nebo pro aktualni hladinu.

Pokud jste zvolili moZnosti meze (LI):
Nastavit meze vykresu? [ano (Y)/Ne] <N>

Zvolte jestli chcete nastavit hranice tohoto vykresu.

Pokud jste zvolili moZnosti jednotek (U):
Zadejte typ jednotek vykresového prostoru [stopy (F)/palce (I)/MEtry/Millimetry] <Palce>

Zvolte které jednotky chcete pouzivat, zda stopy (F), palce (l), metry (ME) nebo milimetry (M)

Pokud jste zvolili moZnosti reference (X):
Zvolte metodu umisténi razitka [eXterni reference/viozlt (I)] <Vlozit>

Zvolte metodu umisténi razitka.Vyberte z nabidky externi reference (X) nebo vlozZit (1).

183. Novy vykres (New)

Ribbon Tlacitko aplikace > Nova
Menu Soubor > Novy

Panel nastojl Standard > Novy
Klavesnice new, novy

Klavesova zkratka Ctrl+N

Alias N

Vytvofi novy vykres na zakladé vychoziho nastaveni, které je definovano v Nastroje > Moznosti...
Zobrazi se prazdné okno vykresu.

Tip: Muzete také pouzit pfikaz NEWWIZ pro vytvofeni nového vykresu s Privodcem novym vykresem.

184. Pravodce novym vykresem (New Drawing Wizard)

Ribbon Tlacitko aplikace > Nova
Menu Soubor > Novy
Klavesnice newwiz



Alias DDNEW

Spusti Privodce novym vykresem, ktery Vas provede celym procesem od vytvofeni nového vykresu dle
vychozi Sablony azZ po preddefinovani vlastniho nastaveni.

Sablona je uzite¢na pro nastaveni standardu vykresu a to vlastnosti, které pouzivate nejéastéji jako
jednotky, pojmenovani hladin, kétovaci styly, specialni klavesové zkratky apod.

Nastaveni Sablony:

1. Vytvorte nejprve vykres se vdemi nastavenimi, ktera chcete definovat a pouzivat (kreslici jednotky,
jednotky méfeni, hladiny, méfitko €ar, kdtovaci styl, format pisma atd.).

2. Ulozte vykres jako Sablonu (.dwt) s vhodnym nazvem do slozky se $ablonami.

PFisté pfi otevieni nového vykresu zvolte "Pouzit Sablonovy vykres" a tlaitka "Vyhledat" vyberete svoiji
vytvofenou Sablonu.

Novy vykres tak bude obsahovat Vami nadefinované nastaveni.

185. Odsadit (Offset)

Ribbon Upravit > Upravit > Odsadit
Menu Modifikace > Odsadit

Panel nastoju Modifikace > Rovnhobézné
Klavesnice offset, ekvid

Alias O, OFFSET

Vytvari rovnobéznou (odsazenou) kopii Usecek a kFivek.

\ !

A. Urcete vzdalenost rovnobézné entity od puvodni.
B. Zvolte entitu, od které chcete vytvofit rovnobé&Zznou kopii.
C, D. Urcete stranu, kam chcete rovnob&zZnou entitu umistit.

Rovnobézné: ENTER pro Skrz bod/<Vzdalenost>:
Pro ureni vzdalenosti, o kterou chcete rovnobé&Znou kopii odsadit, zadejte hodnotu nebo ji uréete dvéma
body. Pro ureni bodu, kterym by rovnobé&zna kopie méla prochazet, zvolte Skrz bod.

Uréeni vzdalenosti odsazeni

Zadejte vzdalenost odsazeni nebo uréete dva body.

Vyberte entitu: Zvolte entitu, pro kterou chcete vytvofit rovnobéznou kopii.

Obé strany (B)/<Strana pro rovnobéznou kopii>:

Zvolte stranu, na kterou chcete rovnobé&znou kopii umistit (leva nebo prava strana).
Obé strany (B — Both sides) | Kopie na obou stranach.

Vyberte entitu: Zvolte dalSi entitu pro odsazeni.

Zadejte Enter pro ukonceni pfikazu.

Rovnobézna kopie prochazejici uréenym bodem
Zvolte Skrz bod.



Vyberte entitu: Vyberte entitu, kterou chcete rovnobé&zné kopirovat.
Skrz bod: Ur¢ete bod, kterym ma kopie prochazet.

Vyberte entitu: Zvolte dal$i entitu pro odsazeni.

Zadejte Enter pro ukon&eni pfikazu.

186. Otevrit vykres (Open)

Ribbon Tlacitko aplikace > Otevrit
Menu Soubor > Otevrit

Panel nastojl Standard >Otevrit
Klavesnice open, otevri

Klavesova zkratka Ctrl+O

Alias OP

Zobrazi dialogové okno "Otevfit vykres", ve kterém muzete vybrat jiz existujici vykres.
Takto Ize otevfit soubory s pfiponou DWG, DXF, DWF a DWT.

Pro nalezeni souboru na jiném disku pouzijte roletové menu "Oblast hledani". Mzete se stromovou
strukturou proklikat, kam potfebujete, nebo napsat pfimo do pole "Nazev souboru" pozadované jméno
vykresu.

Jestlize chcete zménit zpUsob zobrazeni seznamu vykresu, vyberte z roletové nabidky v pravém hornim
rohu menu moznost "Zobrazit" (moznosti: miniatury, vedle sebe, ikony, seznam, podrobnosti).

V poli "Nahled" vidite jeSté pfed otevifenim miniaturu vybraného vykresu. Miniatura vykresu se zobrazi jen
v pfipadé, Ze v dobé& ukladani vykresu byla nastavena tato volba v moznostech nastaveni systému
RASTERPREVIEW.

Pokud pfi otevieni vykresu je pozadovano heslo, zadejte jej a potvrdte "OK". Poté zvolte opét "Otevrit".

187. Moznosti (Options)

Ribbon Nastroje > Spravovat > Moznosti; Tlacitko aplikace > Moznosti

Menu Nastroje > Moznosti
Klavesnice config, konfig
Alias OPTIONS, PR, PREFERENCES, RCONFIG

Zobrazi dialogové okno Moznosti, kde si muzete definovat vychozi nastaveni, které chcete, aby program
vyuzival (jako uzivatelska Uroven, barevné schéma nebo cesty k souboriim).

Dialogové okno se sklada ze zaloZek

- Obecné

- Cesty/soubory
- Zobrazeni

- Profily

- Tisk

- Uchopeni



- Schranka
- Vybér

188. Moznosti - Schranka (Options - Clipboard tab)

Ribbon Tlaéitko aplikace > Moznosti, Nastroje > Moznosti
Menu Nastroje > Moznosti, zalozka Schranka
Klavesnice config-schranka

Pouzijte tuto zalozku pro nastaveni formatu polozek kopirovanych prostfednictvim 4MCAD schranky.
Kopirovani do schranky ve vSech podporovanych formatech ovliviiuje vykon - je lepSi zvolit pouze
nevyhnutné formaty.

MozZnosti X

Obecné Cesty/soubory Zobrazeni Profily Tisk Uchopeni Schranka Cyklicky vybér Vybér

Generovat formaty Autodesk® DWG™

[(JAutodesk AutoCAD® 14

[C] AutoCAD 2000 - AutoCAD 2002
[CJAutoCAD 2004 - AutoCAD 2006
[C] AutoCAD 2007 - AutoCAD 2009
[C] AutoCAD 2010 - AutoCAD 2012
AutoCAD 2013 - AutoCAD 2017
AutoCAD 2018

Automaticka detekce

[] Automaticky detekovatinstalované verze

Generovat jiné formaty

Generovat OLE formaty: EMF, BMP. vloZeny objekt. pfipojeny objekt

@ s

Moznosti dialogového okna




Generovat formaty Autodesk DWG Zvolte, kterou verzi DWG formatu chcete kopirovat do schranky
4MCAD.

Automaticka detekce Zvolte, pokud chcete automaticky kopirovat format podle instalované verze
programu.

Generovat jiné formaty Zvolte, pokud chcete do schranky kopirovat obsah ve formatu EMF, BMP,
vloZzené objekty nebo pfFipojené objekty.

189. Moznosti - Zobrazeni (Options - Display tab)
Ribbon Nastroje > Spravovat > Moznosti; Hlavni tlaCitko > Moznosti

Menu Nastroje > Moznosti, zalozka Zobrazeni
Klavesnice config-display

Zalozka Vam umozni nastavit moznosti zobrazeni.



MozZnosti X

Obecné Cesty/soubory Zobrazeni Profily Tisk Uchopeni Schranka Cyklicky vybér Vybér

Prikazovy fadek
Poéet ulozenych fadku: = Velikost [16 |2
Pouzivat klavesy Sipek nahoru/dolu k navigaci v okné historie pfikazu
Zapnout automatické dokon&ovani Volby automatického dokoncovani_
Kreslici okno

Ramecek papiru ve vykresovém prostoru NastaveniKurzont

[[] obratit smér zoomu koleckem mysi
Barevné schéma...

Zobrazitzalozky
[[] Zobrazit posuvniky Nastaveni atlumu...
Hardwarova akcelerace

Nabidky
Zobrazovat nabidky piikazu Pocet poslednich E—E«
Zobrazit menu uzlu Pruhlednost oken s vyzvami (%): E—%

Uzivatelskeé prostredi
Jazyk Téma  Office 2007 Black v

[[]Zobrazit celou cestu vykresu v zahlavi Nastaveni MDI...

Obnovit vypnuté zpravy

Standardni chovani Windows
Kontextova menu v kreslicim okné

Akce praveho tlacitka...

@

Moznosti dialogového okna

Pocet ulozenych fadku Stanovuje maximalni poc¢et radkd, které se zobrazi jako Historie vyzev 4MCAD
(PMTHIST). 4MCAD sleduje pfikazy, které pouzijete v relaci, zobrazené vyzvy a Vase odpovédi na né.
Tyto informace si mGzete opét zobrazit v okné Historie vyzev. Vychozi hodnota je 256.

Velikost Zadejte velikost pisma textu, ktery se zobrazuje v pfikazovém Fadku. Vychozi hodnota je 16.

Pouzivat klavesy Sipek nahoru/dold k navigaci v okné historie pfikazi Podle vychoziho zobrazeni
muzete pomoci Sipek na klavesnici posouvat vyfez z Vaseho vykresu na obrazovce nahoru a dold. Pokud
byste se radé&ji pomoci Sipek posouvali v historii pfikazového fadku, zatrhnéte toto okénko. V tom pfipadé
pokud pouzijete Sipky nahoru nebo doll, budete se nimi posouvat v okné pfikazového fadku. Toto je
pohodiny zplUsob pro prohlizeni nebo dokonce opakovani pfedchozich pfikazu.

Poznamka Pro posun vykresu muzete vyuzit i klavesovou zkratku Alt+ Sipka. Pro rolovani v historii
prikaz( muzete vyuzit i zkratky Ctrl + K a Ctrl + L.




Zapnout automatické dokonéovani Pro automatické navrhy nazva v pribéhu psani pfikaz do
pfikazového fadku zatrhnéte okénko. Automatické dokonéovani miizete zapnout a vypnout i kliknutim
pravym tla¢itkem mysi v pfikazovém fadku a zvolenim volby AutoDokonc&ovani.

Volby automatického dokon€ovani Kliknéte pro otevieni dialogového okna MoZnosti automatického
dokon&ovani a zvolte zplsob, jakym se budou vytvaret navrhy na dokoncovani slov v pfikazovém fadku.
Toto dialogové okno miizete otevfit i pomoci kliknuti pravym tlacitkem mysi v pfikazovém fadku

a zvolenim volby Nastaveni AutoDokoncovani.

Ramecek papiru ve vykresovém prostoru Pro zobrazeni nebo skryti ohranieni listu papiru ve
vykresovém prostoru zvolte zatrhavaci okénko Ramecek papiru ve vykresovém prostoru.

Obratit smér zoomu kole¢kem mysi Kliknéte pro oddaleni obrazu pfi ota€eni koleCkem mysi vpred
a pfiblizeni pfi otaCeni dozadu. Obraceni sméru zoomu muze byt uzite€né pokud s mysi pracujete levou
rukou.

Zobrazit zalozky Pro zobrazeni nebo ukryti zéloZzek s modelovym a vykresovym prostorem zatrhnéte
okénko Zobrazit zalozky. Mozna budete chtit ukryt zalozky po dobu, kdy budete pracovat pouze

v modelovém prostoru nebo pokud pouzivate pfikazovy fadek a stavovy fadek pro pfepinani mezi
zalozkami.

Zobrazit posuvniky Pro zobrazeni nebo ukryti posuvniku, které se zobrazuji na pravé a spodni strané
4MCAD okna s vyfezem, pokud zatrhnete okénko zobrazit posuvniky. Posuvniky mizete chtit ukryt,
pokud pro posun vykresu pouzivate pouze pfikaz Posun. Ukryti posuvnik( také zvySuje vykon.

Hardwarova akcelerace Odstrarite zatrZitko z volby Hardwarova akcelerace, pokud mate problémy
s vykonem programu nebo pfi renderovani. Ve vychozim nastaveni je hardwarova akcelerace zapnuta,
ale Casto se stava, ze zpusobuje potize s vykonem programu nebo v pribéhu renderovani.

NASTAVENi KURSORU

Vychozi hodnoty nitkového kfize Zatrhnéte okénko, pokud chcete vZdy zobrazovat nitkovy kFiz misto
malého okénka.

Velikost kurzoru Zadejte hodnotu v procentech pro velikost nitkového kfize v poméru k velikosti
obrazovky, nebo vyuzijte Sipky nahoru a doll pro nastaveni Cisla. Nezapomente, Ze v zavislosti na grafice
VasSeho zafizeni by priliSna velikost mohla negativné ovliviiovat vykon pfi zobrazovani.

BAREVNE SCHEMA Kliknéte pro otevfeni dialogového okna Barvy kresliciho okna a zadejte barvy pro
rizné polozky kresliciho okna jako jsou mfizka, pozadi vykresu, nitkovy kfiz a dalsi.

Zobrazovat nabidky prikazi (v rameccich na vykrese) Zapne nebo vypne nabidky pfikazd. Nabidky
pfikaz(i se zobrazuji stejné v rameccich ve vykrese, ve stavovém fadku a v pfikazovém fadku. Vypnuti
této volby mize Setfit misto na obrazovce a omezit nutnost klikat mysi.

Pocet poslednich vykrest NapiSte nebo zvolte pocet vykresu, které se budou vypisovat v seznamu
vykres(, se kterymi jste posledné pracovali.

Prahlednost oken s vyzvami (%) Napi$te nebo zvolte procento prihlednosti rdmeckl s vyzvami, které
se zobrazuji na obrazovce.

Jazyk Zobrazi jazyk, ve kterém se zobrazuji moznosti programu.

Zobrazit celou cestu vykresu v zahlavi Kliknéte pro zobrazeni mechaniky a slozky, ve kterych je
umistény vykres v zahlavi vykresu spole¢né s nazvem souboru. Pokud moznost neni zatrzena (vychozi



nastaveni), v zahlavi vykresu se zobrazuje pouze nazev souboru.

Akce pravého tlacitka mysi Kliknéte pro otevieni dialogového okna Nastaveni pravého tlacitka mysi
a zadejte, co se ma stat po kliknuti pravého tlacitka mysi v pribéhu prace na vykresu.

Téma Zvolte vzhled jaky maji mit okna 4MCAD.

190. Moznosti - Obecné (Options - General Tab)

Menu Nastroje > Moznosti, zadlozka Obecné
Klavesnice config-general

Pouzijte tuto zalozku pro nastaveni uzivatelské urovné, ukladani soubord a zabezpeceni VBA.

MozZnosti X

Obecné Cesty/soubory Zobrazeni Profily Tisk Uchopeni Schranka Cyklicky vybér Vybér
Uroveii ‘ »
Uzivatelska droven:  Pokrogilé il

Automatické zalohovani

Automaticky zaloh.kazdych: 15 > | minut

Pfipona souboru aut zalohy: ~ -SV$
Ulozit jako

Vychozi format | AutoCAD 2018 (dwg) v
Oteviit

[[] otevirat vykresy s recover
Skryt upozornéni pii otevirani vykresu pomoci recover

Aktualni profil

Default
Chybova hlaseni

[Jvypnout chybova hlaseni [Jvytvoiit celou zpravu
Zabezpeceni VBA

[C]Pii spusténi potlacit makra VBA CommonProject

Nastavit asociativitu souboru

o  som

Moznosti dialogového okna



Uzivatelska uroven Nastaveni Urovné obtiznosti pro menu a panely nastroji. Mnozstvi a droven
komplexnosti pfikazu, ktera se zobrazuje v menu a panelech nastroji se postupné zvySuje od zacatecnika
po pokrocilého. Zvolte si svou uZivatelskou uUroveri podle urovné svych zkuSenosti s 4AMCAD. Vychozi
hodnota pokroc€ily se nastavi v prabéhu instalace programu. Pfikaz Customize urcuje, které tlacitka

a polozky z menu se pfi které urovni pokrocilosti zobrazi.

Automatické zalohovani Zapina nebo vypina funkci automatického ukladani Vaseho vykresu. Pokud je
funkce zapnutéd, Automatické zalohovani vytvari soubor se zalohou vykresu ve stanoveném ¢asovém
intervalu, ktery si definujete. Vychozi nastaveni je 30 minut. Pokud zadate Casovy interval 0 minut, je to to
samé jako kdyby jste funkci automatického zalohovani vypnuli. Soubor se zalohou se uklada do slozky
zadané v témze dialogovém okné Moznosti na zalozce Cesty/Soubory pro do€asné soubory. Pfiponu
souboru si muZete nastavit na vychozi nebo .SV$.

Poznamka Nezadavejte pfilis kratké Casové intervaly pro automatické zalohovani, pokud pracujete na
pfilis velkém vykrese, nakolik jeho ukladani maze trvat i déle nez minutu.

Ulozit jako Nastavte vychozi format souboru, ktery chcete aby se zobrazoval v dialogovém okné Ulozit
vykres jako... Napfiklad pokud pouzijete pfikaz ulozit jako pro uloZeni vétSiny vykresl ve stejném typu
formatu, muzete si zvolit tento format souboru jako vychozi a nebudete jej muset zadavat pokazdé, kdyz
budete vykres ukladat pomoci pfikazu UlozZit jako. Toto nastaveni nema zadny dopad na ukladani
existujicich nebo novych vykresu s vyuzitim jinych pfikazt nez Ulozit jako. 4AMCAD pokazdé uklada
existujici vykresy v aktualnim formatu souboru a nové vykresy uklada v posledné pouzitém formatu
souboru.

Otevrit Pokud pravidelné otevirate vykresy, které obsahuji chyby nebo poskozena data, napfiklad, pokud
pouze zacinate pracovat s 4MCAD a puvodni vykres byl vytvofen v jiném CAD softwaru, mizete vykres
oteviit za pomoci pfikazu Recover. Tato moznost automaticky kontroluje vyskyt chyb ve vykrese

v pribéhu jeho otevirani a pokusi se o jeho obnoveni, pokud je to nutné. Zobrazovani zprav

s upozornénimi v pribéhu otevirani vykresu Vam umozni zjistit, které soubory 4MCAD opravil a jaké
chyby se objevili. Varovani je mozné zrusit pomoci zatrhavaciho okénka Skryt upozornéni pfi otevirani
vykresU pomoci recover.

Aktualni profil Zobrazi nazev aktualniho profilu, ktery je zvoleny v tabulce profily.

Chybova hlaseni Kliknéte na Vypnout chybova hlaSeni pouze pokud chcete vypnout hldSeni chyb

o problémech, které se vyskytnou v prabéhu prace ve 4MCAD. Pokud jsou chybova hlaseni vypnuta,
doporucuje se zvolit moznost Vytvofit celou zpravu pouze pokud je to nutné z diivodu feSeni problém
v programu. Cel& zprava je soubor, ktery ma objem dat az do 100 MB, a pfestoze obsahuje uziteCné
informace pro feseni problému v programu, je dost pravdépodobné, Ze kvdli jeho velikosti bude jeho
prenos neuspésny.

Zabezpeceni VBA Kliknéte do zatrhavaciho poli¢ka, pokud neplanujete vyuzivat Visual Basic
Applications (VBS). Pouzivani téchto aplikaci zvySuje vykon programu a rovnéz zvysuje bezpecnost
4MCADu, pokud mate pouze nizkou Uroven jeho zabezpeceni.

Nastavit asociativitu soubort Kliknéte, pokud chcete zvolit, které typy soubort budou asociativni
s 4AMCAD a budou se v tomto programu automaticky otevirat.

191. Moznosti - Cesty/soubory (Options - Paths/Files tab)

Ribbon Nastroje > Spravovat > Moznosti; Tla€itko aplikace > MozZnosti



Menu Nastroje > Moznosti, zalozka Cesty/soubory
Klavesnice config-paths

Na této zalozce si mizete nastavit uzivatelské cesty a systémové soubory.

MozZnosti

X

Obecné Cesty/soubory Zobrazeni Profily Tisk Uchopeni Schranka Cyklicky vybér Vybér

l:~ Automaticka zaloha

' Bloky
i @ Cesty podpory
l Cesty tisku

(B [— Docasna slozka

~#usp

& @ Nahrané skripty

~ E Soubory typu ¢ar:
(}J @ Sablony

&[] Umisténi souboru s nastroji palet

A

N,

Pridat Odebrat Nahoru Dola Reset k Prochazet ..

Program Files  Oteviit..Ctr+O

Soubor proto... ICAD.LOG

Sablona C:\4MCAD21PRO\LANG\CSY\PROTOTYPES\4MCAD2K_CZ.DWG
Alternativni pi... simplex.shx

Fontmapping C:\4dMCAD21PRO\icad.fmp

Pravopisny sl... cs_CZ.dic

Storno

Prochazet..

Moznosti dialogového okna

Uzivatelské cesty Okno obsahuje seznam soubor0, které bude program prohledavat pfi praci se soubory,
fonty, online napovédou, externimi referencemi, menu, Srafovacimi vzory, bloky, tabulkami se styly tisku,
soubory pro tiskové vystupy, do€asnymi soubory, Sablonami a knihovnami barev. Kliknéte na soubor nebo
pouzijte klavesu F2 pro zménu zvolené cesty. Dvaijité kliknuti na cestu ji otevie ve Windows Exploreru.

Kliknuti pravym tlacitkem mysi otevie kontextové menu s moznostmi.

Pokud vpisujete informace o cesté k souboru misto jeho vybéru, syntaxe je stejna jako u Windows cest,
pfi¢emz se pouzije pismeno pro vybér mechaniky, dvoutecka a opacné lomitko. Vyuzit mizete i Universal
Naming Convention (UNC) cesty. Jednotlivé cesty od sebe mlzete oddélit strednikem, napft.:

C:\Program Files\IntelliCAD\Support;C:\




Pridat Kliknéte nebo stlacte klavesu Insert pro pfidani nové cesty pro aktualni kategorii.
Odebrat Kliknéte nebo stisknéte klavesu Delete pro odstranéni zvolené cesty.

Nahoru Kliknéte, pokud se chcete posunout v umisténi souboru o jednu poloZku nahoru ve vysledku
vyhledavani. Funkce je dostupna pouze pro kategorie s vice nez jednou cestou.

Dolt Kliknéte, pokud se chcete posunout v umisténi souboru o jednu polozku doll ve vysledku
vyhledavani. Funkce je dostupna pouze pro kategorie s vice nez jednou cestou.

Reset Kliknéte pro vraceni zmén, které jste vykonali a vraceni sloZky pro umisténi souboru do vychoziho
stavu.

Prochazet Kliknéte, pokud chcete zvolit slozku pro umisténi vybranych polozek.

Program Files Definuje soubory, které systém pouziva pro registraci, Sablony, alternativni fonty

a mapovani fontd. Napfiklad Sablony urcuji, ktery .dwt soubor se vyuziva jako vychozi Sablona pro novy
vykres, pokud si pouzijete pfikazy Novy nebo Priivodce novym vykresem. Zvolte polozku, kterou chcete
zménit, pak kliknéte na Prochazet a zvolte soubor. Nebo kliknéte na soubor v seznamu a napiSte zmény.

192. Moznosti - Tisk (Options - Printing tab)
Ribbon Tlacitko aplikace > Moznosti, Nastroje > Moznosti

Menu Nastroje > Moznosti, zalozka Tisk
Klavesnice config-printing

V Dialogovém okné moznosti na zalozce Tisk mUzete urcit néktera nastaveni pro tisk.



MozZnosti X

Obecné Cesty/soubory Zobrazeni Profily Tisk  Uchopeni Schranka Cyklicky vybér Vybér

Vychozi nastaveni tisku pro nové vykresy
Vychozi vystupni zafizeni:

Samsung M2020 Series (USB001) v

Nastaveni tabulky stylu tisku...
Nastaveni tisku razitka...

Pfidat nebo konfigurovattiskarny...

o

Moznosti dialogového okna
Vychozi vystupni zafizeni Zvolte vychozi tiskarnu pro novy vykres.

Nastaveni tabulky stylu tisku Kliknéte, pokud chcete otevfit dialogové okno Nastaveni tabulky stylu tisku
a zadejte nastaveni tabulky stylu tisku pro nové vykresy, které jsou vytvofeny bez Sablony nebo odkazu
na jiny vykres.

Nastaveni tisku razitka Kliknéte pro otevieni dialogového okna Nastaveni tisku razitka a zadejte
nastaveni pro zahlavi a zapati pro tisk vykresu.

Pridat nebo konfigurovat tiskarny Kliknéte pro otevieni dialogového okna Spravce konfigurace tiskarny
a nastaveni konfigura€nich souborl pro tiskarnu (PC3 soubory).

193. Dialogové okno Moznosti - zalozka Profily (Options - Profiles tab)



Klavesnice config-profily

Tuto zalozku muzete vyuzit pro vytvareni, nastavovani a ukladani prostfedi Vaseho vykresu do profilQ.
Err;‘fiill_ Vam umozni pfizpusobit si nastaveni prostfedi Vaseho vykresu a pak ulozit tyto nastaveni jako
Moznosti dialogového okna

Aktualni profil Zobrazi nazev aktualné nahraného profilu.

Profily Zobrazi seznam dostupnych profild. Zvolte si profil, ktery chcete upravit nebo nahrat.

Vytvorit Kliknéte pro vytvofeni nového profilu, ktery obsahuje aktualni nastaveni prostredi vykresu.
Aktualni Kliknéte pro nahrani zvoleného profilu a aktivaci v ném zadaného nastaveni prostfedi vykresu.
Kopirovat Kliknéte pro vytvoreni kopie zvoleného profilu.

Prejmenovat Kliknéte pro vloZeni nového nazvu zvoleného souboru.

Smazat Kliknéte pro smazani zvoleného profilu.

Exportovat Kliknéte pro uloZzeni zvoleného profilu jako souboru do Vaseho pocitace, disku nebo na sit.
Soubor se ulozi s pfiponou .arg.

Importovat Kliknéte pro otevieni profilu, ktery byl uloZzen do souboru (soubor .arg).
Reset Kliknéte pro obnoveni vychoziho nastaveni zvoleného profilu. Tato funkce smaze viechny Vami

vytvofené nastaveni. Funkci pouzijte pouze pokud jste si jisti, Ze zvoleny profil jiz vice nebudete
potfebovat.

194. Dialogové okno Moznosti - zalozka Uchopeni (Options - Snapping tab)

Menu Nastroje > Moznosti, zalozka Uchopeni
Klavesnice config-uchopeni

Pouzijte tuto zalozku pro nastaveni automatického uchopeni. Automatické uchopeni je vizualni pomuckou,
ktera Vam miize pomoci efektivnéji vyuzivat ichopy entit.

Pro zménu nastaveni na zalozce Uchopeni na ni kliknéte a pak zvolte moznost, kterou potfebujete. Po
ukon&eni nastaveni kliknéte na OK.

Moznosti dialogového okna

Zobrazit nastaveni ichopu u kurzoru Zobrazi specialni obrazek na kursoru, ktery zobrazi, ktery uchop
entity je pravé aktivni.

Pouzivat automatické uchopeni Zapne automatické uchopeni.

Zobrazit popisy Zapne popisy k automatickému uchopeni entit, které zobrazi typ uchopu, ktery byl pouZit
k vybéru ozna¢eného mista.



Zobrazeni ter€iku uchopu Zapne ter¢ik pro automatické uchopy, ktery se zobrazi na kursoru, pokud
zvolite uchop entity. Entity, které se nachazeji uvniti tchopového terciku jsou dostupné pro vybér, ¢imz se
usnadnuje vybér a volba uchopovych bod.

kolem kursoru, ve které jsou vyhledavany uchopové body.

Zobrazit znacku uchopu Zobrazi znacku automatického uchopu, ktera oznacuje uchopové body na
entitach.

Zobrazovat znacku uchopu ve vSech pohledech Zapne zobrazovani znacek automatického uchopu ve
vSech pohledech pokud pouzivate vice nez jeden vyfez.

Barva Umoznuje vybér barvy pro zna¢ku automatického tchopu.

Tloustka Umozniuje zvolit tloustku znacky automatického uchopu.

195. Odstranit duplicitni objekty (Overkill)

Ribbon Rychlé nastroje > Nastroje > Odstranit presahy, Tlac€itko aplikace > Nastaveni kresleni >
Odstranit presahy

Klavesnice overkill, odstranpresahy

Po napsani zkratky OVERKILL, do pfikazového fadku, nebo po kliknuti na pfikaz samotny, zvolte mySi
duplicitni entity. Poté stisknéte enter a vyberte v dialogovém okné vhodné parametry.

196. Posun pohledu (Pan)

Ribbon Pohled > Navigovat > Posunout pohled > Posunout pohled

Menu Zobrazit > Posun
Klavesnice pan, pp

Alias -P, P, RTPAN
Zkratky:

Sipka dolt - posun dol

Sipka vlevo - posun vievo

Page down nebo Shift a Sipka dol - posun dolt o jednu obrazovku
Shift a Sipka vlevo - posun vlevo o jednu obrazovku

Shift a Sipka vpravo - posun vpravo o jednu obrazovku

Page Up nebo Shift a Sipka nahoru - posun o jednu obrazovku nahoru
Sipka vpravo - posun vpravo

Sipka nahoru - posun nahoru

Ctrl + Shift + kliknuti pravym tla¢itkem mysi posun v realném Case

Kliknéte a podrzte mysS na bodu, od kterého byste chtéli posouvat displej. Posurite se mysi do cilové
pozice a uvolnéte tlacitko mysi.



TIP Pokud mate myS s koleCkem, zmacknéte ho a pfidrzte v této pozici, pak pohybujte mysi pro posun
vykresu. Pro posun vykresu mizete vyuzivat i Sipky, pokud jste si nezaktivovali v dialogovém okné
Moznosti na zaloZce Zobrazeni Sipky pro posun v historii pfikazového okna.

197. Prepnuti do vykresového prostoru (Paper Space Toggle)

Klavesnice pspace, vykres
Alias PS

Na zalozce rozvrzeni tvofite, upravujete a tisknete vysledné rozvrzeni Vaseho vykresu. Kone¢né
rozvrzeni pozlstava z poznamek, ohraniceni, blokl s titulky a dalSich entit a vyrez( rozvrzeni, které
pridavate v prlibéhu prace ve vykresovém prostoru na zalozce rozvrzeni. Pro Upravu entit ve Vami
vytvofeném modelovém prostoru (na zalozce modelovy prostor) v pribéhu prace na zalozce rozvrzeni
napiste do pfikazového Ffadku pfikaz MSPACE. Tento pfikaz otevfe jeden z vyfezl rozvrzeni. Kliknéte na
jiny vyfez rozvrzeni pro Upravu entit, které jsou umistény ve vyfezu rozvrzeni. Pro navrat k entitam, které
jste vytvofili na zaloZce rozvrzeni (ve vykresovém prostoru), napiSte PSPACE.

Zalozka rozvrzeni musi byt pfed pouzitim tohoto pfikazu aktivovana jednoduchym kliknutim na
pozadovanou zalozku rozvrzeni.

198. Text - odstavcovy (Paragraph text)

Ribbon Vychozi > Poznamka > Text > Odstavcovy text
Menu Kreslit > Text > Odstavcovy text

Panel nastoju Kreslit > Odstavcovy text

Klavesnice  mtext

Odstavcovy text pozlistava z jednoho nebo vicero fadkl textu nebo odstavce, ktery je zasazeny do
ramecku Sife, kterou jste urcili. S kazdou entitou odstavce textu, kterou vytvofite, se zachazi jako se
samostatnou entitou bez ohledu na mnozstvi odstavcl nebo fadku, které text obsahuje.

Kdyz vytvofite odstavec textu, musite stanovit nejprve Sitku ramecku uréenim protilehlych roh obdélniku.
Odstavec textu se automaticky pfizplsobi Sifce Vami stanoveného ramecku. Prvni roh obdélniku uréuje
vychozi bod umisténi odstavce textu. Mizete zménit bod umisténi obdélniku a mizete urcit smér,

v kterém je text v obdélniku umistény. Mdzete taky zvolit format, styl, vySku pismen a rotaéni uhel textu
nebo odstavce pro celou entitu textu.

Pro vytvoreni odstavce s textem:

1. Udélejte jedno z nasledujiciho:

- zvolte Kreslit > Text > Odstavcovy text

- v panelu nastroju Kreslit kliknéte na nastroj Odstavcovy text
- v panelu nastroju Text kliknéte na nastroj Odstavcovy text

- napiSte mtext a pak stisknéte Enter.

2. Zvolte prvni roh oblasti s textem.



3. V okné s vyzvami MTEXT zvolte viastnosti, které chcete zmeénit nebo prejdéte pfimo ke kroku 4. Tyto
vlastnosti mlzete upravit i v krocich 7 a 8.

4. Zvolte druhy roh oblasti s textem.

5. Do vzniklého okna napiste pozadovany text. Odstavce vytvofrite tak, ze stisknete Enter a pak budete
psat dal.

6. Provedte viechny volby nebo zmény, které chcete v nasledujicim:

- font, vyska pisma, nastaveni tu¢ného pisma nebo kurzivy, podtrZzeni nebo barva pisma

- nastaveni okraji na pravitku — pohybem horni Sipky vievo nastavite odsazeni prvniho Fadku textu,
pohybem spodni Sipky vlevo nastavite odsazeni odstavce a pohybem Sipky vpravo nastavite odsazeni
zprava

- tabulatory na pravitku - kliknéte na symbol pravitka pro vytvoreni tabulatoru, pohyb markeru tabulatoru
pro zménu jeho umisténi nebo odstranéni tabulatoru

Va$e volba ovlivni zvyraznény text, nebo pokud text zvyraznény neni, nastaveni se projevi v textu, ktery
budete psat dal.

7. Provedte zmény, které chcete v stylu textu, jeho zarovnani, Sifce a rotaci.

8. Kliknéte na OK.

Tip Do dialogového okna Odstavcového textu muzete kopirovat text uloZzeny ve schrance.
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New Sample Text

C—34

A. Kliknéte pro odsouhlaseni zmén a uzavreni editoru.

B. Napiste a vyberte text.

C. Kliknéte a tahejte pro zménu vertikalnich rozméra editoru.
D. Kliknéte a tahejte pro zménu horizontéalnich rozméru editoru.
E. Zobrazeni pravitka.

Nastroj Nazev Popis
UoO Podrzeni Kliknéte pro podtrzeni a/nebo nadtrzeni textu.
— a nadtrzitko
24 Ia Velka a mala Kliknéte pro zménu pismen z malych na velké nebo
pismena naopak.
Font textu Zvolte font textu.

Standard »
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Barva textu

Maska pozadi

Kosy uhel
Trasovani

Koeficient Sitky
Zarovnani

Seznam

Velikost radkl

Vychozi, vlevo, na
stfed

Vpravo, zarovnat,
distribuovat

Zpét, opakovat

Symbol

Vlozit pole

Najit a nahradit
Importovat text
AutoKAPITALKY
Pravitko

Text nad sebou

Vice

Uzavreni editoru

Zvolte BYBLOCK, BYLAYER, konkrétni barvu dle
nabidky, nebo Vybrat barvu pro mozZnost volby
z ostatnich barev.

Kliknéte pro nastaveni pozadi pro text. Pro dalsi
detaily kliknéte na otaznik a zobrazi se Vam
napovéda.

Zvolte nebo napiSte uhel textu.

Zvolte nebo napiSte koeficient pro stanoveni mezer
mezi pismeny.
Zvolte nebo napiste koeficient Sifky fontu.

Zvolte zarovnani okénka s textem.

Zvolte druh seznamu do Vaseho textu. Mizete také
specifikovat, jestli chcete pokracovat v pivodnim
seznamu nebo zacit psat novy.

Zvolte velikost radkl v textu.

Kliknéte pro nastaveni zarovnani odstavce s textem
dle vychoziho nastaveni, vlevo nebo na stfed.

Kliknéte pro nastaveni odstavce s textem - zarovnani
vpravo, zarovnat nebo distribuovat.

Kliknéte pro vraceni nebo zopakovani posledni akce.

Kliknéte pro vioZzeni symbolu na misto, kde se
v textovém editoru nachazi kurzor.

Kliknéte pro viozZeni pole na misto, kde se v textovém
editoru nachazi kurzor. Pro dalSi detaily kliknéte na
Népovédu v dialogovém okng, které se zobrazi.
Kliknéte pro nalezeni a nahrazeni textu v textovém
editoru.

Kliknéte pro zvoleni souboru, ktery obsahuje text,
ktery chcete importovat.

Kliknéte pro automatické zapnuti nebo vypnuti
velkych pismen v pribéhu psani.

Kliknéte pro zobrazeni nebo skryti pravitka v textovém
editoru.

Kliknéte pro sefazeni textu nad sebe nebo vedle
sebe, napfiklad zlomky mizete zobrazit jako text nad
sebou.

Kliknéte pro zobrazeni menu s dalSimi moznostmi,

v€etné nastaveni vlastnosti, nastaveni pro textovy
editor a online napovéda.

Akceptuje Vase zmény a uzavie editor.

Starsi verze textového editoru




Po zadani pfikazu MTEXTED a jeho hodnoty OLDEDITOR se zapne starSi verze editoru pro odstavcovy
text:

A. Zvolte prvni roh textového bloku
B. Zvolte proté&jsi roh.

Umisténi odstavce textu

Viceradkovy text: Prvni roh bloku textu: Zadejte prvni roh pro definici oblasti, kde ma byt odstavec
textu vytvoren.

zarovnat (J)/otoceni (R)/Styl/vyska (H)/Sifka (W)/<Protilehly roh bloku textu>:
Ur€ete druhy roh oblasti, kde se ma odstavcovy text objevit.

zarovnat (J — Justification) | Zména zarovnani textu.

otoCeni (R — Rotation) | Zména Uhlu natoceni.

Styl (S) | Zména stylu textu.

vySka (H - Hight) | VySka bloku textu.

Sitka (W — Width) | Zména Sifky textu.

Radkovani (SP - Spacing) | Nastaveni fadkovani textu.

Po zadani bodu vloZeni se zobrazi dialogové okno odstavcového textu.

Odstavcovy text =
Text le
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Zalozka Text

Font Zvolte font textu definovany pomoci stylu textu v Prizkumniku styl textu.

Vyska Zvolte nebo zadejte vySku textu v linearnich jednotkach vykresu.

Tuéné/Kurziva/Podtrzené Kliknéte na poZadované volby.

Zpét Vrati pfedchozi akci.

Barva Zvolte DLEBLOKU, DLEHLADINY nebo jinou barvu. Zvolte Vybrat barvy... pro vybér z dalSich
barev.

Zoom Zvolte nebo zadejte procento zvétSeni, které ur€uje velikost zobrazeni, ne samotnou velikost textu
ve vykrese.

Pravitko Pfesurite horni Sipku pro vytvofeni odsazeni prvniho fadku textu. Pfesurite spodni Sipku pro
odsazeni celého odstavce textu. Kliknéte dovnitf pravitka pro pfidani tabelator(i. Je mozné vlozit az 32
tabelatoru a tazenim ménit jejich pozici. Znacky je mozné odstranit tazenim ven z pravitka.

POZNAMKA Nastaveni tabelatort se tyka textu, ktery zvyraznite dialogovém panelu odstavcového textu.
Pokud neni vybran zadny text, ovlivni zmény novy text, ktery v dialogu napiSete.
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Zalozka Vlastnosti

Styl Zvolte jakykoli pfeddefinovany styl textu. Styly textu jsou vytvareny a spravovany v Prizkumniku stylU
textu.

Zarovnani Zvolte zpisob zarovnani pfi umisténi textu.

Sitka Zvolte nebo zadejte Sifku odstavce v linearnich jednotkach vykresu.

Otoceni Zvolte nebo zadejte uhel nato€eni odstavcového textu.

199. Viozit (Paste )

Ribbon Upravit > Upravit > Vlozit
Menu Upravit > Vlozit
Klavesnice pasteclip, sviloz

Klavesova zkratka Ctri+V

Vklada obsah schranky Windows do aktualniho vykresu.

Entity, které kopirujete z jednoho vykresu, jsou pfeneseny na stejné misto v jiném vykresu. Vlastnosti
spojené s bloky jsou také kopirovany.

Pro kopirovani textu do vaseho vykresu pouzijte pfikaz Text. MGzete také kopirovat text do pfikazového
fadku, ale text, ktery kopirujete, musi byt v syntaxi pfikazového fadku, ktery 4MCAD rozpozna.

200. Vlozit specialné (Paste Special)

Ribbon Upravit > Vlozit specialné ( v Upravit)
Menu Upravit > Vlozit specialné

Klavesnice pastespec, svlozspec

Klavesova zkratka CTRL + N

Alias PA

Umisti obsah schranky do aktivniho vykresu.

V pfipadé, ze ulozené polozky by mohli byt ulozeny do 4MCADu vicero zpusoby, program Vas vyzve,
abyste specifikovali metodu, kterou chcete pouzit.

201. Rovina (Plane)



Ribbon Kreslit > Rovina (v Kreslit)

Menu Kreslit > Rovina
Klavesnice plane
Alias SO, SOLID

Kresli rovinné polygony. Systémova proménna FILLMODE urcuje, jestli je téleso vyplnéno. Pokud
nechcete vyplnéna télesa, vypnéte FILLMODE.

obdélnik (R)/Etverec (S)/Trojuhelnik/<Prvni bod roviny>: Pro nakresleni polygonu nepravidelného
tvaru zvolte Prvni bod. Pro nakresleni obdélniku zvolte R (obdélnik). Pro nakresleni &tverce zvolte S
(Ctverec). Pro nakresleni trojuhelniku zvolte T (trojuhelnik).

TIP: Po nakresleni jednoho Utvaru muzete kreslit dal$i pomoci zvoleni druhého bodu pro ¢tverec, obdélnik
nebo trojuhelnik, nebo zvolenim tfetiho bodu pro nepravidelné tvarované polygony.

Pro kresleni utvari nepravidelného tvaru
P

el

A. Zadejte prvni bod utvaru.

B. Zadejte druhy bod.

C. Zadejte treti bod.
D. Zadejte Ctvrty bod.

V]
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Vysledek.

Zadejte prvni bod.

Zadejte druhy bod: Zadejte druhy bod.
Zadejte tfeti bod: Zadejte tfeti bod.
Zadejte Ctvrty bod: Zadejte Ctvrty bod.

Pro kresleni obdélniku
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A. Zadejte prvni bod obdélniku.
B. Zadejte protilehly vrchol obdélniku.
C. Zadejte rotacni uhel.

Vysledek.

Zvolte obdélnik (R).

Zadejte prvni bod: Zvolte prvni bod obdélniku.
Zadejte druhy bod: Zvolte protilehly vrchol obdélniku.
Pohybem mysi zvolte rotani uhel.

Pro kresleni ¢tverce
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A. Zadejte prvni bod ctverce.
B. Zadejte protilehly vrchol Ctverce.
C. Zadejte rotacni uhel.

Vysledek.

Zvolte Ctverec (S).

Zadejte prvni bod: Zvolte prvni bod &tverce.
Zadejte druhy bod: Zvolte protilehly vrchol Etverce.
Pohybem mysi zvolte rotani uhel.

Pro kresleni rovnostranného trojuhelniku
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A. Zadejte prvni vrchol trojuhelniku.
B. Zadejte treti vrchol trojuhelniku.
C. Zadejte rotacni uhel.

Vysledek.
Zadejte prvni bod : Zadejte prvni vrchol trojuhelniku.

Zadejte tfeti bod: Zadejte posledni vrchol trojuhelniku.
Pohybem mysi zvolte rotacni uhel.

202. Bod (Point)

Ribbon Kreslit > Kreslit > Bod
Menu Kreslit > Bod

Panel nastoju Kreslit > Bod
Klavesnice  point, bod

Alias PO

Kresli samostatné bodové entity.

naStaveni/vice (M)/<Umisténi bodu>:

Zadejte umisténi bodu.

Nastaveni (S — Settings) | Zména nastaveni pro bod.
Vice (M — Multiple) | Kresleni nasobnych bodu.

Zména nastaveni bodu
Zadejte NaStaveni.
Je zobrazen dialog Nastaveni vykresu s aktivni zaloZkou Vytvoreni entity.

Kresleni nasobnych bodii



Zvolte Vice (M).
NaStaveni /<Umisténi bodu>:
Zadavejte body jeden po druhém. Pro ukonceni pfikazu stisknéte Enter nebo pravé tlacitko mysi.

203. Mnohouhelnik (Polygon)

Ribbon Kreslit > Kreslit > Obdélnik > Polygon
Menu Kreslit > Polygon

Panel nastoju Kreslit > Polygon

Klavesnice  polygon

Alias POL

Kresli polygony s ur€enym poctem stran. Polygon je tvofen kfivkovou entitou. Vychozi Sitka polygonu je
uloZena v systémové proménné PLINEWID, ale mozné ji ve volbach zménit.

Polygon: nasobné (M)/Sifka ¢ary (W)/<Pocet stran> <4>:
Stisknéte Enter pro kresleni polygonu s aktualnim nastavenim poctu stran nebo zadejte novou hodnotu.
Nasobné (M — Multiple) | Kresleni vice polygona.

Sitka (W — Width) | Sitka ¢ar v polygonu

Uréete stied polygonu nebo [hrana (E)]:

Zadejte stfed polygonu

Hrana (E — Edge) | Umisténi hrany polygonu

Zadejte moznost [vepsany do kruznlce/opsany kolem kruzniCe] :
Zvolte vepsany nebo opsany polygon.

Urcete polomér kruznice:

Zadejte polomér nebo urete bod mysi.

Polygon definovany délkou strany

N
EO
\ ! a
SN P
A. Zvolte bod strany polygonu
B. Zvolte koncovy bod stran polygonu

Zvolte Hrana (E).
Prvni bod hrany: Zadejte prvni bod hrany
Druhy bod hrany: Zadejte druhy bod hrany

Kresleni nasobnych polygon

Zvolte Nasobné (M).

Polygon: Sifka ¢ary (W)/<Pocet stran> <4>:

Stisknéte Enter pro kresleni polygonu s aktualnim nastavenim poctu stran nebo zadejte novou hodnotu.
Sitka (W — Width) | Sitka ¢ar v polygonu

Urcete stied polygonu nebo [hrana (E)]:

Zadejte stfed polygonu pro definici pomoci vzdalenosti od stfedu k vrcholu.

Hrana (E — Edge) | Umisténi hrany polygonu

Stied polygonu:

Pokracujte kreslenim identickych polygonu zadavanim stfedového bodu kazdého z nich. Pro ukon&eni
pfikazu stisknéte Enter.

Uréeni Sifky ¢ar



Zvolte Sitka (W).

Sirka kfivky <0.0000> :

Stisknéte Enter pro pfijeti aktualni hodnoty nebo zadejte hodnotu novou a pokracujte v kresleni dle voleb
pfikazu.

204. Polygonova sit’ (Polygon Mesh)

Ribbon Kreslit 3D > Kresli 3D sité > Sit’ > Polygonova sit’

Menu Kreslit > Plochy > Polygonova sit’
Klavesnice mesh, sit’
Alias 3DMESH

Vytvari 3D sit slozenou z polygonu. Zadate jeji velikost (pomoci primarnich a sekundarnich os) a umisténi
kazdého vrcholu.

=

A. Mnozstvi vrchold podél primarni osy sité, M-smér sité.
B. Mnozstvi vrchol( podél sekundarni osy sité, N-smér sité.

Sit’ je definovana umisténim vrcholl podél primarni a sekundarni osy (M a N; v tomhle poradi), po¢inajic
vrcholem se soufadnicemi 0,0. Definujte soufadnice pro kazdy vrchol v fadé M dfiv, nez budete definovat
soufadnice v fadé M + 1, a tak dale. Polygonova sit je ve vychozim nastaveni z jedné strany oteviena,
muzete ji ale uzavfit pomoci pfikazu Editace kfivky (Modifikace > Objekt > KFivka).

Pro vytvoieni polygonové sité

Pocet vrcholtl podél primarni osy sité (od 2 do 256): Zadejte mnozstvi vrcholt podél M-sméru sité.

Vrcholy podél sekundarni osy sité (od 2 do 256): Zadejte mnozstvi vrcholl podél N-sméru sité.

Vrchol (1,1): Zadeite prvni vrchol. Cislo v zavorkach znamena, Ze tento bod je prvnim vrcholem na
primarni ose sité a prvnim vrcholem na sekundarni ose sité.

Vrchol (1,2): Zadejte dal$i vrchol. Cislo v zavorkach znamen4, Ze tento bod je prvnim vrcholem na
primarni ose sité a druhym vrcholem na sekundarni ose sité.

Vrchol (2,1): Zadeijte dal$i vrchol. Cislo v zavorkach znamena, Ze tento bod je druhym vrcholem na
primarni ose sité a prvnim vrcholem na sekundarni ose sité.

Program bude vypisovat vyzvy pro zadani dalSich vrchold, dokud nezadate vSechny vrcholy na primarni
i sekundarni ose.

205. Polygonalni oramovani textu (Polygonal text border)



Klavesnice polgtxt

Oramuje zvoleny text do polygonu. Pocet stran je pfedem urcen.

206. Krivka (Polyline)

Ribbon Vychozi > Kreslit > Useéka > Kivka
Menu Kreslit > Kfivka

Panel nastoju Kreslit > Kfivka

Klavesnice  polyline, kfivka

Alias PL, PLINE

Kresli dvourozmérné kfivky (spojené rovné a obloukové segmenty) s volitelnou $ifkou a zdzenim.

NNV NAN

Priklady rdznych typl kfivek. Zuzujici se kfivka, kfivka se zvétSujici se Sifkou a uzaviena kfivka.

Pocatek kfivky: Zvolte pocatecni bod kfivky.

oblouk (A)/vzDéalenost/pokracovat (F)/poloviéni Sifka (H)/Sifka (W)/<DalSi bod>:
Zvolte dalSi bod kFivky.

Oblouk (pismeno A z angl. Arc) | Kresleni obloukového segmentu

Vzdalenost (D — Distance) | Ureni délky dalSiho segmentu kfivky

Podle (F — Follow) | PokraCovani kfivky ve sméru posledni nakreslené entity
Polovi¢ni Sifka (H — Halfwidth) | Ur€eni polovi¢ni Sifky dalSich segmentl kfivky
Sitka (W — Width) | Urgeni itky dal$ich segment(i kfivky

Pokracuijte v kresleni segmentu kfivky zadavanim bodl nebo voleb v pfikazovém fadku. Pfikaz ukongite
stisknutim klavesy Enter.

Pokud jste dfive kreslili entitu, objevi se nasledujici volby:

Klavesou ENTER pouzijete posledni bod/podle (F)/<Poéatek kfivky>:
Zadejte pocatecni bod kfivky.

Pro pouziti posledniho bodu stisknéte Enter.

Pro pokracovani kfivky ve sméru posledni nakreslené entity zvolte Podle (F).

oblouk (A)/vzDalenost/pokracovat (F)/poloviéni Sifka (H)/Sifka (W)/<DalSi bod>:
Zvolte dalSi bod kfivky.

Oblouk (pismeno A z angl. Arc) | Kresleni obloukového segmentu

vzDalenost | Ur€eni délky dalSiho segmentu kfivky

PokraCovat (F — Follow) | PokraCovani kfivky ve sméru posledni nakreslené entity
Polovi¢ni Sifka (H — Halfwidth) | Ur€eni polovi¢ni Sifky dalSich segmentl kfivky
Sitka (W — Width) | Uréeni itky dalSich segmentd kFivky

Pokracujte v kresleni segmentu kfivky zadavanim bodud nebo voleb v pfikazovém Fadku. Piikaz ukoncite
stisknutim klavesy Enter.

TIP Pro kresleni kfivky rovné-oblouk-rovné nakreslete nejprve rovny segment. Zvolte Oblouk (A) pro
kresleni z koncového bodu rovného segmentu. Pak zvolte Usecka (L) pro kresleni rovhého segmentu od
koncového bodu oblouku.



Obloukovy segment kiivky

¢

A. Zvolte prvni bod segmentu kFivky
B. Zvolte druhy bod a ve volbach zvolte Oblouk (A).
C. Zvolte koncovy bod oblouku.

Zvolte Oblouk (A).
uhel (A)/stred (CE)/zavrit (CL)/smér (D)/polovi¢éni_sirka (H)/usec¢ka (L)/poloméR/druhy bod (S)/Sifka
(W)/zpét (U)/<Konec oblouku>:

Pro kresleni oblouku vychozi metodou zadejte koncovy bod oblouku.
Uhel (A — z angl. Angle) | Zadani Ghlu oblouku

Zavfit (CL — CLose) | Uzavieni kfivky

Stifed (CE — CEnter) | Kresleni oblouku s uréenym stfedovym bodem
Smér (D — Direction) | Kresleni oblouku v uréeném sméru

Polovi¢ni Sifka (H) | Ur€eni poloviny Sifky oblouku

Usecka (L — Line) | Zména na rovny segment kFivky

Polomér (R — Radius) | Zadani poloméru oblouku

Druhy bod (S — Secondpt) | Kresleni oblouku pomoci metody tfi bodt
Sitka (W) | Uréeni $itky oblouku

Zadani uhlu oblouku

Zvolte Uhel (A).

Stfedovy Uhel oblouku | Zvolte bod nebo zadejte €iselnou hodnotu Uhlu
Stied (C)/Polomér (R)/<Koncovy bod>:

Zvolte koncovy bod oblouku.

Stied (C) | Zadejte stfed oblouku

Polomér (R) | Zadejte polomér oblouku

Kresleni oblouku s uréenim stifedového bodu
Zvolte Stred (C).

Stfedovy bod | Zadejte stfedovy bod oblouku.
Uhel (A)/Délka (L)/<Konec oblouku>:

Zadejte koncovy bod oblouku

Uhel (A) | Urgete uhel oblouku

Délka (L) | Zadani délky tétivy

Kresleni oblouku zadanim jeho sméru

Zvolte Smér (D).

Smér od pocatku | Zadejte smér kurzorem s kliknutim mysi
Konec oblouku | Zvolte koncovy bod oblouku

Kresleni oblouku se zadanim poloméru

Zvolte Polomér (R).

Polomér | Zadejte polomér Ciselnou hodnotou nebo zadanim dvou bodu
Uhel (A)/<Konec oblouku>:

Zvolte bod pro ukon&eni oblouku.

Uhel (A) | Ur&eni thlu oblouku.

Kresleni oblouku s metodou tfi bod
Zvolte Druhy bod (S).

Druhy bod | Zadejte druhy bod oblouku
Konec oblouku | Zadejte koncovy bod oblouku



Zadani polovi¢ni Sifrky nebo Sifky oblouku

Zvolte Poloviéni §itku (H) nebo Sitku (W).

Pocate€ni polovi¢ni Sifka [Sifka] <0.0000>:

Zadejte poc¢atecni polovi¢ni Sitku nebo Sitku ¢iselnou hodnotou nebo volbou dvou bod.
Koncova polovi¢ni Sifka [Sifka] <0.5.000>:

Zadejte koncovou polovi¢ni Sifku nebo Sitku €iselnou hodnotou nebo volbou dvou boda.

Zadani polovi€ni Sifky nebo Sifky segmentu kiivky

Iy
_— B

A. Polovicni Sitka segmentu kfivky
B. Sifka segmentu kfivky

Zvolte Poloviéni $itka (H) nebo Sitka (W).

Pocate€ni polovicni Sifka [Sifka] <0.0000>:

Zadejte poc¢atecni polovi¢ni Sitku nebo Sitku ¢iselnou hodnotou nebo volbou dvou bod.
Koncova polovi¢ni Sifka [Sifka] <0.5.000>:

Zadejte koncovou polovi¢ni Sifku nebo Sitku ¢iselnou hodnotou nebo volbou dvou bodu.

TIP Pro zuZovani segmentu kfivky zadejte rozdilnou po&ate¢ni a koncovou Sifku.
Zadani délky segmentu kfivky

Zvolte Délka (L).
Délka ¢ary | Zadejte délku segmentu kfivky €iselnou hodnotou nebo volbou dvou bodu.

207. Nahled tisku (Print Preview)

Ribbon Horni lista > Tisk > Nahled tisku
Menu Soubor > Nahled tisku

Panel nastoju Standard > Nahled tisku
Klavesnice  ppreview

Alias MAKEPREVIEW, PRE, PREVIEW

Zobrazi dialogové okno Nahled tisku, takze si mlzete prohlédnout aktualni vykres dfive, nez jej
vytisknete.

208. Styl vykreslovani (Print Style)

Klavesnice printstyle
Alias PLOTSTYLE

Nastavi aktualni styl tisku pro nové entity nebo zméni styl tisku pro zvolené entity. Pfi volbé pfikazu se
objevi jedno z nasledujicich dialogovych oken podle toho, jestli jste entity zvolili pfed nebo po zvoleni
pfikazu Styl vykreslovani.

Dialogové okno Aktualni styl tisku (pokud jste zatim nezvolili entity pro Upravu)



Dialogové okno Zvolte styl tisku (pokud jste entity pro Upravu zvolili pfed zadanim pf¥ikazu)

Pfikaz Styl vykreslovani se pouziva pro vykresy, které pouzivaji pojmenované tabulky stylu tisku. Vykresy,
které pouzivaiji tabulky barevnych stylu tisku maji pozadavky tisku zavislé od barvy pfifazené entité nebo
hladiné.

209. Historie Vyzev (Prompt History Window)

Ribbon Pohled > Zobrazeni > Pfikazovy fadek
Menu Zobrazit > Zobrazit > Textové okno
Klavesnice pmthist

Klavesova zkratka F2

Zobrazuje historii poslednich pfikazd od spusténi stavajiciho vykresu. Pfikaz je pfedevSim pouzivan
v skriptech a menu.

210. Vlastnosti (Properties)

Ribbon Pohled > Zobrazeni > Vlastnosti

Menu Modifikace > Vlastnosti
Klavesnice entprop
Alias Al_PROPCHK, CH, DDCHPROP, DDEDIT, DDMODIFY, ED, MO, MTPROP

Zobrazi panel vlastnosti, ve kterém mUzete upravit mnozstvi vlastnosti jedné nebo vicero entit. Vlastnosti
zvolenych entit, které mizete zménit, jsou hladina, tloustka, typ ¢ary, barva, méfitko typu ¢ary, tloustka
¢ary, styl tisku, pokud pouzivate pojmenované tabulky stylu tisku a nékteré dalsi specifické vlastnosti.

Pokud jste zvolili entity pro upravu, panel se objevi ihned. Pokud jste entity jeSté nezvolili, objevi se
v pfikazovém fadku nasledujici vyzva:

Zvolte entity pro modifikaci: Vyberte entity, které chcete modifikovat. Zobrazi se panel viastnosti.

Pokud jste zvolili vice, nez jednu entitu, kterou chcete upravit a tyto entity maji rdzné vlastnosti (napfiklad
riznou hladinu), aktualni hodnota vlastnosti, které jste vybrali bude "rizné". Pokud zménite vlastnosti
vicero entit, v8echny entity ve zvolené sadé se zméni.

Obecné

Barva Zadejte novou barvu. Hodnotu barvy mlzete vybrat ze standardni palety Windows (1-255), 0 pro
podle hladiny, 256 pro podle bloku, nebo muizete vlozit nazev jedné ze standardnich pojmenovanych
barev (red, yellow, green, cyan, blue, magenta, and white), nebo zvolit moznosti podle hladiny nebo podle
bloku.

Pro True color zadejte hodnotu RGB barvy, kterou chcete. RGB hodnoty jsou Cervena, zelena a modra
vyjadrené Ciselnou hodnotou a oddélené ¢arkami, napfiklad 15,105,210 .

Pro knihovnu barev zadejte nazev Vami vybrané knihovny. Tento se vklada ve formatu .acb s vyuZitim
XML tagu <bookName> a </bookName>. Knihovny barev musi byt umisténé ve slozce, odkud ma 4MCAD
nastavené vyhledavani knihoven barev. Ve vychozim nastaveni jsou uloZeny ve stejné slozce, kde se
nachazi i instalace 4MCAD. Pro ovéfeni umisténi slozky zvolte Moznosti z menu Nastroje, kliknéte na



zalozku Cesty/soubory a najdéte slozku knihoven v seznamu cest. Zadejte nazev pozadované barvy,
ktera se nachazi v pojmenované knihovné barev.

Hladina Zvolte nazev hladiny, ke které chcete pfifadit zvolené entity.

Typ €ary Zvolte nazev nového typu €ary. Pokud typ Cary, které jste vybrali, je$té neni nahrany, program
se pokusi ho nahrat z icad.lin. Pokud program nebude schopen lokalizovat pozadovany typ ¢ary v tomto
souboru, pouzijte Spravce typu ¢ar pro nahrani souboru s typem &ary.

Méritko typu ¢ary Pro pfijeti vychoziho nastaveni 1.0000, stisknéte Enter, nebo vlozte nové méfitko.

Styl tisku Pro pfijeti vychozi volby podle hladiny stisknéte Enter, nebo zadejte nazev nového stylu tisku.
Vlozte ? pro prohlédnuti dostupnych styld tisku.

Tloust'ka ¢ary Pro pfijeti vychozi hodnoty -1 stisknéte Enter, nebo zadejte novou tloustku &ary.
Tloustka Zména tloustky 2D entit méni jejich rozmér na ose Z.

Material Zadejte novy material, ktery chcete pfipsat vybranym entitam.

211. Cistit (Purge)

Ribbon Tlacitko aplikace > Nastaveni kresleni... > Vyg¢istit
Menu Soubor > Nastroje vykresu > Vyg¢istit

Klavesnice purge, Cisti

Klavesova zkratka _purge

Alias PU

Vygisti soubor vykresu od nepouzivanych prvkd. Pouzitim "Cistit" odeberete bloky, hladiny, typy &ar, styly
tisku, textu a kot, které mate definovany, ale nejsou pouzity ve vykrese. VycCisténim vykresu zmensite jeho
datovou velikost.

Typy Car jsou vyciStény pouze ve vykrese; definice v souboru icad.lin zdstanou zachovany.

Volby dialogu



B Vycistit X
Objekty vykresu
(@ Zobrazit polozky. které Ize vy&istt
(O Zobrazit polozky. které nelze vy&istit

PoloZky. které nejsou poulity ve vykresu
- D Viechny poloZky
+- 58 Bloky
4 Kétovaci styly

!ﬁ Skupiny

+ ~:?3 Hiadiny
§ == Typy Car
| @ Styly tisku
;-. Tvary
- By Styly textu
‘ .£ Styly Méar
+ G Registrované aplikace
- & styly mutiodkazi

[[] Potvrdit kazdou &isténou polozku

Cistit vnofené polozky

Nevykresové prvky

Aut ky Eistit ené prvky

o wenn | vy

Zobrazit polozky, které lze vycistit
Zobrazit polozky, které nelze vycistit
Seznam polozek na obrazovce zavisi na vasi volbé.

Potvrdit kazdou ¢iSténou polozku:
Zvolte zobrazeni potvrzeni pfikazu pfedtim, nez je poloZzka smazana nebo volbu zruste.

Vyg¢istit vnofené polozky - pouZijte, pokud vykres obsahuje vnofené bloky a vy chcete vycistit vSechny
urovné najednou.

Automaticky Cistit osamocene prvky
Cisténi Spatné importovanych dat z DGN podkladu.

Vygéistit: Kliknéte pro ¢isténi vybranych polozek.
Vycistit vSe: Kliknéte pro Cisténi vSech nepouzivanych polozek.

212. Jehlan (Pyramid)

Ribbon Kreslit 3D > Kresli 3D télesa > Jehlan
Menu Kreslit > Télesa >Jehlan
Klavesnice pyramid, jehlan



Alias Al_PYRAMID

Kresli jehlan jako pevné téleso.
Pro kresleni jehlanu pomoci stifedu zakladny

Zadejte stiredovy bod zakladny nebo [hrana (E)/Strany]: Zadejte stfedovy bod zakladny jehlanu.
Zadejte zakladni polomér nebo [vepsana (I)]: Zadejte polomér z&kladny, nebo vlozte bod. Pro
nakresleni jehlanu uvnitf zakladny, zvolte | (vepsana), ve vychozim nastaveni se zakladna jehlanu
nakresli kolem zadané zakladny (jako opsand).

Zadejte vysku nebo [2body (2P)/koncovy bod osy (A)/horni povrch (T)]: Zadejte vySku jehlanu. Pro
stanoveni jeji vySky zadanim dvou bodl vyberte 2P (2 body), nasledné zadejte prvni a druhy bod. Pro
stanoveni bodu, ktery urCuje jeji vySku a orientaci jehlanu zvolte A (koncovy bod osy), pak zadejte bod.
Pro stanoveni vysky jehlanu uréenim bodu horniho povrchu zvolte T (horni povrch), nasledné zadejte bod.

Pro kresleni jehlanu zadanim hrany zakladny

Zadejte stiredovy bod zakladny nebo [hrana (E)/Strany]: Zvolte E (hrana).

Prvni bod zakladny jehlanu: Zadejte prvni bod hrany zékladny jehlanu.

Zadejte druhy bod: Zadejte druhy bod hrany zakladny jehlanu.

Zadejte vysku nebo [2body (2P)/koncovy bod osy (A)/horni povrch (T)]: Zadejte vySku jehlanu. Pro
stanoveni jeji vySky zadanim dvou bodl vyberte 2P (2 body), nasledné zadejte prvni a druhy bod. Pro
stanoveni bodu, ktery urCuje jeji vySku a orientaci jehlanu zvolte A (koncovy bod osy), pak zadejte bod.
Pro stanoveni vysky jehlanu uréenim bodu horniho povrchu zvolte T (horni povrch), nasledné zadejte bod.

Pro kresleni jehlanu stanovenim po¢tu stran jehlanu

Zadejte stiedovy bod zakladny nebo [hrana (E)/Strany]: Zvolte S (strana).
Zadejte pocet stran <4>: Vlozte pocet stran jehlanu.

213. Rychly text (Quick Text)

Klavesnice qtext, ptext
Alias QT

Zapne nebo vypne Rychly text. Pokud je Rychly text zapnuty, text je zobrazovan jako ramecky, ne jako
pismena nebo slova. Tento pfikaz umozni zrychlit procesy pfi praci s obrazky, které obsahuji hodné textu.

Ut wisi enim ad minim [ ]

—u.oo:—l —:1:1
@) [ @] n—

Priklad vykresu s vypnutym a zapnutym rychlym textem.

214. Polopfrimka (Ray)



Ribbon Vychozi > Kreslit > Useéka > Polopfimka
Menu Kreslit > Polopfimka

Panel nastoju Kreslit > Polopfimka

Klavesnice ray, polopfimka

Kresli linii nekone&nou v jednom sméru z nebo skrze uréeny bod.

Gy o=t

A. Zadejte pocate€ni bod polopfimky
B. Zadejte smér polopfimky

Nekoneéna primka: Délici (B)/Horizontalni/Vertikalni/Uhel (A)/Rovnobézna (0)/<Zaéatek
polopfimky>:

Pro kresleni polopfimky pomoci bodu a sméru zadejte pocatecni bod polopfimky.

Deélici (B — Bisect) | Polopfimka délici bod nebo entitu

Horizontalni (H) | Polopfimka v horizontalnim sméru

Vertikalni (V) | Polopfimka ve vertikalnim sméru

Uhel (A — Angle) | Zadani uhlu polopFimky

Rovnobézna (O) | Rovnobézna k jiné entité

Smér:

Urcete smér, ve kterém chcete polopfimku vytvofit.

Smér:

Urcete smér, ve kterém chcete vytvorit dalsi polopfimku. Druha polopfimka je vytvofena ze stejného
pocate¢niho bodu jako prvni. Mlzete pokracovat v zadavani sméra pro dalSi polopfimky. Pro ukon&eni
kresleni kliknéte pravym tlacitkem mysi nebo stisknéte Esc.

Polopiimka délici bod nebo entitu
i C
™

N
A)\\‘/—B

A. Zvolte bod pro déleni.
B. Urc€ete pocatek déliciho Uhlu.
C.Urcete konec déliciho uhlu.

Zadejte Polovina (B).
Entita/<Vrchol>:

Zvolte vrchol polopfimky.

Entita (E) | Volba entity pro déleni.
Pocateéni bod plileného uhlu:
Zadejte prvni bod uhlu.

Koncovy bod ptileného uhlu:
Zadejte druhy bod uhlu.

Volba entity pro déleni

Zadejte Entita (E).

Vyberte usecku, oblouk, nebo segment krivky, ktera se ma rozdélit:

Vyberte entitu pro déleni. Je mozZné délit pouze Usecky, oblouky nebo kfivky.

Vyberte stranu pro ptleni polopfimkou:

Zvolte stranu, kam chcete polopfimku vytvofit. Polopfimka je vytvofena kolmo k entité. Mizete pokracovat



vybérem dalSich entit pro puleni.

Vodorovna polopfimka
"3
—_—
A. Zadejte pocate€ni bod polopfimky

Zadejte Horizontalni (H).

Umisténi:

Zadejte poc¢atecni bod (na levé strang) horizontalni polopfimky.

Umisténi:

Urcete pocatecni bod dalSi horizontalni polopfimky. Muzete pokracovat ve vytvafenim vodorovnych
polopfimek zadavanim dalSich bodl. Pro ukongeni kliknéte pravym tlacitkem mysi nebo stisknéte Enter.

Svisla polopfimka

A I
-
A. Zadejte pocatecni bod polopfimky.

Umisténi:

Zadejte pocatecni bod (spodni) vertikalni polopfimky.

Umisténi:

Zadejte poc¢atecni bod dalsi vertikalni polopfimky. Mizete pokracovat ve vytvarenim svislych polopfimek
zadavanim dalSich bodl. Pro ukonceni kliknéte pravym tlacitkem mysSi nebo stisknéte Enter.

Kresleni polopfimky zadanim uhlu
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A. Zadejte poc€ate¢ni bod polopfimky a uhel.

Zadejte Uhel (A).

Reference/<Zadejte uhel (0)>:

Stisknéte Enter pro pfijeti vychozi hodnoty nebo zadejte hodnotu novou.

Reference (R) | Zadani entity jako referenéniho bodu.

Umisténi:

Zadejte pocatecni bod polopfimky.

Umisténi:

Urcete pocatecni bod dalSi polopfimky. Mizete pokraCovat zadavanim pocate€nich bodl dalSich
polopfimek. Pro ukonc€eni kresleni stisknéte pravé tlacitko mysi nebo klavesu Esc.

Kresleni polopfimky s vyuzitim entity jako reference pro uhel

A. Zvolte referencni entitu.
B. Zadejte pocatecni bod polopfimky a urcete uhel.



Zadejte Reference (R).

Vyberte referenéni entitu:

Zvolte entitu, kterou chcete pouzit jako referenni bod pro uhel.

Zadejte uhel:

Zadejte uhel pro kresleni polopfimky, méfeno od referenéniho bodu ve sméru definovaném jako kladny
v nastaveni programu.

Polopfimka rovnobézna s jinou entitou

2
/T—A-
A. Zvolte entitu pro uréeni sméru
B. Zvolte stranu polopfimky.

Zadejte Rovnobézna (P).

Skrz bod (T)/<Velikost odsazeni rovhobézné primky> (Skrz):

Enter pro pfijeti vychozi hodnoty. Zadejte jinou hodnotu pro ur€eni pfesné vzdalenosti.
Skrz bod (T — Through point) | Ur€eni bodu polopfimky.

Vyberte entitu pro rovnobéznou pfrimku:

Zvolte entitu, ke které ma byt polopfimka rovnobézna.

Strana pro rovnobéznou primku:

Strana, kde ma byt rovnob&zna polopfimka vytvorena.

Volba Skrz bod

Zadejte Skrz bod (T).

Vyberte entitu pro rovhobéznou pfimku:

Zvolte entitu, ke které ma byt polopfimka rovnobézna.
Skrz bod:

Zadejte bod polopfimky.

215. Obdélnik (Rectangle)

Ribbon Kreslit > Kreslit > Obdélnik > Obdélnik
Menu Kreslit > Obdélnik

Panel nastoju Kreslit > Obdélnik

Klavesnice rectangle, obd

Alias REC, RECT, RECTANG

Kresli obdélnik. Obdélnik je kfivkova entita.

A. Zvolte prvni roh obdélniku
B. Zvolte druhy roh obdélniku

zkoseni (C)/Elevace/zaobleni (F)/oto€eni (R)/Etverec (S)/Tloust'ka/Sirka (W)/<Vyberte prvni roh
obdélniku>:
Zkoseni (C — Chamfer) | Nastavi zkoseni roh(



Elevace | Vertikalni umisténi obdélniku

Zaobleni (F — Fillet) | Nastavi zaobleni roh(

Pro kresleni obdélniku vychozi metodou, zadejte bod prvniho rohu.
Otogeni (R — Rotated) | Uhel otogeni

Ctverec (S — Square) | Kresleni &tverce (v8echny strany budou shodné)
Tloustka (T) | Dvojity obdélnik dle zadané tloustky.

Sitka (W — Width) | Tloustka &ary

Druhy roh obdélniku: Zvolte prot&jSi roh obdélniku.

Obdélnik se skosenymi rohy

T )

A. Zadejte prvni rozmér zkoseni
B. Zadejte druhy rozmér zkoseni

-

Zvolte Zkoseni (C).

Vychozi (D)/Vzdalenost prvniho zkoseni pro vSechny obdélniky <0.0000> :

Zadejte prvni rozmér zkoseni nebo zvolte prvni bod pro uréeni rozméru. Volbou Vychozi (D — Default)
vyuzijete vychozi nastaveni z dialogového okna Nastaveni vykresu...

Druhy bod:

Zadejte druhy bod pro rozmér zkoseni.

Vzdalenost druhého zkoseni pro vSechny obdélniky <0.5> :

Zadejte rozmér nebo zvolte prvni bod .

Druhy bod:

Zadejte druhy bod pro rozmér zkoseni.

POZNAMKA Rozmér uréeny jako prvni rozmér zkoseni je uloZen v systémové proménné
CHAMFERA. Rozmér ur€eny jako druhy rozmér zkoseni je uloZen v systémové proménné
CHAMFERB. Pro kresleni obdélnikl bez zkoseni, nastavte tyto hodnoty jak nulové.

Uréeni elevace obdélniku
Zadejte Elevace (E).
Elevace pro vSechny obdélniky: Zadejte Uroven elevace (vertikalniho umisténi).

Obdélnik se zaoblenymi rohy

S
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A. Zadejte velikost zaobleni

Zvolte Zaobleni (F).
Vzdalenost zaobleni pro vSechny obdélniky <0.0000>:
Zadejte velikost zaobleni.

POZNAMKA Pouzita velikost zaobleni je pouZita pro véechny dal$i nakreslené obdélniky. Pro zménu
velikosti zaobleni zadejte znova volbu Zaobleni (F) a vloZte novou hodnotu.

Uréeni uhlu otoéeni obdélniku
Zvolte Otoceni (R).
zkoseni (C)/Elevace/zaobleni (F)/otoceni (R)/ctverec (S)/Tloust'ka/Sirka (W)/<Vyberte prvni roh



obdélniku>:

Zadejte bod pro prvni roh.

Dalsi roh obdélniku:

Zadejte protéjsi roh obdeéniku.

Uhel otoc¢eni obdélniku <0.0000>:
Zvolte Uhel otoceni obdélniku.

Ctverec

A. Zadejte prvni roh ¢tverce
B. Zadejte druhy roh &tverce. Pfi zadavani druhého bodu, mazete urcit i otoCeni.

Zadejte Ctverec (S).

zkoseni (C)/Elevace/zaobleni (F)/otoceny (R)/Tloust'ka/Sirka (W)/:
Zadejte bod pro prvni roh.

Druhy roh étverce:

Zadejte dalsi roh ¢tverce.

Sitka éar

Zadejte Sitka (W).

Sitka pro vSechny obdélniky:

Zadejte tloustku €ar a stisknéte Enter.

zkoseni (C)/Elevace/zaobleni (F)/otoceni (R)/Etverec (S)/Tloust'kal/Sirka (W)/:
Zadejte prvni roh obdélniku nebo zvolte nékterou dalsi volbu.

DalSi roh obdélniku:

Zadejte druhy roh obdélniku.

POZNAMKA Zadana $itka &ar je pouZita pro v8echny dal$i obdéiniky. Pro zménu $itky opakujte tuto
volbu a zadejte novou hodnotu.

216. Prekresli (Redraw)

Ribbon Pohled > Navigovat > Prekreslit > Piekreslit

Menu Zobrazit > Prekreslit
Klavesnice redraw, piekr
Alias R

Aktualizuje zobrazeni, pfi¢emz eliminuje vSechny pfebyteéné znacky, nebo pomocné ¢ary k upravovanym
entitam, které zudstali na obrazovce.

SINRAIN

X

Pred a po pouZiti pfikazu.




217. Prekreslit vSe (Redraw All)

Ribbon Pohled > Navigovat > Prekreslit > Piekreslit vSe
Klavesnice redrawall, prekrv
Alias RA

Aktualizuje vSechny vyfezy a odstrani znacky nebo pomocné &ary z upravovanych entit, které zustali
viditeIné na obrazovce.

& |
LINRUEIN

Pred a po pouZiti pfikazu.

218. Regenerovat (Regen)

Ribbon Pohled > Navigovat > Piekreslit > Regenerovat

Menu Zobrazit > Regenerovat
Klavesnice regen
Alias RE

Regeneruje nebo reprodukuje aktualni vyfez a pfepocitava umisténi vSech entit na obrazovce.

O NIRVN

X

Pred pouZzitim prikazu a po ném.

219. Regenerovat vse (Regen All)

Ribbon Pohled > Navigovat > Prekreslit > Regenerovat vSe

Menu Zobrazit > Regenerovat vse
Klavesnice regenall, regenv
Alias REA

Regeneruje nebo reprodukuje aktualni nahledy a prepocitava umisténi viech entit na obrazovce.



& | I
LINRVEIN

Pred a po regeneraci

220. Prejmenovat (Rename)

Ribbon Kreslit > Nastaveni > Pfejmenovat

Menu Format > Pfrejmenovat
Klavesnice rename, piejmen
Alias -REN

Pfejmenuje: Blok * Koétovaci Styl * Hladinu * Typ &ary * Styl * Styl tabulky * UZivatelsky soufadny systém *
Pohled * Vyfez

Prejmenovat: Blok/kotstyl (D)/hLAdina/typ ¢ary(LT)/Styl/sTyl tabulky/Uss/pohled (VI)/vyrez (VP):
Pro pfejmenovani bloku zvolte B (blok). Pro pfejmenovani kétovaciho stylu zvolte D (kotstyl). Pro
pFejmenovani hladiny zvolte LA (hladina). Pro pfejmenovani typu ¢ary zvolte LT (typ €ary). Pro
pFejmenovani stylu zvolte S (styl). Pro pfejmenovani stylu tabulky zvolte T (styl tabulky). Pro pfejmenovani
uzivatelského souradného systému zvolte U (USS). Pro pfejmenovani pohledu zvolte VI (pohled). Pro
prejmenovani vyfezu zvolte VP (vyfez).

Zadejte novy nazev zvolené polozky.

TIP MnoZstvi téchto poloZek je mozné prejmenovat v ramci Privodce 4MCAD.

221. Nahradit (Replace text)

Klavesnice treplace

Umoziuje nahradit text jinym textem.

FILtr/<Vyberte entity>:

Mysi vyberte textove entity, které chcete pfepsat a stisknéte Enter.
Zadejte text pro nahrazeni :

Zadejte text, kterym chcete nahradit text, ktery jste oznacili. Stisknéte Enter.




222. Otocit (Rotate)

Ribbon Upravit > Upravit > Otocit > Otocit
Menu Modifikace > Otogit

Panel nastoju Modifikace > Otogcit

Klavesnice rotate, otoé

Alias RO

Otaci existujici entity kolem uréeného bodu.

o

A

L Lt s

A. Vyberte entity pro otaceni.
B. Zvolte zakladni bod.
C. Zadejte uhel otoCeni

Vyberte entity pro oto¢eni: Zvolte entity, které se budou otacet.

Bod oto€eni: Urcete bod, kolem kterého bude otoceni probihat.

Zakladni uhel (B)/<Uhel otoéeni>:

Zadejte Ciselnou hodnotu Uhlu otoceni.

Zakladni uhel (B — Base angle) | MoZnost zadani hodnoty oto€eni pomoci zékladniho uhlu.

Uréeni zakladniho uhlu

Zvolte Zakladni uhel (B — Base angle)

Zakladni uhel <0>: Zadejte zakladni uhel entity. Je to moZné napfiklad tim, Ze na obrazovce zvolite dva
body — prvni v bodé ota€eni a druhy na entité.

Novy uhel: Zadejte novy uhel. Kliknéte na bod, kam ma byt zvoleny bod na entité otocen.

Rotace kopii entit
Zvolte kopirovat.
kopirovat (C)/zakladni uhel (B)/<uhel oto€eni (R)>: Zadejte Uhel rotace, vychozi nastaveni.

223. Spustit skript (Run Script)

Ribbon Nastroje > Aplikace> Spustit skript

Menu Nastroje > Nahrat akce > Spustit skript
Klavesnice script, demo
Alias SCR

Zobrazi dialogové okno Spustit skript, abyste mohli vyhledat a spustit skript pfikazového fadku.

224. Ulozit (Save)

Ribbon Tlacitko aplikace > Ulozit



Menu Soubor > Ulozit

Panel nastoju Standard > Ulozit
Klavesnice save, uloz
Klavesova zkratka Ctrl+S

Alias SA

Zobrazi dialogové okno "UlozZit vykres jako", ve kterém lze uloZit aktualni vykres.

Muzete ulozit vykres se stavajicim nazvem, nebo jej pfejmenovat a ulozit s jinym nazvem.

Pokud jste aktualni vykres jiz ulozili a opét zadate "Ulozit", vykres a jeho zmény se ulozi bez dotazovani
na jméno a cestu souboru. Pro pfeuloZeni vykresu pod jinym nazvem pouzijte volbu "Ulozit jako".

225. Ulozit vse (Save All)

Klavesnice saveall

Uklada vSechny oteviené vykresy. Pokud jste pfedtim vykres neukladali, zobrazi se vam okno pro Ulozit
vykres jako... .

226. Ulozit jako... (Save as)

Ribbon Tlacitko aplikace > Ulozit jako
Menu Upravit > Ulozit jako...
Klavesnice saveas, ulozjako

Zobrazi dialogové okno Ulozit vykres jako..., takze mizete ulozit aktualni vykres. Mizete ukladat pod jiz
existujicim nazvem, nebo vykres mlzete pfejmenovat a ulozit pod jinym jménem.

V seznamu Ulozit jako typ:, mizete vybrat jakykoli z téchto formatu:

e Standardni vykresové soubory s pfiponou .dwg. Muzete si vybrat .dwg format souboru, ktery je
kompatibilni s rGznymi verzemi AutoCADu

e Vykresovy soubor v Exchange formatu s pfiponou .dxf. Muzete si vybrat .dxf format souboru,
ktery kompatibilni s riznymi verzemi AutoCADu.

e Sablony pro kresleni s pfiponou DWG. Sablony pro kresleni umoZfuji snadno vytvaret nové
vykresy, které znovu pouzZije vade nastaveni a entity vykresu.

227. Ulozit blok na disk (Save Block to Disk)

Ribbon Vlozit > Definice Bloku > Vytvofit blok > Ulozit blok na disk



Menu Nastroje > Ulozit blok na disk
Panel nastoju Nastroje > Ulozit blok na disk
Klavesnice  wblock, piSblok

Alias W

UlozZi blok, cely vykres, nebo entity do samostatného souboru na disku. Blok, ktery jste si ulozili na disk
muzete vyuzit v dalSich vykresech.

Moznosti dialogového okna
Zdroj Zvolte, jaky typ polozek chcete ulozit do samostatného souboru s vykresem. Pokud si vyberete
blok, zvolte blok, ktery chcete uloZit do samostatného souboru ze seznamu, ktery se zpfistupni. Pokud

chcete uloZit cely vykres, uloZi se do samostatného souboru cely vykres. Pokud zvolite entity, zpfistupni
se zakladni bod a entity.

Zakladni bod Kliknéte na B%pro vybér soufadnic x, y, z zakladniho bodu, ktery chcete ulozit do
samostatného souboru s vykresem. Nebo mizete soufadnice X, y, z zakladniho bodu napsat do
pfikazového Fadku.

Entity Kliknéte na g}pro vybér entit z aktualniho vykresu, které chcete uloZit do samostatného souboru
na disk. Pokud nezvolite zadné entity, soubor se nevytvofi.

Zvolte, co se ma stat se zvolenymi entitami z aktualniho vykresu po vytvofeni souboru na disku:
- Zachovat - program ponecha zvolené entity v aktualnim vykrese

- Konvertovat na blok - program konvertuje zvolené entity z aktualniho vykresu na blok

- Odstranit z vykresu - program entity z pdvodniho vykresu vymaze

MnozZstvi aktualné zvolenych entit se zobrazi pod mozZnostmi.

Nazev a cesta souboru: Zadejte cestu a nazev nového souboru, nebo kliknéte na [...] a vyhledejte ji.

Jednotky vlozZeni: Zvolte jednotky, ve kterych se uloZi vybrané entity v novém vykrese.

228. Méritko (Scale)

Ribbon Upravit > Upravit > Méfitko
Menu Modifikace > Méfitko

Panel nastoju Modifikace > Méfitko
Klavesnice  scale, méfitko

Alias SC

Zméni méfitko existujicich entit jejich pomérnym zvétSenim nebo zménsenim ve smérech x. y a z.
Koeficient méfitka vétsi nez 1 entity zvétSuje; koeficient mezi hodnotami 0 a 1 je zménSuje.



A. Vyberte entity pro zménu méfitka.
B. Zadejte zakladni bod.

Vyberte entity pro zménu méfritka: Zvolte entity.

Referenéni bod: Zvolte zakladni bod.

Zakladni méfitko (B)/<Koeficient méfitka>:

Zadejte koeficient méfitka. Pro zvétSeni entit zadejte hodnotu vétsi nez 1, pro zménSeni zadejte hodnotu
mensi nez 1.

Zakladni méfitko (B — Base scale) | Ureni zakladniho méfitka.

Uréeni zakladniho méfitka
Zvolte Zakladni méfitko (B).
Zakladni méfitko <1>: Zadejte zakladni méfitko entit.

Nové méritko: Zadejte nové méritko entit.

229. Posuvnik (Scroll Bar)

Ribbon Pohled > Posuvniky (v Zobrazeni)
Menu Zobrazit > Zobrazit > Posuvniky
Klavesnice scrollbar

Zapina a vypina zobrazeni posuvniku dole na pravé strané kresliciho okna.

WNDLSCRL je pravé zapnut: ANO (ON)/Prepnout (T)<Ne>:
Zvolte Ano pro zobrazeni posuvniku ve vykresu. Zvolte Pfepnout (T) pro zapinani nebo vypinani
posuvniku. Zvolte NE, pro skryti posuvniku ve vykresu.

230. Najit-Nahradit (Search in text)

Klavesnice tsearch

UmozZiiuje vyhledat text, nebo ¢ast textu a nasledné jej nahradit jinym textem.
FILtr/<Vyberte entity>:

Mysi vyberte textové entity na vykresu a stisknéte Enter.

Zadejte text pro vyhledavani :

Zadejte text, nebo jeho €ast, kterou chcete zménit. Stisknéte Enter.

Zadejte text pro nahrazeni :

Zadejte text, kterym chcete oznacCeny text nahradit. Stisknéte Enter.

231. Vybrat vrcholy (Select All)

Ribbon Vychozi > Pomiicky > Vybrat vSe



Menu Upravit > Vybrat vSe

Klavesnice selgrips
Klavesova zkratka Ctri+A
Alias SELGRIP

Zobrazi uzly zvolenych entit.

FILtr/: Zvolte entity, u kterych chcete zobrazit uzly a pak stisknéte Enter. Zvolte FIL (filtr) pro vybér
vlastnosti.

232. Cislovani (Sequence)

Klavesnice sequenps

SEQUENCE - Automaticka alfa/numericka inkrementace textu

Umoziuje Ciselné a abecedni fazeni textu.

Abecedni nebo ¢iselNa sekvence <A nebo N>

Zvolte, jestli chcete poradi Ciselné nebo abecedni.

Které pismeno je prvni ?

Zvolte, které pismeno chcete, aby bylo jako prvni v fadé.

Zarovnani textu

Vyberte styl zarovnani.

Uhel psani

Zvolte uhel.

Pridat predponu <P> nebo pfiponu <S>

Rozhodnéte se, zda chcete k textu pfidat pfiponu nebo pfedponu.

Pokud jste zvolili jednu z moznosti (pfidat pfiponu <S> nebo pfidat pfedponu <P>), napiste do
pfikazového fadku pozadovany text, ktery chcete pfidat.

Stisknéte Enter kliknutim mySi na vykres zvolte po¢ate¢ni bod pfidaného textu.

233. Nastavit USS (Set UCS)

Ribbon Pohled > USS > Uzivatelské soufadné systémy > Uzivatelské soufadné systémy



Menu Nastroje > Uzivatelské soufadné systémy > Zvolte preddefinovany USS
Klavesnice setucs
Alias DDUCSP, UCP

Zobrazi dialogové okno Uzivatelského soufadného systému, takze si mizete zvolit Uzivatelsky soufadny
systém z rlznych pfednastavenych moznosti.

234. Stinovat (Shade)

Klavesnice shade, stin
Alias SHA

Odstrani skryté ¢ary, nasledné pouzije ploché stinovani pro vSechny viditelné povrchy. Stinované entity je
mozné pouze prohlizet, nedaji se ukladat nebo exportovat. Protoze cilem stinovani je pouze rychla
vizualizace, stinované obrazky nemaiji svételny zdroj a na povrchu pouzivaji pouze souvislé barvy, diky
¢emu vypadaji ploSe a nerealisticky. Stinované objekty vyuZivaji viditelné hladiny barev ve vykrese.
Jakékoliv zmény, které udélate po stinovani objektl, se neobjevi okamzité. Pokud chcete zmény vidét,
musite pouzit pfikaz stinovani opakované.

Stinovany objekt

Pro odstranéni stinovani mazete vyuzit pfikazy Pfekresli nebo Regenerovat.

V dialogovém okné& Nastaveni kresleni vyuZzijte pro nastaveni vzhledu stinovaného objektu zaloZzku 3D
nastaveni. Povrch nebo hrany Vaseho objektu muzete stinovat ¢tyfmi rdznymi zplsoby:

- Stinované plochy beze zvyraznéni hran.

- Stinované plochy se zvyrazné&nim hran v barvé obrazovky.

- Prazdné plochy, hrany nakreslené barvou entity (podobné jako zobrazeni skrytych ¢ar pomoci pfikazu
Skryt).

- Plochy vyplnéné pomoci barvy entity, hrany zvyraznéné barvou obrazovky.

235. Krokovani (Snap)

Ribbon Kreslit > Nastaveni > Uchop mFizky
Menu Nastroje > Nastaveni kresleni >Zadani souradnic > Krokovani a mfizka
Panel nastojl Nastaveni > Uchop

Klavesnice snap, krok



Klavesova zkratka F9
Alias SN

Vynuti pohyb kurzoru o nastaveny pfirlistek (velikost kroku, roztec).

Krokovani je vypnuto (x a y = 0.5000): zapnout (ON)/otocit (R)/STyl/Typ/pomér stran (A)/<Rozte¢
krokovani>::

Pro nastaveni velikosti kroku (pfiristku) zadejte hodnotu, stavajici hodnota je zobrazena v pfikazu. Pro
vypnuti krokovani vyberte OFF. Pro zapnuti krokovani vyberte ON. Pro zadani otoCeni mfizky krokovani
(po které se krokovani pohybuje) zadejte otocit (R). Volbou sTyl (T) zménite mfizku krokovani na
izometrickou. Pro zménu poméru stran mfizky zadejte pomér stran (A).

PFi aktivni volbé Izometricky krok a mfizka jsou dostupné dalSi nabidky:

Krokovani je zapnuto, x a y = 0.5000: vypnout (OFF)/natocit (R)/Styl/Typ/pomér strAn/<Rozte¢
kroku>: : Pro nastaveni rozteCe (ve sméru osy y) zadejte hodnotu (aktualni hodnota je zobrazena

v pfikaze). Pro zapnuti/vypnuti zvolte ON/OFF. Pro otoeni mfizky krokovani (po které se krokovani
pohybuje) zadejte otocit (R). Pro zménu na standardni zobrazeni zvolte Styl.

Zadani oto¢eni mfizky krokovani

Zvolte Otocit (R).

Referen¢ni bod pro mfizku krokovani <0.0000,0.0000>: Vyberte zakladni bod.

Uhel otogeni <0>: Zadejte Uhel oto&eni. Pro otogeni ve sméru hodinovych rugiéek zadeijte zapornou
hodnotu. Pro smér v protisméru hodinovych rucicek, zadejte hodnotu kladnou.

Standardni a izometricka mrizka krokovani

Zvolte Style (S).

Izometrické/<Standardni>: Pro aktualni volbu stisknéte Enter. Pro zménu mfizky krokovani zadejte
Izometricky nebo Standardni.

"Zména na izometrickou mfizku krokovani"

Izometricka mfizka je mfizka mezi 30°- 150°. MUzete ji pootocit, ale je tfeba zachovat stejny prirlistek
(stejny pro x a y osu).

Vyberte |zometricky.

Vertikalni odstupy <0.5000>: Pro vybér aktualni hodnoty, stisknéte Enter. Pro zménu rozteCe, zadejte
novou ¢iselnou hodnotu.

"Zména na standardni miizku krokovani"

Standardni mfiZka je obdélna a rovnob&zna k osam x a y.

Vyberte Standardni.

pomeér strAn/Vertikalni rozestupy <0.5000>:

Pro vybér aktualni hodnoty, stisknéte Enter. Pro zménu rozte€e, zadejte novou &iselnou hodnotu. Pro
zadani poméru stran, zvolte Pomér stran (A).

"Zména poméru stran mfizky krokovani"

Pro vytvoreni jiného horizontalniho nebo vertikalniho uchopového prostoru, zadejte pomér stran mrizky.
Vyberte Pomér stran (A). Tato volba je pfistupna, je-li zvolen styl standardni.

Horizontalni rozestupy <0.5000>: Pro zvoleni aktualni hodnoty odstupl stisknéte Enter. Pro zménu
velikosti odstupt, zadejte Ciselnou hodnotu.

Vertikalni rozestupy <1.0000>:Pro zvoleni aktualni hodnoty odstupu stisknéte Enter. Pro zménu velikosti
odstupll, zadejte Ciselnou hodnotu.

236. Koule (Sphere)



Ribbon Kreslit 3D > Kresli 3D télesa > Koule
Menu Kreslit > 3D télesa > Koule

Panel nastoju Kreslit 3D télesa > Koule

Klavesnice  sphere, koule

Alias Al_SPHERE

Kresli 3D koulové entity jako ACIS télesa.
Stied koule <0,0,0>: Zadejte stfedovy bod koule.

Primér (D)/< poloméR koule >: Pro nakresleni koule pomoci zadani poloméru (vychozi hodnota), zvolte
druhy bod nebo zadejte hodnotu v jednotkach vykresu. Pro nakresleni koule pomoci jejiho priméru zvolte
D (primér).

Primér koule: Uréete 2 body nebo zadejte hodnotu priméru v jednotkach vykresu. (Tato vyzva se
zobrazi pouze pokud zvolite pramér.)

237. Spline (Spline)

Ribbon Kreslit > Kreslit > Spline
Menu Kreslit > Spline

Panel nastoju Kreslit > Spline
Klavesnice  spline

Alias SPL

Kresli plynulou kfivku volného tvaru. Pro pfevod kfivky na spline pouzijte pfikaz Editace kfivky (editpline).

A. Zadejte prvni bod, kterym spline prochazi
B. Zadejte dalSi bod(y).
C. Zadejte posledni bod.

Prvni bod spline:

Zadejte prvni bod, kterym bude spline prochazet.

Druhy bod:

Zadejte druhy bod kfivky.

Zavrit (C)/Prizpasobit toleranci (F)/<DalSi bod>:

Zadejte dalsi bod spline.

Zavfit (C — Close) | Uzavieni spline

PFizpUsobit toleraci (F — Fit tolerance) | Zméni toleranci kfivky
Enter pfikaz ukonci.

Zadejte teénu:

Zadejte bod pro ureni te€ny spline v poCatecnim bodé.
Zadejte te€nu pro koneény bod:

U oteviené kfivky budete vyzvani k zadani te¢ny pro koncovy bod. Zadejte bod pro definici teCny



v koncovém bodé.

Zména tolerance kiivky

Zadejte PrizpUsobit toleranci (F).

Zadejte prizpusobeni toleranci (v jednotkach vykresu) <0.000000>:
Stisknéte Enter pro potvrzeni aktualniho nastaveni nebo zadejte novou hodnotu.

238. Natahnout (Stretch)

Ribbon Upravit > Upravit > Prodlouzit > Protahnout
Menu Modifikace > Natahnout

Panel nastoju Modifikace > Natahnout

Klavesnice stretch, protahni

Alias S

Posune &ast vykresu pfi zachovani spojeni s dalSimi ¢astmi. Je mozné natahovat usecky, segmenty
kfivek, spliny, oblouky a eliptické oblouky.

A A

s !

N i - O

A. Vyberte entity pro nataZeni.
B. Vyberte zakladni bod.
C. Urcete bod posunuti.

Vyberte entity pro natazeni pomoci kfizujiciho okna nebo kfizujiciho polygonu:

Zvolte entity, které chcete protahnout pomoci kfiZujiciho okna nebo polygonu a stisknéte Enter.

Koncové body uvnitf kfizujiciho okna nebo polygonu jsou posunuty zatimco ostatni zGstavaji v pivodni
pozici. Entity, které jsou celé uvnitf kfizujiciho okna &i polygonu jsou posunuty celé.

Referenc¢ni bod nebo posun: UrCete bod, ktery chcete pouzit jako zakladni nebo bod posunu.

Druhy bod posunu: Ur€ete bod pro uréeni vzdalenosti, o kterou chcete entity protahnout (vzdalenost od
prvniho do druhého bodu). Pro pouZiti prvniho vybraného bodu jako pfemisténi x, y stisknéte Enter.

239. Ziskat styl (Styleset)

Klavesnice styleset

Slouzi ke zjisténi sou¢asného stylu textu.

NASTAVENISTYLU - Nastavte Styl/Vysku/MéritkoX/Uhel zeSikmeni vybérem existujiciho textu
Vyberte existujici text :

Mysi zvolte text, o kterém chcete zjistit podrobnosti. V historii pfikazového fadku se vam tyto podrobnosti
objevi.




240. Slunce (Sun)

Ribbon Render > Slunce
Menu Render > Slunce
Panel nastoju Render > Slunce
Klavesnice  sun

Funkce slouzi pro nastaveni postaveni slunce pro renderovani v zavislosti od geografické polohy, kde se
objekt nachazi, data a €asu v dany den.

Slunce X
Umisténi Datum

Mésto Mésic : | 737 7
Korsika

Athény Recko Den :

Peking Cina

Bélehrad Srbsko Hodina : ]
Berin Némecko i
Bin'ningham Anglle ':] Letni Cas
Bogota Kolumbie

Bombj Indie v

Zna | GMT-11 v
Geograficka pozice

Sitka : Sever b
Dékka : Zapad b4

Umisténi Vyberte mésto, ve kterém je Vas objekt situovan, nebo manualné vyberte zénu a geografickou
pozici zadanim zemépisné Sifky a délky. Na zakladé téchto udaju program spocita uhel dopadu
slunec¢nich paprsku na scénu.

Datum Zadejte datum a Cas, pfipadné zatrhnéte poli¢ko pro letni ¢as. Program spocita uhel dopadu
sluneénich paprskd v danou denni hodinu a stanovené datum.

241. Tablet (Tablet)

Menu Nastroje > Tablet
Klavesnice tablet
Alias TA

Ridi konfiguraci tabletu pro volbu nastrojd a kalibraci pro dotekovy vstup.

InteliCAD podporuje dotekové tablety kompatibilni s Wintab driverem a vlastnim overlay tabletu. Navod na
instalaci driveru pro tablet a vyuZiti tlaitek na VaSem dotekovém zafizeni naleznete v dokumentaci pro
hardware.

PFi pouziti pfikazu Tablet mate tfi moznosti:
- Konfigurovat - mapuje overlay tabletu na samotny tablet. Vyuzijte tuto moznost, pokud planujete zvolit
nastroje IntelliCAD z overlay tabletu.



- Kalibrovat - mapuje body tabletu v absolutnich soufadnicich k bodum ve vykrese. Kalibrujte tablet, pokud
zamyslite digitalizovat body. Toto je vhodné pro trasovani papirovych vykresu.

- Zapnuti / vypnuti tabletu - zapina a vypina méd tablet. VyuzZijete jej pro prepinani mezi vybérem nastrojl
a dotekovym vstupem.
Nez zaénete

Napiste CFG.

242. Text - Fadkovy (text)

Ribbon Vychozi > Poznamka > Text > Text
Menu Kreslit > Text > Radkovy text
Klavesnice text

Vytvareni fadkového textu

Kdyz tvofite radkovy text, kazdy fadek textu ukoncite stisknutim tlacitka Enter. Kazdy rfadek textu je
vytvoren jako samostatna entita, kterou mizete ménit.

Pro vytvoreni textu

1. Provedte jedno z nasleduijiciho:

- Zvolte Kreslit > Text > Radkovy text

- V Ribbon menu zvolte Vychozi > Poznamka > Text

- Na panelu nastroju Text kliknéte na nastroj Radkovy text

- Napiste dtext nebo text a stisknéte Enter.

2. Ur€ete bod vlozZeni prvého pismene.

3. UrCete vysku pismen.

4. UrCete rotacni uhel textu.

5. Napiste text a pak stisknéte Enter na konci kazdého nového Fadku.

6. Pro ukonceni pfikazu stisknéte opét Enter.

TIP Pokud jste text jiz vytvorili a chcete, aby se dalsi text objevil bezprostredné pod predchozim, zvolte
Kreslit > Text > Radkovy text. KdyZ obdrZite vyzvu na uréeni bodu vioZeni, stisknéte Enter. Novy text

bude mit stejnou vysku a rotacni uhel jako pfedeSly text.

Vytvari textové entity. Text je vypsan dynamicky dle zapisu do pfikazového fadku.

A B

— Duis cutem vel eum iriure
dolar in hendrerit

A. Zadejte vySku textu

B. Zadejte Uhel natoceni textu.



Pro zarovnani textu

Urcete pocatecni bod textu nebo [zarovnani (J)/Styl]:
Zvolte zarovnani (J) - pro zarovnani textu (vychozi nastaveni vlevo)

Zadejte volbu [vLevo/nastfed (C)/vpRavo/zArovnat/uprostied (M)/pFizpisobit
(F)/TL/TC/TR/ML/MC/MR/BL/BC/BR]:

Pro psani textu zarovnaného vlevo zadejte pocatecni bod textu.
Uprostied (M — Middle) | Text vystfedény kolem bodu vodorovné i svisle.
Na stfed (C — Center) | Text zarovnany do stfedu fadku.

Vpravo (R — Right) | Text zarovnany vpravo.

Prizpusobit (F — Fit) | Roztahne Sitku mezi pocate¢ni a koncovy bod
Zadany bod bude v textu:

TL (Top Left) - nahote vilevo

TC (Top Center) - nahofe uprostied

TR (Top Right) - nahofe vpravo

ML (Middle Left) - uprostfed vlevo

MC (Middle Center) - uprostied textu vodorovné i svisle

MR (Mlddle Right) - uprostfed vpravo

BL (Bottom Left) - dole vlevo

BC (Bottom Center) - dole uprostfed

BR (Bottom Right) - dole vpravo

Vyska textu : Zadejte vySku textu nebo uréete bod.

Uhel natoéeni textu <0°>: Zadejte thel nebo uréete bod.

Text: NapiSte text, ktery chcete vlozit. Text je pfi psani zarovnavan dle zadané volby. DalSi fadky textu
jsou zarovnany ke stejnému bodu.

Vybér stylu textu

Uréete pocateéni bod textu nebo [zarovnani (J)/Styl]:

Zvolte Styl (S).

? Pro vypis dostupnych stylu textu/<Styl textu> <STANDARD>:

Zadejte nazev stylu textu.

? | Pro vypis stylG.

Pro pouziti vychoziho stylu stisknéte Enter.

Pocatecni bod textu: Zadejte pocatecni bod textu.

Koncovy bod: Zadejte koncovy bod textu.

Text: Zadejte text pro vlozeni. Text se pfizpUsobi Sifce zadaného prostoru. Dalsi Fadky textu se
pfizplsobi stejnym rozmeéram.

Vlozeni textu bez formatovani

Zadejte poc¢atecni bod textu.

Vyska textu : Zadejte vySku textu nebo uréete bod.

Uhel natoéeni textu <0°>: Zadejte Gihel natoéeni nebo uréete bod.

Text: Zadejte text pro vloZeni. Pro vlozeni vice fadkl stisknéte Enter na konci kazdého fadku. Text se ve
vykrese zobrazuje v pribéhu psani. Pro ukon&eni pfikazu stisknéte Enter na prazdném novém fadku.

TIP Pro pokracovani textu pod pfedchozim fadkem zvolte pfikaz Odstavcovy text.

Prizpuisobeni textu

Zvolte Mezi (F) pro vynuceni Sifky textu mezi dvéma body s uréenou vySkou.
Pocatecni bod textu: Zadejte pocatecni bod textu.

Koncovy bod: Zadejte koncovy bod textu.



Vyska textu : Zadejte vySku textu nebo uréete bod.

Text: Zadejte text pro viozeni. Text se pfizpusobi Sifce zadaného prostoru a uréené vysce. DalSi fadky
textu se pfizpusobi stejnym rozmérdm.

Text na stied

Zvolte Na stfed (C) pro vystfedéni textu.

Stredovy bod textu: UrCete bod, na ktery bude text vystfedén. Text bude zarovnan k zakladové Care
stfedového bodu.

Vyska textu : Zadejte vysku textu nebo urete bod.

Uhel natoéeni textu <0°>: Zadejte Gihel natoéeni textu nebo zadejte bod.

Text: Zadejte text, ktery chcete vloZit. Text je b&€hem psani vystfedén. DalSi Fadky textu jsou vystiedény
stejnym zplsobem.

Uréeni stfredového bodu textu

Zvolte Uprostied (M).

Stredovy bod textu: UrCete stfedovy bod textu, ktery chcete viozit. Text se bude vztahovat k bodu
horizontalné i vertikalné.

Vyska textu : Zadejte vysku textu nebo urete bod.

Uhel natoéeni textu <0°>: Zadejte thel natogeni textu nebo urgete bod.

Text: Zadejte text, ktery chcete vlozit. Text je b€hem psani centrovan kolem zadaného bodu. Dalsi fadky
textu jsou centrovany stejnym zpusobem.

Zarovnani textu vpravo

Pro zarovnani textu doprava zvolte Vpravo (R).

Pravy bod textu: Zadejte bod na pravém okraji textu (textu bude nalevo od tohoto bodu).

Vyska textu <hodnota>: Zadejte vysku textu nebo urcete bod.

Uhel natoéeni textu <0°>: Zadejte thel nebo uréete bod.

Text: Napiste text, ktery chcete vlozZit. Text je pfi psani zarovnavan napravo. DalSi fadky textu jsou
zarovnany ke stejnému okraji.

POZNAMKA Program podporuje standardni skupinu znakl ANSI. Pro zadani specialnich znaku stisknéte
klavesu Alt a zadejte Ciselny ekvivalent znaku. Ciselné ekvivalenty naleznete v aplikaci Mapa znak, ktera
je k dispozici ve Windows.

TIP
K dispozici jsou nahledy fontd dostupnych v programu 4MCAD.

243. Pravouhlé oramovani textu (Text border)

Klavesnice boxtxt

PFikaz oramuje text pravouhlym ¢&tyfuhelnikem.
Vyberte textovou entitu a stisknéte Enter.

244. Velka-Mala pismena (Text case)

Klavesnice tcase

TCASE - Zméni pismena z malych na velka a naopak

FILtr/<Vyberte entity>:



Vyberte entitu u které chcete zménit velikost pismen a stisknéte Enter.
Zmeénit text na velka (U) nebo malLa

Urcete, zda chcete zménit pismena na velka (U) nebo na mala (L) a stisknéte Enter.

245, Zménit vy$ku (Text height)

Klavesnice theight

Méni vySku jiz napsanych textovych entit.

FILtr/<Vyberte entity>:

Vyberte entity, kterym chcete zménit vysku a stisknéte Enter.
Zadejte novou vysku textu v jednotkach tisku (mm):

Zadejte vySku do pfikazového Ffadku nebo ji uréete potahnutim mysi na vykresu do pozadované
vzdalenosti.

246. Zarovnat do bloku (Text justify)
Klavesnice tjustify
UmozZiiuje okamZité zarovnani textové entity do bloku.

FILtr/<Vyberte entity>:

Vyberte entity pro zarovnani do bloku a zvolte enter.

247. Natahnout (Text stretch)

Klavesnice tstretch

Pfikaz TSTRETCH umoZiuje protahnuti stran textu.

Zadat text pro prodlouzeni :

Mysi zvolte text na vykresu, ktery chcete protahnout. A stisknéte Enter.
Zadejte stranu pro protazeni Leva/pRava :

Zvolte stranu textu, kterou chcete protahnout. Pro nataZeni levé strany zvolte L. Pro natazeni pravé strany
zvolte R. Pomoci mysSi roztahnéte text do pozadované Sirky.



248. Radkovy text na odstavcovy (Text to Multiline Text)

Ribbon Vychozi > Poznamka > Text > Radkovy text na odstavcovy
Menu Kreslit > Radkovy text na odstavcovy
Klavesnice txt2mtxt

Prevadi textové entity pfikazu Text, na MText. BEhem pfevadéni jsou vybrané textové entity odstranény
z vykresu a vytvofi se odstavcovy text.

Pro prevedeni textu
Stisknéte Enter pro nastaveni nebo Vyberte entity pro pfevod na MTEXT:

Vyberte textové entity, které chcete prevést nakreslenim kfiZujiciho okna, opakujte pokud je potfeba, poté
stisknéte Enter.

PrizpUsobeni volby prevodu pred vybérem entit

Stisknéte Enter pro nastaveni nebo Vyberte entity pro pfevod na MTEXT:
Stisknéte Enter

V Nastaveni z fadkového textu na odstavcovy, provedte vybér.

- Usporadani textu zvolte Tridit vybér pro pfidani jednofadkového textu v pofadi, které si zvolite nebo
Tridit shora dolt pro pfidani jednofadkového textu v poradi, které je pouzito na vykrese, seshora dold.

- Rozdélit slova MTextu Zvolte pro pfidani volného mista v ramci fadku textu, které vam pomohou
s vyvazenim textu .

Kliknéte OK.
Vyberte entity pro pfevod na MTEXT:

Vyberte textové entity, které chcete prevést nakreslenim kfizujiciho okna, opakujte pokud je nutné, poté
zmacknéte Esc.

249. Casové proménné (Time Variables)

Ribbon Nastroje > Dotaz > Casové proménné
Menu Nastroje > Dotaz > Casové proménné
Panel nastojii Dotaz > Casové proménné

Klavesnice time, €as

Alias TI

Zobrazuje aktualni datum a &as jak vytvoreni, tak aktualizace vykresu. Casovaé miiZzete zapnout nebo
vypnout.



Pokud aktivujete tento pfikaz, aktualni datum a €as vytvoreni vykresu se zobrazi v pfikazovém fadku. Pro
prohlédnuti této informace muizete posouvat informace v pfikazovém fadku, nebo si ji mizete najit v okné
historie vyzev. Upiny &as Uprav a éas, ktery uplynul od doby, kdy jste za&ali pracovat s vykresem jsou tam
také zahrnuté.

ano (ON)/ne (OFF)/zobrazit (D)/obnovit (R): Pro zapnuti ¢asovace zvolte ON (ano). Pro vypnuti
Casovace zvolte OFF (ne). Pro zobrazeni vytvofeni a aktualizaci datumu a €asu zvolte R (obnovit). Pro
vynulovani ¢asovace zvolte R (obnovit).

250. Tolerance (Tolerance)

Ribbon Poznamky > Koty > Tolerance

Menu Koty > Tolerance
Klavesnice tolerance
Alias TOL

Zobrazi dialogové okno Geometricka tolerance, takze mizete definovat geometrické variace v aktivnim
vykrese. Tolerance stanovuje miru pfesnosti pro spravnou funkci a pfizpusobeni entit Vaseho vykresu.

251. Anuloid (Torus)

Ribbon Kreslit 3D > Kresli 3D télesa > Anuloid
Menu Kreslit 3D > Kreslit 3D télesa > Anuloid
Panel nastoju Kreslit 3D télesa > Anuloid

Klavesnice torus, anuloid

Alias AI_TORUS, TOR

Kresli anuloid jako ACIS téleso. Anuloid je definovan hodnotami dvou poloméru: polomér trubice a dalsi
polomér od stfedu anuloidu ke stfedu trubice. Mdzete nakreslit i anuloid bez stfedu, anuloid, ktery protina
sam sebe, tak, Ze zadate polomér trubice vétsi jako polomér anuloidu.

Stred anuloidu <0,0,0>: Zadejte stfed anuloidu.

pramér (D)/<poloméR celého anuloidu>: Zadejte druhy bod pro polomér anuloidu, nebo vpiste jeho
hodnotu v jednotkach vykresu. Pro zadani priméru celého anuloidu zvolte D (pramér). Cely anuloid je
méfeny od stfedu anuloidu do stfedu trubice.

prumeér (D)/<poloméR trubice anuloidu>: Zadejte dva body pro polomér télesa anuloidu, nebo vpiste
jeho hodnotu v jednotkach vykresu. Pro zadani priméru télesa anuloidu zvolte D (pramér). Téleso
anuloidu je trubice.

252. Orez (Trim)

Ribbon Upravit> Upravit > Prerusit > Ofiznout
Menu Modifikace >Orez



Panel nastoju Modifikace >Orez
Klavesnice trim, ofez
Alias TR

Odstrani ¢asti vybranych entit, které kfiZuji uréenou hranici. Je mozné ofezavat usecky, oteviené dvou-
a troj-rozmérné kiivky, polopfimky, oblouky a kruZnice. Entity pouZitelné jako hranice ofezu jsou oblouky,
kruznice, usecky, kfivky, polopfimky, pfimky a vyfezy ve vykresovém prostoru.

A
L{ |~ _—
//r——a e

A. Vyberte entitu, kterou chcete pouzit jako hranici pro ofez.
B. Vyberte entitu pro ofiznuti.

Vyberte entity fezu pro ofiznuti <Klavesou ENTER vyberete vSe>:

Vyberte entity, které chcete vyuZit jako hranice ofezu.

rEzim hran/plot (F)/Projekce/zpét (U)/< Vyberte objekt pro ofiznuti nebo shift-vybér pro prodlouzeni
>:

Vyberte entitu, kterou chcete ofiznout.

Rezim hran (E - Edge) | Ofez entit dle mySleného prodlouzeni hrany nebo priniku v trojrozmérném
prostoru.

Plot (F — Fence) | Zadejte body pro hromadny ofez metodou plot.

Ofez entity metodou plot
Mdzete hromadné ofezavat entity zadanim bodu plotu.
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A. Vyberte hranici ofezu.
B. Urcete prvni bod plotu.
C. Urcete druhy bod plotu.

Zvolte Plot (F).

Prvni bod plotu: Ur€ete prvni bod plotu. Bod plotu je po¢ateénim bodem podél ofezové entity.
DalsSi bod plotu: Urcete dalSi bod plotu. Mizete pokraovat v zadavani dalSich bodd, dokud nejsou
ofiznuty v8echny entity.

Orez entit s pomoci rezimu hran
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A. Vyberte hranu ofezu.
B. Zvolte volbu ofezu s pouzitim rezimu hran a entity pro ofez.

Zvolte ReZim hran (E).

Prodlouzit (E)/Neprodlouzit <Prodlouzit>: Pro pfijeti aktualniho nastaveni stisknéte Enter. Pro urCeni
ofezu entity o prodlouzenou hranu zvolte Prodlouzit (E — Extend).

Neprodlouzit (N — No extend) | Nastaveni ofezu pouze jinou entitou s prinikem ve 3D prostoru.



Ofez prodlouzenou hranou

Zvolte Prodlouzit (E).

Rezim hran (E)/<Vyberte entitu pro ofiznout>:

Zvolte entitu pro ofiznuti.

Rezim hran (E — Edge mode) | Zména metody ofezu hran.
Rezim hran (E)/Zpét (U)/<Vyberte entitu pro ofiznout>:
Zvolte entitu pro ofiznuti.

Zpét (U — Undo) | Vrati posledni ofiznuti.

ReZim hran (E — Edge mode) | Zmé&na metody ofezu hran.

Orez v existujicim pruseciku

Zvolte Neprodlouzit (N).

Rezim hran (E)/<Vyberte entitu pro ofiznout>:

Zvolte entitu pro ofiznuti.

Rezim hran (E — Edge mode) | Zména metody ofezu hran.
Rezim hran (E)/Zpét (U)/<Vyberte entitu pro ofiznout>:
Zvolte entitu pro ofiznuti.

Zpét (U — Undo) | Vréti posledni ofiznuti.

ReZim hran (E — Edge mode) | Zmé&na metody ofezu hran.

253. Trojité cerchované cary (Triple dashed-dot line)

Klavesnice m3dot

Klavesou ENTER pouzijete posledni bod/pokrac¢ovat (F)/<Zacatek usecky>:

Mysi urete pocatecni bod. UrCete mysi vzdalenost koncového bodu a smér tusecky. Mysi uréete koncovy
bod. Stisknéte Enter pro ukonceni entity nebo zvolte nékterou z moznosti pro upfesnéni navazujici
usecky:

uhel (A)/déLka/pokracovat (F)/zpét (U)/<Koncovy bod>:

Napiste A pro uréeni Ghlu mezi sekami. Uhel uréete mysi nebo napiste do pfikazového Fadku. Stisknéte
Enter.

Napiste L pro ur€eni délky nasledujici usecky. Délku zvolte posunutim mySi nebo napiste Cisly do
prikazového fadku. Stisknéte Enter.

Stisknéte Enter pro ukoné&eni kresleni entity.

254. Zpét odstranit (Undelete)

Klavesnice undelete
Alias 00, OOPS

Vraci entity, které byly odstranény pfi poslednim smazani nebo vyuZitim pfikazu Odstranit. Pfikaz Zpét
odstranit navic opét kresli entity, které byly smazany pfi vytvareni bloka.




255. Jednotky (Units)

Ribbon Tlacitko aplikace > Nastaveni kresleni > Jednotky vykresu

Menu Nastroje> Nastaveni vykresu
Klavesnice units, jednotky
Alias -UN

Zobrazi dialogové okno "Nastaveni kresleni", ve kterém naleznete nastaveni jednotek vykresu pro linearni
prvky, uhly a uZivatelsky soufadny systém. Vyberte, pro které jednotky chcete zménit nastaveni
v roletovém menu. Nasleduje nabidka typl jednotek.

B | Nastavenf vykresu a X
Modifikace entit Nastaveni 3D Dynamické zadani
Jednotky vykresu: Zadéni soufadnic Zobrazeni Tvorba entit

[[Jodebrat mezery pfi pfevodu vzdalenosti ¢ Ghld na text

Uhlovéa Délkové [ uss

Typy jednotek
O Exponencialni
(@) Desetinné
(O Palcové desetinné
(O Architektonické
(O zZlomkové
32.3320

PFesnost 4 =

@

Typy jednotek (1-5): Pro zménu typu zatrhnéte odpovidajici typ zobrazeny v nabidce.

Uziti exponencialnich, desetinnych a inzenyrskych jednotek
Vyberte 1., 2. nebo 3. moznost.

Zobrazit presnost: Nastavi poCet desetinnych mist od 0 do 8. Vychozi pfesnost je 4 desetinna mista.
Nastavte pozadovany pocet.

Typ jednotek uhlu: Vyberte ze seznamu zatrhnutim typ uhlovych jednotek. (Stupné desitkové,
Stupné/minuty/sekundy, Grady, Radiany, Zemépisné jednotky).



Zobrazit presnost uhlovych jednotek: Nastavi po€et desetinnych mist od 0 do 8. Vychozi pfesnost je 0
desetinnych mist. Nastavte pozadovany pocet.

Smeér uhlu: Vyberte kladny smér Uhlu (ve sméru / proti sméru hodinovych rucicek).

Zaklad uhlu: Nastavi zakladni uhel, od kterého bude ve vykrese vychazet. Vychozi nastaveni zakladu
Uhlu je 0. Nastavte pozadovany uhel.

Uziti architektonickych a zlomkovych jednotek
Vyberte pro linearni jednotky 4. nebo 5. moznost.

Zobrazit presnost: Zména hodnoty 0-8 nastavi jmenovatele ve zlomku 1,2,3,8,16,32,63,128 nebo 256.
Nastavte poZzadovanou hodnotu.

Pro ukonéeni dialogového okna stisknéte tlacitko "OK".

256. Nastaveni proménnych (Variable Settings)

Ribbon Nastroje > Dotaz > Nastaveni proménné
Menu Nastroje > Dotaz > Systémové proménné
Panel nastoju Dotaz > Nastaveni proménné

Klavesnice  setvar, syspar

Alias SET

Zobrazuje nebo méni systémové proménné.

Zadejte nazev proménné nebo [?]: Pro zobrazeni nebo zménu proménné zadejte nazev proménné. Pro
zobrazeni seznamu proménnym zvolte ?.

Po vybéru System Variables v napovédé pfimo v programu 4MCAD si zvolte System Variables a zobrazi
se kompletni seznam systémovych proménnych.

257. Spustit VBA makra (VBA Run Macros)

Ribbon Nastroje > Aplikace > Makra

Menu Nastroje > Visual Basic > Makra
Klavesnice vbarun
Alias VBA

Zobrazi dialogové okno Spustit makro VBA 4MCAD, takze muUzete spustit VBA makra.
Moznosti dialogového okna

Macro name Zvolte nazev makra, které chcete spustit. Pokud nejsou makra k dispozici, nahrajte VBI
aplikaci s vyuzitim pfikazu VBILOAD.

Macros in Zvolte umisténi pozadovaného makra. Makra mizou byt umistény v Common Projects, ve
vSech otevienych vykresech nebo nahrané VBI aplikaci.



Description Zobrazi popis zvoleného makra.

Run Spusti zvolené makro.

Step into Otevie Visual Basic Editor.

Edit Otevre Visual Basic Editor, kde mUzete upravit zvolené makra.
Create Otevre Visual Basic Editor, kde mlzete vytvorit nové makro.

Delete Smaze zvolené makro.

258. Pohled ulozeni/obnova (View Save/Restore)

Ribbon Pohled > Pohledy > Spravce pohledu
Menu Pohledy > Spravce pohledu
Klavesnice view, pohled

Alias -V

Zobrazi dialogové okno Spravce pohledu, ve kterém muzete vytvaret, pfejmenovavat a ménit definici
pojmenovanych pohledu.

Poznamka Spravce pohledu nemUzete vyuzivat jako transparentni pfikaz, pokud pravé pracujete ve
vykresovém prostoru, pokud vyuzivate pfikazy Viewpoint nebo DView nebo pouzivate posun a zoom
zobrazeni.

MOZNOSTI DIALOGOVEHO OKNA
Aktualni Kliknéte pro nastaveni zvoleného pohledu jako aktualniho.
Novy Kliknéte pro pfidani nového pohledu do seznamu.

Upravit Kliknéte pro pfifazeni aktualniho vybéru v dialogovém okné Spravce pohledu ke zvolenému
pohledu. Zmény v nastaveni se ulozi i pokud kliknete na OK.

Odstranit Kliknéte pro odstranéni zvoleného pohledu.

Upravit hranice Kliknéte pro zvoleni hranic pohledu pfimo ve vykrese.

Obecné
Nazev Zadejte nazev pojmenovaného zvoleného pohledu.
Styl zobrazeni Zvolte vizualni styl pro zvoleny pohled.

USS Zvolte Uzivatelsky soufadny systém pro zvoleny pohled.



Pohled

Sitka Zadejte $itku zvoleného pohledu. Nebo muzete kliknout na Upravit hranice pro zadani ohraniéeni
pFimo ve vykrese.

Vyska Zadejte vySku zvoleného pohledu. Nebo mizete kliknout na Upravit hranice pro zadani ohraniceni
pfimo ve vykrese.

Uhel natoéeni Zadejte thel natogeni pro zvoleny pohled.

Smeér Zadejte soufadnice x-, y-, z- smérového bodu zvoleného pohledu. Toto je vychozi bod ze kterého je
pohled orientovan.

Stredovy bod Zadejte soufadnice x-, y-, z- sttedového bodu zvoleného pohledu.

Cilovy bod Zadejte soufadnice x-, y-, z- cilového bodu zvoleného pohledu. Toto je koncovy bod do
kterého je pohled orientovan.

Ofiznuti

Povolit ofiznuti Zvolte pokud chcete umoznit ofezani zvoleného pohledu.

Pfedni vzdalenost Zadejte pfedni vzdalenost hranice ofezu zvoleného pohledu.

Zadni vzdalenost Zadejte zadni vzdalenost hranice ofezu zvoleného pohledu.

259. Snimek pohledu (View Snapshot)

Ribbon Nastroje > Spravovat > Zobrazit snimek

Menu Nastroje > Zobrazit snimek
Klavesnice vsnapshot
Alias VS, VSLIDE

Zobrazuje dialogové okno Snimek pohledu, abyste si mohli prohlédnout posledni vytvofeny soubor se
snimkem.

260. Bod pohledu (Viewpoint)

Ribbon Pohled > Pohledy > Ovladani dynamického pohledu...
Menu Pohled > Ovladani dynamického pohledu...

Panel nastoju Pohled > Ovladani dynamického pohledu...
Klavesnice  viewpoint

Alias -VP, VPOINT

Umoznuje vybér bodu pro zobrazeni prostorového pohledu na Vas vykres. Mizete zadat libovolny bod ve
3D prostoru, ze kterého se budete divat zpatky na po¢ate¢ni bod. Body pohledu muizete zvolit pro pohled
na vykres v modelovém prostoru. Tuto funkci neni mozné pouzivat ve vykresovém prostoru.



A A

Pohled shora Pohled zepredu 3D pohled

Aktualni smér pohledu: VIEWDIR=0.0000,0.0000,1.0000

Urcete bod pohledu nebo [PErspektiva/ptidorys (PL)/otoc€it (R)/<zobrazit ovladani pohledu (DV)>]:
Pro pfijeti vychozi nastaveni stisknéte Enter. Pro uréeni nového bodu pohledu, ze kterého chcete zobrazit
Vas vykres, zvolte soufadnice, nebo zadejte hodnoty os x-, y-, z. Pro zobrazeni vykresu v perspektivé
zvolte PE (perspektiva). Pro zménu pudorysného pohledu zvolte PO (pldorys). Pro oto€eni pohledu
zvolte R (oto€it).

Pro zobrazeni vykresu v perspektivé

Zvolte perspektiva (PE).

Perspektiva ano (ON)/<ne (OFf)>: Pro pfijeti aktualniho nastaveni stisknéte Enter. Pro zapnuti
perspektivy zvolte ON (ano), pro vypnuti perspektivy zvolte OF (ne).

Pro zménu pudorysného pohledu

Zvolte padorys (PL).

Pohled plidorysu: USS (U)/globalni (W)/<aktualni USS>: Pro pfijeti aktualniho nastaveni stisknéte
Enter. Pro zménu padorysného pohledu na definovany USS zvolte U. Pro zménu pGdorysného pohledu
na globailni stisknéte W.

Pro zménu ptdorysného pohledu na pohled definovany uzivatelem

Zvolte USS (U).

? pro seznam/<Nazev USS>: Zadejte nazev definovaného USS. Pro zobrazeni seznamu USS zvolte ?.

Pro otoc¢eni pohledu

Mdzete zadat novy smér pohledu zvolenim dvou Uhld, pod kterymi se vykres zobrazi.

Zvolte otocit (R).

Uhel v roviné XY od osy X <270>: Pro pfijeti vychoziho nastaveni stisknéte Enter, nebo zadejte novou

hodnotu.
Uhel od roviny XY <90>: Pro prijeti aktualniho nastaveni stisknéte Enter nebo zadejte novou hodnotu.

261. Zobrazeni hladin ve vyrezech (Viewport Layer Control)

Klavesnice vplayer, vhladina
Alias VL



Ovlada viditelnost hladin v samostatnych vyfezech v modelovém prostoru. S vyuzitim tohoto pfikazu
umoznite zobrazeni hladin v jednom nebo vicero vyfezech vykresu, pfi€emz v jinych vyfezech ve stejném
vykrese jsou tyto hladiny neviditelné. Vyrazy zmrazit a rozmrazit, které se vyuZivaji ve spojeni s timto
pfikazem, znamenaiji viditelnost nebo neviditelnost hladin ve vykrese. Pokud rozmrazite hladinu, entity se
zobrazuiji, tisknou a regeneruji jako obvykle. Zmrazit nebo rozmrazit mizete hladiny ve vyfezech
modelového prostoru, které jste jiz vytvofili, zménit mizete i vychozi nastaveni pro vSechny nové vyiezy,
které v modelovém prostoru jesté jenom vytvofite.

Ménit viditelnost hladin ve vyfezech muizete i v Prizkumniku 4MCAD. Kliknéte na ikonu zmrazit /
rozmrazit pro pfepnuti mezi nastavenimi.

Poznamka Viditelnost hladin ve vyfezech mlzete ovladat pouze pro vyfezy z Vaseho aktivniho vykresu.
NemUzete ménit viditelnost hladin pro vyfezy ve vykresech z externich referenci.

Zalozka model musi byt pfed pouzitim tohoto pfikazu aktivni, kliknéte jednodu$e na modelovy prostor.
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VSechny hladiny ve vyfeze jsou rozmrazené.

Zmrazené hladiny (Cerveny drZak) ve vrchni a pravé ¢asti vyfezu.

seznam (L)/barva (C)/typ €ary (LT)/tloustka ¢ary (LW)/zmrazit (F)/rozmraziT/obnovit (R)/Nové
zmrazené hladiny/vychozi nastaveni viDitelnosti: Pro zobrazeni seznamu zmrazenych hladin ve
vybraném vyfezu zvolte L (seznam). Pro zneviditelnéni jedné nebo vicero zmrazenych hladin zvolte F
(zmrazit). Pro zviditelnéni jedné nebo vicero hladin ve vybraném vyfezu zvolte T (rozmrazit). Pro obnoveni
vychoziho nastaveni viditelnosti pro jednu nebo vicero hladin zvolte R (obnovit). Pro vytvofeni nové
zmrazené hladiny ve vSech nahledech zvolte N (nové zmrazené hladiny).

Pro seznam vSech zmrazenych hladin ve vyfezech v modelovém prostoru

Vyberte seznam (L).



Vyberte vyiez: Pro seznam vSech zmrazenych hladin kliknéte na hranici vyfezu.

Pro zmrazeni hladin ve vyifezu modelového prostoru
Zvolte zmrazit (F).

Vyberte hladinu(y) pro zmrazeni: Vlozte nazev hladiny nebo hladin (oddélenych ¢arkami), které chcete
zmrazit nebo napiste * pro zmrazeni v8ech hladin.

Zadejte vyrez(y): vSe (A)/vybrat (S)/<aktualni (C)>: Pro zmrazeni zvolenych hladin v aktualnim vyfezu
stisknéte Enter. Pro zmrazeni zvolenych hladin ve vSech vyfezech zvolte A (v8e). Pro zmrazeni zvolenych
hladin v jednom nebo vicero vyfezech, které zvolite pomoci klikani na jejich hranice, zvolte S (vybrat).
Pokud chcete vidét zmény vyuzijte funkce Pfekresli nebo Prekreslit vSe.

Pro zruseni viditelnosti hladin ve vyifezu v modelovém prostoru

Zvolte obnovit (R).

Vyberte hladinu(y) pro obnoveni: Zadejte nazev hladiny nebo hladin (oddélenych ¢arkami), které chcete
obnovit, nebo napiste * pro obnoveni vSech hladin. Status viditelnosti hladiny (zmrazeny nebo
rozmrazeny) bude obnoven do vychoziho nastaveni, které je definovano pomoci proménné Vychozi
nastaveni viditelnosti, kterou si vysvétlime niZz.

Zadejte vyrez(y): vSe (A)/vybrat (S)/<aktualni (C)>: Pro obnoveni zvolenych hladin v aktualnim vyfezu
stisknéte Enter. Pro obnoveni zvolenych hladin ve vSech vyfezech zvolte vSe (A). Pro obnoveni zvolenych
hladin v jednom nebo vicero vyfezech, které zvolite pomoci kliknuti na jejich hranice, zvolte vybrat (S).
Pro zmrazeni hladin v novych vyiezech v modelovém prostoru

Zvolte Nové zmrazené hladiny (N).

Nazvy novych zmrazenych hladin: Zadejte nazev nebo nazvy (oddélené ¢arkami) novych zmrazenych
hladin, které chcete ve vyfezu vytvofit. NemUzete zadat nazev jiz existujiciho vyfezu. Tato hladina bude
zmrazena i ve vS8ech vyfezech, které vytvorite po vyuziti této moznosti.

Pro nastaveni vychozi viditelnosti pro vyifezy v modelovém prostoru

Zvolte vychozi nastaveni viditelnosti (D).

Nazvy hladin: Zadejte nazev hladiny nebo hladin (oddélené ¢arkami), pro které chcete nastavit vychozi
viditelnost. Timto nastavite vychozi status (zmrazeny nebo rozmrazeny) pro vybrané hladiny ve vSech
vyfezech.

nastaveni zmrazeno (F)/<Rozmrazeno>: Pro vychozi nastaveni na neviditelny zvolte zmrazeno (F). Pro

vychozi nastaveni na viditelny zvolte rozmrazeno (T). Po pouziti moznosti obnovit (R) se nastaveni
hladiny vrati do vychoziho nastaveni zadaného pomoci této moznosti.

262. Vyiezy v modelovém prostoru (Viewports)

Ribbon Pohled > Vyfezy modelu > Vyfezy



Menu Zobrazit > Vyiezy > Vyfezy
Panel nastoju Vyrezy > Vyfezy
Klavesnice viewports, vyiez

Alias VPORT, VPORTS, VW

Rozdéleni vykresu zobrazeného v modelovém prostoru na vicero pohledu, které se nazyvaji vyfezy,
pficemz kazdy z nich obsahuje jiny pohled na aktualni vykres. Modelovy prostor musi byt pfed pouZitim
tohoto pfikazu aktivni.

Pro zménéni viditelnosti hladin ve vyfezu z modelového prostoru zvolte pfikaz Zobrazeni hladin ve
vyfezech (VPLAYER).

Priklad 3 riznych vyrezii z modelového prostoru.

Vyiezy: zapnout (ON)/vypnout (OFF)/prizpusobit (F)/zamknout (L)/Entita/Polygonovy/2/3/4/: Pro
uloZeni aktualnich vyfezl zvolte S (ulozit). Pro obnoveni ulozeného vyfezu zvolte R (obnovit). Pro
smazani konfigurace vyfezu zvolte D (smazat). Pro vraceni vykresu do jednoho vyfezu zvolte SI (jeden).
Pro vytvoreni dvou, tfi, nebo &tyf vyfezl zvolte 2, 3 nebo 4.

Pro ulozeni aktualniho vyiezu z modelového prostoru

Zvolte ulozit (S).
Nazev konfigurace vyiezu k ulozeni: Zadejte nazev pro uloZeni vyfezu.

Pro obnoveni vyiezu z modelového prostoru

Zvolte obnovit (R).
Nazev konfigurace vyiezu k obnoveni: Zadejte nazev vyiezu, ktery chcete obnovit.

Pro smazani nastaveni vyifezu v modelovém prostoru

Zvolte smazat (D).
Nazev konfigurace vyiezu k odstranéni: Zadejte nazev vyfezu, ktery chcete smazat.

Pro navraceni zobrazeni vykresu v jednom vyiezu v modelovém prostoru
Pro slouc¢eni dvou nahledli v modelovém prostoru

Zvolte jeden (SI). Vykres se zobrazi v jednom vyfezu.



263. Klin (Wedge)

Ribbon Kreslit 3D > Kresli 3D télesa > Klin
Menu Kreslit > 3D télesa > Klin

Panel nastoju Kreslit 3D télesa > Klin

Klavesnice  wedge, klin

Alias AI_WEDGE, WE

Kresli 3D klin jako ACIS téleso.
Pro nakresleni klinu s vyuzitim jeho roht

Zadejte prvni roh nebo [stied (C)]: Pro ur€eni prvniho rohu klinu zadejte bod nebo vloZte soufadnice x,
Y, Z.

Zadejte dalsi roh nebo [krychle (C)/déLka]: Pro dynamické kresleni zakladny klinu pomoci vychoziho
nastaveni zadejte protéjSi roh. Pro nakresleni krychle zadejte C (krychle). Pro zadani tfi rozmérd klinu
(délka, Sitka, vySka), zvolte L (délka).

Zadejte vysSku nebo [2body (2P)]: Zadejte vySku klinu podél osy z, nebo zadejte 2 body pro definovani
vysky jako vzdalenosti mezi nimi.

Pro nakresleni klinu s vyuzitim stredu

Zadejte prvni roh nebo [stied (C)]: Zvolte C (stfed).

Zadejte stied: Zadejte stfedovy bod nebo jeho soufadnice x, vy, z.

Urcete roh nebo [krychle (C)/déLka]: Pro dynamické kresleni zakladny klinu (vychozi nastaveni) zadejte
roh. Pro nakresleni krychle zadejte C (krychle). Pro zadani tfi rozmérl klinu (délka, Sifka, vyska), zvolte L
(délka).

Zadejte vySku nebo [2body (2P)]: Zadejte vySku klinu podél osy z, nebo zadejte 2 body pro definovani
vysky jako vzdalenosti mezi nimi.

Pro zadani délky

Zadejte prvni roh nebo [stied (C)]: Zvolte L (délka).

Zadejte délku: Viozte délku v jednotkach vykresu, nebo zadejte bod.

Zadejte Sirku: Zadejte Sifku v jednotkach vykresu, nebo zadejte bod.

Zadejte vySku nebo [2body (2P)]: Zadejte vySku klinu v jednotkach vykresu, nebo zadejte 2 body pro
definovani vysky jako vzdalenosti mezi nimi.

264. Zavrit vSechny vykresy (Window Close All)

Klavesnice wcloseall
Alias CLOSEALL

Zavie v8echny okna s vykresy. Zobrazi se vyzva, jestli chcete uloZit zmény ve vykresu.

265. WMF Export (WMF Out)



Ribbon Vystup > Exportovat > Export WMF
Klavesnice wmfout
Alias WO

Zobrazi dialogové okno Vytvofit snimek, abyste mohli exportovat aktivni vyfez do souboru formatu
Windows metafile (.wmf). Pro vytvofeni metasouboru kliknéte kamkoliv do vyfezu, ktery chcete
exportovat, a pak zadejte pfikaz. Pfejdéte do slozky, kde chcete soubor vytvofit a zadejte jeho nazev. Ze
seznamu nabizenych typu soubortd zvolte Windows metafile (.wmf) a kliknéte na OK.

266. Rozlozit (XPLODE)

Ribbon Upravit > Upravit > Rozlozit
Klavesnice xplode

RozloZi blok na jednotlivé entity. Blok uz se nebude chovat jako jedna entita.
Vyberte objekt k rozlozeni:
Vyberte entitu, ktera je v bloku, ktery chcete rozlozit.

[vSe (A)/barva (C)/hLAdinal/typ ¢ary (LT)/tloustka €ary (LW)/dédit z nadifazeného bloku (l)/rozlozit
(E)] <Rozlozit>:

Pro rozlozeni zvolenych entit a nastaveni vSech vlastnosti vyslednych entit

Zvolte vie (A).
Zobrazi se vyzva pro volbu barvy, hladiny, typu &ary a jeji tloustky.

Pro rozlozeni zvolenych entit a nastaveni indexu barvy vyslednych entit

Zvolte barva (C)

Nova barva [Truecolor/knihovna barev (CO)] : Zadejte novou barvu. Mizete vlozit hodnotu barvy ze
standardni nabidky Windows (1 - 255), 0 pro podle hladiny, 256 pro podle bloku, nebo muazete vlozit
nazev barvy jedné ze sedmi standardnich barev (Cervena = red, Zluta = yellow, zelena = green, azurova =
cyan, modra = blue, purpurova = magenta a bila = white), nebo zvolit moznost podle hladiny nebo podle
bloku.

Pro rozlozeni zvolenych entit a nastaveni truecolor vyslednych entit

Zvolte barva (C)
Nova barva [Truecolor/knihovna barev (CO)] <BYLAYER>: Truecolor.

Cervena, zelena, modra - zadejte hodnoty barvy z RGB spektra. Hodnoty barev oddélte &arkou, napfiklad:
15, 105, 210.

Pro rozlozeni zvolenych entit a nastaveni barvy vyslednych entit z knihovny barev

Zvolte barva (C)

Nova barva [Truecolor/knihovna barev (CO)] <BYLAYER>: Zvolte knihovna barev (CO).

Zadejte nazev barvy z knihovny barev. Tento nazev je vloZeny do .acb knihovny barev s vyuZitim XML
tagl <bookName> a </bookName >. Knihovna barev musi byt uloZzena ve slozce, kde IntelliCAD



vyhledava knihovny barev. Ve vychozim nastaveni je knihovna barev ve stejné slozce, kde je nainstalovan
IntelliCAD. Pro ovéfeni umisténi slozky zvolte Moznosti z menu Nastroje, kliknéte na zalozku
Cesty/soubory a najdéte knihovnu v seznamu souboru.

Zadejte nazev barvy: Zadejte nazev vybrané barvy, ktera je dostupna v knihovné nazvl barev.
Pro rozlozeni entity a nastaveni hladiny vyslednych entit

Zvolte hLAdina.
Nova hladina <0>: Zadejte nazev vrstvy, ke které chcete pfifadit vzniklé entity.

Pro rozlozeni entity a nastaveni typu €ary vyslednych entit

Zvolte Typ €ary (LT).

Novy typ ¢ary <ByLayer>: Pro pfijeti vychoziho nastaveni podle vrstvy stisknéte Enter, nebo zadejte
nazev typu cary.

Pokud Vami zadany typ ¢ary zatim neni nahrany, program se ho pokusi nahrat ze souboru s typy ¢ar
icad.lin. Pokud program nebude schopny lokalizovat zvoleny typ ¢ary, vyuzijte pfikaz LineType pro
nahrani souboru s typem cary.

Pro rozlozeni zvolenych entit a nastaveni tloustky €ary pro vysledné entity

Zvolte Tloustka ¢ary (LW)

Nova tloustka €ary <BylLayer>: Pro pfijeti vychoziho nastaveni podle hladiny stisknéte Enter nebo zadejte
novou tloustku ¢ary. Pokud vloZzena hodnota nepatfi mezi pfednastavené tloustky €ar pfipiSe se ji
nejblizsi hodnota.

Pro rozloZeni zvolenych entit a pridéleni vlastnosti pivodniho bloku vyslednym subentitam

Zvolte Dé&dit z nadfazeného bloku (1)

Vyslednym subentitdm budou pfifazeny stejna barva, hladina, typ a tloustka ¢ary jako méla pavodni
entita, pokud hladina subentity je 0 a dalSi vlastnosti maji hodnotu BYBLOCK (podle bloku).

Pro rozloZeni zvolenych entit stejnym zplsobem jako s vyuzitim pfikazu Explode

Zvolte Explode.
Zvolené entity budou rozlozeny.

267. Zoom (Zoom)

Ribbon Pohled > Navigovat > Zoom v readlném ¢ase
Menu Zobrazit > Zoom > Zoom

Panel nastoju Zoom

Klavesnice  zoom

Alias RTZOOM, Z

ZvétSuje nebo zmensuje zobrazeni aktivniho vykresu. Pokud potfebujete kreslit do vykresu detaily,
muZzete si zobrazeni zvétSit. Pokud obraz pfiblizujete nebo vzdalujete, zvétSujete nebo zmensujete
zobrazeni po pétiprocentnich pfirdstcich.
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1.0brazek - zvétseni, 2.obrazek - zmenseni

Zoom: bliz (l)/dal (O)/vse (A)/stied (C)/Dynamicky/mEze/vLevo/Piedchozi/lvpRavo/okno
(W)/ENtita/<méritko (nX/nXP)>: Pro ureni méfitka vlozte hodnotu zvétseni. Po zvétSeni zvolte | (bliz).
Pro zmens$eni zvolte O (dal). Pro zobrazeni celého vykresu zvolte A (cely). Pro zobrazeni okna
definovaného stfedovym bodem a hodnotou zvétSeni nebo vydkou zvolte C (stfed). Pro zobrazeni mezi
vykresu zvolte E (meze). Pro vybér zobrazené oblasti pfimo ve vykrese zvolte D (dynamicky). Pro
zobrazeni okna definovaného pravym bodem a hodnotou zvétSeni nebo vyskou zvolte R (vpravo). Pro
zobrazeni okna definovaného dvéma protilehlymi rohy zvolte W (okno). Pro zobrazeni okna definovaného

zadanim jedné nebo vicero entit zvolte EN (entity).

Pro zobrazeni okna definovaného stfedovym bodem a zvétSenim nebo vyskou
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Aktuélni pohled ukazuje bod, ktery se stane stfedem nového pohledu (1.obrazek). Stejny vykres po
dvojnasobném zvétseni (2.obrazek).

Zvolte stfed (C).

Stied pohledu <1591.8625,563.8610,0.0000>: Pro pfijeti vychoziho nastaveni stisknéte Enter. Pro
zadani jiného stfedu zadejte bod nebo viozte novou hodnotu.

Zadejte koeficient zvétSeni (nX/nXP), nebo vySku pohledu <911.4767>: Pro prijeti aktualni vysky
zvétSeni stisknéte Enter. Pro zménu vysky zobrazeni zadejte bod. Pro zvoleni koeficientu zvétSeni viozte
hodnotu.

Pro zobrazeni okna zvolenim pozadované oblasti ve vykrese

Zvolte dynamicky (D).

Presurite obdélnik do oblasti, kterou chcete zobrazit.

Prizplsobte velikost obdélniku tak, aby detailnost zobrazeni odpovidala Vasim pfedstavam.
Stisknéte Enter.

Pro zobrazeni okna definovaného levym rohem a zvétSenim nebo vyskou

Zvolte vlevo (L).

Levy dolni roh: Zadejte bod nebo vloZte novou hodnotu.

Zadejte koeficient zvétSeni (nX/nXP), nebo vysku pohledu <0.0000>: Pro pfijeti aktualni vysky
zobrazeni stisknéte Enter. Pro zménu vysky pohledu zadejte bod. Pro vybér koeficientu zvétSeni vioZte
hodnotu.

Pro zobrazeni okna definovaného pravym rohem a zvétSenim nebo vyskou

Zvolte vpravo (R).



Pravy horni roh: Zadejte bod nebo vlozte novou hodnotu.
Zadejte koeficient zvétSeni (nX/nXP), nebo vysSku pohledu <0.0000>: Pro pfijeti aktualni vysky

zobrazeni stisknéte Enter. Pro zménu vysky pohledu zadejte bod. Pro vybér koeficientu zvétSeni viozte
hodnotu.

Pro zobrazeni okna uréeného dvéma body

Pro urceni obdélnikového okna kolem oblasti, kterou chcete zvétsit, vyberte nejprve jeden roh (A) a pak
zvolte protilehly roh (B).
Vysledek.
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Zvolte okno (W).
Prvni roh: UrCete prvni roh okna pro vybér oblasti, kterou chcete pfiblizit.
Opacny roh: Ur€ete protilehly roh.

Pro zobrazeni okna zadanim jedné nebo vicero entit

Zvolte moznost entity (EN).
Vyberte entity: Vyberte entity, kterymi chcete vyplnit okno.



